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Using This Manual

Xmath® is a mathematical analysis, visualization, and scripting package that is one
of the five main products of the MATRIXX® product family. Complementing
SystemBuild™, another member of the MATRIXX product family, Xmath serves not
only as an analytical tool, but also as a working environment and visualization tool
for simulation data. Xmath and SystemBuild run concurrently, which allows you to
simultaneously edit SystemBuild models, perform Xmath analysis or SystemBuild
simulations, and display 2D and 3D graphics in presentation quality.

MathScript, the Xmath programming language, provides unique object-oriented ca-
pabilities that facilitate design analysis. Xmath also offers an interactive debugger, a
programmable graphical user interface (GUI) layer, and an extensive library of
mathematical, system modeling, and analysis functions.

Organization

This manual discusses Xmath structure and concepts. Chapter 1 is a tutorial.
Chapters 2, 3, and 4 cover basic features for general Xmath use. Chapters 5
through 9 describe more advanced aspects of Xmath’s structure and its program-
ming abilities. Appendixes A–D contain material that is only of interest to specific
categories of users. A glossary, which includes some general terms as well as Xmath
terms, follows the appendixes. The following is a summary of this manual:

■ Chapter 1, Getting Started, tells how to invoke and exit Xmath; introduces the
Xmath Commands window, your entry point to Xmath, and the Xmath Help
window. This chapter also discusses environmental variables that you should
know and licensing issues.

■ Chapter 2, JumpStart: A Tutorial covers Xmath’s basic and intermediate capa-
bilities and introduces some of Xmath’s more advanced features and concepts.
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■ Chapter 3, MathScript Basics, introduces Xmath’s object-oriented language,
MathScript, and data management in Xmath.

■ Chapter 4, Graphics, details the plot function, providing a complete listing of
all keywords and many examples. This chapter also describes how to change a
plot’s appearance interactively.

■ Chapter 5, Data Objects and Operators, discusses the nature and definition of
each of Xmath’s object classes. It gives examples of how to build and use each
object.

■ Chapter 6, MathScript Programming, discusses how to create different types of
MathScript files, MathScript Functions (MSFs), and MathScript Commands
(MSCs). This chapter also includes brief descriptions of Xmath-supplied func-
tions and commands designed to help you program in MathScript.

■ Chapter 7, MathScript Objects, describes how to define MathScript objects.

■ Chapter 8, External Program Interface, explains the LNX and User-Callable In-
terface (UCI) features. The LNX facility makes it possible to link C, C++, or FOR-
TRAN subroutines into Xmath. The UCI allows your external programs to use
Xmath for graphics and computation.

■ Chapter 9, Graphical User Interface, describes Xmath’s programmable graphical
user interface (PGUI).

■ Appendix A, X Windows and Motif, is included for users who are unfamiliar with
the workstation environment but want to start using Xmath quickly. This ap-
pendix provides a summary of the X and Motif actions used most frequently in
Xmath.

■ Appendix B, Xmath HP-GL Driver, discusses Xmath’s HP-GL driver and the de-
vices it supports.

■ Appendix C, Xmath for MATLAB Users, is designed to help MATLAB users tran-
sition to Xmath. Differences in syntax, behavior, and functionality are dis-
cussed.

■ Appendix D, Xmath to Mathematica Interface, describes how to set up and use
the Xmath to Mathematica Interface.

This manual also has a Glossary of Xmath terms and an Index.
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Conventions

This publication makes use of several types of conventions: font, format, symbols,
mouse, and various levels of notes. Each convention is discussed in the sections
that follow.

Font Conventions

This sentence is set in the default text font, Bookman Light. Bookman Light is used
for general text, menu selections, window names, and program names. Fonts other
than the standard text default have the following significance:

Format Conventions

Xmath output appears in plain Courier directly below the input (see Example 1). If
the output is extremely large, continuation marks (... or :) are used to indicate con-
tinuation, or replace missing parts.

Courier : Courier is used for command and function names, filenames,
directory paths, environment variables, messages and other
system output, code and program examples, system calls,
prompt responses, and syntax examples.

Note that Xmath commands (SAVE, LOAD, SET, etc.) are shown
in uppercase COURIERwhile Xmath functions appear in lower-
case (random , plot , kronecker , etc.)

bold Courier : bold Courier  is used for user input (anything you are
expected to type in).

italic: Italics are used in conjunction with the default font for empha-
sis, first instances of terms defined in the glossary, and publi-
cation titles.

Italics are also used in conjunction with Courier  or bold
Courier to denote placeholders in syntax examples or generic
examples.

Bold Helvetica narrow: Bold Helvetica narrow font is used for buttons, fields, and icons in
a graphical user interface. Keyboard keys are also set in this
font.
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EXAMPLE 1: Xmath Sample Input and Output

x=random(2,6)

x (a rectangular matrix) =

  0.827908    0.926234    0.566721    0.571164 ...
  0.559594    0.124934    0.727922    0.267777 ...

x'

ans (a rectangular matrix) =

  0.827908     0.559594
      :             :
      :             :
  0.0568928    0.988541

If the input is long, continuing lines of input are indented as shown in Example 2.

EXAMPLE 2: Sample Convention for Handling Longer Lines of Code

Sys=system(makepoly([1,-1.63,5.5],"s"),
makepoly([1,2.7,5.6,13.5,8.1],"s"))

Sys (a transfer function) =

          2
         s - 1.63s + 5.5
  -----------------------------
   4      3      2
  s + 2.7s + 5.6s + 13.5s + 8.1

initial integrator outputs
  0
  0
  0
  0
  Input Names
  -----------
  Input 1

  Output Names
  ------------
  Output 1

  System is continuous
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Throughout the manual you will see italicized type. Although italics are sometimes
used for emphasis or cross references to other manuals, the most frequent use is for
glossary items.

“... an improper transfer function...”

Brief explanations for italicized words can be found in the glossary.

Symbol Conventions

Symbols used in this manual include the following:

Hierarchical menu selections are indicated with arrows. For example:

■ To access online Help for an Xmath function (for example, uiPlot ), go to the
online Help Topics Hierarchy, and select the appropriate topic (for example,
“Programmable GUI” (under MathScript Programming in the left
frame)→uiPlot (in the right frame).

■ In the Xmath main menu select File →Load to load a model or demo.

This indicates a specific selection in the menu hierarchy. Menu selections are also
indicated with text:

“... select Save from the Edit menu...”

Mouse Conventions

This document assumes you have a standard, right-handed 2- or 3-button mouse.
From left to right, the buttons are referred to as MB1, MB2, and MB3 for a right-
hand mouse definition; these buttons are right to left for a left-hand mouse defini-
tion. All instructions assume MB1 unless otherwise noted. See Mouse Conventions
on page 1-9.

% UNIX® operating system prompt for C shell. Xmath input shows no prompt (as
you will usually be typing in the Xmath Commands window command area).

$ UNIX operating system prompt for Bourne and Korn shells.

[] Brackets indicate that the enclosed information is optional. The brackets are
generally not typed when the information is entered.

| A vertical bar separating two text items indicates that either item can be
entered as a value.
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When discussing Windows™ procedures, this manual assumes a two-button mouse
where “click” indicates a “left-click” and “right-click” usually indicates a special ac-
tion such as opening a menu. For workstations with a two button mouse, MB1 is
the left button and usually the right button behaves as MB3.

Note and Caution Conventions

Within the text of this manual, you may find notes and cautions. These statements
are used for the purposes described below.

NOTE: Notes provide special considerations or details which are important to the
procedures or explanations presented.

CAUTION: Cautions indicate actions that may result in possible loss of work
performed and associated data. An example might be a system
crash that results in the loss of data for that given session.

Related Publications

Integrated Systems provides a library of publications to support its products. The
following documents are particularly useful for topics covered in this manual:

■ Getting Started (UNIX)

■ Getting Started (Windows)

■ System Administrator’s Guide (UNIX)

■ System Administrator’s Guide (Windows)

The MATRIXX Product Family includes SystemBuild, a graphical modeling tool. Sys-
temBuild is supported by the following manuals:

■ SystemBuild User’s Guide

■ SystemBuild Fuzzy Block User’s Guide

In addition to the above printed manuals, all Xmath commands and key concepts
are documented in the MATRIXX online Help.

Support

You can contact MATRIXX Technical Support in any of the three ways listed below.
When Technical Support responds, you will be given a Call ID specific to the prob-
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lem you have reported. Please record the Call ID and use it whenever you contact
Technical Support regarding the issue.

■ Submit a problem report via the ISI web site using the following URL:

http://www.isi.com/Support/MATRIXx

This is the preferred method, as it is the most traceable; your problem report
will be automatically entered into our support database.

■ Send an e-mail to mx_support@isi.com . We can serve you better if you e-mail
us with details on your configuration and the circumstances under which your
problem occurred. We provide an ASCII file that you can use as a template for
your e-mail to support; it can be found in:

MATRIXX/version/v6support.txt

where

MATRIXX is your MATRIXX product version directory, which is under ISIHOME.
To determine this directory location, from the Xmath command line, type one of
the following commands.

On the PC:

oscmd("echo %MATRIXX%");

On UNIX:

oscmd("echo $MATRIXX");

If you have Xmath running you can use the following Xmath function call to
copy the template to the current working directory:

copyfile("$MATRIXX/version/v6support.txt")

■ Call 800-958-8885 (where 1-800 service is available) or 408-542-1930. Tele-
phone support hours are 7:00 a.m. through 5:30 p.m. PST, Monday through
Friday. We can respond more efficiently if you are ready to provide the informa-
tion requested in MATRIXX/version/v6support.txt  at the time you call.

Using the ISI FTP Site

If your problem involves scripts or model file(s), Technical Support may ask you to
FTP your files to us for further examination.
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1. Connect to the ISI FTP site:

ftp ftp.isi.com

2. Log on as anonymous , and supply your e-mail address as the password.

3. Change to the /incoming  directory:

cd /incoming

4. Use put or mput to specify the file(s) you are transferring. When the transfer is
complete, quit .

5. Send an e-mail message to Technical Support that states the Call ID (if avail-
able), the exact name(s) of the file(s) you put in /incoming , and the approxi-
mate time you made the transfer; alternatively, call 800-958-8885 (where 1-800
service is available) or 408-542-1930 and provide this information. It will be a
minimum of 15 to 20 minutes before the transferred file(s) will pass through the
firewall.
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1 Getting Started

This chapter contains general information intended to help you get started using
Xmath. Major topics in the chapter are:

■ Environment Variables

■ Starting and Stopping Xmath

■ Licensing

■ Using Xmath Windows

■ Xmath Commands Window

■ MATRIXX Help Window

This chapter assumes Xmath has been properly installed according to the System
Administrator’s Guide for your operating system and platform. For details about X
Windows and the Motif window manager, see Appendix A, X Windows and Motif. For
more information about Windows operating systems, see the appropriate System
Administrator’s Guide for your operating system.

1.1 Environment Variables

This section contains several environment variables that you need to know. You
should also know that MATRIXX environment variables are only defined while the
application is running within MATRIXX. When we use an environment variable in a
pathname with its appropriate designation ($NAMEfor UNIX and %NAME% for Win-
dows), then it is appropriate to use the environment variable as specified. When we
use NAMEin italics alone, for example, ISIHOME, then you substitute the pathname
in the command.
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Xmath defines ISIHOME and XMATH; it recognizes the remainder of the environ-
ment variables provided below. We define these variables below; you can place them
in your .cshrc file (UNIX), in your autoexec.bat file (Windows), or in your system
properties (environment) (Windows NT); alternatively, you can define them in each
session in an xterm or Command Prompt window.

1.1.1 ISIHOME

ISIHOME is an environment variable representing the installation directory for ISI
tools. This variable is used in pathnames.

1.1.2 XMATH

XMATHis an environment variable representing the directory where Xmath was in-
stalled. Throughout this manual XMATH is used in pathnames.

1.1.3 XMATH_STARTUP

XMATH_STARTUPis an environment variable you can use to specify a directory. On a
UNIX system, for example, if you are using the C shell, you could add the following
command to your .cshrc  file:

setenv XMATH_STARTUP "/ home/ this "

When you execute the xmath command, Xmath runs the startup MathScript
file (startup.ms) in the specified directory (/home/this).

1.1.4 XMATH_PRINT

XMATH_PRINTis an environment variable that lets you set up a default printer. To
define XMATH_PRINTfor a SunOS system using the print command lpr and a
printer named hp0 , define XMATH_PRINT:

setenv XMATH_PRINT "lpr -Php0"

The next time you run Xmath and use the HARDCOPYcommand, Xmath uses the
value of XMATH_PRINT to send the graphics to the printer.

If you are on an SGI or HP system, set XMATH_PRINTwith an entry similar to the
following:

setenv XMATH_PRINT "lp -dhp0 -c"

If you are on a Windows operating system, set XMATH_PRINTwith an entry similar
to the following:
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set XMATH_PRINT= ISIHOME\xmath\bin\xmprint your_printer

where your_printer  is the name of your selected printer.

You can place this command in the autoexec.bat file in the root directory of your
C drive. On Windows NT, you have the alternative of using the System Properties,
Environment tab under the Control Panel to specify the environment variable.

NOTE: If you specify the XMATH_PRINTenvironment variable, you do not need to
set the PRINTER variable. (Xmath ignores it.)

1.1.5 PRINTER

PRINTER is an environment variable that lets you specify a default printer (if
XMATH_PRINT) is not defined.

For example, to define PRINTER on a SunOS system, for a printer named hp0 , de-
fine the PRINTER environment variable in your .cshrc  file with the following:

setenv PRINTER "hp0"

The next time you run Xmath and use the HARDCOPYcommand, Xmath will use the
value of PRINTER to send the graphics to the printer.

NOTE: ISI recommends the XMATH_PRINT environment variable in most cases
as the XMATH_PRINT syntax allows for platform-specific parameters.
PRINTER, for example, might work on SunOS but fail on an HP system.

1.2 Starting and Stopping Xmath

This section covers starting and stopping Xmath, as well as terminating Xmath (ab-
normally) and quitting and restarting Xmath at the same point in your process. Ma-
jor topics include:

■ Starting Xmath

■ Interrupting or Terminating Xmath

■ Quitting Xmath

■ Stopping and Restarting Xmath
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1.2.1 Starting Xmath

Starting Xmath is a little different on UNIX and Windows machines, and the options
available are also different. Therefore, we have included sections for each operating
system.

Starting Xmath on UNIX Systems

You can start Xmath from any directory in any xterm window, either in the fore-
ground or the background.

Starting Xmath Locally

To start Xmath:

1. Bring up an xterm window.

An xterm window is any window that allows you to input at the operating sys-
tem prompt.

2. Enter the following command:

% xmath

Unless all licenses are in use (see Section 1.3 on page 1-8), the Xmath Com-
mands window appears after a few seconds.

Internal messages and warnings from Xmath may be written to the xterm win-
dow.

Starting Xmath on a Remote X Host

If you want to run Xmath on a remote UNIX host, you can start it from your local
machine or from the remote host itself.

To start Xmath from your local computer, type:

% xmath -host  remoteHostName

The remote host must accept a remote shell (rsh). Be aware that when the oper-
ating system stores the name of the current working directory, the name may
not be equivalent to that of the same directory on the remote host. (For example,
/home/user on the local machine versus /net/machine/home/user on the
remote machine.) When there is no verbatim match, Xmath will start in your
home directory on the remote machine.
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To confirm your location, go to the Xmath Commands window command area
and type show directory . If necessary, use set directory to change the
working directory from within Xmath.

To start Xmath from the remote host, type:

% xmath -d localHostName :0.0

This command displays the Xmath session on your local machine; you need to
make sure your local machine accepts the display from a remote host. Consult
the documentation on the UNIX operating system command xhost .

Command-Line Options Available on UNIX

Table 1-1 contains a partial list of options; some options might not be available on
your platform.

To get help on the xmath  command in an xterm window, type:

xmath -h
or
xmath -help

TABLE 1-1 Commonly Used Startup Options for UNIX

Switch Action

-tty Start the tty (non-windowing) version. This version is
suitable for command-line calculations. It can also be
used to submit a list of instructions in batch mode (see
Section 3.9 on page 3-27). The tty version has no
online Help or graphics capabilities.

-call name args Runs a user-callable interface (UCI) executable, where
name is the image name and args  can be any com-
mand line arguments required by the UCI.

-clean If a UCI has terminated abnormally you can run
Xmath with this switch to clean up orphaned pro-
cesses. No other switches are accepted when -clean
is specified.
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Starting Xmath on Windows Systems

To start Xmath on a PC, use one of the following methods:

■ Select Start→Programs→MATRIXx xx.x→Xmath

■ Enter the following command from the Command Prompt window:

% ISIHOME\bin\xmath

where ISIHOME represents the installation directory for ISI tools.

Table 1-2 contains a partial list of options; some options might not be available
on your platform.

Internal messages and warnings from Xmath may be written to the Command
Prompt window.

To get help on the xmath  command in the Command Prompt window, type:

ISIHOME\bin\xmath -h
 or
ISIHOME\bin\xmath -help

where you provide the path for the root installation directory of ISI tools (ISIHOME).

1.2.2 Interrupting or Terminating Xmath

To interrupt interactive execution of an Xmath function or command, press Ctrl-C (on
UNIX systems) or Ctrl-Break  (on Windows systems) from any Xmath window.

NOTE: Intrinsic commands (for example, save or load ; see Section 3.5 on
page 3-15) are noninterruptible. The same is true for window, dialog, or
plot creation.

TABLE 1-2 Commonly Used Startup Options for Windows

Switch Action

-call name args Runs a user-callable interface (UCI) executable, where
name is the image name and args  can be any com-
mand line arguments required by the UCI.

-clean If a UCI has terminated abnormally you can run
Xmath with this switch to clean up orphaned pro-
cesses. No other switches are accepted when -clean
is specified.
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On UNIX systems, if either the windowing version or the tty version is not respond-
ing, terminate your Xmath session by pressing Ctrl-\ (hold down the Control key and
press the backslash key [\]). This key sequence terminates Xmath properly in un-
usual circumstances.

1.2.3 Quitting Xmath

From a windowing version of Xmath, use any one of the following methods to quit
Xmath:

■ Type quit in the Xmath Commands window command area (the only part of the
Xmath Commands window that accepts input).

■ Choose File→Quit from the menu bar.

■ With the cursor over the Xmath Commands window, press Ctrl-q .

■ On UNIX systems, select Close from the X Windows Default Menu in the Xmath
Commands window.

■ On Windows systems, click the X (Close) button in the upper right corner of the
Xmath Commands window, or click the Xmath icon in the upper left corner of
the Xmath Commands window and select Close from the system menu, or use
its keyboard equivalent of ALT F4.

In all cases above, the Quit_popup dialog may appear.

You are given the opportunity to save before exiting. Selecting Save here saves all
current variables to a file named save.xmd in the current working directory. The
session terminates after the file is saved.

If you are using the tty version, type quit . You may see the following warning:

Modified variables that have not been saved exist; quit anyway? (y/n)

FIGURE 1-1 Quit Confirmation Dialog
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Type y (yes) or n (no) as desired. For more on saving data, see Section 3.7 on
page 3-19.

1.2.4 Stopping and Restarting Xmath

You can quit Xmath at any time. To resume at the same point, type save in the
Xmath Commands window command area before quitting, or select Save in the Quit
dialog. This saves all existing data to a file called save.xmd in the current working
directory.

NOTE: The Save command overwrites any previous save.xmd file in the current
working directory.

To resume a session:

1. Restart Xmath from the same directory

2. Type load  in the command area.

The default save file save.xmd  is loaded.

1.3 Licensing

When Xmath starts, it checks out the Xmath Core license. The license for each mod-
ule is checked out when that module is started; for example, the Control Design
Module is checked out when that module is started. If your site has a floating li-
cense or counted node-locked license, you may be unable to check out a particular
module.

If a Core license is available, the Xmath Commands window appears after a few sec-
onds (see Figure 1-2 on page 1-12 for the UNIX version).

To get license information for your current version:

■ Select Help→On Version from the Help menu on any Xmath window.

A pop-up appears that tells you the version, date, and platform.

■ In the Xmath Commands window command area, type:

licenseinfo

A list of modules for which your site is licensed and their expiration dates ap-
pear in the log area.
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For additional information about your Xmath license, see the System Administra-
tor’s Guide for your operating system.

1.4 Using Xmath Windows

The major Xmath windows are listed in the table below, along with sections in which
you can find information about them. You get to these windows through the Win-
dows menu on each of the other windows.

This section contains general information that applies to all Xmath windows.

1.4.1 Mouse Conventions

This document assumes you have a 2- or 3-button mouse. From left to right, the
buttons are referred to as MB1, MB2, and MB3. All instructions assume MB1 un-
less otherwise noted. Table 1-4 lists common mouse instructions.

TABLE 1-3 Major Xmath Windows

Xmath Window Section Page

Commands 1.5 1-11

Graphics 4.3 4-46

Variables 3.2.5 3-11

Palette 4.3.4 4-56

Debugger (UNIX only) 2.6.2 2-40

TABLE 1-4 Common Mouse Instructions

Instruction Action

click Press then quickly release MB1.

double-click Rapidly click MB1 twice.

drag Hold down MB1 while moving the mouse; release the
button when the desired result is obtained.
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The following mouse-click combinations are useful for selecting text:

■ To select a word, point anywhere within the desired word and double–click.

■ To select an entire line, point anywhere on the line and triple-click.

■ To select all text in an Xmath window area, move the cursor into the area and
quadruple-click.

1.4.2 Scroll Bars

Most Xmath windows have horizontal and vertical scroll bars so you can look at
data that extends beyond your window border. As you can see in Figure 1-2 on
page 1-12, scroll bars have a small arrow on each end and a center area with a rect-
angular slider.

The size of the slider depends on the amount of data out of view. In Figure 1-2, the
horizontal slider fills the whole area because all data is visible. The slider becomes
smaller as data accumulates. To move the slider, place the mouse pointer over the
slide bar and use MB1 or MB2 to drag in the desired direction. If you click MB1 or
MB2 in the scroll bar and off the slider itself, the slider moves toward the point you
clicked.

1.4.3 Resizing Xmath Windows

Most Xmath windows are divided into several areas. If you make a window shorter,
you may notice that some areas get too small to be useful, or even seem to disap-
pear. When this happens, vertically resize these subwindows.

On the right side of a window on UNIX systems, you can see a small square strad-
dling the border between two areas. (See Figure 1-2 for an example.) This is called a
grip or a sash. When you place the pointer over it, the cursor changes to a cross-
hairs symbol ( ). Drag the grip vertically in the direction you want the area to grow
or shrink. Experiment with a combination of resizing the frame and resizing the ar-
eas.

On Windows versions, you can resize the windows using standard windows tech-
niques.

1.4.4 Menus

The menu bar features pulldown menus that appear on most Xmath windows, al-
though not all menus are active in all windows. You can open menus by clicking on
the menu name or dragging down from the menu name.
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1.4.5 Meta Key

You need to know where the equivalent of the Meta key is on your keyboard if you
plan to use Xmath’s accelerators. Whenever the documentation or one of the menus
refers to Meta, you will need to press the key appropriate to your machine, as shown
in Table 1-5.

1.5 Xmath Commands Window

The Xmath Commands Window appears when you start Xmath (see Figure 1-2).
This is your primary interface to Xmath. On UNIX systems, the Xmath Commands
window contains three primary areas: the log area, the command area, and the
message area. Windows systems have only two primary areas: the log area and the
command area; the information that goes to the message area in UNIX goes to the
log area on Windows systems.

You can interact with Xmath with both keyboard and mouse. While the keyboard is
used for input, mouse position dictates the active input area; the mouse is also used
for menu selection, text manipulation, and for displaying shortcut menus (right-
click). (See Section 1.4.1 on page 1-9 for mouse conventions.)

TABLE 1-5 Meta Key

Platform Key or Key Sequence

Sun Key with a diamond symbol (on either side of the space bar)

HP Extend/Char key (to the left of Shift)

IBM Alt

Windows Alt

SGI Alt
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FIGURE 1-2 Xmath Commands Window (UNIX view)
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1.5.1 Menus

The pulldown menus shown in Table 1-6 are active in the Xmath Commands win-
dow.

1.5.2 Log Area

The log area keeps a record of your interactions with Xmath. Both inputs and out-
puts are displayed in the log area. Certain actions in the user interface also cause
Xmath to write to this area.

To control the number of lines written to the log area, type

set logarea N

where N is the number of lines; N is also limited by the buffer size, which is machine
dependent. Using this command truncates the current contents to that number of
lines.

To set the lines to the maximum, type

set logarea max

This limit is dependent upon hardware and the operating system resources avail-
able.

To turn writing to the log area off:

set logarea off

TABLE 1-6 Xmath Menus

Menu Description

File Allows you to execute files, set partitions and directories,
load files, save all variables, and exit Xmath.

Edit Allows you to clear the log area, message area, and com-
mand area, as well as send a command and insert a new
line in the command area.

Options Allows you to set the output display precision.

Windows Quickly finds other Xmath windows and brings them to the
foreground.

Help Invokes the online Help and provides version information.
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Current contents of the log area are discarded. While logging is turned off, the data
is not being buffered, and it is lost. When you are running batch and simulation
jobs in SystemBuild, setting logging off speeds up their execution slightly.

To turn writing to the log area on:

set logarea on

All subsequent log data is displayed up to the limit; the limit is what you set previ-
ously or the default (maximum).

The command

show logarea

displays both the number of lines (or ALL)  and the state of logging: On or Off.

To erase the log area, select Edit→Clear Log Area, or type

erase {logarea}

This action is not reversible, although you still have access to command recall to
retrieve previous entries.

If a file is executed, the file contents are not written to the log area unless set echo
on is specified (the default is off ).

1.5.3 Command Area

The command area is the only part of the Xmath Commands window (or any of the
major Xmath windows) that accepts text input, so you can focus anywhere on the
window and type. (If you are not familiar with the term focus, see Section A.2.2 on
page A-5.)

Pressing Return  or Enter  causes Xmath to execute everything in the command area.

Specifying Directory Pathnames and Filenames

Within the command area, you often need to specify directory pathnames and file-
names. To do so, you must use valid names. In general, Xmath does not recognize
directory pathnames and filenames that contain spaces. Although such names are
valid in Windows operating systems, Xmath does not recognize them from the
command line; however, if you can select the directory and/or filename from a
Browser or File Selection dialog, Xmath does accept them.
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Scripts, saving and loading data, printing a file, and changing a directory or path
can each be accomplished via a file selection dialog. On UNIX platforms, Xmath
uses the Motif file-selection dialog for interactive directory and file specification.

Figure 1-3 shows a typical file selection dialog on UNIX. Most dialogs have the same
fields, but some actions may not require all fields.

If you know the full pathname of the directory or file you want, type it in the Selection
field at the bottom, and then press Return  or click OK.

NOTE: All of the file interactions described above can also be accomplished from
the command line, provided that the directory pathnames and filenames
do not contain spaces, which are not generally recognized in the Xmath
command area.

FIGURE 1-3 Save Dialog (UNIX version)
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Entering Multiple Lines of Information

Entering multiple lines of text works differently on UNIX and Windows systems. See
page 2-3 for an example.

On UNIX Systems

To enter multiple lines of text, press the Line Feed key or Shift-Return to start a new line.
When you are finished typing, press Return to send all the lines to Xmath. Whenever
the documentation refers to linefeed, you need to press the key(s) appropriate to
your machine, as shown in Table 1-7.

You can achieve the same result by selecting Edit→Insert New Line from the menu
bar. The accelerator for your machine appears to the right of the Insert New Line
menu item.

On Windows Systems

To send a set of multiple lines on Windows:

1. Enter the multiline mode by pressing Shift-Enter .

 You can press Shift-Enter  before or after entering the first line.

2. Enter your lines of text, pressing Enter  after each.

3. Leave the multiline mode by pressing Shift-Enter .

4. Send all lines to Xmath by pressing Enter.

The Edit menu provides the Send Command that you can use instead of the Enter
key.

TABLE 1-7 Linefeed Key

Platform Key or Key Sequence

Sun Line Feed or Shift-Return

HP Insert Line

IBM Shift-Return

SGI Shift-Return
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Editing Text by Selecting, Copying, and Pasting

The command area is in insert mode. You can use mouse clicks or keyboard se-
quences to move the cursor within a line of text.

Your operating system’s standard selection, copy, and paste methods are all valid.

The following selection sequences are defined:

■ To select a character (forward or back), hold down the Shift key and press the
right  or left arrow  key (command area only for UNIX).

■ To select a word, point anywhere in the word and double-click.

■ To select a line, point anywhere on the line and triple-click.

■ To select all text in the window area, click four times (UNIX only).

You can paste text from any Xmath window or other ASCII source into the Xmath
command area.

In UNIX, you can select a previous command from the log area, paste it into the
command area, and re-execute it. The following copy and paste method is standard,
although it may vary slightly with different window managers:

1. Point to the desired text and drag (holding down MB1) until everything you want
appears in reverse video (is highlighted). Avoid highlighting extra characters.

2. Point to the destination and click MB2.

Key Bindings Used in Editing Text

Key strokes help you perform editing functions for Xmath. Key bindings vary some-
what depending upon your type of operating system. You can change the key bind-
ings for UNIX; for Windows, you cannot.

UNIX Default Bindings

The UNIX default bindings are emacs-style, as shown in Table 1-8. On UNIX sys-
tems keyboard types vary, so the default mappings for your particular keyboard
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might be slightly different. For example, arrows may map to editing keys or keypad
arrows according to the keyboard.

TABLE 1-8 UNIX Default Key Bindings

Keystrokes Action

Ctrl-a Beginning of line

Ctrl-b, ← Back one character

Ctrl-d Delete next character

Ctrl-e End of line

Ctrl-f, → Forward one character

Ctrl-j New line

Ctrl-k Kill to end of the line

Ctrl-l Redraw display

Ctrl-n Next line

Ctrl-o Put remainder of line on a new line

Ctrl-p Previous line

Ctrl-u Delete to the beginning of the line

Ctrl-w Wipe (delete) selected text

Ctrl-y Yank back a single line of killed text (unkill)

Ctrl-↑ Move up through recorded inputs (command area recall is dis-
cussed on page 1-20)

Ctrl-↓ Move down through recorded inputs

Backspace Delete previous character

Delete Delete previous character

Home Move cursor to first character of text area

End Move cursor to last character of text area

PgUp Move up one page
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Windows Bindings

On Windows, the set of key bindings is more limited but still exists (see Table 1-9).

Changing the Key Bindings (on UNIX systems)

You may prefer UNIX-style or EDT-style bindings. These, along with many other de-
faults, are implemented through the file $XMATH/etc/Xmath .

To customize your key bindings, use a text editor to create a file called Xmath in
your home directory. Into this file, copy the desired key binding set from $XMATH/
etc/Xmath . Your Xmath file should contain only those changes that differ from the
defaults. Close and save your file.

The new key bindings become effective the next time you invoke Xmath. (For more
on changing Xmath defaults, see Section A.3 on page A-9.)

PgDn Move down one page

Ins Insert a new line (linefeed)

TABLE 1-9 Windows Key Bindings

Keystrokes Action

Ctrl-a Beginning of line

Ctrl-d Delete next character

Ctrl-j New line

Ctrl-k Kill to end of the line

Ctrl-↑ Move up through recorded inputs (command area recall is dis-
cussed on page 1-20)

Ctrl-↓ Move down through recorded inputs

Delete Delete next character

Home Move cursor to first character of text area

End Move cursor to last character of text area

TABLE 1-8 UNIX Default Key Bindings (Continued)

Keystrokes Action
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Recalling Previous Commands

Xmath has a command area recall feature based on keystrokes, as shown in
Table 1-10.

■ Only syntactically correct inputs are recorded.

■ @ commands are not recorded as inputs.

■ Multiline inputs are recorded and recalled as one line.

■ One hundred inputs are recorded; the oldest are automatically discarded to
make room for new inputs.

■ An @command can only be entered in the Xmath Commands window command
area on a line by itself. It cannot be issued from a MathScript batch file.

1.5.4 Message Area

The message area displays Xmath error messages and warnings. If an error oc-
curred when you were typing in the command area, Xmath highlights the possible
source of the error and displays a message in the message area (UNIX) or the log
area (Windows). The input is not accepted until you fix the error.

TABLE 1-10 Command Area Recall Keystrokes

Keystrokes Action

Ctrl- ↑ Moving backwards, print recorded inputs in the command area.

Ctrl- ↓ Moving forward, print recorded inputs in the command area.

@@ Execute the last command.

@@:p Print the last input in the command area.

@str Execute the last input starting with str .

@str:p Print the last input starting with str .

@n Execute the nth input.

@:l List all inputs in the log area.

@str:l List all inputs starting with str  in the log area.

@ List the last 10 inputs. If @ is issued again (without an intervening
Xmath command) 10 inputs back from that point will be listed.
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1.6 MATRIXX Help Window

MATRIXX provides a hypertext markup language (HTML) Help system (see
Figure 1-4). The MATRIXX Help system is a self-contained system with multiple hy-
pertext links from one component to another. This Help system, augmented by on-
line manuals, covers most MATRIXX topics except for installation.

FIGURE 1-4 MATRIXX Help Window Topics Hierarchy and Master
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The MATRIXX online Help system requires Netscape Communicator 4.03 or later. On
UNIX systems, an OEM version of Navigator is automatically included in the
MATRIXX installation. On PC systems, Netscape Communicator must be installed
independently using the Netscape installation procedure included on the MATRIXX

CD.

The fonts and colors shown are determined by your Netscape browser settings, so
the window may only look similar to the one shown here. For more information on
Netscape products, see Netscape’s home page at http://home.netscape.com .

You can invoke the MATRIXX online Help as follows:

■ Select Help→Topic from the Xmath Commands window or type help in the
command area of the Xmath Commands window; a listing of available topics ap-
pears in the left pane (see Figure 1-4). Scroll down to see additional entries.

■ Once in the Xmath Help window you can use the Topics Hierarchy (table of con-
tents) in the left pane to locate topics.

For example, to view a linear algebra function (for example, hessenberg ), find
the Math topic in the left pane, and select Linear Algebra; click hessenberg in
the right pane.

■ You can also use the Master Index (see Figure 1-4 in the right pane) to locate a
topic or function alphabetically. Using the alphabet at the top of the right pane,
you can link directly to the topics for any given letter.
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2 JumpStart: A Tutorial

This tutorial introduces basic Xmath features. It highlights some of the ways Xmath
is different from other tools. After getting you started, this chapter provides the fol-
lowing major topics; the times shown are estimates of how long it takes to complete
each section.

To use the JumpStart you must have a properly installed version of Xmath. You
should also be familiar with the following:

■ Your operating system

■ A text editor

■ On UNIX platforms, your window manager

If you are new to the workstation environment described in this book, see
Appendix A, X Windows and Motif. It will be helpful to new UNIX users because
many UNIX-based window managers share common functionality. We assume
that workstation users have X Windows and a window manager running before

Topic Page Time to Complete

Basic Data-Handling 2-2 15 minutes

Functions and Commands 2-10 10 minutes

Graphics 2-12 30 minutes

Objects 2-24 60 minutes

MathScript 2-39 15 minutes
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starting this tutorial. The Jumpstart is very basic and you will be able to com-
plete it even if you are unfamiliar with the workstation environment.

If you find yourself having difficulties with the most basic elements, such as not un-
derstanding how to use the Xmath Commands window or how to get online Help, re-
fer back to Chapter 1.

This tutorial contains many cross-references to other parts of the document. It is
not necessary to consult the cross references to complete this tutorial. After com-
pleting the tutorial, you may want to look into some of the advanced features in
Chapters 6 through 9.

2.1 Starting Xmath for the Tutorial

In this section, we want you to create a directory called jumpstart , make that di-
rectory your working directory, and start Xmath. From an xterm window (UNIX) or
the Command Prompt window (Windows), enter the following commands:

% mkdir jumpstart

% cd jumpstart

Then start Xmath using one of the methods provided in Section 1.2.1 on page 1-4.

You may stop or interrupt the tutorial at any point. Remember to save your work be-
fore you quit and to reload it upon startup again (see Section 1.2.4 on page 1-8 for
details.)

2.2 Basic Data-Handling

This portion of the tutorial discusses creating and organizing variables, as well as
saving, deleting, and retrieving them.

2.2.1 Creating Variables

A variable is named information. To create a variable, you must type into the Xmath
command area. You can assign a name to data:

a=3.14

a (a scalar) = 3.14
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and assign the results of expressions or the output of an Xmath function:

b=a+expm([1,2;3,4])

b (a square matrix) =

55.109 77.8766
115.245 167.214

Pressing Return or Enter executes everything in the command area. By default, your
input is displayed in the log area, followed by the output. To suppress output dis-
play, terminate inputs with a semicolon (see page 3-24 for a way to change display
behavior).

b;

If you input more than one statement on a line, a semicolon or question mark
(which forces output) must be used as a separator. Type:

c=b^a; d=b/a? c=d-a;

d (a square matrix)=

17.5506 24.8015
36.7022 53.2528

The only output displayed is the value of d, but c  exists.

When entering multiple lines of text in the command area, use the Line Feed key or
Shift-Return to start a new line, and press Return when you are finished. If your key-
board doesn’t have a Line Feed key select Edit→Insert New Line from the Xmath Com-
mands window, or use the key combination appropriate to your platform (see
page 1-16).

In the following example, press Line Feed after inputting the numbers 3 and 6, and
press Return  after the right square bracket:

e=[1,2,3
   4,5,6
   7,8,9]

e (a square matrix) =

  1    2    3
  4    5    6
  7    8    9
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If you don’t assign a variable name to a valid statement, Xmath assigns the value to
the temporary variable ans . The following expression uses the permanent variable
jay  to create a matrix of complex numbers and assign the matrix to ans :

e*jay;
ans?

ans (a square matrix) =

    j    2 j    3 j
  4 j    5 j    6 j
  7 j    8 j    9 j

ans  will be changed the next time a statement output is not assigned to a variable.

To comment an existing variable use the comment command:

comment b "combined an expression and a function"

You must enclose the comment string, like all other strings in Xmath, in double
quotes:

To retrieve the comment, use the commentof  function:

commentof(b)

ans (a string) =   combined an expression and a function

Xmath also displays the comment when you view the variable in the Xmath Variable
Manager window, which is discussed in Section 2.2.3 on page 2-7.

If you make an error, Xmath attempts to highlight the incorrect input. For example,
type:

max(E)

What you typed remains in the command area with the E in reverse video. The mes-
sage area displays E undefined in this scope .

Go to the command area and replace the capital E with a lowercase e:

max(e)

ans (a scalar) =   9

The max function now finds the largest value in the variable e. For detailed informa-
tion on entering and editing text, see Editing Text by Selecting, Copying, and Pasting
on page 1-17.
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Using Command Recall

To print previous inputs to the command area, hold down the Control key and press
the up arrow  (Ctrl- ↑). For more on command area recall, see page 1-20.

Sending Multiple Lines of Data at Once

On UNIX, you press Shift-Return after each line until you are ready to send the entire
set of lines to Xmath; then you press Return.

On Windows, pressing Shift-Enter turns on multiline mode. In this mode, pressing the
Enter key adds a new line rather than sending the command line to Xmath. Pressing
Shift-Enter again turns off this mode. Pressing Enter a final time sends the multiple
lines to Xmath for execution.

For example:

sends the multiline for-loop to Xmath at one time.

2.2.2 Variables and Partitions

Xmath variable names are case-sensitive (for example, MyVar, myvar , and MYVAR
are different variables).

A partition is a named non-hierarchical directory that contains variables. Partition
names are also case-sensitive.

Xmath always starts in the default partition main . You can verify this by typing
show partition in the command area. The full name of a variable includes its
partition, so the variable a, found in partition main , is named main.a . However,
you don’t need to supply a prefix when handling variables in the current partition.

Use the command new partition to create partitions. Other commands used for
partition handling are set , show, and delete .

UNIX Windows

for i=1:10
i?

endfor

Shift-Return
Shift-Return
Return

Shift-Enter
Enter
Enter
Shift-Enter
Enter
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1. Create new partitions:

new partition data1
new partition data2

2. Using variables in the current partition (the default partition main ), create new
variables for the partition data1 :

data1.a=a\b;
data1.b=lyapunov(b,c);

3. Go to the new partition data1 and display a list of the variables in that partition
to the log area:

set partition data1

who # List variables in the current partition
data1:

a -- 2x2
b -- 2x2

4. Attach a comment to a partition in the same way you comment variables, except
that you must put a period after the partition name to distinguish it from a vari-
able name:

comment data1. "vault"
commentof(data1.)

ans (a string) =   vault

5. Use the same variable name in other partitions:

data2.a=random(4,4);
comment data2.a "a random matrix"
who data2.* # List variables in the named partition
data2:

a -- 4x4

6. Look at all the partitions and all existing variables:

show partitions # Shows all partitions
who *.* # Show all variables in all partitions

7. Delete a partition (data1 ).

To delete a partition, you must first empty it:

delete data1.* # Delete variables in data1.
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To delete a partition you are in, change to another partition first:

set partition main

delete data1. # Delete the partition data1

2.2.3 Viewing Data

The Xmath Variable Manager window lists all variables in the current partition.
While it is open, Xmath immediately updates it whenever changes occur in the
viewed partition.

1. To invoke the Xmath Variable Manager window, select Windows→Variables from
the Xmath Commands window.

You should be viewing the current partition (main) .

2. Click the Partition button in the Xmath Variable Manager window. In the dialog
that appears, select main , and click OK.

This lists the variables in main . Note that you are only viewing the partition;
you have not changed your working partition. (Only the set partition com-
mand issued from the command area will change the partition. Remember, you
can type show partition  to see the current partition.)

3. Try the selections on the Variable Manager window View menu to change the or-
ganization of the variables. Try sorting by Name, Size , and Type .

4. To close the Variable Manager window, select File→Close Window.

For additional information on the Variable Manager window, see Section 3.2.5 on
page 3-11.

2.2.4 Saving Data

The functions in Table 2-1 save data to files.

TABLE 2-1 Save Functions

save Save variables in Xmath or MATRIXX format to a binary or ASCII file.
This is the standard way of saving data.

print Print the values of a list of variables to an ASCII file.

fprintf Convert numeric values to a string representation, and then write
the string(s) to an ASCII file.
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You can perform save operations from the command area and from the File menu of
most windows.

Save Command

The easiest save method is to type save in the command area. When you do, Xmath
saves all variables to a file named save.xmd in the current working directory. By
default, save  produces a binary file with the variables saved in Xmath format.

You can specify a list of variables, a filename, or a format. For example,

save main.* file="main"  {ascii}

saves all variables in the partition main to an ASCII file named main.xmd in the
current partition. Note that save  adds the .xmd  extension for you.

To save all variables to a binary data file via the File menu in either the Xmath Com-
mands window or the Xmath Variable Manager window:

1. From the menu bar, choose File→Save All (UNIX) or File→Save (Windows).

The Save dialog comes into view.

2. Add the filename data1.xmd to the path in the Selection field at the bottom of
the dialog (UNIX), or select a directory and then specify a filename in the File
name field of the Windows’ dialog.

For a complete explanation of this dialog, see Specifying Directory Pathnames
and Filenames on page 1-14.

3. Click OK or Save.

If you look at the log area, you will see that the text equivalent of your save ac-
tion is echoed there (UNIX only). The current message will be similar to:

save file="/YourPath/data1.xmd"

Print Command

The print  command writes a variable in a text format you can read.

To print a specific variable to a text file:

set seed =0;
x=(rand(2,2))*sin([5,1;4,2]);
print x file="x.dat"
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The function oscmd lets you use an operating system command to display the con-
tents of the file you created to the Xmath Commands window log area:

oscmd("cat x.dat") # UNIX
oscmd("type x.dat")# Windows

main.x =
-0.77482 0.865292
-0.250204 0.300552

ans (a scalar) = 0

2.2.5 Loading Data

Load Command

If you type load (with no file specified) in the command area, Xmath looks for the
default file save.xmd  in the working directory and loads it if it exists.

To test this, go to the command area and input the sequence below; these instruc-
tions assume you are in partition main .

a=1; b=2; c=3; d=4; # Create variables a, b, c, and d
save #  Save all variables to save.xmd
who *.* # Verify that the variables are in main

delete *.* #  Delete variables in main
who *.* # Verify that the variables have been deleted

You can then retrieve selected variables or all saved data:

load c d "save" # Load variables c and d from save.xmd

-or-

load # Load all variables in save.xmd

who *.* # Verify that the variables have been loaded

Xmath supplies the default filename extension xmd when you don’t supply one.
Another way to load saved data is to go to the commands or Variable Manager win-
dow and select File→Load from the menu bar.

xb.book  Page 9  Wednesday, October 6, 1999  11:28 AM



JumpStart: A Tutorial Xmath Basics

2-10

Read Command

The read command copies the contents of a file into an Xmath matrix. This func-
tion is particularly useful for loading externally generated data into Xmath. The data
can be character, integer, or floating-point types, as well as ASCII. Consult the on-
line Help for read . Note that the arguments are a filename, the rows and columns of
the data, the type (or format), and the number of bytes in the file you want to skip
before reading.

Read in the file you made with the print command (see Print Command on
page 2-8).

■ Specify the input filename (x.dat ), give the row and column dimensions of the
data, and specify the input file format (ascii ).

■ Specify an offset of 1; this instructs Xmath to skip the first line (main.x = ).

We do not have to worry about the last line in the file, (ans (a scalar) = 0 ),
because read stops after the two rows and columns you specified have been
read.

xx=read("x.dat",2,2,"ascii",1)

xx (a square matrix) =

-0.77482 0.865292
-0.250204 0.300552

2.2.6 Cleanup

This concludes the section on basic data-handling. You can delete the variables and
partitions you created, as you do not need them later. Do not, however, delete the
partition main ; delete only its contents.

2.3 Functions and Commands

If you have been working through the tutorial, you have already used several com-
mon commands and functions. In addition to discussing functions and commands,
this section includes references to more detailed passages.

2.3.1 Function Syntax

Functions operate on a list of input values and return output values. Input argu-
ments are passed by value (a local copy is nested inside the function scope).
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Functions are called in the following form:

[out1,out2,...,outn] = funName(in1,in2,...inm,{options,keywords})

For examples of this syntax, see the Xmath online Help (function s topic).

■ Input and output arguments are separated by commas.

■ Keywords are enclosed in braces and separated by commas.

■ When a string is required, it must be enclosed in double quotes; for example,
line_color="blue" .

■ If a function has multiple outputs, by default only the first output is returned.
You must use the brackets if you wish to acquire more than one output.

The following example shows two possible syntaxes for residue . Input the following
data to see the default output behavior:

sys=(makepoly([2:4:6])/makepoly([3,5]));
Rp=Residue(sys,[5,10,inf],{tol=.5})

To see both outputs, use square brackets and assign the outputs to variables:

[Rp,C]=Residue(sys,[5,10,inf],{tol=.5})

For additional information, see Section 3.5 on page 3-15. Xmath functions and their
syntaxes are organized alphabetically in the Xmath online Help. For a detailed de-
scription of how to use MathScript to define your own functions, see Chapter 6.

2.3.2 Command Syntax

Like functions, commands operate on inputs. However, command inputs are passed
by reference and can be changed within the command.

In the MathScript language, command syntax is as follows:

command arg1, arg2, …argN, {keywords}

For examples of this syntax, see the Xmath online Help (commands topic).

If you have been working through the tutorial, you might realize that intrinsic com-
mands have a special syntax. Syntaxes we have used are:

new partition part_name
set partition part_name
delete part_name.
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save " filename " var_1 var_2 var_n
load " filename " var_1 var_2 var_n

The most obvious difference is that these commands require spaces rather than
commas as separators. The whatis command reveals a fundamental difference be-
tween these commands and other MathScript commands (MSCs):

whatis save

save: intrinsic command

Xmath includes many intrinsic commands and functions. These commands and
functions are part of the Xmath executable.

See the Xmath online Help for descriptions of Xmath commands. For a detailed de-
scription of how to use MathScript to define your own commands, see Chapter 6.

2.4 Graphics

Xmath provides two and three-dimensional graphics that you can manipulate inter-
actively while they are displayed in the Xmath Graphics window. This section briefly
introduces the plot  function and the major types of plots you can make.

2.4.1 Plot

The plot function creates a graph object that Xmath displays in the Xmath Graph-
ics window. The most complete syntax for plot  is:

graphObj = plot(x,y,z,colorindex,{keywords})

2D graphs are produced with y , or x , y as arguments, while 3D graphs require x , y ,
and z . For other possible syntaxes see Section 4.1 on page 4-1.

plot behaves like other Xmath functions in the following ways ( functions are dis-
cussed in Section 2.3 on page 2-10.):

■ If no output variable name is assigned, Xmath assigns the output (graph object)
to the temporary variable ans .

■ Xmath displays a graph object in the Xmath Graphics window when it is created
unless you use a semicolon as a terminator. If you create a graph object within
a MathScript, only a ? terminator causes it to display.

■ You can display a graph object with the ? terminator anytime after creation.

■ You can save and load a graph object.
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Keywords

Keywords define a graph’s labeling, layout, and appearance. This tutorial introduces
basic keyword use. (For a complete keyword listing, see Table 4-3 on page 4-7 or the
Xmath online Help for the plot function). You can create or change many of the fea-
tures for which keywords are used interactively via the Xmath Graphics window
menus or the Xmath Palette.

Graph Objects

plot is the only function that outputs a graph object. Xmath creates a graph object
whenever it displays the output of the plot function in the Xmath Graphics win-
dow. If you specify an output variable name, Xmath writes the contents of the
Xmath Graphics window to the variable; otherwise, Xmath writes the contents to
the default variable ans . If you suppress plot with a semicolon, Xmath writes
nothing to the Xmath Graphics window. (Other functions may display plots in the
Xmath Graphics window, for example, windowing functions such as firwind , but
their actual function output is numeric. Only plot allows you to name the contents
of the Xmath Graphics window.)

You can copy, save, display, and reload a graph object like any other variable. Addi-
tionally, it can be altered or used in a new graph if you use the keywords keep or
copy . We explore the implications of the graph object later in the tutorial.

2.4.2 Working in the Xmath Graphics Window

When you use the plot function without suppressing its output, Xmath opens the
Xmath Graphics window. The following mouse actions are defined for this window:

■ To select an object, click it.

An object can be a text string, label, grid, data, and so forth.

■ Double click an object to select the object and bring up the Xmath Palette.

The palette title area (center top) gives information on the object you’ve selected.
For example, the title Xmath Palette (tics:axis line) indicates that you’ve selected
an axis line.

Different menu items and palette locations on the Xmath Palette are enabled
based on your selection. For example, if a label is selected, the Font and Point
menus are enabled, and the text color can be changed via the palette.

xb.book  Page 13  Wednesday, October 6, 1999  11:28 AM



JumpStart: A Tutorial Xmath Basics

2-14

■ If you have difficulty selecting an object (for example, you attempt to select a tic
mark, but you keep getting the axis), then hold down the Shift key while clicking.

Xmath cycles through selecting the objects closest to the cursor. A glance at the
palette title area reveals the selected object.

■ Click and drag to move objects.

Objects that you can move independently are the legend, date, time, free text,
and graphics that you create with the graph tools in the Xmath Graphics win-
dow icon bar. You cannot move a graph and its associated plot data, grids, la-
bels, axis information, and so forth interactively, but you can move the entire
graph with the plot  keyword position  (see page 4-31).

2.4.3 Using Plot and Graph Objects

You can plot objects in two- or three-dimensional plots.

Using 2D Plotting Capabilities

Before continuing, generate a few waveforms:

set seed = 0 # Set random seed
a = sin(logspace(1,10,15));
b1 = kronecker(a,a);
b2 = b1 + 0.2*random(1,225);

Here graph_b1  is a graphical object with b1 plotted versus a time sequence:

t=0:0.01:2.24;
graph_b1=plot(t, b1,{title="xy plot",x_lab="time(sec)"})?

If you can’t see the graph, select Windows→Graphics to bring the Xmath Graphics
window to the front.

Plot b2 with specific labels and titles:

graph_b2=plot(b2, {y_lab="volts",x_lab="sample",
title = "sample display",legend = "noisy wave"})?

You can plot the original noise-free waveform b1 over the existing plot by copying
the graph object graph_b1  into the current graph. In the command area type:

both_b=plot(b1,{copy=graph_b2,line_style=3,
line_width=2,legend = "original wave",!grid})?
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Figure 2-1 shows the result. b1 is plotted as a thicker dotted line added to
graph_b2 , a new entry is added to the legend box, the grid is suppressed by the !

negator, and the image is given the name both_b .

To see the first plot, type:

graph_b1?

You do not need to execute the previous plot call to see the graph. graph_b1 is un-
changed because the keyword copy was used and the current contents of the win-
dow were given a new name (both_b ). If you are adding to a plot and it is not
important to retrieve your previous efforts, use keep instead of copy . keep is much
faster than copy .

When you make interactive changes to a graph object displayed in the Xmath
Graphics window, the changes immediately become part of the current graph object.
To preserve graph_b1 as it is, rename the graph before making changes in one of
following ways:

FIGURE 2-1 Overlaid Graph Objects
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■ From the Xmath Graphics window menu bar select File→Bind to variable and
save the contents of the Xmath Graphics window to the name g1.

■ From the Xmath Commands window command line, type:

g1=plot()

Calling plot with no arguments binds the contents of the Xmath Graphics win-
dow to the output variable name.

To illustrate that changes immediately become a part of the current graph object, go
to the Options menu and turn on the timestamp and datestamp; then move them to
new locations. Double-click a text string, and then change the font and point size
using the Xmath Palette. Double-click a curve either in the data or in the legend,
and then go to the Xmath Palette and change the marker and line styles.

Display the object graph_b1  and then the object g1:

graph_b1?

g1?

Using 3D Plotting Capabilities

To demonstrate some of the 3D plotting capabilities, create x , y , and z :

x= [-2*pi:.65:2*pi]';
y= logspace(1,2*pi,20);
z= sin(x)./x*(sin(y)./y);
plot(x,-y,z,{title="A 3D Plot",xlab="the xlabel",
ylab="the ylabel",zlab="the zlabel",!grid})?

Figure 2-2 shows these results.

You can rotate 3D plots with the rotation tools on the far right of the menu bar in
the Xmath Graphics window. The first tool allows you to rotate in all directions (un-
constrained); the remaining tools rotate about the three principal axes. Select a ro-
tation tool in the icon bar, and then move to the plotting area. When the tool is
active, just the grids are shown; click and drag the cursor until the grid is in the po-
sition you want to see, and then release the mouse. Xmath redraws your graph in
the new position.

To return to the initial plot position:

Select View→Reset.
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To turn off the rotation tool:

Click the arrow (selection tool) on the far left of the menu bar.

2.4.4 Using Different Plot Types

In this section, we illustrate the use of different kinds of plots: strip, polar, bar, and
contour.

Strip Plots

The strip keyword aligns two or more waveforms in stacked graphs sharing a com-
mon x-axis. Optionally, you can specify the number of curves you want in each
graph. (Strip plots, like all other multiple graph plots, cannot be rotated or zoomed.)
The example below plots four variables; strip=2 specifies that each graph should
contain two curves (see Figure 2-3). We specify an optional line_style vector with
legend  to distinguish the original values of b from the absolute values.

FIGURE 2-2 3D Plot with Labels and Title
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set seed = 0 # Set random seed
a = sin(logspace(1,10,10));
b1 = kronecker(a,a);
b2 = b1 + random(1,100);
t=.1:0.05:5.05;
plot (t, [b1;b2;abs(b1);abs(b2)]',{strip=2,

title ="strip chart",line_style=[2,1],
legend=["volts","abs"],xmax=5.1,
ylab=["b1 volts","b2 volts"],xlab="time"})?

Xmath creates a single legend, and the two plots share the title and xlab . Strip
chart data is linked; to illustrate this, select a curve in one of the plots; the corre-
sponding curve in the other plot is also highlighted.

FIGURE 2-3 Strip Plot with Two Curves in Each Strip
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Polar Plots

Xmath can display data in polar plots (see Figure 2-4). For example,

r = abs(sin(0:.1:35.9));
theta = 0:1:359;
plot(theta,r,{polar, fg_color="gray2",
line_color="royal purple", line_width=2})?

Bar Plots

Xmath also has bar graph capabilities.

Bar plots can be overlaid using the keep keyword. If a variable name is not speci-
fied, keep adds what you specify to the current contents of the Xmath Graphics
window. The results of the example below appear in Figure 2-5.

plot(10:-1:1,{bar})?
plot([8,4.5,2,6,4.5,5,1.5,2,.5,.7],
{keep,bar,!xgrid,legend})?

FIGURE 2-4 Polar Plot
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Contour Plots

x= [-2*pi:.6:7]'; y=x;
z=1.2 + sin(x)./x*(sin(y))';

The first graph is a 3D surface plot, with grids suppressed:

plot (x,y,z,{!grid})?

With the keep keyword, you can overlay a 2D contour plot of the same surface (see
Figure 2-6):

plot(x,y,z, {keep,contour2d,!face,contour_interval = 0.5})?

Alternatively, you can display a 3D contour plot:

plot (x,y,z, {contour3d}) ?

FIGURE 2-5 Overlaid Bar Plots
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2.4.5 Displaying Multiple Plots at Once

The rows and columns keywords allow you to display up to 25 different 2D and 3D
graphs at once. The values you assign to rows and columns determine how the
screen is subdivided. Plots are then positioned on the screen with a combination of
row and column numbers or a graph_number . The row s and column s keywords
are initiators. This means they remain in effect until a plot call that does not contain
a row or column keyword is issued; at this point the default values rows=1 , col-
umns=1 are reset.

The following example places four plots on the screen in two rows and two columns.
Note that you don’t need to specify row=1 or column=1 ; these are default values.
The result is shown in Figure 2-7.

FIGURE 2-6 3D Plot with 2D Contour
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set seed 0
h=histogram(rand(1:100),{nbins=7,noplot});
plot (b1,{rows=2,columns=2, line_color="blue"})?

plot (theta,r,{polar,row=2, fg_color=”gray2”,
line_color=”royal purple”, line_width=2})?

plot (h,{bar,column=2,!xlab})?

plot (x,y,z, {contour3d, xinc=4, yinc=4,!grid, graph_number=4})?

2.4.6 Animating Plots

Given a series of plots, the animate keyword draws each plot as fast as possible so
the progression looks like movement. For the following example, create a vector:

an1=sin(logspace(1,10,25));
an2=an1(25:-1:1);
an3=kronecker(an1,an2);

FIGURE 2-7 Different Plot Types Positioned with row  and column  Keywords
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We will be looking at an3 using 100 points at a time. First, we plot the entire vector
using animate and a fixed axis (axisfix) . By default, axes are adjusted to the
current plot range, so, if animate is enabled, axes may change while plotting. In
this call, axisfix holds the axes of the current plot (until they are changed), en-
sures that the plot background remains the same, and (since the whole vector is
plotted) that the plot area is not too small for the plot.

plot(an3,{animate,axisfix,xmax=100})?

The animate  keyword stays active until it is disabled explicitly.

Use a loop to plot portions of the data while animate  is enabled:

for i=1:7:524
plot(an3(1,i:i+100))
endfor

To turn off animate  type:

plot({!animate})

Alternatively, you can use plot({reset})  to reset all plot defaults.

If you are curious about axisfix , repeat the above example without it, and watch
the axes.

2.4.7 Finishing the Graphics Tutorial

The above examples skim the surface of the wealth of available plot options.

■ For more on graphics, first ensure that the animate  is off:

plot({!animate})

■ Then run the graphics demo:

execute file = "$XMATH/demos/graphics"

For further explanation, see Section 4.3 on page 4-46, or see the Xmath online
Help (Xmath, Plotting topic).

This ends the graphics section of the tutorial. We suggest you delete the variables
you made in this section:

delete *.* # Delete all variables in all partitions
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2.5 Objects

Unlike most numerical tools, which only deal with matrices, Xmath employs object-
oriented programming principles. See Figure 5-1 on page 5-2 for a full description of
the Xmath object hierarchy structure. For example, the Toeplitz matrix class is a
special kind of square matrix class. It inherits all the properties of the square matrix
class but automatically takes advantage of specific operations which can be per-
formed more efficiently for Toeplitz matrices.

Benefits from Xmath’s object-oriented structure include:

■ Fewer variables to manage. A single variable can represent several very complex
pieces of data. Therefore, you don’t need as many variable names, which simpli-
fies variable management.

■ Fewer functions. For example, a single function handles continuous and dis-
crete cases.

■ Faster calculations. Many objects take advantage of optimized algorithms. This
is especially true of all the specialized matrix objects. Xmath recognizes special
data properties and automatically uses an optimal method if available.

■ More intuitive syntax and ability to overload operators. Overloading means that
a single operator can have different meanings when it interacts with different
objects.

■ More compact user code. Because objects have clearly defined properties, it is
simpler for users to check and handle data in their programs.

This section briefly discusses the major Xmath objects. There are examples of how
to create each one and, in some cases, examples of special techniques with opera-
tors or indexing. The examples create unique data for each object. Therefore, you
may quit the tutorial between any of the object discussions and restart when conve-
nient.

2.5.1 Strings

A string is a set of characters enclosed in double quotes. To display double quotes
within a string you must provide two sets of quotes (""). You can convert numbers to
strings with the string function, while the char function gives the ASCII character
for a given integer between 0 and 255.
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a = "The total score is  ";
b = 301;
c = a + string(b)?

c (a string) =   The total score is 301

You can create a matrix of strings using the familiar matrix-constructor syntax.

a = ["one", "two"; "three", "four"]

a (a square matrix of strings) =

  one      two
  three    four

When entering strings in the Xmath Commands window command area, remember
that a single string must be complete on a line. If for some reason you must break
the string, create separate strings and append them with the + operator:

text="Xmath strings cannot be continued " +...
"across lines, but separate strings can " +...
"be appended with the + operator."

text (a string) = Xmath strings cannot be ...

2.5.2 Matrices and Vectors

This section demonstrates how to create and use matrix and vector objects. It also
shows how Xmath’s object-oriented structure improves the computational speed of
matrix operations.

Creating Matrices and Vectors

You must enclose matrix specifications in square brackets; you separate elements in
separate rows by commas and row elements, by semicolons or line feeds:

[1,2; 3,4] # A semicolon or a linefeed
[1,2 # can separate rows
 3,4]

ans (a square matrix) =
  1    2
  3    4

ans (a square matrix) =
  1    2
  3    4
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A vector is a single row or single column matrix. An apostrophe (’) transposes a
vector or a matrix.

i=[1,2,3]

 (a row vector) =   1    2    3

i'

ans (a column vector) =

  1
  2
  3

Regular vectors are row vectors specified as three values in the form
start:step:end .

time=0:0.01:10

time (a regularly spaced vector) =   0 : 0.01 : 10

The logspace function creates logspaced vectors with points evenly spaced on a log
scale. Like regular vectors, logspaced vectors are stored as three values.

log1=logspace(1,2,5)

log1 (a log-spaced vector) =   1 : 2 (5 points)

Transposing a vector or enclosing it in square brackets expands it:

log1'

ans (a column vector) =

  1
  1.18921
  1.41421
  1.68179
  2

[time]

ans (a row vector) =   0  0.01  0.02  0.03  0.04...

To form a vector with descending values, use a negative step:

k2=[2:-.25:1]

k2 (a row vector) = 2 1.75 1.5 1.25 1
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To reverse a vector, use a negative step value:

k3=k2(length(k2):-1:1)

k3 (a row vector) = 1 1.25 1.5 1.75 2

Use vectors in expressions and to define new matrices:

g=[1:3;logspace(1,20,3)]

g (a rectangular matrix) =

  1    2           3
  1    4.47214    20

Matrix Index Operations

Create the matrix testm :

testm = [1:3;4:6;7:9]

testm (a square matrix) =

  1    2    3
  4    5    6
  7    8    9

To find any element in testm , give the matrix name followed by the row and column
index in parentheses:

testm(2,3)

ans (a scalar) =   6

To find the second row in testm , use a colon (:) as a wildcard symbol in place of the
column index to denote “second row, all columns”:

testm(2,:)

ans (a row vector) =   4    5    6

To find any column in testm , use the wildcard symbol (:) in the rows position:

testm(:,1)

ans (a column vector) =

  1
  4
  7

xb.book  Page 27  Wednesday, October 6, 1999  11:28 AM



JumpStart: A Tutorial Xmath Basics

2-28

To find submatrices, use vector inputs:

testm(1:2,2:3)

ans (a square matrix) =

  2    3
  5    6

The function find allows you to find indices for matrix elements that meet a certain
criterion. find  returns each index in [row , column ] format.

find(testm > 7)

ans (an index list) =

  3    2
  3    3

The output indicates that the elements found in the third row, second and third col-
umns (3,2) and (3,3) are greater than 7.

You can incorporate find results as a special indexing scheme to perform an oper-
ation on only the elements meeting the criterion in find .

testm(find(testm > 7)) = 0

test_matrix (a square matrix) =

  1    2    3
  4    5    6
  7    0    0

Xmath changed the elements greater than 7 to zeros.

Using Matrix Functions

Matrix functions take advantage of the structure of matrix objects. The more spe-
cialized a matrix is (that is, the more properties it inherits), the greater the computa-
tional speed improvement. For example, consider computing the eigenvalues of a
common matrix, a symmetric matrix, and a triangular matrix of the same size (100
×100).
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The clock function monitors elapsed CPU time. It returns the time in seconds since
clock was last called. Therefore, you should call it before and after the monitored
process.†

rmat = random(100,100);
clock({cpu});mm = eig(rmat); clock({cpu})?

Xmath automatically uses more efficient algorithms when the matrix fits a given
structure. The above example tells how long it takes to find the eigenvalues of a
general, random (100 ×100) matrix.

In the following example, you can see how long it takes with a symmetric matrix of
the same size. We use the transpose operator (') to ensure that the matrix is sym-
metric:

smat = rmat * rmat';
clock({cpu}); mm = eig(smat);clock({cpu})?

eig  takes even more advantage of a triangular matrix:

tmat = triu(rmat);
clock({cpu}); mm = eig(tmat); clock({cpu})?

Xmath checks object properties before computations so that it uses the fastest algo-
rithms and performs no unnecessary computations.

2.5.3 Polynomials

To create a polynomial, specify its roots with the polynomial function, or specify
its coefficients with makepoly :

poly1 = polynomial([1,5])

  (x - 1)(x - 5)

poly2 = makepoly([1:.7:4.5])

5  4 3 2
  x + 1.7x + 2.4x + 3.1x + 3.8x + 4.5

The default variable name is x. Both functions have an optional string argument
that specifies the variable name. For example:

† clock  results depend on your machine’s configuration.
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p = polynomial([1+jay,1-jay],"s")

p (a polynomial) =

    2
  (s  - 2s + 2)

Several operators and functions are defined differently for polynomials than they are
for matrices.

Multiplying two polynomials with the * operator returns the polynomial convolution:

poly3 = poly1*poly1

poly3 (a polynomial) =

         2       2
  (x - 1) (x - 5)

When adding two polynomials, the corresponding order terms of the two polynomi-
als are added:

poly1+poly3

ans (a polynomial) =

   4  3 2
  x - 12x + 47x - 66x + 30

Similarly, when adding a scalar and a polynomial, the scalar is added to the scalar
term of the polynomial:

poly1+1

ans (a polynomial) =

   2
  x - 6x + 6

When multiplying a polynomial and a scalar, the output format depends on the for-
mat of the polynomial:

poly1*2

ans (a polynomial) =

  2(x - 1)(x - 5)
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Use roots to find the roots of a polynomial:

roots(poly3)

 ans (a column vector) =

  1
  1
  5
  5

Use polyval  to evaluate the polynomial with a scalar value for the variable:

polyval(poly2,3)

ans (a scalar) =   489.3

Indexing into a polynomial is similar to indexing into a matrix. To find and change
the coefficient of the third element, type:

poly2(3)

ans (a scalar) =   2.4

poly2(3) = 9

poly2(a polynomial) =

5      4 3      2
  x + 1.7x + 9x + 3.1x + 3.8x + 4.5

2.5.4 Dynamic Systems

Xmath represents a dynamic system as either a transfer function or a state-space
system. A transfer function consists of two polynomials; a state-space system is rep-
resented by four matrices. Transfer functions can only represent single-input sin-
gle-output (SISO) systems, but state-space systems can represent multiple inputs
and output (MIMO) systems. Objects for both types of systems can be either discrete
or continuous, depending on the value of the object’s sample rate.

Transfer Functions

A transfer function is built from numerator and denominator polynomials:

num = makepoly([1,-163,5.5]);
den = makepoly([1,2.7,5.6,3.5,8.1]);
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Use system  to create the transfer function:

sysTF = system(num, den, {dt = 1})

sysTF (a transfer function) =

          2
         x - 163x + 5.5
  ----------------------------
   4      3      2
  x + 2.7x + 5.6x + 3.5x + 8.1

  initial delay outputs
  0
  0
  0
  0
  Input Names
  -----------
  Input 1

  Output Names
  ------------
  Output 1

  System is discrete, sampling at 1 seconds.

If you do not wish to specify a sampling rate, you can use the shorthand form:
sys=num/den .

To extract the numerator or denominator of a transfer function, use numden:

[n,d]=numden(sysTF)

n (a polynomial) =

   2
  x - 163x + 5.5

d (a polynomial) =

   4      3      2
  x + 2.7x + 5.6x + 3.5x + 8.1
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State-Space Systems

To create a state-space system of the form,

use system  with four matrices as inputs:

ha=[1,0,0,.1; 0,-.2,.1,0; 0,1,0,0;-.2,0,0,1];
hb=[.5,0,0,.3]';
hc=[1,0,1,0];
hSS=system(ha,hb,hc,0)

hSS (a state space system) =

A
1 0 0 0.1

 0 -0.2 0.1 0
 0 1 0 0
-0.2 0 0 1

B
0.5
0
0
0.3

C
1 0 1 0

D
0

X0
0
0
0
0

System is continuous

ẋ A x B u+=

y C x D u+=
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Notice that Xmath creates continuous systems by default. To create a discrete sys-
tem, include the keyword dt , which sets the sampling period in seconds:

hSSd=system(ha,hb,hc,0, {dt = .1});

To extract the state and initial condition matrices from a system, use abcd :

[ A,B,C,D,X0 ] = abcd(hSSd)

The functions sys2sns  and sns2sys  might interest you:

■ sns2sys  converts a system from MATRIXX to an Xmath object.

■ sys2sns  converts an Xmath system object to MATRIXX format.

Analyzing Dynamic Systems

You can display the time domain response of a system using the functions in
Table 2-2.

These functions return parameter dependent matrices (PDMs), our next topic. For
more on these functions, see the Xmath online Help.

bode , nyquist , and nichols display frequency-domain response in several stan-
dard formats. For example, to see the bode plot of the continuous-time system we
created earlier, type:

bode(hSS)?

TABLE 2-2 Time Display Functions

impulse Computes the impulse response of a system.

initial Computes the unforced response of a system to a given initial
condition.

step Computes the step response of a system.

defTimeRange Computes a default time vector for simulations.

sys*u Performs a general simulation, where u is a PDM representing
system input.
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2.5.5 Parameter Dependent Matrices

A parameter-dependent matrix (PDM) is a collection of same-size matrices, with a
vector (called the domain) attached; each matrix depends upon a corresponding ele-
ment of the domain vector. A PDM stores matrices as functions of an independent
element parameter (the domain). A PDM is often a matrix of a physical parameter,
such as time, frequency, or speed.

PDMs are built from string, vector, and matrix objects using the pdm function. For
example, the following PDM stores data in a legible compact format:

d=[95:99];
AR=[ 60.8; 59.3; 54.4; 50.7; 50.7];
CO=[ 41.2; 41.7; 36.3; 35.7; 35.3];
OR=[ 46.1; 47.5; 47.6; 46.7; 48.7];
WA=[ 45.4; 45.6; 44.0; 43.2; 43.9];
states=["AR","CO","OR","WA"]
eJobs=pdm([AR,CO,OR,WA],d,{domainName="Year",columnNames=states})

eJobs (a pdm) =

Year | AR CO OR WA
-----+-------------------------

 95 | 60.8 41.2 46.1 45.4
 96 | 59.3  41.7 47.5 45.6
 97 | 54.4 36.3 47.6 44
 98 | 50.7 35.7 46.7 43.2
 99 | 50.7 35.3 48.7 43.9

The advantage of storing the data, names, and domain together is clearer when we
create a plot such as Figure 2-8.

g2=plot(eJobs,{strip,ymax=65,ymin=32,ylab="THOUSANDS",
line_color = "mulberry", line_width = 2})

PDMs are commonly seen as outputs from functions, such as those listed in
Table 2-2. If we calculate the impulse response and step response of hSSd (the dis-
crete state-space system created earlier), the responses are formatted as PDMs. The
output is too long to show here, but you can view it in the log area:

hIm=impulse(hSSd);
hSt=step(hSSd)?

It is convenient to store these related PDMs together in another PDM:

hPdm=pdm([hIm;hSt],{rowNames=["Impulse","Step"]})?
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Plot the responses separately with the strip  keyword:

plot(hPdm,{strip})

shows the results.

FIGURE 2-8 PDM Plotted with the strip  Keyword
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The size of a PDM is given as rows × columns × length of the domain:

size(hPdm)

ans (a row vector) = 2 1 303

Portions of a PDM are accessible with indexing, similar to matrices. Extract the fifth
dependent matrix from hPdm:

hPdm(5)

ans (a pdm) =

domain |
-------+----------------

 0.4 | Impulse 0.5594
 | Step 2.1394

-------+----------------

FIGURE 2-9 PDM Impulse and Step Responses Plotted Separately
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To look at only the impulse responses, type:

hPdm(1,1)

ans (a pdm) =

domain |
-------+-----------------

 0 | Impulse 0
 0.1 | Impulse 0.5
 0.2 | Impulse 0.53
 0.3 | Impulse 0.55
 0.4 | Impulse 0.5594
 0.5 | Impulse 0.5578

: : :

To perform a general simulation, you can multiply a system by a PDM. Here we use
freq  to create a PDM.

u=freq(hSSd,deftimer(hSSd));
Y=hSSd*u;
plot(Y)

For more detailed information on PDMs, see Section 5.4 on page 5-21.

2.5.6 Lists

A list object is a named collection of elements (objects). A list can contain varied ob-
jects (including other lists). It is one-dimensional, storing your specified objects re-
gardless of dimensions or properties. Use the list  function to create this object:

set seed 0
scalar1 = 1;
string1 = "This is a string object";
poly = makepoly([1,2]);
matrix = random(5,5);
a_list = list(scalar1,string1,poly,matrix)

a_list (a list with 4 elements) =

1:
  1

2:
  This is a string object
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3:

  x + 2

4:

0.211325 0.756044 0.000221135 0.330327 0.665381
0.628392 0.849745 0.685731 0.878216 0.068374
0.560849 0.662357 0.726351 0.198514 0.544257
0.232075 0.231224 0.216463 0.883389 0.652513
0.307609 0.932962 0.214601 0.312642 0.361636

A list containing four objects has a size of 4. To extract an element, specify its order
in the list:

a_list(3)

ans (a polynomial) =

x + 2

a_list(1)

ans (a scalar) =   1

2.6 MathScript

MathScript is the language of Xmath. Every instruction you have typed into the
Xmath Commands window so far is a MathScript statement. With a MathScript
script file, you can create and define a MathScript function, command, or object as
MathScript entities, which are immediately available for use without special linking
or compiling. (Chapter 6 describes how to create, define, and debug MathScript en-
tities.)

2.6.1 MathScript Features

MathScript provides the following features:

■ Familiar programming constructs such as for and while loops and if state-
ments.

■ Expressions that can be combined in a single statement. For example:

x =  20 * log(abs(1 + 2 * jay))
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■ Functions to obtain interactive user input, such as getline  and getchoice .

UserIn=getline("Enter the number of states now:")

vote=getchoice("Choose or Lose", ["Repub","Demo","Inde"])

■ Functions to determine whether objects possess certain properties (check and
is ). For example:

a = [1,0;0,1]
check(a, {identity})

ans (a scalar) =   1

These features and more programming issues are discussed in Chapter 6.

2.6.2 Debugger Window (on UNIX Systems)

The MathScript Debugger window (Figure 2-10), referred to as “the debugger,” al-
lows you to interactively debug MathScript. Usually the debugger is activated be-
cause a script contains a syntax error or a runtime error (see Section 6.4 on
page 6-23). It also opens if you have set up a file to be debugged. You call debug the
same way for both functions and commands:

debug entity_name

The debugger opens whenever the function or command is invoked. To turn off de-
bugging, type:

debug entity_name  off

When the debugger opens, the top field in the window contains the source of the
MathScript function or command you are debugging. The filename is displayed be-
low the menu bar. If you don’t have write privileges to the source file, the source
code may be opened read-only (not editable). The line that is about to be executed is
highlighted (unless there are syntax errors in the function, in which case highlight-
ing is used to identify the error). The message area, which displays error messages
that occur during execution, is just below the source code area. You can use but-
tons at the bottom of the window in lieu of debugger commands.

Run the debugger demo. It instructs you on how to edit an MSF that contains syn-
tax errors. From the command area, type:

execute file="$XMATH/demos/debuggingMS1"

For more on the debugger window, see Section 6.4 on page 6-23.
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2.7 GUI Tools

Xmath offers a programmable graphical user interface (PGUI or GUI). For an intro-
duction to the GUI, and instructions on starting and using the GUI demos and tools,
see Chapter 9, Graphical User Interface.

FIGURE 2-10 Debugger Window (on UNIX Systems)
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To see some examples of GUI tools, type:

guidemo

To exit Xmath, see Section 1.2.3 on page 1-7.

2.8 Conclusions

This concludes the Xmath tutorial.

If you have worked through the tutorial, you should be acquainted with the con-
cepts and procedures necessary to use Xmath’s basic features (described in Chap-
ters 3 through 5). Chapters 6 through 9 discuss advanced topics:

■ Chapter 6 tells how to write your own functions and commands using Math-
Script.

■ Chapter 7 tells how to create your own MathScript object.

■ Chapter 8 tells how to link C, C++, or FORTRAN files to Xmath, and also details
how to call Xmath from an external program.

■ Chapter 9 tells how to program your own graphical user interface.

If you have comments on this tutorial, or any part of the documentation, please con-
tact ISI by e-mail at mx_support@isi.com .
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3 MathScript Basics

MathScript is the language of Xmath. MathScript contains many of the facilities
common to high-level programming languages, such as logical expressions loops,
comments, conditional statements, nested functions and recursion.

3.1 MathScript Statements

A statement is the smallest independent executable instruction. Here are some ex-
amples of statements:

x = 7
y = ones(3,3)
who
set format long

The first two statements are examples of assignments. The last two statements are
examples of commands.

3.1.1 Assignments

The most common MathScript statement is an assignment. An assignment is a
statement that sets a variable to a specific value defined by the expression on the
right-hand side:

variable = expression

■ If an expression output is assigned to a variable, use the question mark (?) ter-
minator to display the result. To suppress the output, use the semicolon (;) ter-
minator.
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■ A carriage return is also a statement terminator. If set display is on, a return
displays the result; if set display  is off, nothing is displayed (see page 3-24).

■ Variable types do not have to be declared before assignment.

■ Objects can be completely or partially modified using assignment statements
combined with indexing. For example:

y = [100,21:24]

y (a row vector) =   100    21    22    23    24

y(1) = 0

y (a row vector) =   0    21    22    23    24

3.1.2 Rules for Names

Variable names consist of alphanumeric characters and internal underscores ( _)
only.

■ Name components must be less than 32 characters in length. For example, vari-
able b in partition a (a.b ) could have a total of 31 characters.

■ Names should not start with an underscore, because initial-underscore names
are reserved for internal use.

■ Variable and partition names are case sensitive. The following variables repre-
sent two partitions and four different variables:

a.b; A.b; a.B; A.B;

You can create a variable with the same name as a predefined Xmath function or
command; however, you will be unable to access that pre-defined feature until you delete
the variable.

3.1.3 Expressions

An expression is a combination of variable names, functions, and operators that
evaluate to a single Xmath object. The Xmath object can then be assigned to a vari-
able name. For example,

(1+sin(pi/4))^2 # An expression

Expressions can be used as arguments to other functions or operators.

cep = abs(fft([1,-4,8,-2]))
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The functions exist and check are exceptions. These functions require a variable
name as an argument.

Logical Expressions

In MathScript, a nonzero value (with the exception NAN and Inf) is considered
TRUE. All logical operators return 0 if FALSE and 1 if TRUE.

x = 3; x < (3 * cos(0))

ans (a scalar) =   0

Logical operators are “short-circuited.” For example, exp1 | exp2 | exp3 will re-
turn 1 if exp1 is nonzero without evaluating exp2 or exp3 . Therefore, careful order-
ing of subexpressions in logical expressions may speed up execution.

Table 3-1 lists all MathScript logical operators. For a list of all Xmath operators, see
Table 3-3.

Logical Expressions with Matrices

When used with logical operators, two matrices must be equal in size; the output
will be a matrix containing the element-by-element comparison results.

TABLE 3-1 MathScript Logical Operators

Operator Effect

< Elementwise less than.

> Elementwise greater than.

<= Elementwise less than or equal .

>= Elementwise greater than or equal.

== Elementwise equal.

<> Elementwise not equal.

& Elementwise logical and.

| Elementwise logical or.

! The logical negator (!) appears directly be-
fore an expression. For example, !expr .
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a = [1,0;1,1];b = eye(2,2);
a & b

ans (a square matrix) =

 1    0
 0    1

ans  is a matrix with 1 in the locations where a and b are the same.

a < b

ans (a square matrix) =

 0    0
 0    0

You can also make logical comparisons with the functions check and is , which re-
turn a logical value. The functions all , any , and none can also be used to return a
logical value. See page 6-19 or the Xmath online Help for more details.

3.1.4 Operators

An operator is a nonalphanumeric symbol that operates on its operand(s). Opera-
tors with only one operand are called unary operators. Operators with two operands
are called binary operators. Table 3-2 shows how operators are used in expressions.

Table 3-3 lists the operators available in Xmath and their intrinsic functions; over-
loaded functions are described in other chapters.

TABLE 3-2 Uses of Operators in Expressions

Format Type Example

operator operand Unary (prefix) -x

operand operator Unary (suffix) x'

operand1 operator operand2 Binary x+y

TABLE 3-3 Xmath Operators

Xmath Operators

+ addition

- subtraction (and the unary operator negation)
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* multiplication

/ right division, A/B solves the equation X∗B=A

\ left division, B\A solves the equation B∗X=A

' transpose (unary suffix)

*' Hermitian (complex conjugate) transpose

.* elementwise multiplication

./ elementwise division (left divided by right)

.\ elementwise division (right divided by left)

^
or
**

raise to a power

.^
or

.**

raise elements to a power

.*. Kronecker product

./. Kronecker right division

.\˙ Kronecker left division

& logical AND

| logical OR

! logical NOT (unary operator)

< less than

> greater than

<= less than or equal

>= greater than or equal

== equal

TABLE 3-3 Xmath Operators (Continued)

Xmath Operators  (Continued)
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Operator behavior depends on the objects involved. Special behaviors are discussed
in detail in the object descriptions in Chapter 5, Data Objects and Operators.

Operator Precedence

You can control operator precedence with parentheses. In Table 3-4, operators are
ordered with precedence from highest to lowest (reading from top to bottom).

<> not equal

= assignment

( ) indexing, precedence, and function reference

{ } keyword delimiters in function references

[ ] matrix construction and concatenation

TABLE 3-4 Operator Precedence

high non–associative ' *'

left–associative ** ^ .** .^

↓ left–associative * / \ .* ./ .\ .*. ./. .\.

non–associative ! unary + unary -

↓ left–associative + –

left–associative :

↓ left-associative > < >= <= == <>

left–associative &

low left–associative |

TABLE 3-3 Xmath Operators (Continued)

Xmath Operators  (Continued)
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3.2 Partitions

All variables reside in partitions. main is the default partition. You do not need to
specify the partition name of a variable if it resides in the current partition; just call
it by its local name.

Partitions must be created using new partition before any variables may be
placed in them. To create or use a variable in another partition, you must specify
the partition name. (Partition names must meet the naming rules in Section 3.1.2
on page 3-2.) For example,

job1.R = R # Assign R in the current partition to the
# variable R in partition job1.

job2.R = job1.R # From the current partition, perform
# an assignment between two other
# partitions.

■ To show the current partition, use the show partition  command:

show partition

main

■ To list all defined partitions, type:

show partitions

Notice the s  at the end.

Please perform the following steps to get a better understanding of partitions.

1. main is the default partition that is created whenever Xmath is started. If you
are in main , you can create an object in partition main  by typing:

xx = 1

This is equivalent to main.xx = 1 .

2. To create a new partition named var , type:

new partition var

3. You can navigate between partitions with the set partition  command:

set partition var

show partition
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var

xx

xx not found.

4. Because xx  is defined in partition main , its partition name must be included:

main.xx? # variable from another partition

main.xx (a scalar) =   1

yy = 55? # create variable in current partition

yy (a scalar) =   55

5. Return to the main partition. The original main.xx is in local scope, while yy
exists in the partition var .

set partition main

xx

xx (a scalar) =   1

var.yy

var.yy (a scalar) = 55

6. A partition must be empty before it can be deleted. To delete a partition, use the
delete  command. First, delete the partition contents, then the partition itself:

delete var.* var.

3.2.1 Listing Defined Variables

To list all defined variables in the current partition, use the who command:

who

A single wildcard can be used with who:

who a* # List variables in the current partition
# that start with a.

who otherPartition .*1 # List all variables that end in 1 in another
# partition.

To list all variables in all partitions, type the following:

who *.*
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Wildcards

Xmath allows the asterisk (*) and percent (%) symbols to be used as wildcards for
viewing, saving, loading, or deleting variables.

An asterisk denotes “any characters.” Used by itself, an asterisk is a wildcard for all
names. Therefore, delete * deletes all variables in the current partition. Used with
other characters, an asterisk replaces any number of characters in that position.
The percent sign replaces a single character in that position.

a3=4; a23=1; b22=144; c23=random(a3,a23);

who* #Show variables in the current partition.
who a* #Show variables starting with a.
who *3 #Show variables ending with 3.
who %2%" #Show 3-character names where 2 is

#the second character(a23, b22, c23).

NOTE: You cannot use the wildcard * twice in a pattern. For example, *sys* is
not allowed, but *sys%% is accepted.

3.2.2 Variable and Partition Comments

You may attach a comment string to a variable or partition name with the comment
command.

comment main. "this is the default partition"
a=97;
comment a "the first letter of the alphabet"

■ To retrieve the comment, use commentof :

commentof(a)

ans (a string) = the first letter of the alphabet

commentof(main.)

ans (a string) = this is the default partition

■ You can also view a variable’s comment if you invoke the Xmath Variables win-
dow (see Section 3.2.5 on page 3-11).
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3.2.3 Permanent Variables

Permanent variables are values that have special meanings. These variables are de-
fined in all partitions as shown in Table 3-5.

The name of a permanent variable or predefined function/command can be overrid-
den in the current partition or function/command scope, although it is not recom-
mended. When a value that has been given the name of a permanent variable is
deleted, the original definition reappears:

eps=2

eps (a scalar) = 2

delete eps

eps?

eps (a scalar) = 2.22e-16

sin=1?

sin (a scalar) =   1

sin(pi) # argument out of range

delete sin

TABLE 3-5 Permanent Variables

Variable Definition

Inf infinity

Jay sqrt(-1)

NaN Not a Number

eps very small number used to initialize out-
puts to be near zero but not exactly zero

huge largest finite number less than Inf

null empty object

pi famous Greek number

tiny smallest possible number greater than 0

err global error status variable (set to NaN)

xb.book  Page 10  Wednesday, October 6, 1999  11:28 AM



Xmath Basics MathScript Basics

3-11

3

sin(pi)

ans (a scalar) =   1.22465e-16

3.2.4 ans

When a value returned from a function is not assigned to a variable name, it is as-
signed to the variable ans .

sin(0.5)

ans (a scalar) =   0.479426

The value of ans is overwritten anytime the output of a function is not assigned to a
variable. Note that the value of ans  is local to the current partition.

3.2.5 Xmath Variables Window

The Xmath Variables Manager window (shown in Figure 3-1) is a graphical interface
that simplifies variable management. From this window, you can view variable and
partition information, and load and save data.

Select Windows→Variables to invoke the Variables Manager window. The Variables
Manager window lists all variables in the current partition. At a glance you can see
the variable’s type, size, and attached comments (if any). If a variable is locked, an @
sign appears on the far left. To display a variable, double-click on it. Numeric and
string objects are displayed in the log area of the Xmath Commands window, and
graph objects are displayed in the Graphics window.

Because the Variables Manager window is updated each time the value of a variable
changes, it is a good idea to minimize or close the window when you don’t need it.
Leaving it open while executing a lengthy For or While loop, for example, decreases
Xmath’s execution speed.

Fields

The mid portion of the window is devoted to variable information. Partition informa-
tion is displayed at the bottom of the window. To view variables in a different parti-
tion, click the Partition button, and then select another partition from the subsequent
dialog.

Variable Name — The name of the variable.

Data Type — For variables, displays the major type: matrix, vector, polynomial, PDM,
system, string, list, or graph.
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Value — The value of the variable.

Size — For variables, the dimension of the object. See the Xmath online Help for in-
formation on the size function. For partitions, the number of variables in the
partition.

Comment — Displays the comments attached to the partition or the variables. You can
scroll to see lengthy comments for variables, but you may need to resize the
Variables Manager window to see a lengthy partition comment.

Name  — The name of the partition.

Menus

The Variables Manager window provides several pull-down menus with many func-
tions. Some of the most common functions on the menus are also available from
buttons immediately below the menu bar.

File — Allows you to save and load variables. For an explanation and an example of
how to use the file selection dialog, see Specifying Directory Pathnames and File-
names on page 1-14. The load command accepts data saved from Xmath or
MATRIXX.

If you want to load data that has not been created by the above applications, go
to the command area in the Commands window and use the read command.
read can place part or all of a data file into an Xmath matrix variable (see

FIGURE 3-1 Xmath Variables Window (UNIX version)
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Section 3.7.3 on page 3-22). save and load operations can also be accom-
plished from the command area of the Commands window (see Section 3.7 on
page 3-19).

The File menu also allows you to print and perform standard window opera-
tions.

Edit — Lets you perform various editing functions for the partition or variable.

Copy, Rename, and Modify Data operate on a selected variable; note that wild-
cards are not allowed here. Modify Data also allows you to lock or unlock a vari-
able.

Delete removes the selected variable, and Undelete retrieves the last deleted
variable.

View — Controls the order in which variables are listed. By Namedisplays variables
in case-sensitive alphabetical order from top to bottom. By Date (the default)
displays variables in the order created. The latest variable is shown at the bot-
tom of the list. By Size shows variables sorted by dimension from top to bot-
tom. By Type  shows objects grouped by alphabetized type.

Format — Allows you to set the format of the Value field for variables.

Options — Provides a Find function along with select and deselect functionality.

Find searches the current partition for the specified variable, and lists the re-
sult. A single wildcard is allowed in the find pattern. To find the specified vari-
able in all partitions, select Edit→Find and specify the * wildcard in place of the
partition name in the Pattern field. For example, to find the variable a in all exist-
ing partitions, specify the following pattern: *.a .

3.3 Punctuation

MathScript has special uses for the ?, ;, ..., #, and . characters. These are illustrated
in Table 3-6.

TABLE 3-6 Punctuation Mark Usage

A question mark is a statement terminator. When placed after a numeric
or string object, the value is displayed in the log area; when placed after a
graph object, the graph is displayed in the Graphics window.

y = eye(3,3)?x=y/2;

?
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y (a square matrix) =

  1      0      0
  0      1      0
  0      0      1

Interactively, the default display behavior (which can be changed via set
display) , is to display the output of all assignments and expressions not
terminated by a semicolon. If this is the behavior, the question mark is
only needed as a separator. If set display is turned off, output is sup-
pressed unless a question mark is used (see page 3-24).

A semicolon (; ) disables display to the log area, and acts as a separator or
terminator. A semicolon disables display regardless of whether set display
is on or off.

x = 1:3:10; x'

ans (a column vector) =

   1
   4
   7
  10

An ellipsis (... ) is a continuation symbol that allows an Xmath statement
to span multiple lines:

plot ...
(rand(1,50),{title="Testgraph",line_style=1})

Ellipses are not required if a line ends with a comma, or an operator:

plot (x,y,z,{x_lab="Hello",y_lab="Goodbye",
z_lab="Leave town before sundown!"})

However, you cannot continue all commands, even if you use the ellipsis.
For example, you cannot split an output assignment; thus, the following
multiple line entry results in an error:

[blocknr=selectedblocks,sbname=name,
sbin=inputs,sbinname=inputname,
sbout=outputs,sboutname=outputsignal] = querysuperblock();

You could split this example input before or after the equal sign (=) but no-
where else.

TABLE 3-6 Punctuation Mark Usage (Continued)

;

...
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33.4 Iterative Conditional Statements

In MathScript, For  and While  loops have the syntax shown in Figure 3-2.

If  statements in MathScript have the syntax shown in Figure 3-3.

Note that end  can be used in place of endFor , endWhile,  or endIf .

3.5 Using Predefined Functions and Commands

To determine the origin of a function or command use the whatis  command:

whatis freq

freq : intrinsic function

whatis bode

bode : ISI function (path/bode.xf)

A pound sign (#) comments out everything to the right on a single line. To
comment multiple lines of text, surround them with #{ }# .

#Comment a single line
#{You can comment
   multiple lines}#

TABLE 3-6 Punctuation Mark Usage (Continued)

#

For variable = expression

commands

endFor

•

•
•

While expression

commands

endWhile

FIGURE 3-2 For and While Loops

For Loop While Loop

•

•
•

For variable=vector, commands; EndFor

While expression, command; endWhile
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whatis build

build: intrinsic command

■ Entities referred to as ISI functions and commands are written in MathScript.
You can view the ISI function and command MathScript source in the location
returned by whatis , as shown above.

■ Intrinsic functions and commands are written in C++ and built into Xmath by
Integrated Systems; you cannot view this source. Chapter 6 describes how to
use MathScript to define your own functions (MSFs) and commands (MSCs).
The characteristics of Xmath objects are also intrinsic; Chapter 7 describes how
to use MathScript to define your own objects (MSOs).

3.5.1 Command and Function Calling Syntax

The rules described in this section are general; they apply to both intrinsic functions
and commands and MathScript functions and commands.

■ The names of functions, commands, and keywords are case-insensitive.

■ Function and command names can be abbreviated to minimum of four letters,
or the minimum number of characters that uniquely identify the name.

For example:

cova([1,2;3,4]);
t = makep([1,2,3,4]);

If expression

commands

elseIf expression

commands

else

commands

endIf

FIGURE 3-3 If Statements

If relation, commands; endIf
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covariance can be called by specifying the first four characters, while
makepoly must be abbreviated to five characters (because it conflicts with
makematrix ):

■ Function inputs, keywords, and outputs are separated by commas.

[Ke,ev,P] = estimator(Sys,Qxx,Qyy)

Aliases

Names or strings can be aliased to a shorter string with the alias command (see
Section 3.8.3 on page 3-27). Then you can refer to the name or string by its alias.
For example:

alias ef execute file
alias ts title="TOP SECRET";plot(A,{ts})

Input Arguments

■ The syntax for calling intrinsic commands and MathScript commands is slightly
different. Inputs for MathScript commands are separated by commas, similar to
MathScript functions.† For example:

xgraph t, {tgraph, average}

The majority of commands supplied with the Xmath Core are intrinsic (see
Section 3.5 on page 3-15), and the arguments are separated by spaces:

save "filename" a b c

Use the syntax shown in the Xmath online Help when in doubt.

■ Functions and commands cannot be called with fewer than the required num-
ber of input arguments, or more than the maximum number of inputs (as spec-
ified in the syntax shown in the Xmath online Help).

Keywords

■ Keywords are optional and case insensitive. Keywords must be placed inside
curly braces { }, but the order is not important.

■ A value can be assigned to a keyword. Keywords with no value assigned are
given Boolean values.

† On the other hand, SystemBuild SBA commands are all written in
MathScript, and use this syntax exclusively.
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For example, the following calls give an identical result:

g=plot(x, {legend,!grid})?
g=plot(x, {legend=1,grid=0})?

If a keyword is specified but not assigned to an expression, its value is set to 1.
This is useful for Boolean keywords, because 1 is interpreted as TRUE. Preced-
ing a keyword with the negation operator (!) causes its value to be set to zero, or
logical FALSE. The plot keywords specified above display a legend and no grid
lines.

■ Expressions can be used as arguments to keywords.

t = plot (x, {x_max = (4 * 256), x_lab="time"})

Single and Multiple Output Arguments

■ As discussed in Section 3.2.4 on page 3-11, if no output variable is specified,
the output is assigned to the default variable ans .

■ To view and assign multiple function outputs, an output name must be speci-
fied in square brackets on the left side of the equation for each output needed.

[T,S] = schur(A);

■ If functions return multiple arguments, the output arguments will be matched
left to right. Consider the function size :

[outputs,inputs,states] = size(aSystem)

If a multiple output function is called with a single output name, the output will
take the value assigned to the leftmost output according to the function syntax.

x = size(aSystem) # returns outputs
[x,xx] = size(aSystem) # returns outputs, then inputs

■ You can skip specific output arguments. To do this, use commas as placehold-
ers.

[,,states] = size(aSystem)

■ Functions cannot be called with fewer than the required number of input argu-
ments or more than the maximum number of outputs (as specified in the syntax
shown in the Xmath online Help).

See also Variable Arguments on page 6-30.
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3.6 Operating System Interface

The oscmd function lets you use operating system commands while in the Xmath
environment. The output of the operating system command is displayed in the Com-
mands window log area. For example:

oscmd("ls") # UNIX
oscmd("dir") # Windows

The return value of oscmd is the exit code of the operating system command. For
UNIX, if the command passed to oscmd is backgrounded with &, the return status is
0, not the execution status of the background command. This behavior is consistent
with UNIX calls.

3.6.1 Manipulate and Show Current Directory

The Xmath command set directory defines the default working directory. Here’s
how to change this directory:

show directory # Show current working directory.

/home/usr/xmath

set directory "/ home/ projX "
save x y z "3dTest.ms"

To set the directory via a dialog, select File→Set Directory.

3.7 Saving and Loading Data

Xmath provides commands for reading data files and writing Xmath objects in files.
One pair of commands, save and load , works directly on Xmath objects and files.
To increase the flexibility of the interface, the commands print, read , and
fprintf  work with a wider variety of file formats.

The save  command writes Xmath variables to a file if entered without arguments:

save

All variables in all partitions are written to the binary file save.xmd , in the current
working directory. This is equivalent to selecting File→Save All.

The load command without arguments loads the file save.xmd from the current
working directory:
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load

Alternatively, selected objects can be saved and loaded, and you can specify a differ-
ent filename:

a = 1:1:10; b = "this is a test";c = 55;

Save a and b in file mysave.xmd :

save a b "mysave"; b = 27000;

Save b and c  in file saveagain.xmd :

save b c "saveagain"
delete *
load b "mysave"
b

b (a string) =   this is a test

load b "saveagain"
b

b (a scalar) =   27000

The extension xmd is appended to the filename unless you specify a different exten-
sion.

Objects with the same names as objects in the loaded file are overwritten. For exam-
ple:

a = 1:1:10;
aa = "this is a test";
save
aa = 55

aa (a scalar) =   55

load
aa

aa (a string) =   this is a test

The data is saved in Xmath binary format by default. Alternatively, the data can be
saved in an Xmath ASCII, MATRIXX binary, or MATRIXX ASCII (FSAVE) format.

save "mysave" {ascii} # Xmath ASCII
save "mysave" {MATRIXx} # MATRIXx binary
save "mysave" {MATRIXx, ascii} # ASCII
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See the Xmath online Help for more information on save and load . For information
on how to save and load files in Xmath format without starting Xmath, see LNX and
UCI Functions on page 8-11.

3.7.1 ASCII Versus Binary Considerations

Which format (ASCII or binary) to use is a tradeoff between speed of loading and
portability.

Compared to the ASCII format, the binary format loads faster in Xmath. The larger
the data file, the more noticeable the speed advantage will be. On the other hand,
the binary format is typically larger in size and is not portable across different
Xmath platforms. For example, a data file created on SunOS will not be usable on
Windows NT. Furthermore, a binary data file must be transferred as binary, for ex-
ample, via the binary mode in FTP.

Before you send a binary data file via email, you must first encode the file with
uuencode (or an equivalent mail encoder), and the recipient of the email can then
use uudecode  to recover the original binary file.

The ASCII format is fully portable. An ASCII format save file can be transferred to
any Xmath platform with NFS, FTP, or email. However, some email gateways have
restrictions on the length of lines of the email content. For such systems, the save
file, even though it’s ASCII, should be treated as a binary file for the purpose of
email transmission as mentioned above. Again, this requirement is the same for
non-Xmath files that contain long lines.

3.7.2 Saving Data in Non-Xmath Formats

print

The print  command outputs Xmath data to a file.

a = [1.1,2.2,3.3;4.4,5.5,6.6];
print a file="print.tst"
oscmd("more print.tst") #UNIX

::::::::::::::
print.tst
::::::::::::::
main.a =
1.1    2.2    3.3
4.4    5.5    6.6

ans (a scalar) = 0
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If a file of the same name exists, it will be overwritten.

fprintf

Using the same conventions for formatting as the C language routine fprintf , the
fprintf function converts numeric values to a string representation for display,
and writes them to an external file. For example:

N = 3;
s=fprintf("fpr.asc","%d Laws of Motion"n",N)

where "n is the newline escape character sequence (see Section 5.6.2 on page 5-52).
If an fprintf call uses a filename that already exists, the output will be appended
to the existing file:

s=fprintf("fpr.asc","%d Laws of Thermodynamics"n",N)

NOTE: You can use the keyword reset to specify that the output file (if it already
exists) be truncated.

Print out the contents of the newly created file to the log area:

oscmd("more fpr.asc") # UNIX
oscmd("type fpr.asc") # Windows

::::::::::::::
fpr.asc
::::::::::::::
3 Laws of Motion
3 Laws of Thermodynamics

ans (a scalar) = 0

Refer to the Xmath online Help for more information on print  and fprintf .

3.7.3 Reading Non-Xmath Data Files into Xmath

The read function reads data files of binary numbers or ASCII text files into an
Xmath matrix. The syntax for read  is:

matrix=read(filename,out_rows,out_cols,type,seek)

read can be called with just the filename argument, in which case the entire con-
tent of the file is read into an Xmath string value.

See the Xmath online Help description of read  for more examples.
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3.8 MathScript Environment

The set , show, get , and remove commands allow you to customize the MathScript
environment. The set command affects many settings, including data output for-
mat, and random distribution. Commands such as show and remove and the func-
tion get support other utilities for displaying current variables and resetting
conditions.

3.8.1 Changing Environment Settings

Certain aspects of the MathScript programming environment can be modified using
the set command. For example, set format changes the numerical output format:

x = 0.12345678901234567890?

x (a scalar) =   0.123457

set format longe
x

x (a scalar) =   0.1234567890123457e-01

set format shorte
x

x (a scalar) = 1.234578e-01

set echo on

show directory

/disk/math/test

Table 3-7 is a list of variables that set  controls.

TABLE 3-7 Environment Variables Controlled with SET

Variable Effect

autocompile Sets automatic compilation on/off for user-defined MSFs and
MSCs (see MathScript Program Compilation and Execution (.xf,
.xc) on page 6-12). Default is On.

break Use from within the Xmath debugger (Section 6.4) to set a
breakpoint at a specified line number.
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buffering Sets text buffering on/off for output to the log area. Default is
Off . By default, Xmath sends output to the log area as soon as
it is available. If you are looking for maximum possible speed,
SET BUFFERING ON.

commanddiary Records command input in the file you specify (Section 3.10 on
page 3-32).

debugonerror Determines whether or not a script that contains a runtime er-
ror will be debugged. Default is On. See Section 6.4 on
page 6-23.

directory Sets the working directory.

display When in interactive mode, if display is set to On, the result of
an assignment is displayed to the log area unless a
semicolon (;) is used to suppress the output. If display  is set
to Off , assignment outputs are not shown unless a question
mark (?) is used.

When a MathScript file is executed, the interactive display
setting is ignored. Function outputs, including plot output, are
not shown unless the question mark (?) terminator is used in
the MathScript.

Default is On.

distribution Sets the distribution type for the function random . Options are
uniform  and normal . Default is uniform .

echo Sets on/off echoing of contents of executed MathScript files to
the Commands window log area, or the Graphics window, as
the case may be (see Echoing an Executable File on page 3-28).

If you want a function output to be displayed upon execution
(this includes plot output) a ? must be used in the file, and
echo  must be on when it is executed.

Default is Off .

format Sets numerical display output format. Choices are: compact ,
engineering , fixed , long , longe , scientific , short ,
shorte . fixed  sets the number of decimal digits in a floating
point number to the value defined with set precision  (see
precision below). Default is compact .

TABLE 3-7 Environment Variables Controlled with SET (Continued)

Variable Effect
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The remove command cancels or deletes environmental settings, such as path ,
sessiondiary , or commanddiary to cancel or delete the function. remove fills this
need:

remove commanddiary

To check the current setting of any set  parameter, use the show command:

show seed

1.11121e+09

partition Sets the working partition (see Section 3.2 on page 3-7).
The default for a new Xmath session is main .

path Sets a search path for user-defined MSFs and MSCs (page 6-
10). Multiple set path commands may be issued.

pause Sets pause to on/off . If pause is set to off , the pause  com-
mand is ignored. Default is On.

precision Specify an integer representing the number of decimal digits.
This number affects variable display when set format fixed
is specified. Note, most machines cannot display more than 15
or 16 digits.

seed Specify an integer to be the random seed. The random seed is
reset to 0 at the beginning of each Xmath session. To find the
current seed, use show seed  or get({seed}) .

sessiondiary Record Xmath inputs and outputs in a file (Section 3.10 on
page 3-32).

timestamp Turn on/off  variable timestamping whenever a variable is
changed or modified. Turning timestamp  off can save compu-
tational time when variables used in a loop. Default is On.

uiupdate Turn on/off  variable and partition updating whenever a vari-
able is changed or modified. Turning uiupdate  off can save
computational time when variables used in a loop. Default is
On.

watch Use within the debugger to set a watchpoint for the named vari-
able.

TABLE 3-7 Environment Variables Controlled with SET (Continued)

Variable Effect
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The function get can be used to return a current setting that can then be assigned
to a variable.

working_dir = get({directory});
working_dir

current_dir (a string) =   /home/xmath/data

3.8.2 Expanding Pathnames in MathScript Files

Commonly, pathnames are represented by environment variables. You can expand
them within a MathScript file in several different ways. For example,

set directory = $ ENVIR_VAR

works because directory is a specific option designed for the set command. On
the other hand, if you use a general assignment, such as

file = "$XMATH/foo"

Xmath provides the result

$XMATH/foo

because this assignment does not contain a command that was specifically de-
signed to expand environment variables.

If you want the expected results from the assignment statement above, you should
use the get  command with the keyword path . For example,

file = get({path="$XMATH"}) + "/foo"

provides the expanded pathname.

You can find additional examples of this type of usage in the following files:

$XMATH/modules/basic/hardcopy.msc
$XMATH/modules/basic/version.msc

You can also use the oscmd with the $ENVIR_VARformat; in this case, the operat-
ing system expands the environment variable.

See the get , set , and oscmd entries in online Help for further information.
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3.8.3 Abbreviating Command Names (alias and unalias)

The alias  command allows you to substitute a name for a text string.

alias clear delete *
alias mkm makematrix

To see all current aliases, type:

alias

An alias defined in any context is local to the defined scope. For example, an alias
entered from the command line is not accessible from an MSF, MSC, or MSO. Con-
versely, an alias defined in an MSF, MSC, or MSO is not accessible from the com-
mand line.

Use the unalias  command to undo any aliases.

unalias clear

Alias substitution is performed at compilation time. Therefore, a code fragment sim-
ilar to the following will not have the intended effect:

alias sl save
if do_load

alias sl load
endif
sl # Always substituted with load because that was

# the last alias command.

3.9 MathScript Batch Files

MathScript batch files contain sequences of Xmath statements. They are useful for
setting up user environments, performing repetitious tasks, and processing pro-
grams in batch. MathScript batch files have no declaration statement, and there-
fore, no inputs or outputs.

Batch files are run using the execute file command. A MathScript batch file typ-
ically has the suffix.ms , but any suffix will do. If the suffix is .ms , you can execute
the file without specifying the extension (see Section 3.9.1).

If you do not want a function or command output to be displayed when the file is ex-
ecuted, use the semicolon terminator (see page 3-14). If you want the output to be
displayed, you must use a question mark as a terminator. This also applies to the
output of the plot  function.
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Executable strings must also be terminated by a semicolon (;) or question mark (?).
For example, the following is incomplete:

test_string = "show format";
execute test_string

From the above incorrect syntax, you receive the message:

Error(s) in executing show format

The correct syntax is as follows:

test_string = "show format;"
execute test_string

3.9.1 Executing a Batch File

You can execute a batch file from either the command area in the Xmath Com-
mands window or the File menu. From the command area, use the execute file
command. For example, to execute a batch file called myfile.ms in the current
working directory, type:

execute file = "myfile"

3.9.2 Echoing an Executable File

By default, when you execute a MathScript file, the contents of the file itself are not
echoed to the log area. If you specify SET ECHO ON, each statement is displayed to
the log area as it is being executed. To turn this feature on, type:

set echo on

You can find out the current echo setting by typing:

show echo

To turn the echo off, type:

set echo off

3.9.3 startup.ms (on UNIX systems)

The environment variable XMATH_STARTUPdefines the properties of the Xmath
startup icon to execute the startup.ms batch file. This batch file contains Math-
Script statements that execute every time you start a new Xmath session. You can
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set up your initial working environment for the Xmath session (for example, you can
specify a list of directories as a search path).

Xmath looks for and executes startup.ms  in the following order:

1. The space-separated list of directories specified in the environment variable
XMATH_STARTUP

2. The optional xmath subdirectory under your home directory ($HOME/xmath/
startup.ms)

3. The current directory (./startup.ms)

The environment variable XMATH_STARTUPcan be set to include multiple directo-
ries. For example:

setenv XMATH_STARTUP "/home/group /home/user"

Xmath will run startup.ms in /home/group and then /home/user .
Example 3-1 shows a sample startup.ms  file.

EXAMPLE 3-1: Sample startup.ms  File

# set up aliases
alias sp set path =
# set path to several test directories
sp "/usr/me/tests"
sp "/usr/me/tests/routines"
# set up new partition and go there
new partition projectX
set partition projectX
# output data display format
set format long

3.9.4 startup.ms (on Windows Systems)

The environment variable XMATH_STARTUPdefines the properties of the Xmath
startup icon to execute the startup.ms batch file. This batch file contains Math-
Script statements that execute every time you start a new Xmath session. You can
set up your initial working environment for the Xmath session (for example, you can
specify a list of directories as a search path).
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The following are sample definitions for %XMATH_STARTUP%.

Xmath looks for and executes startup.ms  in the following order:

1. The space-separated list of directories specified in the environment variable
XMATH_STARTUP

2. The optional xmath subdirectory under your home directory
(%HOME%\xmath\startup.ms)

3. The current directory (.\startup.ms)

NOTE: You must define the %HOME% variable yourself.

You can set the environment variable XMATH_STARTUPto include multiple directo-
ries. For example:

set XMATH_STARTUP="%HOME%\group %HOME%\user"

Xmath runs startup.ms in %HOME%\group and then %HOME%\user.
Example 3-2 shows a sample startup.ms  file.

Windows NT: Set the path to the startup.ms  batch file by selecting
Start→Settings→Control Panel→System. From the System Properties
dialog Environment tab, for example, add an entry in the User Variables
field (Variable, Value):

XMATH_STARTUP %HOME%\user

Windows 98
or
Windows 95:

Set the path to the startup.ms batch file by adding the following line
to your AUTOEXEC.BAT file (or to any other startup batch file):

set XMATH_STARTUP=%HOME%\user
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EXAMPLE 3-2: Sample startup.ms  File

# set up aliases
alias sp set path =
# set path to several test directories
sp "\\user\me\tests"
sp "\\user\me\tests\routines"
# set up new partition and go there
new partition projectX
set partition projectX
# output data display format
set format long

3.9.5 I/O Redirection

If you have a lengthy automated process that does not require interactive input, you
can run it in background or batch mode using the tty (non-graphical) version of
Xmath.

To create a MathScript file suitable for batch execution, start by using an editor to
write a script file containing the instructions as you would enter them from the
Xmath command line. Alternatively, you can start with a command diary file. Data
generated in the batch script file can be written to an external file using the SAVE
command.

If a file runs to completion and unsaved variables exist, Xmath asks the question:

Modified variables that have not been saved exist; quit anyway? (y/n)

This presents a problem because you cannot respond while in batch mode. To by-
pass the situation, you must SAVEor delete the data at the end of the file. The fi-
nal entry in a batch file must be QUIT. (If QUIT does not end the file, Xmath will
remain in terminal mode.)

I/O Redirection

To run the completed batch file from the UNIX command line, type:

% xmath -tty < batchfile.ms > batchfile.output

where the MathScript input is contained in batchfile.ms , and the output results
are redirected to batchfile.output . (The output file contains anything that would
normally appear in the Commands window log area, so be sure that echo is set
properly.)
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3.10 Recording an Xmath Session (Diaries)

Xmath can automatically record commands and responses using command and
session diaries. A command diary records user input only, while a session diary
records user input and the Xmath responses.

To create a diary, the environmental variable echo must be on. If it is off , a diary
file may be opened but nothing will be recorded in it. To determine the echo setting,
type:

show echo

If echo  is off , you must type set echo on to activate it.

3.10.1 Recording Inputs (Command Diary)

Command diaries record MathScript input. A command diary is by definition an ex-
ecutable file; it contains all valid instructions issued while the command diary was
set. However, when the file is executed, you may not see all the outputs you did
when you captured the commands; you must either edit the diary to insert the
proper terminators, or be sure to use them when you input the commands you are
capturing.

To open a command diary, type:

set echo on

set commanddiary "mytest.ms"

where mytest.ms is the name of the diary file. The file is placed in the current
working directory (see Section 3.6.1 on page 3-19 for details on setting the working
directory). To see if a diary file is already open, type:

show commanddiary

If the specified file does not exist, it will be opened for writing. If a diary file of the
same name exists, it will be closed and a new file opened.

t = 1:0.1:100
s = sin(t)
g=plot (s)?

To close a diary file, use the remove  command:

remove commanddiary
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Since a command diary contains only executable MathScript commands, you can
replay the contents using execute:

execute file = "mytest"

Note the output behavior when the file is replayed. When the calls were typed inter-
actively, the outputs of t and s were written to the log area, but when the file was
executed the outputs were omitted. When a value is assigned to a variable, the func-
tion outputs will only be displayed if the question mark terminator (?) is used, as
was the case for the graph object g.

3.10.2 Recording Inputs and Outputs (Session Diary)

A session diary records inputs and outputs, that appear in the Commands window
log area while the diary is open. This can be useful when the contents of a data ob-
ject need to be recorded in the file. For example:

set echo on

set sessiondiary "session1"

test1 = 0.75;
exist(test1)
sin(test1)

remove sessiondiary
oscmd("more session1")

Because session diaries include outputs (which are not MathScript statements),
they cannot be executed as command diaries until they are edited.
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4 Graphics

The Xmath Graphics window displays Xmath plots and other graphics. It is typically
opened and updated whenever the plot function is called, or a function that calls
plot (such as bode ) is invoked. It provides complete interactive facilities for building,
modifying, and viewing two-dimensional (2D) and three-dimensional (3D) graphics.
You can specify graph characteristics, such as labels, placement, and size, as key-
words to plot , or you can add or modify them interactively from the Xmath Graph-
ics window menus or the Xmath Palette. This chapter provides a functional
approach to both displaying and changing the appearance of your data.

4.1 Using the plot Function

The plot function creates 2D and 3D plots from data; complex components (those
containing imaginary elements) are ignored.† You can call plot with any one of the
following syntaxes:

graphObj = plot(y,{keywords})
graphObj = plot(x,y,{keywords})
graphObj = plot(x,y,z,{keywords})
graphObj = plot(x,y,z,colorindex,{keywords})
graphObj = plot()
graphObj = plot({keywords})
graphObj = plot(graphObj, {keywords})

In the preceding plot syntaxes, x is a vector or matrix; y is a vector, matrix, or
PDM; and z is a vector or matrix. If z is a matrix, a color index matrix colorindex
can be supplied to add color as a fourth dimension. Each syntax is discussed in the
following sections.

† If you need to plot complex data, you can make a real vs. imaginary cartesian
graph. Given complex data z , call plot(real(z),imag(z)) .
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An existing graph object can be reused as an input in several ways; it can be altered
with keywords or combined with another plot to create a new image.

An optional graph object can be included as an input (for one, two, or three input
plots). If the data is compatible, the new data is overlaid on graphObj , and the
modified graph is returned as a graph object from plot . However, a graph object
can also be referenced with the keep or copy keywords. The keep keyword is pref-
erable because it is fastest. In either case, you can reference a single graph object.
(You can’t specify keep  and the optional graph object input in the same call.)

If you input the data below, you can test each syntax in the sections that follow:

# define vectors for plotting

v=[0:.25:30]';
vc=v.*cos(v); vs=v.*sin(v);

# define a PDM

ypdm=pdm([vc,vs]);

# define matrices for plotting
x=[vc,vc]; y=[vs,vs]; z=[1.5*v,1.5*v];
vm=vs*vc';
m=v*v';
ms=[vs,-vs];
mc=[vc,-vc];

4.1.1 Plot One Input

For a single argument the syntax is plot(y) :

■ If y  is a vector with m elements, then y  is plotted versus the vector 1:m.

plot(vc)?

■ If y is an m × n matrix, then each column of y is plotted versus the vector 1:m.
The result is n curves, each with m points.

plot(vm)?

■ If y is an m × n × d PDM where m × n is the size of each dependent matrix, and d
is the length of the domain (the independent parameter), then m × n curves of d
points are drawn, each versus domain(y) . Therefore, each line corresponds to
a channel of a PDM (see Section 5.4.4 on page 5-29):

plot(pdm([vc,vs]))?
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4.1.2 Plot Two Inputs

The syntax for two arguments is plot(x,y):

■ If x  and y  are vectors of the same length, then y  is plotted against x :

plot(vs,vc)?

■ If x is an m × 1 or 1 × m vector and y is an m × n matrix, each of the n columns of
y  is plotted against x  on a single graph. Each curve has m points:

plot (vs,m(:,1:7:length(vs)))?

■ If x and y are both m × n matrices, then n curves are drawn, each consisting of a
column of y  versus the corresponding column of x :

plot (m,vm)?

4.1.3 Plot Three Inputs

The syntax for three arguments is plot(x,y,z) :

■ If x , y , and z are vectors of the same length, then z is plotted versus x and y as
a curve in space:

plot (vc,vs,v/3)?

■ If x is an m × 1 or 1 × m vector, and y is n × 1 or 1 × n, and z is an n × m matrix,
then z  is plotted as a surface versus x  and y :

plot (vc(1:50),vs(1:50),vm(61:110,61:110),{!grid})?

■ If x , y , and z are matrices of the same dimensions, then z is plotted versus x
and y  as a surface in space:

plot (mc,ms,z,{!grid})?

4.1.4 Color as a Fourth Dimension

If inputs x , y , and z are supplied and z is a matrix, then you can pass a fourth ar-
gument to use color to represent an additional dimension over the data surface. In
the following example, the fourth argument is a matrix the same size as z generated
by the colorind function (a colorindex matrix). The values specified with the
face_color keyword are applied to the data surface at the locations in the colorin-
dex matrix:

v=[0:.25:30]';
x=v.*sin(v);
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y=x;
z=vs*-vs';
z=z(31:60,31:60);
g1=plot(x(1:30),y(1:30),z,colorind(z),{face_color=9:19})

4.1.5 Creating and Displaying a Graph Object

This section discusses common plotting approaches. Keywords mentioned here are
discussed in detail later in this chapter.

Graph object output is handled like any other function output, except that it is dis-
played in the Xmath Graphics window rather than to the log area. When no output
is assigned, the graph is written to the default object ans .

It is a good practice to use the ? terminator with plot , regardless of how you cal it:
interactively, in executable files, or in MathScript entities. This is particularly im-
portant when plots are developed in a .ms file. (By default, set echo is off when
files are executed so Xmath displays only graphs with the ? terminator.)

The keep keyword (which is also discussed in Section 4.2.5 on page 4-18) combines
an existing graph object and any new information. If the plots are compatible, the
new information becomes part of the specified graph. For example:

v=[0:.05:5];
plot(v.*sin(v),{title="The first curve."})?
plot(-v.*cos(v),{keep,title="The second curve."})?

The second curve is plotted over the first; note that plot recognized there was al-
ready a title and substituted the newest one. You can still add to the graph, and this
time name the output:

final=plot({ keep, xlog, xmax=100, title="The Final Graph",
legend=["1st curve","2nd curve"]})?

If saving a graph to a variable is an afterthought, you can capture the current image
in the Xmath Graphics window by selecting File→Bind to variable from the Xmath
Graphics window menu bar or by calling plot  with no arguments:

g2=plot() # name current graph object g2

Both File→Bind to variable and Variable=plot() do the same thing as Vari-
able=plot({keep}) .

Once a graph object is assigned to a variable, it can be saved to a file and then
load ed and displayed at a later time. Rather than creating an executable file that
recreates the graph, you can archive the images themselves.
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NOTE: If you have an observable delay, when you drag a window across an
Xmath Graphics window, try disabling the Show window contents while dragging
checkbox on the Control Panel→Display→Plus! tab (Windows NT only).

4.2 Using Keywords with plot

Every call to plot can have a list of keywords that modify the plot’s appearance. Al-
most everything that can be done using keywords can be done interactively with
tools available from the Xmath Graphics window menus and the Xmath Palette.
Keywords, however, are very convenient because they provide command-line control
of graphics modifications. This implies that plot instructions can be saved to and re-
trieved from a diary file or built up independently in a MathScript file. Also, a key-
word string may be aliased to a shorter string.

■ Plot keywords, as shown in Table 4-1, are used like any other keywords. As a
reminder, though, the type of information dictates how the keyword is imple-
mented.

For Boolean scalars, note that a nonzero value denotes TRUE/on, while 0 de-
notes FALSE/off. For example:

plot({grid,marker})   # grid and marker are on
plot({!grid,!x_lab}) # grid and x_lab are off

■ If you use the hold keyword, the keyword settings remain until you redefine an
attribute, until you use !hold , or until you call plot({reset}) (see Hold Key-
word on page 4-37).

■ You can use the negative operator ! to set a keyword to FALSE or 0. For exam-
ple, you can use either !grid or grid=0 to turn off all grid marks while
grid=1  enables them.

TABLE 4-1 Keyword Types

Keyword Type Sample Input

Boolean {!legend}, {!axisfix}

integer {rows=5}, {line_color=12}

vector {scale=[.5,.5],line_color=2:24}

string {title="My Beautiful Graph"}

vector of strings legend=["input 1","input2"]
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Sections 4.2.1 through 4.2.18 discuss keywords in functional groups (see Table 4-2)
using examples to illustrate how they work. Each keyword description gives its de-
fault setting.

An alphabetized list of all keywords and the location of each appears in Table 4-3.

TABLE 4-2 Keyword Categories

Category Section

Labels and legend 4.2.1

Colors 4.2.2

Line and marker specifications for data 4.2.3

Multiple graphs and graph positioning 4.2.4

Adding new data to existing plots (keep, copy ) 4.2.5

Axis and zero lines 4.2.6

Tics and grids 4.2.7

Free text and global text settings 4.2.8

Axis limits and logarithmic scaling 4.2.9

Animate 4.2.10

Placement, scaling, and rotation 4.2.11

Background, edge, and face settings 4.2.12

Lighting source settings 4.2.13

Holding graph attributes 4.2.14

Strip plots 4.2.15

Bar plots 4.2.16

Contour plots 4.2.17

Polar plots 4.2.18
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TABLE 4-3 Plot Keywords (Alphabetized Listing)

Keyword Page Keyword Page Keyword Page

animate 4-30 line_width 4-13 x_axis_fix 4-21
axis 4-8 log 4-28 x_axis_line 4-22

axix_fix 4-21 marker 4-14 x_grid 4-23
axis_line† 4-22 marker_color 4-14 x_inc 4-28
bar 4-42 marker_size 4-15 x_lab 4-8
bg_color 4-33 marker_style 4-15 x_log 4-28
colormap 4-10 move 4-31 x_max 4-28
column 4-16 polar 4-45 x_min 4-28
columns 4-16 position 4-31 x_tic 4-23
contour 4-43 projection 4-31 x_tic_lab 4-23
contour2d 4-43 r_inc 4-45 x_zero_line 4-22
contour3d 4-44 r_max 4-45 y_axis 4-21
contour_interval 4-44 reset 4-37 y_axis_fix 4-21
copy 4-20 rotate 4-30 y_axis_line 4-22
date 4-8 row 4-17 y_grid 4-23
edge 4-33 rows 4-17 y_inc 4-23
edge_color 4-33 scale 4-30 y_lab 4-8
edge_style 4-34 strip 4-40 y_log 4-28
edge_width 4-34 text 4-25 y_max 4-28
face 4-33 text_angle 4-25 y_min 4-28
face_color 4-33 text_color 4-25 y_tic 4-23
face_style 4-33 text_font 4-25 y_tic_lab 4-23
fg_color 4-20 text_position 4-26 y_zero_line 4-22
graph_number 4-34 text_style 4-26 z_axis 4-21
grid 4-23 text_size 4-26 z_axis_fix 4-21
hold 4-37 theta_inc 4-45 z_axis_line 4-22
keep 4-19 theta_max 4-45 z_grid 4-23
keepsubplot 4-20 theta_min 4-45 z_inc 4-28
legend 4-8 tic 4-23 z_lab 4-8
light 4-35 tic_lab 4-23 z_log 4-28
light_color 4-35 tic_maj 4-23 z_max 4-28
light_direction 4-35 tic_min 4-23 z_min 4-28
line 4-12 time 4-8 z_tic 4-23
line_color 4-12 title 4-8 z_tic_lab 4-23
line_style 4-13 x_axis 4-21 z_zero_line 4-22
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4.2.1 Labels and Legend

Labels allow you to place a text string in a specific location relative to the plotted
data. Labels are therefore bound to the plot and their locations cannot be changed.

The keywords legend , date , and time also place text on the graph, but you can
move these small text objects with the mouse. (To create “independent” text, use the
tex t keywords on page 4-25, or create free text interactively.) Table 4-4 summa-
rizes the labels and legends.

Tic labels (numbers corresponding to major tic marks) are discussed on page 4-23.

The example that follows creates 3D data and then creates the contour graph shown
in Figure 4-1. All axis information is negated so that you can clearly see every label
(negating axis information is optional). Note the string of vectors used to label the
legend. There are four intervals in this contour, and this vector of strings provides

†. Underscores are always optional. For example, both x_axis  and xaxis  are acceptable.

TABLE 4-4 Label and Legend Keywords

Keywords Description

title String for the graph title above the plot. Default is an empty string.

x_lab String for the x-axis label. Default is an empty string.

y_lab String for the y-axis label. Default is an empty string.

z_lab String for the z-axis label. Default is an empty string.

date Places the date in the upper left corner; format is:
dayName_month_date_year .

Default is an empty string.

time Places the time in the upper left corner. Format is
hour_minutes_seconds  on a 24 hour clock. Default is an empty
string.

legend For multi-line or contour plots, you can specify a vector of strings
naming each line or contour, for example, legend
=["Time","Speed"] . The default labels for 2D plots are the line
number followed by the corresponding line style (and color, for color
monitors). For 3D plots, the default legend corresponds to differing
surface styles.
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new labels for only the first and last; the default label is displayed for intervals
where the null string ""  is specified.

x=[-2*pi:0.35:2*pi]';
x=[x;x];y=x;
z=sin(round(x))./x*(sin(y)./y)';
legetext=["Mt. Everest","","","sea level"];
g=plot(x,y,z,{!grid,contour3d, time, date,
title="Contour Graph", xlab="the x label",
ylab="the y label", zlab="the z label",
legend=legetext})?

4.2.2 Colors

Many keywords take a color as an argument. You can specify colors by number or
name, and a vector of color names or numbers is acceptable. You can see the cur-
rent colormap on the Xmath Palette. On color monitors, up to 64 colors can be allo-
cated.

FIGURE 4-1 Label Locations and Legend
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If a value is specified (an integer between 1 and 64), Xmath indexes into the current
colormap.

If a color name is specified, Xmath searches for a match in the following tables in
the order shown:

1. The currently installed Xmath colormap.

For black and white systems, the current colormap simply represents black, six
shades of gray, and white. On color systems, each row in the colormap is a
color; the first column represents red intensity; the second, green intensity; and
the third, blue intensity.

2. On UNIX systems, the X11 color name database (often stored in /usr/lib/
X11/rgb.txt )

This is a very long list.

3. The list of supported Xmath color names (Table 4-5).

The first eight colors on this list compose the default sequence for line and
marker colors. The first color is black or white (depending on the background
color), followed by red, green, yellow, blue, magenta, cyan, and black or white.

If you use strings to specify these colors, spacing must be typed as shown, but
case is not important. For example:

plot(x, {bg_color="CADET BLUE",fg_color=51})

4. The list of default (built-in), machine-dependent color names.

As soon as a name match is found in one of the locations above, Xmath looks at
the corresponding values, compares them to values in the current colormap,
and then implements the closest color available in the current colormap.

To supply your own colormap, construct an n×3 matrix with values representing
red, green, and blue intensity ranging from 0 to 1. Before installing your color map,
it’s a good idea to save the default color map:

mapDefault=plot({colormap})

This saves the colormap to the variable mapDefault .

To replace the current colormap with your own mapMyColors , type:

plot({colormap=mapMyColors})

Your colormap now appears in the Xmath Palette as the current colormap.
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For more on colormaps, see the online Help listings for Color List , Colormaps ,
and Color .

TABLE 4-5 String Color Names for Xmath Supported Colors

No. Name No. Name No. Name

1 "black" 22 "chris cyan" 43 "aliki aqua"

2 "red" 23 "periwinkle" 44 "cyan"

3 "green" 24 "prussian blue" 45 "cerulean"

4 "yellow" 25 "cadet blue" 46 "big blue"

5 "blue" 26 "kam blue" 47 "lapis"

6 "magenta" 27 "royal purple" 48 "blue"

7 "cyan" 28 "red violet" 49 "marine blue"

8 "white" 29 "mulberry" 50 "violet"

9 "silly putty" 30 "orchid" 51 "mark magenta"

10 "peach" 31 "maroon" 52 "purple"

11 "salmon" 32 "strawberry" 53 "fuchsia"

12 "brick" 33 "fire engine red" 54 "berry"

13 "kin orange" 34 "orange" 55 "raspberry ron"

14 "burnt umber" 35 "pumpkin" 56 "red"

15 "brown" 36 "golden dawn" 57 "black"

16 "coffee" 37 "yellow" 58 "gray5"

17 "mustard" 38 "lemon yellow" 59 "gray4"

18 "neon green" 39 "light green" 60 "gray3"

19 "forest green" 40 "algae" 61 "gray2"

20 "teal" 41 "grant green" 62 "gray1"

21 "ocean green" 42 "new grass" 63 "gray0"

64 "white"
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The following keywords dictate color changes for different plot elements:

■ bg_color

■ edge_color

■ face_color

■ fg_color

■ grid_color

■ light_color

■ line_color

■ marker_color

■ text_color

The meanings of these keywords are discussed elsewhere within the keyword func-
tional groups.

4.2.3 Line and Marker Specifications for Data

You can change the color, style, and width for lines (for example, curves) of data as
specified in Table 4-6. If you make changes to lines and specify the legen d key-
word, your changes are reflected in the legend.

TABLE 4-6 Line Specification Keywords

Keyword Description

line Boolean that turns line plotting on or off. Default=1.

line_color Integer, string, vector of integers, or vector of strings for specifying
data line colors (see Section 4.2.2 on page 4-9). If line_color
specifies a vector, the given color sequence is cycled through. On
color monitors for plots with multiple curves, Xmath automati-
cally assigns each curve a different color.
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The following example generates several line styles and widths; the plot appears in
Figure 4-2:

v=[0:2/7:20]';vc=v.*cos(v);
x=[vc,vc*2,vc*4,vc*6];
plot (x,{legend, line_width=[8,6,4,2],line_style=[4,3,2,1],
line_color=["peach","teal","lapis","purple"]})

line_width Any float is accepted. The variety of line widths allowed is ma-
chine dependent; if you specify a value the machine can’t provide,
it supplies the closest thing. The default value of 1 is approxi-
mately equal to 1 pixel on your monitor. On a high resolution
monitor, the difference between .5 and 1 may be visible; on others
the output might be the same.

line_style Integer, vector of integers, string, or vector of strings that specify
line styles for each curve on the graph. The line_style mapping
is:

Integer                      String
0          "    "
1          "----"
2          "- - "
3          "...."
4          "-.-."
5          "-..-"
6          "-..."
7          "-- --"

If line_style  is set to a vector of integers, strings, or names,
Xmath cycles through the specified sequence of styles.

TABLE 4-6 Line Specification Keywords (Continued)

Keyword Description
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Markers, as described in Table 4-7 are symbols plotted at each data point. You can
change a marker’s size, style, or color using integers, floats, or strings the same as
you do with line styles. To see a plot with only markers, use the keywords
{!line,marker} .

TABLE 4-7 Marker Specification Keywords

Keyword Description

marker Boolean that turns on/off plot markers. Default=0.

marker_color Integer, vector of integers, string, or vector of strings that
specifies marker color (see Section 4.2.2 on page 4-9). You can
specify an integer or string for each curve on a graph. If a vec-
tor is specified, the color sequence is cycled through.

FIGURE 4-2 Line Styles and Widths
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You can use a combination of line styles and markers to expand the number of
unique lines you can plot. This is especially valuable for those using black-and-
white monitors or for complicated plots that will be printed in black and white.

a=1:9; b=ones(9,9);for i=1:9; b(i,:)=a;endfor
plot({!grid,!x_axis,y_inc=1,axisfix,hold})

plot(b,{columns=2,
line_width=[.5, 1, 2, 3.5, 4, 5.5, 6.5, 7, 7.5]})?

g=plot(b,{keep,column=2,!line,marker_size=[.25, .5,
.75, 1, 1.5, 2.25, 2.25, 2.5, 2.75]})
plot({reset})

The final result, Figure 4-3, shows some of the line and marker styles in a variety of
widths and sizes. Normally hold and axisfix need to be turned off with !hold
and !axisfix , but plot({reset}) , which resets everything, is used in this exam-
ple.

marker_size Any nonzero float is accepted. The range of marker sizes al-
lowed is machine-dependent; if you specify a value the ma-
chine can’t provide it will supply the closest thing. The default
value is 0.5.

marker_style Integer, vector of integers, string, or vector of strings that
specifies marker style for each curve on the graph.
The marker style mapping is:

Integer                      String                        Style

  0         "  "              no markers
1         "*"                asterisks

  2      "x"                x’s
3         "+"                crosses
4         "o"                circles
5         "(*)"        filled circles

  6         "[]"              squares
  7         "[*]"            filled squares
  8         "/\\"            triangles
  9         "/*\\"          filled triangles

The default marker style is 1. If a vector of marker styles is
specified, they will be cycled through.

TABLE 4-7 Marker Specification Keywords (Continued)

Keyword Description
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4.2.4 Multiple Graphs and Graph Positioning

The keywords shown in Table 4-8 allow you to place more than one plot in the
Xmath Graphics window. If you are displaying multiple graphs, you can ensure that
they are the same size by dividing the window into rows and/or columns and then
positioning the graphs with row and column coordinates or graph number. You can-
not rotate or zoom plots with multiple graphs interactively.

TABLE 4-8 Graph Specification Keyword

Keyword Description

column Integer specifying the column position of the graph. De-
fault=1.

columns Integer specifying how many columns the plot window is di-
vided into. Default=1.

row Integer specifying the row position of the graph. Default=1.

FIGURE 4-3 Line and Marker Styles with Varying Widths and Sizes
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Note that the keywords row , rows , column , and columns all default to 1. Therefore,
you needn’t specify row=1 or column=1 because Xmath attempts to place graphs in
these locations by default. The keywords rows and columns are initiators. If they
are used in a plot call, the row/column setting remains in effect for subsequent
plots that use the keywords row , column , or graph_number . If a plot is called that
does not contain row , column , or graph_number , the default format
({rows=1,columns=1} ) is reset.

The following example places six graphs in the window; the final plot appears in
Figure 4-4.

v=[0:.25:20]';
vc=v.*cos(v);
x=[vc,vc*2,vc*4,vc*6,vc*8,vc*10];
g=plot (x,{rows=2,columns=3}) #assume row 1 col 1
g=plot (vc*2,{keep=g,column=2}); #assume column=1
g=plot (vc*4,{keep=g,column=3}); #assume row=1
g=plot (vc*6,{keep=g,graph_number=4});
g=plot (vc*8,{keep=g,graph_number=5});
g=plot (vc*10,{keep=g,graph_number=6})?

rows Integer specifying how many rows the plot window will be di-
vided into. Default=1.

graph_number Integer specifying alternate representation for row and col-
umn in a multi-graph plot. For rows=m and columns=n , the
“cells” are numbered from 1 to m × n going across the rows
and then down the columns. Thus, for rows=2  and col-
umns=2, graph_number=3  is equivalent to row=2 , col-
umn=1.

TABLE 4-8 Graph Specification Keyword (Continued)

Keyword Description
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4.2.5 Adding New Data to Existing Plots (keep, copy)

Xmath has two ways of storing the image in the Xmath Graphics window in a vari-
able. The keywords keep and copy described in Table 4-9 both use the contents of
the Xmath Graphics window, but they may affect previously saved variables differ-
ently.

Keep combines the attributes and data from your current plot call with the current
contents of the Xmath Graphics window and updates the variable. Keep is best
used when you are building a plot by overlaying data or adding attributes to an ex-
isting plot. Because keep uses whatever is in the Xmath Graphics window, Xmath
keeps changes you make with interactive tools automatically.

If you create a graph object g1 and later create a graph object g3 that keeps g1, a
common incorrect perception is that g1 has the old view and g3, the new. In reality,
both variables point to the same graph object. You can test this as follows:

FIGURE 4-4 Plots Placed with row, column , and graph_number  Keywords
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v=[1:.25:30]';vs=abs(v.*sin(v));vm=vs*vs';
g1=plot(vs,v)

g2=plot(vs(1:30),vs(1:30),vm(61:90,61:90))

g3=plot({keep=g1,log})

g1

where g1  and g3 are the same.

As long as the data dimensions allow it, Xmath performs any keep you specify. For
example, you can combine a 2D and 3D plot. The following example uses the keep
keyword to specify a 2D plot and provides the 3D information internally:

plot(vs(1:30),vs(1:30),vm(61:90,61:90),{!grid,keep=g3,
ylab="The Y label",xlab="The X label",
zlab="The Z Label"})

If you want to re-use a graph object but you don’t want it to be altered, use the key-
word cop y instead of kee p (see Table 4-9 for these keyword descriptions). For ex-
ample, g1 and g2 remain different in this case:

g2=plot({copy=g1,legend})

g1

Copying is computationally expensive, but it means you can save each stage when
building a plot.

TABLE 4-9 Data Keywords

Keyword Description

keep Specifies that the current plot should be added to the specified
graph object. If no graph object is specified, the plot is combined
with the current contents of the Xmath Graphics window. If the
graphs are incompatible, the new plot overwrites the Xmath
Graphics window.
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Figure 4-5 shows an example created by combining graph objects through the se-
quence of inputs below. By default, if graph objects with different data ranges are
combined, Xmath rescales the plot to accommodate all the data. As you create each
plot below, notice how the axes change to accommodate the new data with each
curve addition.

v=[0:.25:20]; vc=v.*cos(v);vs=v.*sin(v);
plot({title="You can add to a graph as you work!"})?

plot(vc,{keep})?

plot(vs,{keep})?

plot(-vc,{keep})?

plot(-vs,{keep})?

g=plot({keep,!grid,legend=[" vc"," vs","-vc","-vs"]})?

If you do not want the plots rescaled, you must specify one of the axisfix key-
words (see Table 4-10).

keepsubplot Boolean. Used with keep when adding or replacing data on a sub-
plot. keepsubplot  indicates that new data should be laid over
the existing data on the subplot.
!keepsubplot  indicates that the subplot should contain only
the new data. Default is 1.

copy copy  can be specified with a graph object argument
{copy = GraphObj} ; if no graph object is specified, the plot is
combined with the current contents of the Xmath Graphics win-
dow. copy differs from keep in that copy does not alter the origi-
nal graph object. In this case, the new data and graph keywords
are combined with a copy of the existing graph object. The com-
bined graph object is returned, while the copied graph object re-
mains unchanged.

TABLE 4-9 Data Keywords (Continued)

Keyword Description
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4.2.6 Axis and Zero Lines

The keywords described in Table 4-10 control axis and zero-line display.

TABLE 4-10 Axis and Zero Line Keywords

Keyword Description

axis Boolean that turns on or off all axis graphics on the entire
graph. This includes grids, zero lines, tic marks, and tic labels.
If an attribute is specified, it is applied to all axis graphics.

x_axis
y_axis
z_axis

Booleans that toggle all axis graphics on the x, y, or z axis.

Axis graphics color, style, and width attributes affect all com-
ponents on the named axis.

axisfix
x_axisfix
y_axisfix
z_axisfix

Booleans that toggles automatic axis scaling when graph ob-
jects are combined. Default=0 (autoscaling on). If axisfix=1 ,
axis limits are those of the kept graph object.

FIGURE 4-5 Combination of Graph Objects
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The following call produces the zero lines and axes for 2D and 3D plots shown in
Figure 4-6. This demonstrates axis and zero lines in 2D and 3D plots.

plot(sin(-5:.2:5),{columns=3,!grid,
title="2D Axis Lines and Zero Lines"})
plot(0,0,0,{column=2,!axis,title="3D Zero Lines"})
plot(0,0,0,{column=3,!zero_line,title="3D Axis Lines"})?

axis_line Boolean that toggles lines for all axes. Default=1.

x_axis_line
y_axis_line
z_axis_line

Booleans that toggle axis line for the x, y, or z axis, respec-
tively. Default=1.

zero_line Boolean that toggles zero lines on all axes. Default=0.

x_zero_line
y_zero_line
z_zero_line

Booleans that toggle zero lines on the x, y, or z axis, respec-
tively. Default=0.

TABLE 4-10 Axis and Zero Line Keywords (Continued)

Keyword Description

FIGURE 4-6 Zero Lines and Axes for 2D and 3D Plots
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4.2.7 Tics and Grids

Tics and grids appear by default on all plots. You can suppress these features on
one or more axes. Table 4-11 describes the keywords grid , tic , and tic_lab
which are especially useful because they control all axes.

TABLE 4-11 Tic and Grid Keywords

Keyword Description

tic Boolean that toggles tic marks on all axes. Default=1.

tic_maj Boolean that toggles major tic marks on all axes. Default=1.

tic_min Boolean that toggles minor tic marks on all axes. Default=0.

x_tic
y_tic
z_tic

Booleans that toggle tic marks on the x, y, or z axis, respectively.
Default=1.

x_inc
y_inc
z_inc

Integers specifying the major tic increment for the x, y, or z axis,
respectively.

tic_lab Boolean that toggles tic mark numbering on all axes. Default=1.

x_tic_lab
y_tic_lab
z_tic_lab

Booleans that toggle tic mark numbering on the x, y, or z axis, re-
spectively. Default=1.

grid Boolean that toggles all grids. Default=1.

grid_color
grid_style
grid_width

Grid color, style, and width attributes can be changed for the en-
tire graph. Colors are specified as described starting on page 4-9.
Line styles and widths are specified as described on page 4-12.

x_grid
y_grid
z_grid

Booleans that toggle the x, y, or z grid, respectively. Default=1.
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The following instructions produce the changing tic and grid setting shown in
Figure 4-7.

v=[[1:.15:15],[15:-.15:1]];
vc=[v.*cos(v)];vs=[v.*sin(v)];
vc5=vc.*.[ 2;2.5;2.75;2.5;2];
vs5=vs.*.[ 1;1.5;2;1.75;1.25];
plot(-vc5,vc5,vs5,{yinc=30,xinc=15,!zgrid})

FIGURE 4-7 Changing Tic and Grid Settings
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4.2.8 Free Text and Global Text Settings

The text keyword places a single string onto the plot. You can alter the angle, color,
font, position, size, and style of the string with keywords (see Table 4-12).

The text keyword loosely corresponds to the interactive free text feature. If you
want to add more than one text string to a plot or show a variety of text styles, you
can work on the plot interactively or combine several plots with the keep keyword.
Text keywords do not affect text associated with the data, such as labels and titles.
You can change these interactively, or, in the case of labels, with keywords.

TABLE 4-12 Free Text and Global Text Keywords

Keyword Description

text String containing the text to be written on the plot.

text_angle Vector of three float numbers [x,y,z] specifying the angle of
the text’s clockwise rotation about the axis.

text_font Integer or a string from the following:

Integer String

1 "simplex"
2 "duplex"
3 "triplex"
4 "complex"
5 "script"
6 "greek"
7 "times"
8 "helvetica"
9 "courier"

Fonts 1 through 6 are Hershey fonts, while fonts 7, 8, and 9
are PostScript fonts. The default font (font=8 ) is Helvetica.

If your platform is not be able to create the font you want in
the size you want, it attempts to supply the closest thing.

text_color Integer or string indicating the color name. Specifies the
color for all text in the graph. Default="black" . See page 4-
11.
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text_position Vector of two float numbers [x,y] used to place a line of text
anywhere in the Xmath Graphics window. The upper left cor-
ner of the text line is placed at the specified position. When
first drawn, a plot extends from -1 to +1. Note that any float
is acceptable, so it is possible to position the text outside the
viewport. If you do, it may seem as though the string was not
created; you must zoom out to view the text. Default= [0,0].

text_size Floating-point number specifying the size in points. One
point is about 1/72 inches.

text_style Integer or string indicating the text style:

Integer Font

1 "plain"
2 "bold"
3 "italic"
4 "bold italic"

Default is 1 (plain) .

TABLE 4-12 Free Text and Global Text Keywords (Continued)

Keyword Description
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The following example uses text keywords; it produces the plot shown in
Figure 4-8. Note that text_position  and position  work on the same principle.

v=[0:.5:25]'; vc=v.*cos(v); vs=v.*sin(v); vm=vs*vc'; plot(v,v,vm)
plot({keep, scale=[.9,.9],position=[-.4,0],
x_inc=5,y_inc=10,
text="Text is placed with "ntextposition"+...
""n and textangle.",
text_font=3,text_size=14,
text_angle=[0,0,30],
text_position=[.1,-.7]})

FIGURE 4-8 Text Changes and Text String Placement
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4.2.9 Axis Limits and Logarithmic Scaling

You can change the actual scaling of the data (to log scale, for example). You can
also specify the minimum and/or maximum range of data you want to see on any
dimension (see Table 4-13 for the pertinent keyword descriptions).

TABLE 4-13 Axis Limits and Logarithmic Scaling Words

Keyword Description

log Turn on/off log scaling for all axes.

Default=0.

x_log
y_log
z_log

Turn on/off log scaling for the specified axis. Default=0.

x_min
y_min
z_min

Integer indicating the minimum for the x, y, or z axis, respectively.

x_max
y_max
z_max

Integer indicating the maximum for the x, y, or z axis, respectively.

x_inc
y_inc
z_inc

Integer indicating the increment for the x, y, or z axis, respectively.

For logarithmic axes, this value becomes multiplicative. This means
that if the integer is greater than 1, it increases by multiples, and if it
is less than 1, it decreases by multiples. So if x_inc=10 , tic values
are 1,10,100, etc. If x_inc=0.1 , values are 1, 0.1, .01, etc.
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You can make an axis go backward by making the value of xmin greater than xmax
as illustrated in the following example:

x=exp(.5:0.15:5);
plot(x,{x_log,rows=3,xmax=32})
plot(x,{keep,row=2,y_log,ymax=150})
plot(x,{keep,row=3,xmin=35,xmax=1,title="Reversed Scaling"})

The results appear in Figure 4-9.

FIGURE 4-9 Axis Maximums and Minimums
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4.2.10 Animate

The animate keyword allows you to plot new data without redrawing other parts of
the plot. It is a Boolean used to show changes in data as quickly as possible for an
animation effect between successive plots. Default=0.

The following example plots a series of curves on the same axes. The first plot sets
the dimensions of the plot; the second plot holds the dimensions of the first and
specifies that only the data will be redrawn each time. The curves are plotted within
a loop and then animate is turned off. Alternatively, plot({reset}) could be used
to restore the original settings.

a=[0:20/75:20];a=a.*cos(a);
b=[10:-10/75:0];b=b.*sin(b); c=[a,b];
plot ({animate,ymin=-85,ymax=85,xmax=150});
for i=[[1:.25:5],[5:-.25:100]];
plot(c*i,{linestyle=1})?
endfor
plot({!animate})

4.2.11 Placement, Scaling, and Rotation

The placement , scaling , and rotation keywords operate on a graph as a whole
(see Table 4-14 for descriptions). This means scal e changes reduce or enlarge the
entire graph, including labels, and so forth. The keywords, rotate , projection ,
and position, also operate on an entire graph. You can use these keywords when
plotting a single graph or multiple graphs (Section 4.2.4 on page 4-16).

TABLE 4-14 Placement, Scaling, and Rotation Keywords

Keyword Description

scale Vector of two float numbers [x,y]. Each float indicates the
amount of compression (float < 1) or expansion (float >1) on the
relevant x or y Xmath Graphics window coordinate. Default is
[1,1].

rotate Vector of three float numbers [x,y,z] specifying the angle in de-
grees of a 3D plot’s rotation. Assumes a right-hand coordinate
system, based on the Xmath Graphics window axes (not the ob-
ject coordinates). Rotations are performed counter-clockwise,
first about the x-axis, then about the y-axis, then about the z-
axis. Because this rotation is based on window coordinates (the
current view), it may be simpler to rotate one axis at a time.
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projection String equal to one of the following string values:

"stretched"

Stretches the graph so that it fills as much of the plotting area as
possible. This is the default projection for 2D graphs.

"orthographic"

Indicates a coscaled setting such that unit distances on all axes
are equal. This is the default projection for 3D graphs.

move Vector of two float numbers [x,y] specifying the distance (in
Xmath Graphics window coordinates) to move the object from its
current position. [-1,-1] is the lower left corner, [1,1] is the upper
right corner, and [0,0] is the center of the window.

position Vector of two float numbers [x,y] specifying the Xmath Graphics
window coordinates of the center of the graph object. Default is
[0,0] (the middle of the window). [-1,-1] is the lower left corner,
and [1,1] is the upper right corner.

TABLE 4-14 Placement, Scaling, and Rotation Keywords (Continued)

Keyword Description
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The following example uses scaling, rotation, and projection, and the
text_position keyword, which works much the same as position does. This
example creates the projection shown in Figure 4-10.

x=[-2*pi:0.35:2*pi]';
x=[x;x];y=(x); z=sin(round(x))./x*(sin(y)./y)';

v=[0:.5:20]';vs=v.*sin(v);vm=vs*vs';
plot (x,y,z,{columns=2,scale=[1,.9],rotate=[-20,0,0],
projection="stretched"})?

g=plot (x,y,z,{keep,column=2,projection="orthographic",
text="Stretched and Orthographic Projections",
text_position=[-.35,-.9]})?

FIGURE 4-10 Stretched and Orthographic Projections
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4.2.12 Background, Edge, and Face Settings

TABLE 4-15 Background, Edge, and Face Setting Keywords

Keyword Description

bg_color
fg_color

Specifies the Xmath Graphics window background or fore-
ground color. Accepts an integer or a string (see page 4-11).

face Boolean that turns surface filling on 3D surfaces or bar plots on
or off. Default=1.

face_style Changes the style on all faces. Specify an integer corresponding
to the desired style from the following list:

Integer              Face Style
   0 none (default)
   1 solid
   2 cross-hatched pattern
   3 vertical-line
   4 horizontal-line pattern
   5 left-slanting diagonal pattern
   6 right-slanting diagonal pattern
   7 dotted pattern
   8 diamond pattern
   9 square pattern

NOTE: For black and white monitors, the face styles are only
shown if the face color is black or white. If you specify a
shade of gray and a face style, you only get gray.

face_color Specifies the color of 3D surfaces based on the z data values.
Acceptable inputs are an integer, a vector of integers, a string, or
a vector of strings (see page 4-11). If you specify a vector, Xmath
cycles through the given sequence.

edge Toggles the display of web lines on 3D surfaces or bar plots.
Default=1.

edge_color Specifies the color of the web lines on 3D surfaces or bar plots.

Acceptable inputs are an integer, a vector of integers, a string, or
a vector of strings (page 4-11). If you specify a vector, Xmath cy-
cles through the given sequence.
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The following example displays a variety of edge and face specifications.

x=logspace(1,180,90);y=logspace(90,270,90);
z=45:134;
a=[-x;x;-x;x];b=[y;-y;-y;y];c=([z;z;z;z]);

plot(a,b,c,{edge_width=2,
face_style=7,!grid,!axis,bg_color="gold",
edge_color="black",face_color="cyan"})

The graph appears in Figure 4-11.

edge_style Sets the style of all web lines. This keyword accepts an integer or
a string equivalent indicating the border line type.
Default=1 (a solid line). Allowed values are:

Integer             String

  0     " "
1     "----"
2     "- -"

  3     "...."
  4     "-.-."

edge_width Sets the width of all web lines. This keyword, like line_width ,
accepts any floating point number.

TABLE 4-15 Background, Edge, and Face Setting Keywords (Continued)

Keyword Description
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4.2.13 Lighting Source Settings

TABLE 4-16 Lighting Source Setting Keywords

Keywords Description

light Boolean that turns light source on or off. Default=0.

light_color Integer (color number) or string (color name) specifying
light source color. Default="white" .

light_direction Vector of three real numbers [x,y,z] indicating the direc-
tion in which the light travels. Light source location is as-
sumed to be infinitely far away. The default path vector is
[1,-1,3] .

FIGURE 4-11 Edge and Face Styles
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Setting light= 1 for the plot shown in Figure 4-11 produces a very different graph
(see Figure 4-12)

FIGURE 4-12 Edge and Face Styles with Light Added
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4.2.14 Reusing plot Attributes

Hold Keyword

You can use plot attributes, such as line widths, the legend, and titles, with the
hold keyword, but you cannot use plot types (strip, bar, contour, and polar) with
hold . When you use an attribute with the hold keyword, it replaces the current de-
fault. The following example uses the hold stack:

v=[0:.3:20]';vs=v.*sin(v);
plot(v,vs,{hold, time, date, legend,
title="Top Secret Project", scale=[1,.95]})

plot([-vs,-vs],[v,v],{hold,scale=[1,.95]})

plot(v+12,vs,{!hold})

plot([-vs,vs],{!hold})

You can see the results of each of these four plots in Figure 4-13 and Figure 4-14.

TABLE 4-17 Holding Graph Attributes

Keyword Description

hold Boolean. When {hold}  is used with other keywords it makes them
‘permanent’, applying them to all future graphs until hold  is termi-
nated with plot({!hold} ). Note that {!hold}  removes keywords
specified by the most recent hold. When you invoke hold  in numer-
ous plot calls, a hold stack is formed. You can specify a negative inte-
ger as an argument to hold ({hold =-n})  to remove the last n
hold  invocations from the hold stack. Use plot({reset})  to clear
the entire hold stack. (Default=0)

reset Resets plot options to their startup values. Use this keyword alone,
that is, plot({reset}) .
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FIGURE 4-13 Results of First and Second plot Commands Using hold
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FIGURE 4-14 Results of the Third and Fourth plot  Commands Using !hold
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Using an Alias in the Keyword String

Another way to reuse plot attributes is to create an alias. You can then use the alias
in the keyword string. An advantage of using an alias is that the defaults are not af-
fected. You can store the aliases you use frequently in your startup.ms  file.

You can obtain the results we achieved with the hold  keyword with an alias:

alias XX time,date, title="Top Secret Project",scale=[1,.95], legend
plot([-vs,vs],{XX})

This example reproduces the fourth plot  command above (see Figure 4-14).

NOTE: The rows and columns keywords are a special case and cannot be
explicitly used with the hold keyword (see page 4-17). Because they are
initiators, they are automatically held until a plot call is made that does
not contain the row  or column  keyword.

4.2.15 Strip Plots

The strip keyword is an integer indicating the number of data lines to be plotted
on each strip plot in a given set.

The default is 1; Xmath plots one strip per channel or column of data for up to 10
strips. After 10, strip  adds data to the existing strips.

If a value n is specified, Xmath creates strip plots with n data lines per strip plot. If
the number of lines is not evenly divisible by n, the data lines corresponding to the
remainder are lost.

Xmath creates strip charts such that the first data line appears on the first strip
chart, the second appears on the second strip chart, and so on until each strip in
the first cycle has a data line. All the lines in the first cycle have the same line style.
Xmath draws the second cycle of lines with a different line style. You can interac-
tively modify line styles, colors, markers, and so forth (see Interactive Graphics Win-
dow on page 4-46). When you alter a data line, Xmath also changes all lines in that
cycle. Note, however, that changes that do not affect data (for example, grid lines)
are not passed to other strips.

By default, strip plots are laid out as follows:

■ plot(y,{strip=N}) where y is an (m × n) matrix and n is an integer multiple
of N. Strips are arranged as an ((n/N) × 1) matrix of plots. Each strip contains N
graphs.

xb.book  Page 40  Wednesday, October 6, 1999  11:28 AM



Xmath Basics Graphics

4-41

4

■ plot(y,{strip=N}) where y is an (m × n × T) PDM and m is an integer multi-
ple of N. The results are an ((m/N) × n) plot matrix. (Think of the PDM as a col-
umn vector of blocks.)   Each subplot contains N graphs.

■ plot(y,{strip,columns=m,rows=n}) where y is a matrix with N columns
and N is an integer multiple of m × n. This syntax creates an (m × n) plot matrix
that is filled with graphs rowwise. The number of data lines in each subplot is N.
This option is very handy because it precludes having to write a nested loop to
fill in a matrix of plots.

■ plot(y,{strip,columns=m,rows=n}) where y is an (m1 × n1 × T) PDM and
m1 × n1 is an integer multiple of m × n. The result is identical to that obtained
by plotting makematrix(y) with the same keywords. When used with col-
umns=1, this syntax specifies a column of strip plots instead of a matrix of strip
plots.

To demonstrate strip plots, load the following file:

load "$XMATH/demos/sys.xmd"

This file contains sys , a lightly damped mechanical system that inputs two forces
and outputs two positions. It is discrete, sampling at 1 second. For this example, we
use this data to create a system with a sampling rate of 1 second and named inputs
and outputs:

sysd=system(sys,{dt=1,inputNames=["Force 1";"Force 2"],
outputNames=["Position 1";"Position 2"]});

Obtain a frequency response of the new system.

f = [1:200]/400; gd=freq(sysd,f);

Create a continuous version of this system and create a frequency response for it:

sysc=makecontinuous(sysd); gc=freq(sysc,f);

Plot the continuous and discrete systems.

plot(abs([gd;gc]),
{xlog,ylog,strip=2,legend=["Discrete";"Continuous"],!grid})?

The results of this example appear in Figure 4-15.
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4.2.16 Bar Plots

The bar keyword is a Boolean used to indicate that the current plot is a bar plot.
Each coordinate is plotted as the center of a bar whose height is the y or z coordi-
nate. Default=0.

plot(logspace(1,10,13),{bar,face_style=5,!x_grid})

This plot appears in Figure 4-16.

FIGURE 4-15 Frequency Responses
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4.2.17 Contour Plots

A contour plot is a 3D plot that shades portions of the plot based on the z data val-
ues; the effect is like a topographical map. You can use a legend to show which
value ranges correspond to the color or fill pattern shown in the contour plot. If you
specify the keyword face_color and supply a vector of colors, those colors will be
used to shade the data values.

TABLE 4-18 Contour Plots Keywords

Keywords Description

contour
contour2d

Booleans used to indicate that the current 2D plot is a
contour plot. Requires x, y, and z data. Default=0.

FIGURE 4-16 Bar Plot
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The following instructions produce Figure 4-17:

v=[0:.5:7]';
vc=v.*cos(v); vs=v.*sin(v); vm=vs*vc';
plot(vc,vs,vm,{rows=2,columns=2,contour2d,!grid})
plot(vc,vs,vm,{keep,row=2,contour2d,!grid,
contour_interval=1.3})
plot(vc,vs,vm,{keep,column=2, contour3d,!grid})
plot(vc,vs,vm,{keep,row=2,column=2,contour3d,
!grid,contour_interval=1.3,!z_tic_lab})

contour3d Boolean used to indicate that the current 3D plot is a
contour plot. Requires x, y, and z data. Default=0.

contour_interval Float value which can be used with contour  or
contour3d  to determine the intervals of the contour
plot. Defaults to the internally calculated tic label val-
ues of the z  data.

TABLE 4-18 Contour Plots Keywords (Continued)

Keywords Description

FIGURE 4-17 3D Contours with Different Intervals
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4.2.18 Polar Plots

The polar plot option draws a 2D plot on a polar grid. Polar plots require a radius
(magnitude vector) and an angle vector in degrees (theta):

plot(radius,theta,{polar})

The following instructions produce Figure 4-18.

t=[logspace(1,180,32);logspace(90,270,32);
logspace(180,360,32);logspace(360,540,32)];
plot (t,t,{polar,!x_grid,r_inc=90,
theta_inc=10,marker})

4.2.19 Clearing the Xmath Graphics Window

To clear the Xmath Graphics window, type ERASEin the Xmath Commands window
command area.

TABLE 4-19 Polar Plot Keywords

Keywords Descriptions

polar Boolean used to make the current 2D plot a polar plot. Default=0.

r_inc Integer specifying the polar radius increment value to be marked
on the vertical axis of the polar plot.

r_max Integer specifying the maximum polar radius to be plotted on a
polar plot.

theta_inc Integer specifying the polar angle increment value to be marked
around the circumference of the polar plot.

theta_min
theta_max

Integer specifying the minimum or maximum polar angle incre-
ment to be marked around the circumference of the polar plot.
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4.3 Interactive Graphics Window

Graphs are composed of objects such as lines, labels, and so forth. Object attributes
can be prespecified as keywords when the plot command is issued from the Com-
mands window command area. (Keyword usage is covered in Section 4.2 on
page 4-5.) You can also manipulate an object’s attributes interactively from the
Xmath Graphics window’s menus or toolbar or from the Xmath Palette. Figure 4-19
shows the graphics environment on UNIX platforms.

FIGURE 4-18 Polar Plot
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FIGURE 4-19 Xmath Graphics Environment (UNIX Platform)
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In the example shown in Figure 4-19, the graph originated with a plot function call
in the Xmath Commands window command area:

v=[0:.1:25]';vc=v.*cos(v);vs=v.*sin(v);
plot(vc,vs)?

plot(-vc,-vs,{keep,!grid,
legend=["positive","negative"],
xlab="Keep allows you to combine graphs.",
title="Use tools to alter or add to a graph."})

Note that two plots were combined using the keep keyword (see page 4-4). Graphi-
cal additions (the arrows, for example) were created with tools from the toolbar. New
objects (for example, the timestamp and datestamp) were added from the Options
menu in the Xmath Graphics window. The mouse was used to select and position
objects (for example, the legend, timestamp, and the datestamp).

4.3.1 Working Interactively

The most common approach is to start with a graph and then use interactive tools
to alter it to your satisfaction.

■ To make interactive changes, first click on an object to select it.

Xmath selects the closest object to the mouse-click. When you select text, round
handles appear on the corners of the text box. When you select a line or curve,
it is highlighted and has a thicker appearance.

When you make a selection, the appropriate attributes are enabled for both the
Xmath Palette and the Xmath Graphics window menus. For example, when the
background is selected, the Xmath Palette shows that only the fill patterns are
available (line and marker styles are disabled, and the Fills button is pushed). If
a label is selected, the Font and Point menus become available in the Xmath
Graphics window; in the Xmath Palette, the Text button is pushed. You can then
change the font and point size from the Xmath Graphics window and select a
new color from the Xmath Palette.

■ Place the pointer over an object and drag to move objects.

You can also use pulldown menus to modify and move selected objects, make global
changes (zooming, rotating, and so forth), or add objects (via the Options menu).
Click on an object to select it. When you pull down the menus, only the items appro-
priate for the object selected are displayed.
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4.3.2 Toolbar

The toolbar appears in the Xmath Graphics window by default. This feature pro-
vides quick mouse access to simple graphical drawing tools and the zoom and rotate
tools. To toggle the toolbar off and on, select Options→Icon Bar (UNIX only).
Figure 4-20 shows the toolbar in both UNIX and Windows and shows labels for each
tool.

NOTE: Note that not all tools are enabled for all plot types. In general, zooming
and rotation are disabled for all multiple graph plots (such as strip plots).

Selection Arrow

You use the selection arrow to reset the cursor to selection mode after you use a
drawing or text tool.

Text Tool

To use the text tool, click on the Text Tool toolbar button. You receive an I-beam
cursor. Move to the graph area and click. An empty text box appears; you may start
typing. The text box expands as you type. To create a paragraph (continuous lines of
text) press Return and keep typing. To start a new string, click in a different place. To
turn off the text tool, click the selection arrow or another tool.

The key commands described in Editing Text by Selecting, Copying, and Pasting on
page 1-17 are also active in the text box. Note that the font and size in the text box
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are not what is displayed in the graph. Figure 4-21 demonstrates this in the center
text piece. To edit existing text, click the Text Tool toolbar button, and then click in
the text; the text box reappears. Note that the changes you make are not displayed
until you click the selection arrow (or another tool).

To format text, select it, and then choose a font style and point size from the Font
and Size menus on the Xmath Palette; you can also enable checkboxes for bold and
italic font. To change text color, select the text, and then select a color from the
Xmath Palette. Figure 4-21 shows reversed text created with a text string and a
graphical object.

FIGURE 4-21 Using the Text Tool and the Xmath Palette
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Drawing Tools

The line tool, rectangle tool, ellipse tool, arc tool, and arrow tool are primitive draw-
ing tools that allow you to draw in the Xmath Graphics window. When you use
drawing tools, they remain active until you choose the selection arrow or another
tool. To use a tool, click on the desired toolbar button; a crosshairs cursor appears.
Press down MB1 and drag until the desired shape is formed; then release MB1.

NOTE: You cannot resize or reshape the polygons you create because these are
primitive tools.

Zoom In/Zoom Out

To zoom in on a graph, click the toolbar button with the larger image on the left. Po-
sition the mouse over your plot; then click and drag to create a box around all or a
portion of the graph; the area captured in your box is enlarged to fill the Xmath
Graphics window. Every time you zoom in, the previous view is saved on a stack.

You can use Zoom Out toolbar button (the toolbar button with the smaller image) to
undo a series of enlargements. If you zoom out when you are at the default view, the
graph is reduced by approximately 10%.

The zoom feature is disabled for multiple graph plots.

Rotation Tools

Rotation is only allowed with 3D plots and other contour plots. The first rotation tool
allows rotation on all axes. The other tools are constrained to rotate only in the di-
rections indicated by the arrows. Select a tool, and then move the cursor to the plot
area. Press down MB1, and slowly drag the cursor in the direction allowed. The data
disappears and you see the plot axes turning in response to your mouse movement;
when the axes are in the position you wish to view the plot, release MB1, and the
data is redrawn. To return to the original graph, select View→Reset.

Consider the following example:

x = [0:10];
y = [0:10];
z = [0:10];
graph = plot(x,y,z, {marker=1, x_lab="X", y_lab="Y", Z-lab="Z"})
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The default plot appears in Figure 4-22; this 3D vector is projected in such a way
that it isn’t particularly useful.

FIGURE 4-22 Default View of 3D Vector
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Using the rotation toolbar buttons, you can rotate this plot in almost an infinite
number of ways. Figure 4-23 shows one rotated view, which gives more information
that the default plot.

4.3.3 Menus

This section discusses the menus that are available in the Xmath Graphics window.

FIGURE 4-23 Rotated View of 3D Vector
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File

Bind to Variable — Saves the current Xmath Graphics window image as a variable that
you specify. You can redisplay the plot at a later time by typing the variable
name, or you can reuse the graph in another plot by using the keep  keyword.

Print — Raises the Print dialog (UNIX version shown below), which allows you to send
the image in the current Xmath Graphics window to a printer. The UNIX Print
dialog allows you to save a graphics file in PS (PostScript), EPS, HPGL, PICT,
CGM-ANS, CGM-CAL, or CGM-TXT format.

For UNIX, the default printer shown in the Print Command field is set at the operat-
ing system level. The default line printer for your system is assumed. The sys-
tem’s default print command is set using the environment variables
XMATH_PRINTand PRINTER. XMATH_PRINTdefines the default print utility,
while PRINTER defines the default printer.
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On Windows operating systems, this command raises the standard Windows
Print dialog from which you can also print to a file.

For all systems, you can print from the Xmath command area using the
HARDCOPY command (see HARDCOPY in online Help for details).

Iconify Window — Lower the Xmath Graphics window.

Close Window — Kill the Xmath Graphics window.

Edit

Cut — Delete the selected object.

Move Up, Down, Left, Right — Move the selected object. Distance will be 1-2 pixels, de-
pending on the size of the window.

NOTE: These commands work only for objects that you place on the graphic
interactively or with keywords such as legend , date , time , and so
forth.

Bring to Front — Bring the selected object to the front.

View

Reset — Reset to the original graph.

Projection — Change the projection for the current graph. In stretched projection (the
default for 2D plots), the plot is scaled to occupy the maximum amount of avail-
able space. For orthographic projection (the default for 3D plots), all axes are
coscaled to have the same unit length (a circle will look round and a cube will
look like a cube, not a shoe box).

Lights — Toggle lights on/off.

Options

Timestamp — Add the timestamp to the graph. The timestamp appears in
hour:minutes:second format and is positioned by default in the upper left
corner of the graph. You can select it and then change the text attributes or
move it. To remove the timestamp, select it then use Ctrl-x .

Datestamp — Adds the datestamp to the graph. The date stamp appears in the
day:month:date:year format and is positioned by default in the upper left
corner of the graph. You can select it and then change the text attributes or
move it. To remove the datestamp, select it, and then use Ctrl-x .
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Legend — Toggle the legend on/off.

Icon Bar — Toggle the toolbar on/off (UNIX only).

Font (UNIX Only)

This menu is only available if text is selected in the Xmath Graphics window. Post-
Script fonts available are Times, Helvetica, and Courier. Stroke fonts available are
Simplex, Duplex, Triplex, Complex, Script, and Greek.

NOTE: Your machine might not be able to display all fonts in all sizes listed in
the Point menu; the same is true for printer output. In either case, the
device produces the font it can manage.

Point (UNIX Only)

This menu is only available if text is selected in the Xmath Graphics window. Point
sizes are 6, 9, 10, 12, 14, 18, 24, 36, and 48. You can also choose the font style:
plain, bold, italic, or bold italic.

NOTE: Your machine might not be able to display all fonts in all sizes; the same
is true for printer output. In either case, the device produces the font in
the closest size it can manage.

Tools (Windows Only)

You can use this menu to duplicate all the functions on the toolbar. Select the menu
item rather than the toolbar button to perform the same function (see Section 4.3.2
on page 4-49).

Windows

This menu allows you to bring other Xmath windows to the front quickly. Of special
note is the Palette, which is used to make interactive changes to graphic objects.

4.3.4 Xmath Palette

Xmath provides another window from which you can work interactively.

To bring up the Xmath Palette:

Click Windows→Palette in the Xmath Graphics window.

The Xmath Palette comes on view. The UNIX version looks a little different from
the Windows version, but the functions are essentially the same. The default
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UNIX version appears in Figure 4-19 on page 4-47. You can also select colors
via a color wheel on the UNIX version; this view of the Xmath Palette appears in
Figure 4-24, as well as the Windows version of the window.

FIGURE 4-24 Xmath Palette: UNIX and Windows Versions
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To use the Xmath Palette:

1. Select an object in the Xmath Graphics window.

The object type appears at the top of the Xmath Palette in the title bar.

The radio button for the active option—Lines, Markers, Fills, or Text—is
pushed. All items that are available for the selected item are active, whereas
others are inactive in the window.

2. Click the radio button for the option that you wish to change: Lines, Markers,
Fills, or Text.

3. Make the desired changes for this option.

You can control the color of all attributes. You can turn lines, markers, and fills
off or choose the type of each. For lines and markers, you can also choose the
width. For text you have a choice of fonts, sizes, plain, bold, italic, or bold italic
style. The text choices mimic the options available through the Font and Point
menus in the Xmath Graphics window in UNIX.

4. Modify as many attributes for as many objects as you want, and the click Close
to close the window.
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5 Data Objects and Operators

This chapter provides a conceptual overview and detailed descriptions of Xmath
data objects and operators.

5.1 Data Hierarchy

Xmath data hierarchy, as shown in Figure 5-1, is divided into numeric and nonnu-
meric branches.

The matrix, for example, is general. It consists of matrices of various shapes. The
square matrix is a specific kind of matrix that requires an equal number of rows and
columns, but otherwise inherits the characteristics of the matrix. A scalar is a spe-
cial kind of square matrix with dimensions of 1 × 1. A scalar is also defined as a spe-
cial kind of vector, because it is a vector with a length of 1.

Xmath’s object-based structure provides three significant benefits:

simplified data management — As variables in Xmath can represent complex groupings of
data, you don’t have to track numerous variables. For example, with a state-
space system using system(A,B,C,D) , all the data (including input names,
output names, etc.) is stored in a single variable. The matrices can be deleted.

optimized performance — Many Xmath data objects were designed to take advantage of
optimized algorithms. This is especially true of the specialized matrices. The
eigenvalues of a symmetric matrix, for example, can be found more quickly with
a symmetric eigensolver rather than a general eigensolver. Xmath recognizes the
special properties of a matrix and uses the appropriate, optimized algorithm.
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natural syntax — Because Xmath recognizes the special properties of each type of data
object, operations are intuitive. For example, it is more natural to multiply two
polynomials by typing p1∗p2 than it is to call convolve(p1,p2) .

List

Variable

Non-Numeric

scalar

triangular

Hessenberg

diagonal

identity

symmetric

Square

PDM

Transfer
FunctionState-SpaceIndex List

Matrix

Numeric

Vector

regular
vector

Polynomial

logspaced
vector

Toeplitz

String
Dynamic
 System ListGraphic

FIGURE 5-1 Object Relationships
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5.1.1 Data Object Descriptions

This chapter describes Xmath data objects in the following order:

■ Matrix

■ Polynomial

■ Parameter-dependent matrix (PDM)

■ Dynamic system

■ String

■ List

Some of the categories are subdivided. For example, dynamic systems include state-
space systems and transfer functions, and matrices include the following:

■ Vector

● Regular vector

● Logspaced vector

■ Square

● Symmetric, Diagonal, Identity, Toeplitz

● Hessenberg, Triangular

● Scalar

■ Indexlist

NOTE: To reproduce the examples, cut and paste the bold courier  text.

5.2 Matrix

A matrix is an object organizing m rows and n columns (m × n) of real or complex
numbers (elements). A complex number contains both a real and an imaginary
term. A matrix is complex if at least one element is complex; to qualify as a real ma-
trix, all elements must be real.
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Matrices are specified with the following syntax elements:

■ A matrix specification is enclosed in square brackets.

■ Matrix column elements must be separated by commas.

■ A semicolon separates rows.

For example, x=[jay, 4; 3,–1] . In a formatted matrix, a line feed replaces the
semicolon:

x=[ jay, 4 # Line Feed
3, –1] # Return

(If your machine does not have a Line Feed key, see Table 1-7 on page 1-16.) The ma-
trix specification ends with a right bracket.

Specific types of matrices are also created with functions such as zeros , random ,
diagonal , etc. These functions require row and column dimensions as inputs:

set seed = 0
x=random(3,4)

x (a rectangular matrix) =

  0.211325    0.756044    0.000221135    0.330327
  0.665381    0.628392    0.849745       0.685731
  0.878216    0.068374    0.560849       0.662357

The functions check and is can be used to determine if a variable is a matrix. For
brief explanations of check and is , see Section 6.3.2. Sample syntaxes are:
check(x,{matrix})  or is(x,{matrix}) .

Use size  to find the row and column dimensions of a matrix:

size(x)

ans (a row vector) =   3    4

To find the total number of elements, use length :

length(x)

ans (a scalar) =   12

Many classes stem from the matrix class, and it is the primary component of several
more specialized objects.
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5.2.1 Matrix Concatenation

Concatenation (combining several matrices into a new matrix) is performed using
square bracket operators []. Right concatenation is indicated with commas [,] ;
bottom concatenation is indicated by semicolons [;].

For example,

■ [A,B] concatenates B to the right of A (where B must have the same number of
rows as A).

■ [A;B] concatenates B to the bottom of A (where B must have the same number
of columns as A).

x=random(3,2)*12

x (a rectangular matrix) =

  8.71621    2.38217
  6.53109    2.7849
  2.77468    2.59756

x=[x,ones(3,4);ones(2,2),zeros(2,4)]

x (a rectangular matrix) =

  8.71621    2.38217    1    1    1    1
  6.53109    2.7849     1    1    1    1
  2.77468    2.59756    1    1    1    1
  1          1          0    0    0    0
  1          1          0    0    0    0

5.2.2 Matrix Operators

The operators in Table 5-1 have special meanings for matrices:

scalar operator  matrix

usually means applying the operator elementwise.

mat1=[1,1,1,1; 2,2,2,2; 3,3,3,3];
mat2=mat1 * mat1'

mat2 (a square matrix) =
4     8    12

   8    16    24
  12    24    36
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3 * mat1

ans (a rectangular matrix) =

  3    3    3    3
  6    6    6    6
  9    9    9    9

TABLE 5-1 Matrix Operations

Operator Effect

+ Addition (or unary plus). Matrices must have the same dimen-
sions.

– Subtraction (or unary minus). Matrices must have the same di-
mensions.

* Matrix multiplication. The number of columns in the first matrix
must equal the number of rows in the second matrix.

/ Matrix right division. A/B solves the equation X × B=A. The num-
ber of columns in A must equal the number of rows in B.

\ Matrix left division. B\A solves the equation B × X=A. The number
of columns in B must equal the number of rows in A.

' Transpose (unary suffix).

*' Complex conjugate transpose (unary suffix).

.* Elementwise matrix multiplication. Matrices must have the same
dimensions.

./ Elementwise division (left divided by right). Matrices must have
the same dimensions.

.\ Elementwise division (right divided by left). Matrices must have
the same dimensions.

^ or ** Raise a square matrix to a scalar power.

.^ or .** Raise elements to a power. Another matrix of the same size can
contain the powers.

.*. Kronecker product.

./. Kronecker right division.

.\. Kronecker left division.
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5.2.3 Matrix Indexing

Indexing (extracting a specific subset of matrix elements) is performed using the pa-
rentheses operators () . Indices can consist of any one of the following:

■ Two integers specifying the desired row and column.

A(i,j) extracts from A the element located in row i , at column j . This can be
demonstrated using the matrix mat2  created earlier.

mat2

mat2 (a square matrix) =

   4     8    12
   8    16    24
  12    24    36

mat2(2,3)

ans (a scalar) =   24

■ Two vectors of integers specifying a range of rows and columns.
A(vector1,vector2) extracts a portion of A with rows corresponding to vector
1 and columns corresponding to vector 2.

& Elementwise logical and .

| Elementwise logical or .

! Elementwise logical not.

< Elementwise less than.

> Elementwise greater than.

<= Elementwise less than or equal .

>= Elementwise greater than or equal.

== Elementwise equal.

<> Elementwise not equal.

= Assignment.

TABLE 5-1 Matrix Operations  (Continued)

Operator Effect
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mat2(1:2,2:3)

ans (a square matrix) =

   8    12
  16    24

■ An index list that specifies all desired element locations in terms of row and col-
umn indices. An index list can be created with the find or indexlist func-
tions. For more on the index list object, see Section 5.8 on page 5-54.

ijList=find(mat2>15)

ijList (an index list) =

  2    2
  2    3
  3    2
  3    3

■ Note that find returns the row and column coordinates for elements in mat2
that are greater than 15: (2,2), (2,3), (3,2), and (3,3). You can use indexing to
display the values in these index list locations:

mat2(ijList)

ans (a column vector) =

  16
  24
  24
  36

Indexing with the Colon Operator (:)

The colon operator (:) is a wildcard for all elements, thus A(i,:) is the i th row of
A and A(:,j)  is the j th column of A.

You can use a wildcard and a decreasing vector to reverse the columns of a matrix.

mat2(:,[3:-1:1])

ans (a square matrix) =

  12     8     4
  24    16     8
  36    24    12
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Here wildcards are used to extract rows, which are reassembled into a new matrix:

mat3=[mat2(1,:);sqrt(mat2(2,:));mat2(3,:)^2]

mat3 (a square matrix) =

    4            8      12
    2.82843      4       4.89898
  144          576    1296

5.2.4 Vector

The vector class is a subclass (or specialization) of the matrix class. A vector object
is a matrix that has a row or column dimension equal to 1. Vectors can be oriented
as either rows or columns.

Many of the functions defined for matrices apply to vectors as well. Vectors also
have many special behaviors. The most important of these are listed below:

■ Use ^  to raise elements to a power (for matrices, use .^ ).

[1:4]^[1:4]

ans (a row vector) =   1    4    27    256

■ Vectors can be indexed with a single index variable. Thus v(i) is the ith element
of the vector v . A single vector of integers can also be used as an index.

a=[2,4,6,8,10]

a (a row vector) =   2    4    6    8    10

a([1,3,5])

ans (a row vector) =   2    6    10

■ The colon (:) wildcard expands vectors in column form. aVector(:) is always
defined as a column, regardless of whether the vector is a row or column.

■ The length function is the most natural method of determining the length of
vector. length(aVector)  is defined as max(size(aVector)).

■ To see if a variable is a vector, invoke is(v ar,{vector})  or
check(var,{vector}) .

To determine whether the vector is a row or column, use is(var,{row}) or
is(var,{column}) (or use check ). The {row} and {column} keywords imply
{vector} . For brief explanations of check  and is , see Section 6.3.2 on page 6-17.
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Regular Vector

A regular vector is evenly spaced, with each element a fixed increment from the pre-
vious value. If a regular vector is created with the colon operator, Xmath stores it as
just three values (start: increment: stop). You can treat it as a vector, but it is dis-
played in a special manner.

■ A regular vector can only be a row vector. Transposing it expands it to full size
(turns it into a simple vector).

x=0:0.33:1

x (a regularly spaced vector) =   0 : 0.33 : 1

x'

ans (a column vector) =

  0
  0.33
  0.66
  0.99

■ Putting a regular vector between square braces []  will expand it.

[x]

ans (a row vector) =   0    0.33    0.66    0.99

A regular vector is internally expanded for most operations, except indexing.

Although a regular vector is stored in compact form (as start, stop, and incre-
ment values), it has the same dimensions as if it were created in expanded form.
You can view the sizes of all the variables in your current partition with the who

command. Use the size  function to view the size of a single variable:

size(x)

ans (a row vector) =   1    4

Logspaced Vector

A logspaced vector is just like a regular vector except that its points are evenly
spaced on a log scale. It can only be created with the logspace function. logspace
inputs are the initial value, the final value, and the number of points desired in the
vector. All the display considerations for a regular vector apply to logspaced vectors.
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x1=logspace(0.1,10,4)

x1 (a log–spaced vector) =   0.1 : 10 (4 points)

[x1]

ans (a row vector) =   0.1   0.464159   2.15443   10

5.2.5 Square Matrix

The square matrix class is a subclass of the matrix class. A square matrix object
has equal row and column dimensions.

All of the functions that are defined for matrices are also defined for square matri-
ces. However, there are several square matrix functions that are not valid for rectan-
gular matrices. The most important of these are shown in Table 5-2.

TABLE 5-2 Functions That Are Only Valid for Square Matrices

Function Result

^ or ** raise matrix to a power (A^3=A  × A × A)

.^ or .** raise each element to a power

cholesky Cholesky decomposition

cosm matrix cosine (use cos  elementwise)

det determinant

eig eigenvalues

expm matrix exponential (use exp elementwise)

hessenberg Hessenberg decomposition

inv inverse

logm matrix logarithm (use log elementwise)

lu L-U decomposition

orth orthogonal decomposition

polynomial characteristic polynomial

polyvalm evaluates polynomial function of a matrix
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Symmetric

The symmetric matrix class is a subclass of the square matrix class. A symmetric
matrix object is equal to its transpose.

For most applications, symmetric matrices act just like square matrices. Certain al-
gorithms take advantage of their special structure to achieve improved results. For
example, the eigenvalues of a symmetric matrix can be found more quickly than the
eigenvalues of a general matrix; also, the answers are constrained to be purely real.

a=[1:4];b=[a;a;a;a]

b (a square matrix) =

  1    2    3    4
  1    2    3    4
  1    2    3    4
  1    2    3    4

is(b,{symmetric})

ans (a scalar) =   0

c=tril(b,1) + tril(b,1)'

c (a square matrix) =

  2    3    1    1
  3    4    5    2
  1    5    6    7
  1    2    7    8

qz generalized eigenvalues

rref reduced–row echelon form

schur Schur form

sinm square matrix sine (use sin elementwise)

sqrtm matrix square root (use sqrt  elementwise)

trace find the sum of the diagonal elements of a matrix

TABLE 5-2 Functions That Are Only Valid for Square Matrices  (Continued)

Function Result
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is(c,{symmetric})

ans (a scalar) =   1

Diagonal

The diagonal matrix class is a subclass of the symmetric matrix class and the trian-
gular matrix class (see page 5-14). A diagonal matrix object has zero in all positions
except along the main diagonal.

The diagonal function can be used to extract a diagonal from a matrix. Extract the
diagonal from the matrix c  defined above:

d=diagonal(c)

d (a column vector) =

  2
  4
  6
  8

If a vector is used as an input, a matrix is created that has the vector on the main
diagonal.

e=diagonal(d)          # use the vector d as the
# diagonal of a new matrix

e (a square matrix) =

  2    0    0    0
  0    4    0    0
  0    0    6    0
  0    0    0    8

Identity

The identity matrix class is a subclass of the diagonal matrix class. An identity ma-
trix object has ones on the main diagonal and zero for all other elements. The func-
tion eye  creates an identity matrix from row and column dimensions:

eye(3,3)

ans (a square matrix) =

  1    0    0
  0    1    0
  0    0    1
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For most applications, identity matrices act like square matrices. Certain algorithms
(such as multiplication and inversion) take advantage of their special structure.

Toeplitz

The Toeplitz matrix class is a specialization of the square matrix class with constant
entries along the diagonals. A Toeplitz matrix can be described by its first row and
first column (if it is symmetric, it can be described by a single vector). The matrix left
and right division operations have been overloaded for solving matrix equations of
the form T × X=A and X × T=A (where T is a Toeplitz matrix):

t=toeplitz([3,2,1],[1,2,3])

t (a toeplitz matrix) =

  3    2    1
  2    3    2
  3    2    3

Hessenberg

The Hessenberg matrix class is a subclass of the square matrix class. A Hessenberg
matrix has zeros in all elements below the first subdiagonal or above the first super-
diagonal. The hessenberg function puts a matrix A in Hessenberg form H, defined
such that A=T × H × T*' where T is a unitary transformation matrix of the same
size and type as A.

hessenberg([1,2,3;1,2,3;1,2,3])

ans (a square matrix) =

   1          -3.53553         0.707107
  -1.41421     5              -1
   0          -3.14018e-16     3.14018e-16

Triangular

The triangular matrix class is a specialization of the Hessenberg matrix class. A tri-
angular matrix object has zeros in all elements above the main diagonal (upper tri-
angular) or below the main diagonal (lower triangular).

set seed 0
a=round(rand(4,4)*4)
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a (a square matrix) =

  1    3    0    1
  3    3    3    3
  4    0    2    3
  3    1    2    1

aTriu=triu(a)

aTriu (a square matrix) = # an upper triangular
# matrix has zeros below

  1    3    0    1 # the main diagonal
  0    3    3    3
  0    0    2    3
  0    0    0    1

aTril=tril(a)

aTril (a square matrix) = # a lower triangular
# matrix has zeros above

  1    0    0    0 # the main diagonal
  3    3    0    0
  4    0    2    0
  3    1    2    1

Scalar

The scalar class is a subclass of the square matrix class. A scalar object is a matrix
with a single row and a single column.

Any function or operator defined for a matrix is also defined for a scalar. However,
scalars have many special properties when used in combination with other classes
of objects, as shown in the samples that follow.

scalar x matrix — Each element of the matrix is multiplied by the scalar. The same
holds true for vectors and PDMs. Division works the same way.

5∗[1:5]

ans (a row vector) =   5    10    15    20    25

ans/5

ans (a row vector) =   1    2    3    4    5

scalar x polynomial — If the polynomial is in factored form, the gain of the polynomial is
multiplied by the scalar. (Polynomials are discussed in detail starting on page 5-
19.) If the polynomial is in coefficient form, each coefficient is multiplied by the
scalar. Division works the same way.
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Using a scalar with a polynomial in roots form:

4*polynomial(1:4)

ans (a polynomial) =

  4(x - 1)(x - 2)(x - 3)(x - 4)

Using a scalar with a polynomial in coefficients form:

makepoly(1:4)

ans (a polynomial) =

    3    2
   x + 2x + 3x + 4

ans/0.5

ans (a polynomial) =

    3    2
  2x + 4x + 6x + 8

scalar x system — Multiplies the gain of the system by the scalar. (Dynamic-system ob-
jects are discussed in detail starting on page 5-42.) For transfer functions, the
numerator polynomial is multiplied by the scalar. For state-space systems, the
C and D matrices are multiplied by the scalar. Division works the same way.

system([2,2;2,2],[3;3],[4,4],1);

2*ans

ans (a state space system) =

  A
  2    2
  2    2

  B
  3
  3

  C

  8    8

  D
  2
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  X0
  0
  0

  System is continuous

system(makepoly(2:5),makepoly(0:3))

ans (a transfer function) =

    3    2
  2x + 3x + 4x + 5
  ----------------
      2
     x + 2x + 3

  initial integrator outputs
  0
  0
  0
  Input Names
  -----------
  Input 1

  Output Names
  ------------
  Output 1

  System is continuous

ans/2

ans (a transfer function) =

   3      2
  x + 1.5x + 2x + 2.5
  -------------------
       2
      x + 2x + 3

  initial integrator outputs
  0
  0
  0
  Input Names
  -----------
  Input 1
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  Output Names
  ------------
  Output 1

System is continuous

matrix+scalar — The scalar is added to each element of the matrix. This operation is
commutative. The same holds true for vectors and PDMs. Subtraction works the
same way.

-2+(3+(ones(3,3)))

ans (a square matrix) =

  2    2    2
  2    2    2
  2    2    2

polynomial+scalar — Converts the polynomial to coefficient form and adds the scalar to
the scalar (order 0) term of the polynomial. This operation is commutative. Sub-
traction works the same way.

p=polynomial(3:5)

p (a polynomial) =

  (x - 3)(x - 4)(x - 5)

2+p

ans (a polynomial) =

    3     2
   x - 12x + 47x - 58

matrix(vector,vector)=scalar — Copies the scalar to each element of the specified partition
of the matrix. The same holds true for vectors and PDMs.

o=ones(4,5);
o([2:3],[2:4])=32

o (a rectangular matrix) =

  1     1     1     1    1
  1    32    32    32    1
  1    32    32    32    1
  1     1     1     1    1
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5.3 Polynomial

Polynomials take the form or . The first nota-
tion is in coefficients form; its coefficients (1, 9, -4 and 7) are plainly shown. The
second polynomial is in roots form (its roots being 0, 2, and -6). Polynomial objects
consist of a vector of coefficients or roots and a single independent variable (a text
string, usually a single character).

Polynomials can be defined in terms of their roots or coefficients. The polynomial
function creates a polynomial object where roots are the elements of a vector or
eigenvalues of a square matrix you supply. You can specify a text string for the poly-
nomial variable. makepoly  converts a simple vector into a polynomial.

Create a polynomial from its roots with polynomial . The polynomial is displayed in
roots form:

p1=polynomial([1*jay, -1*jay, 1,
               2*jay, -2*jay, 2,
               3*jay, -3*jay, 3], "j")

p1 (a polynomial) =
2 2 2

(j - 1)(j - 2)(j - 3)(j + 1)(j + 4)(j + 9)

p2=polynomial([9,8,7])

p2 (a polynomial) =

(x - 7)(x - 8)(x - 9)

Create a polynomial from a vector with makepoly ; the polynomial will be displayed
in coefficients form:

p3=makepoly(logspace(1,3,5),"L")

p3 (a polynomial) =

4 3 2
   L + 1.31607L + 1.73205L + 2.27951L + 3

p4=makepoly(1:.5:3)

p4 (a polynomial) =

 4 3 2
x + 1.5x + 2x + 2.5x + 3

x
3

9x
2

4x 7+–+ x x 2–( ) x 6+( )
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5.3.1 Polynomial Operators

The following operators are valid for polynomials:

Operations can only be performed between polynomials that have the same inde-
pendent variable or between polynomials and scalars.

p5=p2+p4

p5 (a polynomial) =

   4      3     2
  x + 2.5x - 22x + 193.5x - 501

p6=p2*p2

p6 (a polynomial) =

         2       2       2
  (x - 7) (x - 8) (x - 9)

sysp=3/p6

sysp (a transfer function) =

             3
  ------------------------
         2       2       2
  (x - 7) (x - 8) (x - 9)

initial integrator outputs
  0
  0
  0
  0
  0
  0
  Input Names
  -----------
  Input 1

+ polynomial addition

– polynomial subtraction

* polynomial multiplication

/ creates a transfer function
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  Output Names
  ------------
  Output 1

  System is continuous

The functions in Table 5-3 can handle parts of polynomials; for more information on
inputs and outputs, see the Xmath online Help.

5.4 Parameter-Dependent Matrix (PDM)

A parameter-dependent matrix (PDM) is a flexible extension of the matrix data type.
It consists of a vector of same-size matrices with a vector attached to it. The at-
tached vector (or parameter) is referred to as the domain (Figure 5-2). A PDM also
has optional string names for its rows and columns (see Figure 5-3).

PDM data is stored as a series of matrices indexed by a single domain vector. Com-
putations involving the PDM are performed on each matrix separately. Data can
also be handled as a series of vectors, called channels, having a common domain
vector (time or frequency, for example). In this format, the computations are per-
formed on each vector of the data separately.

Used either way, PDMs provide a convenient method for storing data as a function
of a parameter and are particularly useful in the analysis of multiple input and/or
output dynamic systems, where they can be used to store time or frequency re-
sponses.

So, for example, when the frequency response of a system with n inputs and m out-
puts is calculated, a PDM is created. Each of the n columns represents an input,
each of m rows represents an output, and the dependent matrix at element i of the
domain corresponds to the frequency response from each output to each input.
Plotting time and frequency responses stored as PDMs are particularly convenient
when the {strip} keyword is used, in which case a matrix plot is produced where

TABLE 5-3 Polynomial Handling Functions

roots extracts the roots of a polynomial

makematrix extracts the coefficients of a polynomial

domain extracts the independent variable from a polynomial or PDM

polyval evaluates a polynomial at each element of a given matrix

polyvalm evaluates a polynomial over an entire square matrix
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the rows and columns correspond with inputs and outputs, respectively (for infor-
mation on strip plots, see Section 4.2.15 on page 4-40). For an explanation of time
response, see Section 5.5.5 on page 5-49.

5.4.1 PDM Organization

Consider the object radar as an example of PDM organization (Figure 5-3). Exactly
how radar  is created is outlined in Section 5.4.2.

Every PDM consists of five main parts:

Dependent Data Matrix — Every PDM contains one or more matrices; radar has five 2 × 2
matrices in the dependent data area. The matrices must be the same size. There
is no limit to the size or number of matrices in this area.

Domain Vector — The PDM allows you to group an independent vector of parameter
values and a stack of associated matrices. The vector of independent parameter
values is called the domain of the PDM. The domain usually represents a physi-
cal parameter, for example, time, frequency, temperature, pressure, or altitude.
If no domain vector is specified, the PDM domain defaults to increasing positive
integers starting from one.

FIGURE 5-2 Structure of a PDM

Domain

vectors is called a channel
One vector in a matrix of

m rows

n columns

i
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Domain Name — A label for the domain vector. In radar , the domain string is "RCS" . If
no name is specified, the default string is "domain" .

Row Names — Each dependent matrix row may have an optional string name. In ra-
dar , the names are "Radar 1" and "Radar 2" . Each matrix has the same row
names associated with it. If no names are specified, the row names are labeled
"Row 1" , "Row 2" , ..."Row N" .

Column Names — Each dependent matrix column may have an optional string name. In
radar , the names are "Range" and "% Error" . If no column names are speci-
fied, the columns are labeled "Col 1" , "Col 2" , ..."Col N" .

5.4.2 Creating PDMs

PDMs are created from a single matrix object using the function pdm. Additional op-
tional arguments to pdm specify the domain, domain label, and row and column la-
bels to be associated with the matrices in the final PDM.

RCS | Range % Error
---------+----------------------------

0.01 |  Radar 1 5.311 0.01
|  Radar 2 6.316 0.07

---------+----------------------------
0.02 |  Radar 1 16.79 0.0

|  Radar 2 19.97 0.07
---------+----------------------------

1 |  Radar 1 26.28 0.08
|  Radar 2 29.86 0.04

---------+----------------------------
2 |  Radar 1 35.51 0.04

|  Radar 2 42.23 0.09
---------+----------------------------

6 |  Radar 1 53.11 0.01
|  Radar 2 63.16 0.02

---------+----------------------------

Domain

Domain

Dependent Data Matrices

FIGURE 5-3 Parts of the PDM radar

Vector

Name

Row Names Column Names
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For the PDM radar , the dependent data is formed from a columnwise concatena-
tion of the vectors maxrange  and perr :

maxrange=[ 5.311, 6.313, 16.79, 19.97, 26.28, 29.86, 35.51, 42.23,
53.11, 63.16]';
perr = [0.01, 0.07, 0.0, 0.07, 0.08, 0.04, 0.04, 0.09, 0.01, 0.02]';

The final dependent data matrix [maxrange,perr] used as an argument to pdm
has 2 columns and 10 rows.

The domain vector used in radar , rcs , has 5 elements.

rcs = [0.01,0.02,1,2,6];

Use the pdm function to construct the PDM radar from the matrix
[maxrange,perr]  and the domain vector RCS:

radar = pdm([maxrange,perr],rcs,{domainName="RCS",
rowNames = ["Radar 1","Radar 2"],
columnNames = ["Range","% Error"]})

radar (a pdm) =

 RCS |          Range   % Error
-----+-------------------------
0.01 | Radar 1   5.311  0.01
     | Radar 2   6.313  0.07
-----+-------------------------
0.02 | Radar 1  16.79   0
     | Radar 2  19.97   0.07
-----+-------------------------
1    | Radar 1  26.28   0.08
     | Radar 2  29.86   0.04
-----+-------------------------
2    | Radar 1  35.51   0.04
     | Radar 2  42.23   0.09
-----+-------------------------
6    | Radar 1  53.11   0.01
     | Radar 2  63.16   0.02
-----+-------------------------

You have just recreated the PDM shown on page 5-22.

The dependent matrix is the only required argument to a PDM. Any additional argu-
ments can modify the structure of the PDM. For example, using pdm with no op-
tional arguments results in a PDM with each dependent matrix having one row.
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5.4.3 Default PDM Behavior

If you do not use the rows or columns keywords and do not specify a domain vec-
tor, each row of the input matrix becomes one of the output dependent data matri-
ces. For example, for the following input:

r43=rand(4,3)

Xmath generates the output:

r43 (a rectangular matrix) =

0.849745    0.685731    0.878216
0.068374    0.560849    0.662357
0.726351    0.198514    0.544257
0.232075    0.231224    0.216463

For the following input:

pdm(r43)

Xmath generates the output:

ans (a pdm) =

domain |   Col 1     Col 2     Col 3
-------+-------------------------------
     1 |   0.849745  0.685731  0.878216
     2 |   0.068374  0.560849  0.662357
     3 |   0.726351  0.198514  0.544257
     4 |   0.232075  0.231224  0.216463

This default behavior also applies if any or all of the rows or columns keywords, or
domain vector, are specified in a way that matches the default case. For example,
Xmath generates the same PDM output (the rows and columns keywords are ig-
nored in this case):

pdm(r43,{rows=1,columns=3})

ans (a pdm) =

domain |   Col 1     Col 2     Col 3
-------+-------------------------------

1 |   0.849745  0.685731  0.878216
2 |   0.068374  0.560849  0.662357
3 |   0.726351  0.198514  0.544257
4 |   0.232075  0.231224  0.216463
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pdm(r43,1:4)

ans (a pdm) =

domain |   Col 1     Col 2     Col 3
-------+-------------------------------

1 |   0.849745  0.685731  0.878216
2 |   0.068374  0.560849  0.662357
3 |   0.726351  0.198514  0.544257
4 |   0.232075  0.231224  0.216463

If you specify arguments that deviate from the default, pdm produces results similar
to the following:

pdm(r43,1:3)

ans (a pdm) =

domain |
-------+----------------

1 | Row 1  0.849745
 | Row 2  0.068374
 | Row 3  0.726351
 | Row 4  0.232075

-------+----------------
 2 | Row 1  0.685731

 | Row 2  0.560849
 | Row 3  0.198514
 | Row 4  0.231224

-------+----------------
 3 | Row 1  0.878216

 | Row 2  0.662357
 | Row 3  0.544257
 | Row 4  0.216463

-------+----------------

In the above example, the number of rows of the input matrix (4) is not a multiple of
the length of the domain vector (3). However, the number of columns of the input
matrix (3) is a multiple. In this case, each column (instead of each row) of the input
matrix becomes one of the output Dependent Data Matrices.

When no domain vector is specified, the default vector is [1:1:#rows] .
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pdm([maxrange,perr])

ans (a pdm) =

domain |   Col 1   Col 2
-------+----------------
     1 |    5.311  0.01
     2 |    6.313  0.07
     3 |   16.79   0
     4 |   19.97   0.07
     5 |   26.28   0.08
     6 |   29.86   0.04
     7 |   35.51   0.04
     8 |   42.23   0.09
     9 |   53.11   0.01
    10 |   63.16   0.02

To change the dimensions of the dependent matrices, use the rows and columns
keywords. For example:

pdm([maxrange,perr], {rows = 2, columns = 2})

ans (a pdm) =

domain |        Col 1   Col 2
-------+---------------------
     1 | Row 1   5.311  0.01
       | Row 2   6.313  0.07
-------+---------------------
     2 | Row 1  16.79   0
       | Row 2  19.97   0.07
-------+---------------------
     3 | Row 1  26.28   0.08
       | Row 2  29.86   0.04
-------+---------------------
     4 | Row 1  35.51   0.04
       | Row 2  42.23   0.09
-------+---------------------
     5 | Row 1  53.11   0.01
       | Row 2  63.16   0.02
-------+---------------------
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Alternatively, the row and column size is implied in the number of strings entered in
keywords columnnames  and rownames :

pdm([maxrange,perr],{rowNames = ["Radar 1","Radar 2"],
columnNames = ["Range","% Error"]})

ans (a pdm) =

domain |          Range   % Error
-------+-------------------------
     1 | Radar 1   5.311  0.01
       | Radar 2   6.313  0.07
-------+-------------------------
     2 | Radar 1  16.79   0
       | Radar 2  19.97   0.07
-------+-------------------------
     3 | Radar 1  26.28   0.08
       | Radar 2  29.86   0.04
-------+-------------------------
     4 | Radar 1  35.51   0.04
       | Radar 2  42.23   0.09
-------+-------------------------
     5 | Radar 1  53.11   0.01
       | Radar 2  63.16   0.02
-------+-------------------------

The dependent matrix size can also be influenced by the domain vector. In this case,
the columns of the PDM matrices are the same as the input matrix. The number of
rows of each matrix is equal to the total number of rows in the input matrix divided
by the number of elements in the domain vector. For radar , the domain rcs has 5
elements. Therefore, each matrix in radar  will have 10/5 (two) rows.
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pdm([maxrange,perr],rcs)

ans (a pdm) =

domain |        Col 1   Col 2
-------+---------------------
  0.01 | Row 1   5.311  0.01
       | Row 2   6.313  0.07
-------+---------------------
  0.02 | Row 1  16.79   0
       | Row 2  19.97   0.07
-------+---------------------
  1    | Row 1  26.28   0.08
       | Row 2  29.86   0.04
-------+---------------------
  2    | Row 1  35.51   0.04
       | Row 2  42.23   0.09
-------+---------------------
  6    | Row 1  53.11   0.01
       | Row 2  63.16   0.02
-------+---------------------

The PDM row and column dimensions specified by rows , rowNames, columns , and
columnNames must agree with the PDM dimensions specified by the domain vector,
or a warning is returned:

WARNING: Dimensions of PDM do not match specified rows and columns
and length of domain vector.

5.4.4 PDM Channels

In some circumstances, a PDM is a collection of vectors instead of a collection of
matrices. For PDMs, these vectors are called channels of the PDM. A channel is a
vector consisting of the same element from each dependent matrix. For example,
radar  has four channels,

(1,1) :  5.311, 16.79, 26.28, 35.51, 53.11
(2,1) :  6.313, 19.97, 29.86, 42.23, 63.16
(1,2) :  0.01,      0,  0.08,  0.04, 0.01
(2,2) :  0.07,   0.07,  0.04,  0.09, 0.02

and all channels have the common independent variable defined by rcs . Figure 5-2
illustrates this idea.

Certain MathScript functions, such as fft , have the option of operating on the de-
pendent matrices or the channels of a PDM. By default, all functions operate on the
dependent matrices.
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Y = fft(radar)

If the FFT of each channel is needed, the channels  keyword must be included.

Y = fft(radar, {channels})

See Section 5.4.8 on page 5-40 for more details on using functions with PDMs.

5.4.5 Indexing to Extract Portions of a PDM

PDM Dimensions

Use the size  function to see the dimensions of the new PDM:

size(radar)

ans (a row vector) = 2 2 5

The above result indicates that each dependent matrix has two rows and two col-
umns, and that the length of the PDM (the length of the domain or the number of
dependent matrices) is five.

Dependent Matrices

PDM indexing allows you to extract parts of a PDM. The output of any PDM indexing
operation is always another PDM. If you want to index to extract a single piece of
data (as opposed to a dependent matrix or a channel of a PDM) it may be simpler to
use makematrix  before indexing (see page 5-37).

To extract a single dependent matrix, use a single index corresponding to the do-
main value of interest. For example, you might want to extract only the data per-
taining to objects with RCS value of 1:

radar(3)

ans (a pdm) =

RCS |          Range  % Error
----+------------------------
  1 | Radar 1  26.28  0.08
    | Radar 2  29.86  0.04
----+------------------------

To see the third through fifth elements of the PDM, you could index into radar us-
ing the standard colon notation (see page 5-8):

radar(3:5)
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ans (a pdm) =

RCS |          Range  % Error
----+------------------------
  1 | Radar 1  26.28  0.08
    | Radar 2  29.86  0.04
----+------------------------
  2 | Radar 1  35.51  0.04
    | Radar 2  42.23  0.09
----+------------------------
  6 | Radar 1  53.11  0.01
    | Radar 2  63.16  0.02
----+------------------------

You can also examine one or more channels of the data in a PDM and see changes
over the length of the PDM (as the RCSparameter changes). When indexing with
both row and column specifications, you extract the (i,j) channel over the entire do-
main. The following example extracts the element that resides in the second row
and first column of each dependent matrix.

radar(2,1)

ans (a pdm) =

 RCS |          Range
-----+----------------
0.01 | Radar 2   6.313
0.02 | Radar 2  19.97
1    | Radar 2  29.86
2    | Radar 2  42.23
6    | Radar 2  63.16
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The standard colon notation can be used to access more than one channel:

radar(1:2,1)

ans (a pdm) =

 RCS |          Range
-----+----------------
0.01 | Radar 1   5.311
     | Radar 2   6.313
-----+----------------
0.02 | Radar 1  16.79
     | Radar 2  19.97
-----+----------------
1    | Radar 1  26.28
     | Radar 2  29.86
-----+----------------
2    | Radar 1  35.51
     | Radar 2  42.23
-----+----------------
6    | Radar 1  53.11
     | Radar 2  63.16
-----+----------------

To extract a single value in PDM form, you can use a temporary value:

temp=radar(5);
FinalPerr=temp(2,2)

FinalPerr (a pdm) =

RCS |          % Error
----+-----------------
  6 | Radar 2  0.02

Individual PDM elements can be extracted and modified using three scalar indices
to specify the row, column, and domain positions, respectively. The returned object
is always a scalar. Thus, for the radar example:

radar(1,1,1)

ans (a scalar) =   5.311

radar(2,2,5)

ans (a scalar) =   0.02
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radar(2,1,3)=radar(1,1,5)

radar (a pdm) =
RCS |          Range   % Error

-----+-------------------------
0.01 | Radar 1   5.311  0.01
     | Radar 2   6.313  0.07
-----+-------------------------
0.02 | Radar 1  16.79   0
     | Radar 2  19.97   0.07
-----+-------------------------
1    | Radar 1  26.28   0.08
     | Radar 2  53.11   0.04
-----+-------------------------
2    | Radar 1  35.51   0.04
     | Radar 2  42.23   0.09
-----+-------------------------
6    | Radar 1  53.11   0.01
     | Radar 2  63.16   0.02
-----+-------------------------

Domain and Name Information

The domain can be extracted using domain .

rsvector = domain(radar)

rsvector (a row vector) = 0.01 0.0 2 1 2 6

The PDM names can be extracted with the names function. In order to get all three
labels, specify three outputs:

[rowN,colN,domN]=names(radar)

rowN (a row vector of strings) =   Radar 1    Radar 2

colN (a row vector of strings) =   Range    % Error

domN (a string) =   RCS

EXAMPLE 5-1: Indexing into a PDM

This example illustrates PDM indexing by plotting a PDM and different combina-
tions of data that can be extracted from it. Note that plot will reuse the row and
column labels from your PDM, if possible.
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x=logspace(1,100,3);F=([1.02:.02:2.5]);
s1c=system(makep([sin(x)]),makep(-x*2));
s2c=system(makep([cos(x)]),makep(x*2));
s3c=system(makep([cot(x)]),makep(x));

s1d=discr(s1c,1);
s2d=discr(s2c,2);
s3d=discr(s3c,3);

f1c=freq(s1c,F);f1d=freq(s1d,F);
f2c=freq(s2c,F);f2d=freq(s2d,F);
f3c=freq(s3c,F);f3d=freq(s3d,F);

p=pdm([[f1c;f1d],[f2c;f2d],[f3c;f3d]],
{columnnames=["sys","sys2","sys3"], rownames=["cont","disc"]});
plot(p,{strip})

If strip is specified alone, each submatrix is plotted in a separate subgraph, as
shown in Figure 5-4. Try plotting portions of the PDM with the different stri p set-
tings shown below.

If the number of strips is specified, the inputs will be plotted accordingly.

FIGURE 5-4 PDM Plotted with strip
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plot(p,{strip=3})

Extract all discrete rows, then plot one plot per subgraph:

plot(p(2,:),{strip=1})

Plot all rows of the 2nd column with default strip settings.

plot(p(:,2),{strip})

5.4.6 Modifying PDMs

Substitution

Using PDM indexing (outlined in Section 5.4.5 on page 5-30), assignments can be
made to replace parts of a PDM. For example, to replace the third dependent matrix
of radar with an identity matrix, type:

ind = eye(2,2); radar_copy = radar; radar_copy(3) = ind

To replace a channel of data, type:

radar_copy (a pdm) =

 RCS |          Range   % Error
-----+-------------------------
0.01 | Radar 1   5.311  0.01
     | Radar 2   6.313  0.07
-----+-------------------------
0.02 | Radar 1  16.79   0
     | Radar 2  19.97   0.07
-----+-------------------------
1    | Radar 1   1      0
     | Radar 2   0      1
-----+-------------------------
2    | Radar 1  35.51   0.04
     | Radar 2  42.23   0.09
-----+-------------------------
6    | Radar 1  53.11   0.01
     | Radar 2  63.16   0.02
-----+-------------------------
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ind = [10,20,30,40,50];
radar_copy(1,1) = ind

Concatenation

Compatible PDMs can be concatenated in the same manner as matrices. A comma
results in right concatenation, and a semicolon results in bottom concatenation.

new_radar =[radar,radar(1:2,1)^2]

new_radar (a pdm) =

 RCS |          Range   % Error  Range
-----+------------------------------------
0.01 | Radar 1   5.311  0.01       28.2067
     | Radar 2   6.313  0.07       39.854
-----+------------------------------------
0.02 | Radar 1  16.79   0         281.904
     | Radar 2  19.97   0.07      398.801
-----+------------------------------------
1    | Radar 1  26.28   0.08      690.638
     | Radar 2  29.86   0.04      891.62
-----+------------------------------------
2    | Radar 1  35.51   0.04     1260.96
     | Radar 2  42.23   0.09     1783.37
-----+------------------------------------
6    | Radar 1  53.11   0.01     2820.67
     | Radar 2  63.16   0.02     3989.19
-----+----------------------------------------

radar_copy (a pdm) =

 RCS |          Range   % Error
-----+-------------------------
0.01 | Radar 1  10      0.01
     | Radar 2   6.313  0.07
-----+-------------------------
0.02 | Radar 1  20      0
     | Radar 2  19.97   0.07
-----+-------------------------
1    | Radar 1  30      0
     | Radar 2   0      1
-----+-------------------------
2    | Radar 1  40      0.04
     | Radar 2  42.23   0.09
-----+-------------------------
6    | Radar 1  50      0.01
     | Radar 2  63.16   0.02
-----+----------------------------
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Converting PDMs to Matrices

The makeMatrix function converts a PDM into a matrix by discarding the indepen-
dent parameter (domain) and right concatenating the dependent matrices column-
wise. If a PDM is an argument to makematrix , a matrix containing all dependent
matrix data is returned:

radar_mx = makematrix(radar)

radar_mx (a rectangular matrix) =

5.311    0.01    16.79    0 26.28    0.08    35.51 0.04 ...
6.313 0.07 19.97 0.07 29.86 0.04 42.23 0.09 ...

All Radar 1 values are right-concatenated to form the first row, and all Radar 2
values appear in the second row.

To create a matrix formatted in the same manner as the dependent matrix elements
in radar , transpose the PDM (this transposes each dependent matrix separately for
each domain element), then transpose the result as shown below. Compare this re-
sult to radar  and radar_mx .

radar_mxTrans = makematrix(radar')'

radar_mxTrans (a rectangular matrix) =

   5.311    0.01
   6.313    0.07
  16.79     0
  19.97     0.07
  26.28     0.08
  29.86     0.04
  35.51     0.04
  42.23     0.09
  53.11     0.01
  63.16     0.02

When the channels keyword is used, rows of each dependent matrix are right-con-
catenated to form rows in the resulting matrix:†

radar_mxChan = makematrix(radar,{channels})

† This feature can be used to convert time and frequency responses to a format
similar to that used in MATRIXX.
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radar_mxChan (a rectangular matrix) =

5.311  0.01  6.313  0.07
16.79  0 19.97  0.07
26.28  0.08 29.86  0.04
35.51  0.04 42.23  0.09
53.11  0.01 63.16  0.02

Sections of a PDM can also be used as an input to makematrix . This makes it easy
to extract a desired value. For example, to see the range for Radar 2  at 0.01:

temp=makematrix(radar(1))

temp (a square matrix) =

5.311    0.01
6.313    0.07

temp(2,1)

ans (a scalar) = 6.313

The SAVEcommand also has the ability to create matrices from PDMs. When SAVE
is called with the matrixx keyword, all saved PDMs are stored as two matrices. The
domain is given the name pdmName_t and the dependent matrix data is given the
name pdmName_u, where pdmNameis the name of the original PDM. This handling is
designed to map to simulation data.

5.4.7 Using PDMs with Operators

Operators defined for matrices are also defined for PDMs. For example, the square
of each element in the first dependent matrix of radar  can be calculated by:

radar(1)^2

ans (a pdm) =

 RCS |          Range    % Error
-----+--------------------------
0.01 | Radar 1  28.2699  0.05381
     | Radar 2  33.9703  0.06803
-----+--------------------------

Notice the output is also a PDM.

Operations between two PDMs are defined such that the operation is performed ele-
mentwise on each pair of corresponding matrices. These operations are restricted to
PDMs with identical dimensions.
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For example, the average value of Row 1  and Row 2  is calculated by:

(radar(1,1) + radar(2,1))/2

RCS |
-----+----------------
0.01 | Radar 1   5.812
0.02 | Radar 1  18.38
1    | Radar 1  28.07
2    | Radar 1  38.87
6    | Radar 1  58.135

Operators can also be used between matrix objects (including vectors and scalars as
well as matrices) and PDMs. In this case, the operation is performed between the ma-
trix object and each dependent matrix in the PDM. The result of the operation is a
PDM with the same domain as the PDM operand.

For example, the identity matrix is added to each dependent matrix using the ex-
pression:

radar + eye(2,2)

ans (a pdm) =

 RCS |          Range   % Error
-----+-------------------------
0.01 | Radar 1   6.311  0.01
     | Radar 2   6.313  1.07
-----+-------------------------
0.02 | Radar 1  17.79   0
     | Radar 2  19.97   1.07
-----+-------------------------
1    | Radar 1  27.28   0.08
     | Radar 2  29.86   1.04
-----+-------------------------
2    | Radar 1  36.51   0.04
     | Radar 2  42.23   1.09
-----+-------------------------
6    | Radar 1  54.11   0.01
     | Radar 2  63.16   1.02
-----+-------------------------

A scalar value can also be used in operators with a PDM. The operation will be ap-
plied to each matrix element and the scalar.

5.0 * radar(1)
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ans (a pdm) =

 RCS |          Range   % Error
-----+-------------------------
0.01 | Radar 1  26.555  0.05
     | Radar 2  31.565  0.35
-----+-------------------------

5.4.8 Using Functions with PDMs

When a PDM is used as an input to a function, the function is applied to each de-
pendent matrix (Figure 5-5). If the ch annel s keyword is available and is used, the

function will be applied to each channel.

For example, if xpdm is a step response of a system with n inputs, m outputs over p
time points, then y=max(xpdm) is a (1 × 1) × p PDM whose kth element contains the
maximum element of the kth matrix in xpdm (the maximum output for every time
point). † The result of any function that accepts the channels keyword is always a
matrix the size of the dependent matrices in the PDM (see Figure 5-6).

PDMs use optimized internal looping to speed up the total computation time. There-
fore, using a single PDM as a function input is much more efficient than looping
through a set of separate matrices with MathScript commands.

Next you will use the intrinsic function max to illustrate the flexibility of PDMs. max
finds the maximum over a specified subset of the PDM data.

To find the maximum range for both Radar 1 and Radar 2 over all RCSvalues, ap-
ply the function to all rows of the first column of dependent matrices. Type:

† Where max(xpdm,{channels}) is an n x m matrix where (i,j) element is
the maximum of the vector of the (i,j) elements of all the dependent matrices.

FIGURE 5-5 Functions of PDMs

ypdm1

ypdm2

↓

ypdmn

=

=

=

f xpdm1( )[ ]

f xpdm2( )[ ]

↓
f xpdmn( )[ ] 

 
 
 
 
 
 

ypdm=f(xpdm)
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maxrad = max(radar(:,1))

maxrad (a pdm) =

 RCS |
-----+---------
0.01 |    6.313
0.02 |   19.97
1    |   29.86
2    |   42.23
6    |   63.16

max treats the PDM as a series of matrices, returning a PDM with the same domain
as radar . It loops over all the domain points (values of RCS), finds the largest value
each dependent vector contains (in this case, the Range value), and returns that
scalar value as the dependent matrix corresponding to the same domain point in the
output PDM.

You might want to know the maximum ranges for Radar 1 and Radar 2 sepa-
rately. In this case, the PDM is treated as a matrix of vectors, each corresponding to
a channel of the PDM. To use max in this manner, invoke the channels  keyword:

maxvals = max(radar(1:2,1), {channels})

maxvals (a column vector) =
53.11
63.16

The range for Radar 1 corresponds to the (1,1) channel, and the range for Radar 2
corresponds to the (2,1) channel. The (1,1) element of the output matrix, 53.11, is

FIGURE 5-6 Functions of a PDM Over Channels
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the maximum value for the range of Radar 1 over all the RCSvalues. The second el-
ement is the maximum value for Radar 2 .

5.5 Dynamic System

The dynamic system class represents systems of time-dependent equations for mod-
eling input/output relationships. In general, there are many different kinds of dy-
namic systems, with many different representations.

Xmath supports linear, time-invariant systems. These can be continuous (systems
of differential equations) or discrete (systems of difference equations). Two specific
representations are provided: state-space systems and transfer functions. Both are
created with the system function and are discussed later. Sampling times (0 for
continuous systems and nonzero for discrete) are automatically stored within a dy-
namic system object.

The dynamic system class is closely tied to the PDM class. Simulations or dynamic
systems are defined using a PDM to represent inputs, and return a PDM represent-
ing the outputs. The * (product) operator has also been overloaded (defined) such
that system*input_pdm  performs a simulation over the data in input_pdm .

5.5.1 State-Space Systems

A state-space dynamic system stores the A, B, C, and D matrices associated with the
following equation:

x is the state vector (with initial conditions X0), u is the input vector, and y is the
output vector. All matrices are stored, even if they are null.

■ State-space systems can be single-input/single-output (SISO) or multiple-in-
put/multiple-output (MIMO).

■ Names can be attached to each of the inputs and outputs and states of a state-
space system. This capability is particularly useful with MIMO systems.

xk 1+ A x k B uk+=

y C x D u+=

d x
d t
------ A x B u+=

yk C xk D uk+=

for continuous systems for discrete systems
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5.5.2 Transfer Functions

A transfer function is described as:

The notations H(s) and H(z) are common for transfer functions. s represents the
Laplace transform variable, and z represents the z-transform variable. A transfer
function represents a dynamic system in terms of numerator and denominator poly-
nomials.

■ A transfer function is proper if the order of the numerator is less than or equal
to the order of the denominator.

■ It may sometimes be convenient to use an improper or noncausal transfer func-
tion (to represent an ideal differentiator, for example). Xmath allows you to de-
fine an improper transfer function, but restricts the types of analyses you can
perform. You can find the frequency response of an improper transfer function,
but not the time response. An improper transfer function cannot be connected
with state-space systems or converted to state space form.

■ Currently, only SISO transfer functions are supported.

■ Names can be attached to the inputs and outputs of a system in transfer-func-
tion form.

■ To perform a time-domain simulation (Sys × u), multiply a system by a PDM
whose columns contain the input vector(s) for the simulation(s). (See
Section 5.5.5 on page 5-49).

5.5.3 Creating Systems

Dynamic systems can be created with the system function. If four compatibly-sized
matrices are given as inputs, a state-space system is formed.

a=[1,2;3,4]; b=[.1,-.1,1; 2,-.2,2]; c=[3,3]; d=[.4,-.4,4];
ssSys=system(a,b,c,d, {inputNames=["red","white","blue"],
  outputNames=["Flag"], stateNames=["Alaska","Nebraska"],dt=.01})

y s( )
u s( )
----------- H s( ) n u m s( )

d e n s( )
---------------------= = y z( )

u z( )
------------ H z( ) n u m z( )

d e n z( )
---------------------= =

for continuous systems for discrete systems
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ssSys (a state space system) =

  A
  1    2
  3    4

  B
  0.1    -0.1    1
  2      -0.2    2

  C
  3    3

  D
  0.4    -0.4    4

  X0
  0
  0

State Names
-----------
Alaska    Nebraska

Input Names
-----------
red
white
blue

Output Names
------------
Flag

System is discrete, sampling at 0.01 seconds.

A handy shortcut for creating state-space systems with an all-zero D matrix is to
use a null-matrix specifier ([]) for the D matrix. This automatically sets the D matrix
to a zero matrix, with row size equal to the row size of C and column size equal to
the column size of B.

If dt  was not given a value, ssSys  would have been continuous (dt  defaults to 0).

The size of a system object is defined by the number of outputs, inputs, and (in the
case of a state-space system) the number of states it has. You can use the size
function to find these dimensions.

[out,in,states]=size(ssSys)?
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out (a scalar) =   1

in (a scalar) =   3

states (a scalar) =   2

If a pair of polynomials is given, a transfer function results:

n=makepoly(polynomial([1,-1;2,-2],"s"));
d=polynomial([-2,1;1,-2],"s");
tfSys=system(n,d,{inputNames="In", outputnames="Out"})

tfSys (a transfer function) =

     s(s + 1)
  ----------------

  (s + 1)(s + 3)

  initial integrator outputs
  0
  0
  Input Names
  -----------
  In

  Output Names
  ------------
  Out

  System is continuous

The various parts of a transfer function or a state-space system can be extracted
with the abcd , numden, period , and names functions (see the Xmath online Help).
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Using Operators with Dynamic Systems

Operators have also been defined to perform connections between dynamic systems.
Suppose you have dynamic systems Sys1 and Sys2 , where outputs are y1 and y2
and inputs are u1 and u2, respectively. The statements in Table 5-4 would then be true.

TABLE 5-4 Operations on Dynamic Systems

Sys = Sys1 + Sys2 Defined such that y = y1 + y2 .
The inputs are tied together such that
u=u1=u2 .

Sys = Sys1 – Sys2 Defined such that y = y1 – y2 .

In the unary case, Sys = –Sys2  is de-
fined such that y = –y2
(Sys1=system([],[],[],[]) ).

Sys = Sys2 * Sys1 The cascade connection of Sys1  followed
by Sys2 . The output of Sys  is y2  and the
input is u1.

Sys = [Sys1;Sys2] Defined such that y = [y1;y2]  and
u=u1=u2  (inputs are tied together).

Sys = [Sys1,Sys2] Defined such that y = y1 + y2  and
u = [u1;u2] .

Sys1

Sys2

u

u1 y1

y2u2

y
+

Sys1

Sys2

u

u1 y1

y2u2

y
-

Sys1 Sys2
u

u1 y1 u2 y2
y

Sys1

Sys2

u

u1 y1

y2u2

y

Sys1

Sys2

u1 y1

y2u2

y
+
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Creating Subsystems by Indexing into Dynamic Systems

You can index into a dynamic system to create a subsystem comprising a subset of
the original inputs and outputs, as shown in Table 5-5.

If you are familiar with input/output notation, you may feel that the above defini-
tion (outputs first, inputs second) of indexing seems reversed. It was designed with
the traditional definition of a transfer function in mind, where outputs are specified
first: y(s) = Sys(s) × u(s). (This definition also led to Xmath’s definition of Sys × aPDM
to perform simulation, since in that case y(t) = Sys × u(t)). For a MIMO system with
m outputs and n inputs, y is an m × 1 vector and u is n × 1; thus, it makes sense for
Sys to be m × n. We can see this if we index into ssSys  from page 5-43:

Sys2=ssSys(1,3)

Sys2 (a state space system) =

  A
  1    2
  3    4

  B
  1
  2

  C
  3    3

  D
  4

  X0
  0
  0

  State Names
  -----------
  Alaska    Nebraska

  Input Names
  -----------
  blue

TABLE 5-5 Indexing Into a Dynamic System

Sys = Sys1(i,j) Defined to be a system such that y=y1(i ) and
u=u1(j) . i and j can both be vectors as well, in which
case multiple inputs and outputs will be extracted.
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  Output Names
  ------------
  Flag

  System is discrete, sampling at 0.01 seconds.

The output is a SISO dynamic system containing the third column of the B and D
matrices.

5.5.4 Functions for Manipulating Dynamic System Objects

Table 5-6 briefly describes functions commonly used to manipulate systems. To see
a full description of each function, see the Xmath online Help.

TABLE 5-6 Functions Commonly Used to Manipulate Systems

abcd Extracts the component A, B, C, and D matrices from a
state-space system object. In addition, it returns the initial
conditions on the states if a fifth output argument is re-
quested.

abcd can be called on systems in either state-space or
transfer-function form. If the system is a transfer function,
the conversion to state-space is done internally to return
A, B, C, and D, although the format of the variable itself
remains unchanged. The transfer function must be proper.

discretize Converts a continuous system to discrete form.

makecontinuous Converts a discrete system to continuous form.

numden Returns the numerator and denominator polynomials
comprising a SISO system in transfer function form. If the
system is in state-space form, an internal conversion is
performed to find the transfer function equivalent, but the
format of the system variable itself remains unchanged.
State-space systems used as inputs to numden must be
SISO. Note that common roots in the numerator and de-
nominator polynomials are not canceled.

period period  extracts the sample period (in seconds) of a sys-
tem. If the system is continuous, period  returns zero.
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5.5.5 Time Response

The behavior of a dynamic system as a function of time in response to external stim-
uli is referred to as the system’s time response. Xmath can simulate the response of
a dynamic system to various inputs to obtain the system's time response. This is ac-
complished with the * operator between dynamic systems and parameter-dependent
matrices (PDMs) and with one or more of the functions in Table 5-7.

Borrowing from the convenient frequency response notation for a system where y(s)
= H(s)*u(s), Xmath defines the operation system ∗PDMas a time domain simulation.
Thus, for any dynamic system Sys (continuous or discrete) and for a PDM u repre-
senting the external stimulus as a function of time, the operation y=Sys ∗u creates a
PDM y  that contains the outputs of the system as a function of time.

For a dynamic system with ny outputs and nu inputs, the input vector is defined to
be nu × 1 and the output vector is ny × 1. Thus, the input PDM u should be ny × 1 ×
Nsamp, where Nsamp is the number of time points in u.

names Extracts matrices of strings representing the input, out-
put, and (if the system is in state-space form) state names
of a system. It works much the same as described for
PDMs on page 5-33.

check Can be used to return a Boolean indication of whether a
system is in transfer-function or state-space form, dis-
crete, continuous, or stable. In addition, check  can be
used with the convert  keyword to change a system’s rep-
resentation between SISO state-space and transfer-func-
tion forms.

TABLE 5-7 Time Response Functions

impulse Computes the impulse response of a system.

initial Computes the unforced response of a system to a given
initial condition.

step Computes the step response of a system.

defTimeRange Computes a default time vector for simulations.

TABLE 5-6 Functions Commonly Used to Manipulate Systems  (Continued)
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■ The input PDM must have a regular domain.

■ If the system is discrete, the domain intervals must be equal to the system’s
sampling period.

■ If the system is continuous, it is discretized using the exponential (zero-order
hold) method, with the sampling interval set equal to the input domain interval
spacing. For accurate results, make sure this sampling interval is small enough
that discretization effects are negligible.

If you desire to run several simulations with different inputs, you can define a PDM
where columns contain the input vectors for the different simulations. Then u will
be ny × q × Nsamp, where q is the number of different simulations to be run. The re-
sulting y will be ny × q × Nsamp, with each column of the PDM corresponding to a dif-
ferent simulation.

See Section 4.2.15 on page 4-40 for a explanation of how PDMs are plotted.

5.6 Strings

A string object is a sequence of characters enclosed by double quotes. To be recog-
nized as a string, an object must be created with double quotes or be the output of
the string  function, which converts numbers to strings.

■ You can concatenate strings with the plus (+)  operator.

c="California";s="Sacramento";
str=""nThe capital of "+c+ " is "+s+"."

str (a string) =
The capital of California is Sacramento.

■ You can concatenate strings and then use them on the Xmath command line.

alias mypath "C:/myhomedir/myexamples/"
display mypath + "engine"
execute file = mypath + "engine"

■ You can group multiple strings into string matrices (also called tables) using the
same punctuation as matrices.

r=" rest"; i=" ice"; c=" compression"; e=" elevation";
rice=[r,i,c,e];ouch=[82,73,67,69];
sport=[char(ouch)',rice']
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sport (a rectangular matrix of strings) =

  R     rest
  I     ice
  C     compression
  E     elevation

■ For strings, size returns the number of rows and columns of the whole string
matrix.

size(sport)

ans (a row vector) =   4    2

To find the total number of elements (characters) in a string, use length .

length(sport)

ans (a scalar) =   35

5.6.1 Converting Strings and Numbers

Numbers can be converted to strings using the string function, and strings to
numbers using makematrix .

aStr=string(32)

aStr (a string) =   32   # result is a string

aNum=makematrix(aStr)

aNum (a scalar) =   32   # result is a scalar

The displayed result looks the same; only the object type has changed.

The ascii function returns the ASCII representation of a single character. The
char  function returns the character representation of a single character.

ascii("A")

ans (a scalar) =   65

char(65)

ans (a string) =   A
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5.6.2 Special Characters in Strings

Sometimes you may want to format your string output. You can insert a newline
with the sequence "n or char(10) . To insert a tab, use the sequence "t or
char(9) . To cause double quotes to appear in a string, use a pair of double quotes
("" ) or char(34) .

str=""n2 feet, 3 inches can be shortened to " + "2'3"".";

display str

2 feet, 3 inches can be shortened to 2'3".

You can use the DISPLAY command to display a string, variable, or the result of an
expression; only the string is displayed (the message ans (a string) = is omitted.)

str1="A string must be enclosed in ";
str2="quotation marks. For example:"; nl=char(10); q=char(34);
test=nl + str1 + nl + str2 + nl + char(9) + char(10) + q +...
"What's next?" + q;
display test

A string must be enclosed in quotation marks. For example:

"What's next?"

For more examples see DISPLAY in the Xmath online Help.

5.6.3 Manipulating Substrings

You cannot use conventional indexing (see page 5-8) to index into a string, but you
can index into a matrix of strings.

Create a matrix of strings:

mat=[65:69;97:101];m=char(mat(1:2,:))

m (a rectangular matrix of strings) =

  A    B    C    D    E
  a    b    c    d    e

Index into a matrix of strings:

bball="The N"+m(1,2)+m(1,1)+...
" is where the action is."

bball (a string) =   The NBA is where the action is.
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You can use the index function to find the starting location of a substring within a
string.

i=index(bball,"ac")

i (a scalar) =   22

As mentioned earlier, length returns the total number of characters in a string.
The function stringex extracts a substring from a string, and the function
delsubstr deletes all instances of a substring. Look up these functions in the
online Help, and note how you can use them to alter a string, as shown in the
following example:

bball2=stringex(bball, i, length(bball))

bball2 (a string) = action is.

bball3=delsubstr(bball, bball2)

bball3 (a string) = The NBA is where the

bball4=bball3+"money is."

bball4 (a string) = The NBA is where the money is.

5.7 Lists

Lists are created with the list function. A list object can be thought of as a collec-
tion or set of other objects. Each element in the list can be of any arbitrary class, in-
cluding another list. This makes nested lists possible. A list is one-dimensional, in
that it can only be addressed with a single index. The following is an example list:

title="Gasoline Prices"; t=1:12; d=1:100;
fg=makepoly([1,2,-.9],"t"); p="p=polyval(fg/t)/d;";
L=list(title,t,d,fg,p)

L (a list with 5 elements) =

1:
  Gasoline Prices

2:
  1 : 1 : 12
3:
  1 : 1 : 100
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4:
   2
  t + 2t - 0.9
5:
  p=polyval(fg/t)/d;

A single index can be used to access entire objects from the list.

p=polyval(L(4),L(2))'

p (a column vector) =

    2.1
    7.1
   14.1
   23.1
   34.1
   47.1
   62.1
   79.1
   98.1
  119.1
  142.1
  167.1

The plus (+) operator can be used to concatenate two lists.

5.8 Index Lists

An index list contains a list of indices or pointers into a vector, matrix, or PDM. An
index list looks like a matrix, but matrices cannot be used as lists. The function
find  outputs an index list, and you can create your own with indexlist .

An index list has either one, two, or three columns. If it has one column, it can be
used to index into a vector. If it has two columns, it can be used to index into a ma-
trix; the first column contains row pointers, and the second column pointers. If it
has three columns, it can be used to index into a PDM; the first column is used for
domain pointers, the second for row pointers, and the third for column pointers.

set seed 0
m=hessenberg(random(4,4))
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m (a square matrix) =

   0.211325    -0.563151    0.529676     0.288135
  -1.31969      1.47381     0.313928     0.0170223
   0           -0.599434    0.164669     0.00777988
   0      0           0.173159 -0.217164

Find the row and column location of each element smaller than 0, and assign the
value 3 to it:

lis=find(m<0)

lis (an index list) =

  1    2
  2    1
  3    2
  4    4

m(lis)=3

m (a square matrix) =

  0.211325    3          0.529676    0.288135
  3           1.47381    0.313928    0.0170223
  0           3          0.164669    0.00777988
  0           0          0.173159    3

The following example shows the use of a three-column indexlist with a PDM. (For a
complete discussion of PDMs, see Section 5.4 on page 5-21.) Using the above ma-
trix, create a PDM with two dependent matrices:

mpdm=pdm(m,[1,2])

mpdm (a pdm) =

domain |        Col 1     Col 2    Col 3     Col 4
-------+-----------------------------------------------
     1 | Row 1  0.211325  3        0.529676  0.288135
       | Row 2  3         1.47381  0.313928  0.0170223
-------+-----------------------------------------------
     2 | Row 1  0         3        0.164669  0.00777988
       | Row 2  0         0        0.173159  3
-------+----------------------------------------------------
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The goal is to find all elements of mpdmin row 2 of a dependent matrix that are
greater than 0 and less than .5 and set them to 0.1. To do this, first find the location
of all elements of mpdm that meet the criteria:

mlis=find((mpdm > 0) & (mpdm < .5))

mlis (an index list) =

  1    1    1
  1    1    4
  1    2    3
  1    2    4
  2    1    3
  2    1    4
  2    2    3

The first column shows the domain, the second the row, and the third the column.
Extract the portions of the index list that index elements in row 2 of the dependent
matrices.

row2=find(mlis(:,2)==2)

row2 (an index list) =

  3
  4
  7

Create an indexlist that locates only the elements in row 2 of a dependent matrix
that meet the criteria used to create mlis .

rlis=indexlist(mlis(row2,:))

rlis (an index list) =

  1    2    3
  1    2    4
  2    2    3
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Now, set all elements of mpdmthat are greater than 0, less than .5, and in the sec-
ond row to 0.1:

mpdm(rlis)=0.1

mpdm (a pdm) =

domain |        Col 1     Col 2    Col 3     Col 4
-------+-----------------------------------------------
     1 | Row 1  0.211325  3        0.529676  0.288135
       | Row 2  3         1.47381  0.1       0.1
-------+-----------------------------------------------
     2 | Row 1  0         3        0.164669  0.00777988
       | Row 2  0         0        0.1       3
-------+----------------------------------------------------
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6 MathScript Programming

This chapter describes how you can combine MathScript expressions, statements,
commands, and functions to create MathScript programs.

Xmath handles MathScript functions (MSFs) and MathScript commands (MSCs)
you write in the same manner as it does Integrated Systems commands and func-
tions (see Section 3.5 on page 3-15). MSCs and MSFs can call other MSCs and
MSFs, or call themselves recursively.

6.1 Overview

This section explains how to create a MathScript function (MSF) and a MathScript
command (MSC), giving you a brief overview of the scripting process along the way.
In subsequent sections, scripting will be explained in detail, and we will use these
samples as a point of reference.

6.1.1 Creating a Sample MSF

User-defined MSFs behave exactly like predefined functions; they take input argu-
ments, perform the statements in the body of the function using these arguments,
and return one or more outputs. Input arguments are not modified.

The sample MSF halfwave (Example 6-1) converts all values less than zero to the
value of zero. Go to your Xmath working directory and use a text editor to create a
file named halfwave.msf  as shown.
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EXAMPLE 6-1: halfwave.msf

#{
 Function halfwave() has 1 required input argument
}#

Function out1 = halfwave(in1)   # function declaration line
out1 = in1

     out1(find(in1 < 0)) = 0
endFunction

The file begins with an optional block comment (text enclosed in #{ }# ). If supplied,
the comment serves as Help on this function if you supply a Help file (see
Section 6.1.6 on page 6-8).† The function declaration is required. This declaration
defines the function name, the number and type of input arguments, and the num-
ber of output arguments.

To use halfwave , call the function just like any intrinsic MathScript function.

y = [1,0,-1,0,1,0,-1,0];
z = halfwave(y)

z (a row vector) =   1    0    0    0    1    0    0    0

6.1.2 Creating a Sample MSC

While MSFs return one or more new objects as outputs and cannot modify input ar-
guments (pass by value). MSCs do not return any values, but they can modify input
arguments (pass by reference).

As an example of a typical MSC, consider the command graphit (shown in
Example 6-2), which takes a single input and plots it on a log-log scale; a legend is
supplied if the input is a matrix. Inputs other than a vector or matrix invoke an er-
ror message. Go to your Xmath working directory and use a text editor to create the
file shown in Example 6-2.

† This text will be displayed in the local Help window when you type help
halfwave  in the Command window command area.
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EXAMPLE 6-2: graphit.msc

#{
GRAPHIT plots a numerical input.
}#

Command graphit indata    # command declaration
if !is(indata,{scalar}) & !is(indata,{string})
  if is(indata,{matrix,!vector}) == 1
    plot (indata,{legend})?
  else
    plot (indata,{xlog,ylog,xmax=length(indata),
      ymin=min(indata), ymax=max(indata)})?
  endif
else
  error("Input is not worth plotting!","C")
endif

endCommand

The first line of the file after the optional block comment (#{ }# ) section is the com-
mand declaration. The command declaration is required. It defines the command
name, and the number and type of input arguments. Notice that the arguments are
not in parentheses as they are in functions.

To test this command, call it as follows:

a=[1:.01:3];[,c]=size(a);
k = a(1,100:125);
m = k .*. sin(a);
v=[a*5, a*2, a*4, a];
graphit c
graphit m
graphit v

In these examples, the argument to graphit is a single variable that requires no
parsing; in cases where the argument is a simple token—a single variable or con-
stant, you can separate the command name from the first argument with white
space only, and it works. If the first argument is more complex, such as an expres-
sion, you must also place a comma after the command name. A comma separating
the command name from the first argument always works. The example below illus-
trates this point.
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Create the following MSC in your working directory:

Command add3nums arg1, arg2, arg3
arg1+arg2+arg3?
endCommand

The following usages of this command all work:

add3nums 1,2,3
add3nums a,b,d
add3nums a,b-c,d
add3nums a,b,d-c

The following produces an error message:

add3nums a-c,b,d

If you place a comma after the command name, however, the command works:

add3nums, a-c,b,d

6.1.3 General Rules for MathScript Programs

There are two types of names in MathScript programming: the MathScript name
and the filename.

■ MathScript names follow the same rules as variable names (see Rules for Names
on page 3-1).

■ MSF and MSC filenames must be lowercase, and they must match the Math-
Script name.

■ All filenames must be unique. For example, creating both name.msf and
name.msc  is ambiguous (the filename for Xmath to call is undefined).

6.1.4 MathScript File Formats

The file formats are shown in Figure 6-1 and Figure 6-2.
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FIGURE 6-1 MSF File Format

#{
Optional Block Comment
that may be used for Help

}#

Function [out1,…outn]=fun_name(in1,… inN,{keywds})

# MathScript instructions that operate on the
# arguments.
Optional Return

endFunction
…

MathScript Function Format

MathScript Command Format

FIGURE 6-2 MSC File Format

#{
Optional Block Comment
that may be used for Help

}#

Command command_Name in1,… inN,{keywds}

# MathScript instructions that operate on the
# arguments.
Optional Return

endCommand
…
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Comment Header

The optional comment at the top of the file may serve as the online Help entry for
your MSF or MSC. To display your Help for your MSF or MSC in the local Help win-
dow type:

help script_name

NOTE: See Section 6.1.6 on page 6-8 for additional information about creating
online Help for your MSF or MSC.

Declaration

The first line of code following the comment Help block is the declaration, which de-
fines the number of input and output arguments. Required arguments are placed
before the braces, while keywords are defined inside the braces.

■ Files must end with the appropriate end statement (endCommandor endFunc-
tion)  followed by a carriage return (blank line).

■ There can only be one user-defined command or function in an MSF or MSC file
(see Example 6-3 on page 6-13 and Example 6-4 on page 6-14 for extended ex-
amples of MSCs and MSFs). MSOs (see page 7-1) allow for more than one func-
tion or command to be declared in a file. An optional return statement can be
used to exit before the endFunction  or endCommand statement.

Void Function Declaration

Although the discussion and examples show both input and output arguments, you
can define a void function that has no outputs. The syntax of this function declara-
tion is as follows:

function [ ] = void_func_name(in1,...inN, {keywds})

6.1.5 MathScript Programming

This section gives an overview of MathScript programming. Some of the functions
mentioned here are also discussed in Section 6.3 on page 6-15.

For a detailed description of any function or command provided by Integrated
Systems, see the Xmath online Help.
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Assigning Default Values

Optional arguments and keywords typically have default values that will be used if
the argument is not specified. The DEFAULTcommand assigns a default value to the
specified argument. In the following function syntax, kwd1 is given a default value of
5.0, and kwd2 is assigned "Earth"  by default.

function [out1,out2,out3]=funName(in1,in2,{kwd1,kwd2})
DEFAULT kwd1 = 5.0
DEFAULT kwd2 = "Earth"

...

Output Keywords

For MathScript programs, output keywords provide a feature whereby desired out-
put can be selected directly by name rather than positionally. For example, consider
an MSF defined with this prototype:

[o1,o2,o3] = function myfun(i1)

To access only the third output of an MSF, use one of the following methods:

■ Skip the first two outputs like this:

[,,thirdout] = myfun(a)

■ Use output keywords like this:

[thirdout = o3] = myfun(a)

For a general discussion of keywords, see page 3-17.

Calling Void Functions

When you call a void function, you must use the following syntax:

[ ] = void_func_name(...)

See Void Function Declaration on page 6-6.

Variable Scoping

All variables created within MathScript functions and commands are local unless
you use an explicit partition name (partitionName.variableName ). Remember,
you cannot change partitions within a program.
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For MSFs, input arguments are passed by value. This means that functions cannot
alter the values of their arguments. Output arguments requested by the caller are
copied back to the scope of the caller.

For MSCs, arguments are passed by reference and can alter the values of their argu-
ments, rename them, or delete them altogether if the argument is a variable name.

NOTE: If you get an error message from Xmath indicating that your file is
incomplete, your file may be missing an ending carriage return.

6.1.6 Creating Online Help for User-Defined MSFs and MSCs

You can provide online Help for your MSF or MSC in one of the following ways:

■ Provide a Help file in the same directory as your MSF or MSC.

■ Allow Xmath to use the block comment at the top of your MSF or MSC if you do
not provide a Help file.

When you try to bring up Help for your MSF or MSC by typing the following com-
mand

help script_name

Xmath follows these steps:

1. Xmath searches for the Help topic name in the standard Xmath Help project file
(help.hpf ).

If Xmath finds your Help topic, it displays it in the MATRIXX Help window.

2. If Xmath does not find an Xmath Help topic, it looks in the local help project file
(local.hpf ).

If Xmath finds your Help topic, it displays it in the Local Help window.

NOTE: On UNIX systems, local.hpf is in your home directory. On
Windows systems, local.hpf also exists in your home directory if
the home directory is defined; otherwise, you can find local.hpf in
%XMATHTMPDIR%.

3. If Xmath does not find the Help topic in the local help project file, it looks in the
same directory as your MathScript file for a Help file with the name
script_name .html, script_name .htm,  or script_name .txt .

If Xmath finds your Help file, it displays it in the Local Help window and ap-
pends the topic name to the local.hpf  file.

xb.book  Page 8  Wednesday, October 6, 1999  11:28 AM



Xmath Basics MathScript Programming

6-9

6

4. If Xmath does not find a Help file, it goes to the MathScript itself, extracts the
text in the comment section at the top, and creates a text file
(script_name .txt ) that contains the extracted information.

On UNIX systems, Xmath stores the script_name .txt file in your home di-
rectory. On Windows systems, Xmath stores the script_name .txt file in
your home directory if the home directory is defined; otherwise, Xmath stores
the file in %XMATHTMPDIR%.

Xmath displays the Help topic in the Local Help window and appends the topic
name to the local.hpf  file.

6.1.7 Using User-Defined MSFs and MSCs

Your MSF or MSC can be called in the same way as Xmath functions and com-
mands. However, Xmath must know where to look for them.

Search Paths

When you call a MathScript program, Xmath looks for it in the search path using
the following criteria:

■ The current working directory (.) is put in the search path when Xmath starts
up.

■ The search path is searched only upon the first call to the MSF or MSC.

■ You can use DEFINE and UNDEFINE to select or deselect an MSF or MSC.

For example, if halfwave.msf is not found in the search path, you receive the fol-
lowing message:

File halfwave not found

If this occurs, add the new directory to the search path with the command set
path "directory" where directory can be any valid directory path string. As-
suming halfwave.msf is in the subdirectory myScripts , you add its path as fol-
lows:

set path "myScripts"
show path

1) .
2) myScripts
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Manipulating Search Paths

If the file graphit.msc is in the directory test , you can add this entry to the
Xmath search path as follows:

set path "test"
show path

1) .
2) myScripts
3) test

To remove an entry from the Xmath search path, use the REMOVEcommand and the
path number.

remove path 2
show path

1) .
2) test
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To handle paths through a file selection box, use Select File→Set Path. In the Directo-
ries field (of the Set Path dialog shown below), double-click on the directory you want
for your search path, and then click OK.

DEFINE

By default, Xmath looks for built-in functions and commands (see Section 3.5 on
page 3-15) before searching user paths. The DEFINE command explicitly associates
an MSF or MSC with a MathScript name. It is useful for accessing functions that are
not in the search path. For example, the Xmath function hilbert is stored in the
following location:

whatis hilbert

hilbert is an ISI function ( path /hilbert.xf)

where path is the path to your Xmath installation. Suppose we have an MSF called
hilbert.msf located in a subdirectory called funs , and we would rather use it for
Hilbert computations. To make and verify the change, type:

define hilbert, {directory = "funs"}
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whatis hilbert

hilbert is a Mathscript function (funs/hilbert.xf)

All calls to the hilbert function will now use the function located in funs instead
of the predefined function. To retrieve the predefined function, release your local
version of hilbert  (and then verify with the whatis  function):

undefine hilbert
whatis hilbert

hilbert is an ISI function ( path /hilbert.xf)

For more information on DEFINE and UNDEFINE, see the Xmath online Help.

MathScript Program Compilation and Execution (.xf, .xc)

When a program is defined or called for the first time, Xmath compiles the program
and stores the resulting binary code in an .xf or .xc file, depending on the file
type. See Figure 6-3.

When halfwave is called again, the Xmath interpreter checks the last modified
dates of halfwave.xf and halfwave.msf . If halfwave.msf is more recent, the
ASCII .msf file is recompiled, overwriting the existing .xf file. After compilation,
the new halfwave.xf  binary file is executed.

You can use the following command to turn off file usage time stamp checking:

SET AUTOCOMPILE OFF

If you know that you will not be modifying a source file, this can improve the speed
of a task such as calling an MSF in a loop.

If a new version of Xmath is installed, old local .msf and .msc files are automati-
cally recompiled.

halfwave.msf halfwave.xf

MathScript ASCII Source Compiled MathScript Code

(compile)

FIGURE 6-3 Compile Process for an MSF
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6.2 Examples

Example 6-3 provides a sample user-defined MSF called pdm2mx. This MSF changes
a PDM to a matrix of the same dimensions as the input matrix. This is to reverse
any PDM formatting so that you can compare a PDM’s dependent matrices with the
source matrix for the PDM.

EXAMPLE 6-3: pdm2mx.msf

#{------------------------------------------------------------------
Destructs a PDM to a matrix of the same dimensions as the input
matrix. Idea is to reverse any PDM formatting so that you can compare
a PDM's dependent matrices with, for example, the original matrix the
PDM was created from.

Syntax: Function [mat,same]=pdm2mx(m,p)
Inputs: m A matrix to compare to the elements of a PDM.

p A PDM with elements you wish to organize in a
matrix of the same dimensions as m.

Outputs: mat A matrix of elements of p formatted according to m.
same If mat and m are the same, same=1. If not, same=0.

--------------------------------------------------------------------
}#
Function [mat,same]=pdm2mx(m,p)
[mr,mc]=size(m); [pr,pc,pl]=size(p);

if is(m,{matrix}) & is(p,{pdm}) & mr*mc==pr*pc*pl

  if mr==pr & mc==pc
    mat=makem(p')';
  else
    mat=makem(pdm(makem(p')',{rows=mr, columns=mc}));
  endif

if any(mat-m) <> 0; same=0; else same=1; endif
else
  error("Matrix and PDM must have same number of elements.","C")
endif
endFunction

A call to pdm2mx might be:

b=rand(6,3)? bp=pdm(b,{rows=3,columns=6})
[,same]=pdm2mx(b,bp)
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The command plotspec tru min Example 6-4 takes PDM input and plots the origi-
nal wave and its magnitude spectrum in the Graphics window. plotspectrum uses
check to see if the input is a PDM. If the input is a PDM, the length of the PDM
channels is returned from length  to the variable len .

EXAMPLE 6-4: plotspectrum.msc

#{plotspectrum first uses check() to see if the input is a PDM. If
the input is a PDM, the length of the PDM channels is returned from
length()  to the variable len . The domain of the PDM is a vector
stored as in am.}#

command plotspectrum input

stat = check(input, {pdm,abort});len = length(input);
dm = domain(input);

#compute the fft of the input, and the frequency range

qPDM=fft(input,{channels});
res =(len-1)/(len*(dm(len)-dm(1)));
dmF=(0:res:(len-1)*res);
output = pdm(abs(makematrix(qPDM)), dmF);

#{set up the frequency axis label. The x label on the spectral graph
is generated using + to append strings together. The final string is
stored in xLab.}#

xLab = "Frequency (resolution = " + string(res) + ")";

#{ The first call sets up the plot format. By default in the first
graph, the time series graph is placed in row 1.}#

t = plot(input,
    {rows=2,title = "original wave",
    y_lab = "amplitude", x_lab = "time (sec)"})?

#{The second plot  call plots the spectrum in the second row).}#

t = plot (output, {keep, row=2, y_log, x_lab = xLab,
y_lab = "Log Magnitude", title="Spectrum"})?
endCommand
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A typical call to plotspectrum  looks like:

time = 1:1:256; wave = pdm(cos(5*time), time);
plotspectrum wave

The Graphics window will display the time and spectrum plots.

6.3 Programming

This section describes MathScript functions, commands, and constructs used for
programming.

6.3.1 Iterative and Conditional Looping Statements

Loops provide the ability to repeat a command or sequence of commands, either for
a fixed number of iterations, or until some criterion is met. You can also exit a loop
with the EXIT statement as described in the Xmath online Help.

For

The For command executes a statement or a set of statements for a specified num-
ber of iterations. If a statement contains a variable on which the loop_variable
operates, the order of execution is as follows:

■ If the variable is a column vector, the order is top to bottom of the column vec-
tor.

■ If the variable is a matrix, the order is by columns, moving from left to right.

■ If the variable is a row vector, the order is from left to right.

The For  loop syntax is as follows:

For loop_variable = vector
   statements
endFor

A line break acts as a terminator in this construct. A comma, a semicolon, or the DO
keyword can be used. For example, the following formats are correct:

For x=1:n, statements; endFor
For x=1:n; statements; endFor
For x=1:n DO statements; endFor
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While

A While loop iterates as long as a conditional expression is TRUE. The While loop
can be structured as follows:

While conditionalExpression
   statements
endWhile

WHILE conditionalExpression, statements; ENDWHILE
WHILE conditionalExpression; statements; ENDWHILE
WHILE conditionalExpression DO statements; ENDWHILE

If

If executes a statement or set of statements when a particular condition is met; if
the condition is not met, any else  or elseIf  statements are executed.

The syntax for an if  statement is:

If condition
   statements
elseIf condition
   statements
else
   statements
endIf

A line break acts as a terminator in the above construct, or a comma, a semicolon or
the THEN keyword can be used. For example, the following variations are correct:

IF condition, statements ELSE, statements ENDIF
IF condition; statements ELSE, statements ENDIF
IF condition THEN statements ELSE, statements ENDIF

For example:

if input < cost
   display "Please deposit: "+ string(cost-input)+ " cents"
elseif input > cost
   display "Your change is: "+ string(input-cost)+ " cents"
else
   display "Thank You."
endIf

Or, for example:

IF in1 | in2 < 1 THEN x=0; ELSE x=1; ENDIF
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Goto and Labels

A goto and corresponding label can be defined in a MathScript function (MSF),
MathScript command (MSC), or MathScript object (MSO) file (not in a .ms file); goto
cannot be used interactively. The goto command causes a jump to a specific label
in the program. A label is a name enclosed in angle brackets; labels must be unique
within a script.

For example, an MSF, MSC, or MSO file might have the following:

If input > cost & change < input-cost
    GOTO exact           # jump to <exact>
endIf

#{
definition of label exact
}#
<exact>

display "Please use exact change only."

6.3.2 Object Query Functions

These functions are useful for testing the validity of input arguments of MathScript
entities. To see the full set of available keywords for each function, see the Xmath
online Help.

exist

exist checks to see if an object is defined with the given name. exist returns
TRUE (1) if the object is defined, and FALSE (0) otherwise.

a = 1; exist(a)

ans (a scalar) =   1

delete a
exist(a)

ans (a scalar) =   0
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check

check performs multiple checks on a variable and prints out error messages (by de-
fault); check is similar to is (see page 6-19), but has additional features including
error reporting, two-input comparisons, and conversions between different object
types. Both functions are useful in programming and often used interchangeably.

check only operates on variable names (you can use is if your input is an expres-
sion); check can also compare certain properties of two inputs, such as sameClass
or sameRate . See the check topic in Xmath online Help for a listing associated key-
words.

■ By default, check automatically reports an error when the keyword list does not
match the input object. If you type:

a = [1,2,3,4];
t = check(a,{symmetric})

t (a scalar) = 0 is displayed in the log area, and the following message ap-
pears in the error log window:

Specified argument to check must be symmetric.

■ To turn off reporting, specify !report in the keyword list; the status of check
is still displayed in the log area, but the message is suppressed.

The abort keyword highlights a specific argument and returns an error mes-
sage; the statement does not execute until the appropriate correction is made.

■ check  can accept two inputs, and compare them:

a = [1:4]; b = [3:5];
check(a,b,{samelength, !report})

ans (a scalar) =   0

■ check  can be used to make the following conversions:

● single channel PDM ↔ vector

● polynomial ↔ vector

● row ↔ column

When the convert keyword is used, the input is a variable; if all keyword re-
quirements are met, the input variable is converted to the appropriate keyword
format.

xb.book  Page 18  Wednesday, October 6, 1999  11:28 AM



Xmath Basics MathScript Programming

6-19

6

p=pdm([4:-.675:2])

p (a pdm) =

domain |
-------+--------
     1 |   4
     2 |   3.325
     3 |   2.65

[status,p]=check(p,{real,matrix,convert})

status (a scalar) =   1

p (a row vector) = 4 3.325 2.65

check converts p from a PDM to a vector. Please refer to the Xmath online Help
for a complete description of check  and its keywords.

is

is accepts a variable name or an expression as an input, and then determines if the
input variable is of the type specified in the keyword argument. is returns 1 if
TRUE and 0 if FALSE.

tmatrix = [1,3;0,1];
is(eig(tmatrix), {identity})

ans (a scalar) =   0

is(tmatrix, {triangular})

ans (a scalar) =   1

is can be used to report errors as follows (note that the error function can only be
used in a MathScript program):

if !(is (a,{symmetric})); error("Argument must be symmetric.")? endif

Many keywords can be used with is ; see is and check in the Xmath online Help
for details about these keywords.

6.3.3 User Interface Functions

Xmath provides the simple graphical user interface functions getline ,
getchoice , pause , error , and beep . For more sophisticated tools, see Chapter 9.
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getline

getline  pops up a dialog box with a prompt asking for input.

response = getline("Enter input here:")

The dialog box appears:

You will not be able to enter text in the command window until the dialog box is
closed. If the string returned from getline must be converted into a number, use
the makematrix  function (it is overloaded to handle strings).

response (a string) =   2.333

response = makematrix(response)

response (a scalar) =   2.333

getchoice

getchoice pops up a dialog with choices defined by an input string matrix. By de-
fault the dialog will have radio buttons, which allow only one choice. If the multi-
ple keyword is used, the dialog will have check boxes, which allow more than one
selection. If the keyword defaultChoice is specified, certain choice(s) are pre-se-
lected when the dialog appears.

choice = getChoice("The title",["Choice 1";
"Choice 2";"Choice 3"],{defaultChoice=3})

The output variable returns the user’s choice(s) as a scalar or vector.

pause

This command displays a dialog with a button that must be pressed before Xmath
will continue. pause is commonly used in .ms files to view a graph in the Graphics
window.

If a string is added to the pause command, that string will appear in the Xmath
Pause dialog.
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plot(1:10)
pause "press Continue to see the next plot"
plot(random(1,10))

You can disable pause  with the following command:

set pause off

error

error can only be used inside MathScript entities. You supply a severity code of W,
C, S, or F to signify the type of error: warning, confirmation, strong warning, or fatal.
The operating system and the error severity determine where the error is displayed:

■ For all operating systems, F aborts execution; the instruction remains in the
command area with the error highlighted, and the error message displayed in
the message area.

■ On Windows operating systems, all error messages remain in the Xmath Com-
mands window; W, C, and S settings display your message in the log area.

■ On UNIX, C and S settings display a dialog with the error message you specified.
W writes your message to the message area.

See the Xmath online Help for additional details.
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if is(Input2, {!matrix})==1
error("Not a matrix!", "F", Input2)
endif

If the error criterion is met, the string Not a matrix! is written to the commands
window message area.

beep

beep  causes an audible beep; on UNIX, it also displays a popup.

beep "this is a test"

6.3.4 Indexing Functions

This section is a brief overview of indexing functions that are useful in programs.
For detailed descriptions of these functions, see the Xmath online Help.

index

index finds the starting location of a substring within a string. If the substring is
not found -1 is returned.

s="What is the meaning of this?";
i=index(s,"this")

i (a scalar) =   24

find

find returns an index list of the elements in the matrix that meet the specified con-
dition. An index list is a matrix containing the row and column locations (the indi-
ces) of all elements that meet the condition.
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a = [20,4,-14;30,-65,0;48,582,29]

a (a square matrix) =

  20      4    -14
  30    -65      0
  48    582     29

elements = find(abs(a)>25)

elements (an index list) =

  2    1
  2    2
  3    1
  3    2
  3    3

6.4 Using the Xmath Debugger

The Xmath Debugger can be controlled interactively from the Debugger window
(Figure 6-4), or from the commands window command line. The command line de-
bugger is the only available method for Windows users and anyone running the tty
version. This section describes both interfaces.

Note that debug mode starts under three circumstances:

■ A call is made to a program that is set up for debugging.

■ A program contains a syntax error. A syntax error is an error in punctuation, for
example, a missing brace: plot(a,{xlab="A missing brace") .

■ A program contains a runtime error. A runtime error occurs when an instruc-
tion is impossible to process. The following statement would cause a runtime er-
ror because the objects are incompatible: x=5 + "hello" .

6.4.1 Debug

You can use the debug command to define and set break for a program. In the com-
mand window command area, type:

debug program_name

If you activate debug for a program, the debugger opens automatically on the first
executable line in the script whenever you call the entity. While in debug mode you
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can step through your file and evaluate any expression or run any command. In ad-
dition, the NEXT and SET BREAK commands can be used to debug nested functions.

FIGURE 6-4 Xmath Debugger Window in Debug Mode (UNIX)

Menu Bar

Debug Mode

Buttons

Error
Message

Filename
Line #

Suspected
Error

Location of
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6.4.2 Debug Mode

In addition to the above cases (where you are intentionally debugging a specific MSF
or MSC), a programming error also invokes the Debugger window in debug mode
(see SET DEBUGONERROR).

Entering Debug Mode

■ All windows say “(Debugging)” in the title area (at the top) when you are in de-
bug mode. In the Debugger window, the full filename of the entity being de-
bugged is displayed just below the menu bar.

In the command line debugger, the command prompt will change to:
(program)Debug> .

■ If the Debugger window was opened because the file contains a syntax error, the
Next button is enabled (see Figure 6-4). If there are multiple errors, the Next Mes-
sage and Previous Message button is also enabled. You can repair a syntax error,
then continue to step through your file or look at the previous message.

Stepping Through a Script

■ In the command line debugger you can step forward, using the next command,
or continue execution with the go command.

■ You can set and remove break points from the Debugger window or the com-
mand line (see Section 6.4.3).

■ You can set and remove watch points from the Debugger window or the com-
mand line (see Section 6.4.4).

Exiting Debug Mode

■ To stop debugging from the Debugger window, click End Debug .

■ To stop debugging from the command line, type abort .

In the Debugger window, the word Debugging disappears from the title area of all
windows. This mode is referred to as Edit mode.

To close the window select File→Close Window. To stop debugging and close the de-
bugger in one step, place the cursor over the Debugger window and type Ctrl-W (for
workstations only).
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Editing a File in the Debugger Window

When the Debugger window is not in debug mode, it is acts as an editor. To fix your
script, click into the Debugger window and make your change. If you modify the
script via the Debugger window, the Save and Revert buttons become active, and you
can no longer step through. Before saving, make sure that the script file is not open
in any other editor.

The Debugger window provides the same simple editing capabilities available from
the Xmath Commands window command area (Section 1.5.3 on page 1-14). You can
manually open the debugger by selecting Windows→Debugger. To edit a file, select
File→Open. The file appears in the window. Once you make a change, the Save and
Revert  buttons are activated.

SET DEBUGONERROR

The environmental setting debugonerror determines the mode in which the de-
bugger will appear.

■ The default setting is On. If an error is detected in a program, Xmath opens the
debugger and redirects focus to the Xmath Debugger window (see page 6-25).

■ If debugonerror is set to On, and you have activated debugging for a program
with debug program_name , the debugger opens in debug mode whenever the
entity is called.

■ If debugonerror is set to Off , and you have activated debugging for a program
with debug program_name , the debugger opens whenever the entity is called,
but focus stays in the commands window.

6.4.3 Setting, Showing, and Removing Breakpoints

A breakpoint causes the debugger to stop execution at a specific line number in the
source, provided that set debugonerror on  is in effect (the default).

■ If you issue the command DEBUG NAMEa break is automatically set on the first
executable line of the script, causing the debugger to open whenever that script
is called.

■ You can set a breakpoint interactively in the Debugger window, or from the
Commands window command area.

NOTE: In order to set a breakpoint interactively, the file in which you wish to
set or remove breakpoints must currently be open in the Xmath
debugger in debug mode.

xb.book  Page 26  Wednesday, October 6, 1999  11:28 AM



Xmath Basics MathScript Programming

6-27

6

● To set a breakpoint in the Debugger window, position the cursor in the line
where you want to break execution, then press the Set Break button. Note
that when you position the cursor in the Debugger window, the line number
is shown below the filename on the upper left.

or

● Go to the command area and type:

SET break lineNumber

■ To see a list of the breakpoints you have set, go to the command area in the
Commands window and type:

SHOW break

A list of breakpoints will appear in the format fileName:Line_Number . You
will see breakpoint line numbers for all entities that have debugging enabled.

■ Breakpoints can be removed via the commands window with the REMOVEcom-
mand. (Again, you must be viewing this script in debug mode.) Go to the com-
mand area and type:

REMOVE break lineNumber

As mentioned earlier, all scripts that have been called or explicitly defined auto-
matically have a breakpoint set on the first executable line. Type SHOW debugto
see the files you are debugging.

■ To run a file without stopping at its breakpoints, go to the command area and
type:

DEBUG program_name off

Note, however, if the script contains an error, the debugger will open regardless.

6.4.4 Setting and Removing Watchpoints

A watchpoint causes the debugger to stop execution whenever a watched variable is
modified.

You can set a watchpoint interactively in the Debugger window, or from the com-
mands window command area. The script containing the variable you want to watch
must currently be shown in the debug window in debug mode:

■ To set a watchpoint interactively, go to the Xmath Debugger and highlight the
variable you want to watch, then press the Set Watch  button.
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■ To set a watchpoint with the set command, go to the commands window com-
mand area and type:

set watch varName

Now you can use the commands window to display the values of variables that are
local to the current MSF or MSC.

To see a list of the variables you are watching, go to the Commands window com-
mand area (while in debug mode) and type:

show watch

A listing appears in the format functionName:varName .

Watchpoints can be removed via the commands window with the remove command.
The entity containing the watchpoints you want to remove must currently be shown
in the debug window in debug mode. Go to the command window command area
and type:

remove watch varName

If you want a function to run without stopping at the watchpoints but you do not
want to remove them, type

debug program_name off

in the command area.

6.4.5 Debugger Window Interface

This section describes the Xmath Debugger’s user interface.

Fields

The filename of the function being debugged is displayed just below the menu bar.

The top field in the window contains the source of the MSF or MSC that you are de-
bugging. The line that is about to be executed is highlighted (unless there are errors
in the function, in which case the highlighted line points to the error). The source
field is read-only unless you have write privileges to the source file. The middle field
is the message area. Status and error messages that occur while debugging are dis-
played here.
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Menus

The enabled menus are the File menu and the Windows menu. The File menu allows
you to edit another MSF or iconify the debugger. The Windows menu allows you to
quickly find other Xmath windows and bring them to the foreground.

Buttons

Next Message — Enabled when there are multiple errors. This button highlights the
next line that contains an error (assuming you are not at the bottom of the list).

Previous Message — Enabled when there are multiple errors. This button highlights the
previous line that has an error (assuming you are not at the top of the list).

Redisplay — Refreshes the window.

Edit On/Off — Toggles the source to be editable or read only. You may want to toggle
edit off to prevent accidental edits.

Save — Enabled whenever you make changes to the source. Pressing this button
saves your changes to the file.

Revert — Discard edit changes and load the last saved version of the file.

Next — Executes the next line of code.

Go — In debugging, causes the function to run until a break point is encountered, a
watched variable is modified, or the end of the file is reached.

Rerun — Enabled after source changes have been saved. Press to rerun the function
with previous inputs.

Set Break — Sets a breakpoint on the current line (where the cursor is in the source
field). Xmath will pause function execution at any breakpoint(s) you set. To do
this from the command area, see the Xmath online Help under set break.

Set Watch — Sets a watch on a variable. To watch a variable, use the pointer to high-
light the variable name, then press this button.

End Debug — Exit debug mode; no arguments will be returned from the function.
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6.5 Advanced Topics

This section includes the following topics:

■ Variable arguments

■ Executing a function at a specific directory

■ Partition and variable directory functions

■ MathScript command output and error capture

■ Programming for platform independence

6.5.1 Variable Arguments

When you use the colon (:) index operator in a MathScript entity declaration, the
program handles a variable number of inputs, outputs, or keywords. The function
argn returns the number of a program’s arguments, while argv extracts the value
and name of the argument.

argn

argn returns the number of inputs (the default), keywords, or outputs for a Math-
Script entity (see Example 6-5). To get the number of keywords, specify the key-
word, keywords;  to get the number of outputs, specify the keyword, outputs .

EXAMPLE 6-5: argn

function [args]=howmany(:)
   args=argn()
endfunction

Example 6-5 counts the number of inputs. For example, howmany(1,1,1,1 ) re-
turns 4.

argv

argv allows you to index into the inputs, keywords, or outputs for a program. argv
can return the value and/or name of the argument; for argv to return the name of
the argument, however, it must be a keyword. To return the name of an output, the
calling statement must use output keywords (see Output Keywords on page 6-7).
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Using argn and argv

Example 6-6 uses the arg n to determine the number of inputs and loop over them
accordingly. argv gets the value of each argument, and then the length is deter-
mined for the output.

EXAMPLE 6-6: argv  combined with argn

function out=howlong(:)
n=argn();
for i=1:n
  in=argv(i)
  out(i)=length(in);
endfor
endfunction

x=howlong(rand(2,3),1:7,pdm(ones(4,5),{rows=2}))?

x (a column vector) =

   6
   7
  10

Example 6-7 accepts any number of scalars; it displays a message when the key-
word reply  is specified but not otherwise.

EXAMPLE 6-7: msg.msf

function [out]=msg(:,{reply})

ni=argn()
nk=argn({keywords});
[v,n]=argv(ni);
ni=ni-nk;
if n=="reply"
  key=1;
else
  key=0;
endif

for i=1:ni
  if is(argv(i),{!scalar})
     error("Scalars Only!", "C");
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  else
     out(i)=argv(i);
  endif
  if key==0  & i==ni
    out;
  endif
  if key==1 & ni==1
    display "Thanks for the scalar!" ;
  elseif  key==1 & i==ni
    display "Thanks for the " + string(ni) + " scalars!" ;
  endif
endfor

endfunction

msg(1,1000,pi,{reply})

Thanks for the 3 scalars!

ans (a column vector) =

     1
  1000
     3.14159

msg(5,5,9)

ans (a column vector) =

  5
  5
  9

Example 6-8 provides the function varargs , which has a variable number of out-
puts, inputs, and keywords. In the following call

[out1=fop1,out2=fop2]=varargs(1,2,3,{k=9})

note that we define two outputs (fop1 , fop2 ), three inputs, and one keyword (k ).

Within the function, argn is used to determine the number of arguments, and argv
is used to determine the name of the arguments. Note the use of the
[value,name]=argv(i,{keywords}) syntax for inputs and keywords and the
name=argv(i,{outputs}) syntax for outputs. Note also that the function itself
does not assign a value to the outputs.
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The output of the above call appears in Example 6-9. The names of the keyword and
the outputs appear in the output stream; the names of other input arguments are
null.

EXAMPLE 6-8: varargs.msf  Using argn  and argv

function [:] = varargs(:,{:})

for i=1:argn({keywords})
[v,n] = argv(i,{keywords})?            # display value and name of
end                                    # keyword inputs
display “-----------------------------------------------------”n”

for i=1:argn({!keywords})
[v,n] = argv(i,{!keywords})?           # display value and name
end                                    # of non-keyword inputs
display “-----------------------------------------------------”n”

for i=1:argn()
[v,n] = argv(i)?                       # display value and name
end                                    # of all inputs
display “-----------------------------------------------------”n”

for i=1:argn({outputs})
n = argv(i,{outputs})?                 # display name of all outputs
end

endfunction

EXAMPLE 6-9: Output of varargs.msf

v (a scalar) =   9
n (a string) =   k
------------------------------------------------------
v (a scalar) =   1
n is null
v (a scalar) =   2
n is null
v (a scalar) =   3
n is null
------------------------------------------------------
v (a scalar) =   1
n is null
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v (a scalar) =   2
n is null
v (a scalar) =   3
n is null
v (a scalar) =   9
n (a string) =   k
------------------------------------------------------
n (a string) =   fop1
n (a string) =   fop2

To assign values to the outputs fop1 and fop2, the function needs an assignment
statement(s), which must be a text string. For example, the following loop assigns
the outputs with the values 1 and 2, respectively:

for i=1:argn({outputs})

      n = argv(i,{outputs})

execut e n + "=" + string(i) + ";"; # assign i to the i'th output

endfor

6.5.2 Executing a Function at a Specific Directory

The function assignment syntax used in calling an LNX in background mode allows
a directory to locate the function to be specified with a keyword. For example:

[out] = (define myfunc, {directory="mydir"})(1,2,3)

where Xmath calls the MSF or LNX function myfunc in the directory mydir , leaving
an existing definition of myfunc  unchanged.

6.5.3 Partition and Variable Directory Functions

The function directory allows directory listings of Xmath partitions and variables
to be captured as vectors of string names. The directory function requires one in-
put, a string containing a wildcard as used in the command WHO, and produces one
output, a vector of names of partitions and variables as produced by the command
WHOusing the specified wildcard. The names are always full names, and the parti-
tion name is always prefixed. The syntax is shown in the following example:

out = directory("main.*")

where the variable out will contain a vector of strings of the variable names found in
main  (for example, main.a , main.b , etc.).
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6.5.4 MathScript Command Output and Error Capture

The following syntax allows the textual output and error messages of a MathScript
command to be captured in MathScript variables as string values:

[ outputs  = format, errors ] === statement

or

[ outputs , errors ] === statement

where outputs and errors are MathScript variable names and statement can be
any valid MathScript statement. The format keyword formats the output in a com-
mand-dependent way; see the examples below for details.

If the outputs variable is specified, the textual (nongraphical) outputs of state-
ment , if any, are inserted into the outputs variable instead of displaying in the
Xmath log area of the Commands window. If the outputs variable is omitted, the
output of statement  is displayed normally.

If the errors variable is specified, Xmath will suppress normal processing (error lo-
cation highlighting, bringing up the Debugger window, and stopping command exe-
cution) of any errors generated by statement . Instead, the error messages are
converted to text and inserted into the errors variables. If errors is omitted,
Xmath performs normal error processing of errors generated by statement .

This error capture feature allows a program to perform error handling of commands
that may fail as shown in the following Examples section.

Examples

In the following example of error handling, if the variable name contained in the
string varname is a legal Xmath variable name, err would be a null; otherwise, err
would contain an error string. For example:

varname = getline("Please enter an Xmath variable name:");
[,err]===execute varname + "=1;"

In the following example of error handling, any error calling myfunc is converted
into an error message and inserted into err  as a text string:

[,err] === myfunc(123)

In a similar example, the variable out captures the output of the Windows dir com-
mand in a string:

[out] === oscmd("dir")
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In the following example, out  contains a formatted version of the captured output:

[out=format] === statement

Currently, the WHOand SHOW PARTITIONScommands support this formatting. The
directory function described in Section 6.5.3 on page 6-34 uses both these com-
mands. For example,

DIRECTORY("main.*")

actually executes this statement:

[out=format] === who main.*

The captured output is a vector of strings containing the names of the variables in
the partition main .

When [out=format] is used with other statements that don’t support formatting,
the captured output will be a vector of strings, each of which contains a line of out-
put. By default, the length of the row vector out is the number of strings (and there-
fore the number of lines in the captured output). You can transpose out to see the
output strings as they are normally displayed in the Xmath log area.

[out=format] === rand(2,2)
size(out)
out'?

NOTE: This syntax cannot be nested.

6.5.5 Programming for Platform Independence

While MathScript is portable across UNIX and Windows platforms, calls to the oper-
ating system are platform-dependent. For example:

oscmd("ls *.xmd") # UNIX
oscmd("dir *.xmd")  # Windows

With the MathScript function platform , you can program a command so that it
can be run on either platform. For example:

if platform() == "UNIX"
   oscmd("ls *.xmd")  # UNIX
else
   oscmd("dir *.xmd") # Windows
endif

Another problem area with cross-platform programming is the directory path name
syntax difference. The get({path}) function is useful in reconciling these
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differences. The COPYFILE command, for example, makes use of the get({path})
function to provide a platform-independent way of copying files. For more informa-
tion, see the Xmath online Help.
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7 MathScript Objects

This chapter outlines the procedure for writing and using your own MathScript ob-
ject (MSO). Before writing an MSO you should have a good understanding of object-
oriented concepts and Xmath objects in particular. Chapter 5, Data Objects and Op-
erators, introduces each intrinsic Xmath object and the operators that are over-
loaded for that object. You should also be proficient in the MathScript language
(Chapter 3 and Chapter 6).

As described in Chapter 5, you can easily augment these intrinsic objects by design-
ing your own custom objects using MathScript.

7.1 MSO Overview

The MathScript object feature enables you to create custom high-level objects for
use in the Xmath environment. Object development in Xmath fundamentally in-
volves determining what data defines the instance of an object, writing the initializer
function and creating the various commands, functions, and operators which can
manipulate object instances. The complete definition of an object and its behavior is
encapsulated within an MSO file. The structure and contents of an MSO file are de-
scribed in greater depth in subsequent sections.

Careful thought should be used when developing objects, especially those which will
be shared among a number of people. The object author should design, test, and
document objects before allowing others to use them. Once an MSO is in use, any
changes to the definition of the class variables will create inconsistencies between
current and future instances that may be difficult to identify.
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7.1.1 Object Instantiation

Once an object is defined by creating an MSO file, object instances can be created
from the Xmath command line or within any script using the following syntax:

instance = myobject( parameters );

This statement executes the object’s initializer function with the supplied input pa-
rameter(s). The output of this expression is an object instance. An object instance is
recognized as an Xmath variable; this implies that it can be operated on by Xmath
commands such as SAVE, LOAD, and DELETE, copied with the assignment opera-
tion, passed as a parameter to a function or command, and returned as a function
output.

The object instance is a container that stores the persistent class variables that
characterize a particular instance. The syntax for accessing a class variable is the
same as the syntax for addressing a variable in another partition. For example, if an
object named myobject contains a class variable named sigma , then that variable
can be accessed with the following statement:

instance.sigma

7.1.2 MSO File Format

MSO file format structure adheres to the rules in Sections 6.1.3 and 6.1.4 on
page 6-4, with one exception. The MSO file format accommodates multiple con-
structs in a single file. This enables you to use a single file to define the object, over-
load or create pertinent functions and commands, and overload operators to
support the new object. Example 7-1 illustrates the structure of an MSO file.

EXAMPLE 7-1: Sample MSO File Format

#{
Block comment used as Help for this object.
}#

Object[x1,...] = mymso(in1,..., {kwds})
... MathScript statements
endObject

Operator z1 = +(<type>left,<type>right)
... MathScript statements
endOperator
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Function[y1,...] = memFun(<type>a,..., {kwds})
... MathScript statements
endFunction

Command memCmd <type>input {kwds}
... MathScript statements
endCommand

■ If Xmath online Help is desired, supply a Help file or begin the file with com-
mented text that will serve as the Help text.

NOTE: You provide online Help for MSOs the same way as for MSFs and
MSCs; see Section 6.1.6 on page 6-8 for more details.

■ The body of the file consists of programming constructs. The first construct in
the file must be the initializer function for the object. The initializer function con-
tains the MathScript statements which are executed by Xmath whenever a new
instance of this object is created. The initializer function is explained in greater
detail in Section 7.2.

■ Optional constructs to define or overload MathScript functions and commands
that act on your object can follow the initializer function in any order, as dis-
cussed in detail in Section 7.4 on page 7-11.

■ Optional constructs to overload operators can also appear anywhere after the
initializer function, as discussed in detail in Section 7.3 on page 7-6.

7.1.3 Using MSOs in Xmath

The process for defining an MSO is identical to that for other MathScript entities
(see Section 6.1.7 on page 6-9). Just include the MSO files you need in your Xmath
path. Alternatively, you can define them explicitly with the DEFINE command:

define mymso,{directory="/myHome/myobjects/my_mso"}

Xmath dynamically loads an MSO definition into memory only when it is necessary.

7.2 Initializer Function

The initializer function is a special function that is executed to create a new in-
stance of an object. It is the only required component in an MSO, and it must be the
first construct in the MSO file following the optional Help text. The syntax for an ini-
tializer is the same as MathScript functions, except that the initializer is declared
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between the statements Object and endObject . All other rules in Sections 6.1.3
and 6.1.4 on page 6-4 apply.

A simple initializer function is shown below.

Object[y]=mymso(a1,{b1})
... MathScript code
endObject

7.2.1 Class Variables

An object instance is characterized by persistent variables that are stored within the
object instance, similar to the way variables are stored within a partition. The ini-
tializer is responsible for creating an instance and storing the class variables within
the instance. After object instances have been created, any other constructs defined
in the MSO file can access the class variables.

There are three types of class variables: required, optional, and computed. Examine
the following code fragment:

Object[y1]=mymso(a1,{b1})
... MathScript code
endObject

■ Required variables, such as a1 in the example above, must be specified by the
user when the object instance is created.

■ Optional variables, like b1, are optional input arguments to the initializer.

■ Computed variables, such as y1 , are calculated by the initializer, typically as a
function of the input arguments.

Any number of required, optional, or computed class variables may be defined for
an object. The DEFAULTcommand is sometimes useful to give optional and com-
puted variables a default value.

When the initializer completes execution, a class variable that exists within the
function scope will be stored within the object instance. The MathScript statements
within the initializer can modify or delete any class variable. As a result, required,
optional, or computed arguments may or may not exist within an object instance,
depending on statements in the initializer.

Variables created in the body of the initializer that are not class variables are con-
sidered temporary and are automatically deleted when the initializer completes exe-
cution. If you want a variable to be persistent, specify it as a computed variable.
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When an object initializer is called, the result of that statement is always a single in-
stance of the new object. The defined outputs, such as y1 in the above initializer
function, are used to create a computed class variable (as opposed to the output of
an ordinary function).

The following is a sample initializer function for the new object mysys . Note that this
object does not have any computed variables. They are not required.

Object mysys(a,b,c,d, {dt})
... MathScript code
endObject

You would create an instance of mysys  as follows:

inst= mysys(1,2,3,4);

After the input variables are created within the object and given their appropriate
values, the initializer is called in the scope of the inst object. The initializer checks
the arguments for correctness, sets any optional arguments that require a default
value, and then calculates the output arguments based on the inputs. When the ini-
tializer is complete, all local variables are deleted from the object.

7.2.2 Nested Objects

Any class variable can be an instance of another object. As a result, you can create
quite complex nested object hierarchies. If a required or optional class variable is an
object, the user must create an instance of the nested object and supply it as an in-
put to the initializer. If a computed class variable is an object, the initializer itself
will create the instance of the nested object.

Let’s say you had the following nested object embedded within two other objects.

Object nested(z)
... MathScript code
endObject

Object supplied(<nested> x)
... MathScript code
endObject

Object [x] = computed(y)
x=nested(y)
delete y
endObject
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To create an instance of the object supplied , the user would type the following:

a = nested(1);
b = supplied(a);

However, to create an instance of the object computed , the user only types the fol-
lowing:

c = computed(1);

7.2.3 Type Declaration

Type declarations are qualifiers that can optionally precede each input argument for
functions, commands, and operators defined in an MSO. They create a restriction
that an argument must be an instance of a particular type of object.

The syntax of a type declaration is to specify the name of an MSO within a set of an-
gle brackets immediately before any input argument.

Object[x]= mymso(in1,<alien>in2)
... MathScript
endObject

In the initializer function shown above, the type declaration <alien> specifies that
any instance of an object of type alien  will be accepted as the second argument.

Arguments that do not have a type declaration indicate that any object will be ac-
cepted when this function, command, or operator is called.

The Xmath interpreter uses type declarations for two purposes:

■ Ensure that parameters passed to user-defined functions and commands are
the correct type. If a mismatch is encountered, Xmath will automatically gener-
ate an error message.

■ Facilitate function, command, and operator overloading by limiting the use of
certain constructs to a specific combination of input arguments. The use of type
declarations to achieve overloading is described in detail in a later section.

7.3 Operator Overloading

The ability to customize the behavior of operators in Xmath to manipulate MSOs is
called operator overloading. Operator definitions containing MathScript statements
that should be executed to achieve the desired behavior are placed within an MSO
file. The syntax of an operator definition is similar to that of a function definition,
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with the exception that the operator behavior is declared between the Operator
and endOperator statements. For example, to define the plus (+) operator to add
two apple objects together, you would insert the following construct in apple.mso .

Operator y = + ( <apple>left, <apple>right)
... MathScript code
endOperator

Multiple operator definitions may be required for the same operator to completely
define all possible object combinations. For example, if you have an apple.mso and
an orange.mso , you would need the following three operator definitions in addition
to the one above to describe all possible combinations of adding apples and oranges.

Operator y = + ( <apple>left, <orange>right )
... MathScript code
endOperator

Operator y = + ( <orange>left, <apple>right )
... MathScript code
endOperator

Operator y = + ( <orange>left, <orange>right )
... MathScript code
endOperator

Operator definitions can be inserted in any of the MSO files that are declared as ar-
guments. So the two operators that combine apples and oranges can appear in ei-
ther the apple.mso or the orange.mso . However, because Xmath searches MSO
files from the left argument to the right argument, it is more efficient to put the op-
erator definition in the MSO file corresponding to the first argument.

Type declarations, like <apple> , tell the Xmath interpreter which operator defini-
tion to choose from when performing operations that deal with objects. For unary
and binary operator definitions, at least one of the arguments must have a type dec-
laration for the MSO in which the operator definition resides.

Type declarations are not required on all arguments. If a type declaration is not
specified, Xmath will accept any variable for that argument. For example, the follow-
ing operator will add an apple object to any type of object including intrinsic Xmath
objects such as matrices, strings , etc.

Operator y = + ( <apple>left, right )
... MathScript code
endOperator
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The MathScript code within such an operator should check unqualified arguments
and restrict inputs to the object types that the MathScript code can properly handle;
an error should be returned if the conditions are not met.

Operators that can be overloaded are listed in Table 5-1 on page 5-6.

Unary operators act on a single variable and their operator definitions will have only
one input argument. Binary operators act on two variables and their definitions will
have two input arguments. The - operator is both a unary and binary operator and
Xmath will automatically select the correct definition from an MSO file based on the
number of declared arguments.

Operator y = - ( <apple> arg)
... MathScript code
endOperator

Operator y = - ( <apple>left, <apple>right )
... MathScript code
endOperator

The comma and semicolon operators are special operators that can accept two or
more operands. For example the following operator definitions describe two combi-
nations of different types of objects manipulated by the comma operator.

Operator y = , ( <obj1>one, <obj2>two )
... MathScript code
endOperator

Operator y = , ( <obj1>one, <obj2>two, <obj3>three )
... MathScript code
endOperator

The comma operator definitions above would correspond to the following two types
of expressions, assuming a, b, and c  are of the appropriate type:

case1 = [a,b];
case1 = [a,b,c];

The comma and semicolon operators can also be used in compound expressions. In
the following example, a and b would first be resolved using the appropriate comma
operator to produce an intermediate result, then, c and d would be resolved with
the appropriate comma operator to produce a second intermediate result. Finally,
the two intermediate results would be resolved with the appropriate semicolon oper-
ator.

result = [a, b; c, d];
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When the comma or semicolon operators act on an operand of heterogeneous types,
a separate operator definition is required for each specific combination of operands,
as was illustrated in the above examples. However, the variable argument con-
struct (:) can be used when all operands are of the same type (see Section 6.5.1 on
page 6-30). The variable argument construct also has the advantage that a single
operator definition can generically handle any number of operands. The following
definition of the comma operator illustrates the variable argument syntax:

Operator y = , ( <special>: )
n = argn();
for i = 1:n
  x = argv(i);
  y = ...
endfor
endOperator

The colon argument (:) instructs Xmath that any number of operands will be ac-
cepted by this definition, all of which must be of type special . The argn function,
which requires no inputs, will return the number of operands. The argv(i) func-
tion accepts an integer between 1 and the number of operands and will return a
copy of the requested operand. Consequently the variable argument operator defini-
tions can be generically programmed with loops to handle any number of homoge-
neous operands.

The insertion and extraction index operators are also special operators. The inser-
tion index operator enables indexing into an object instance on the left side of the
equal sign in an expression. In the following example, inst is an instance of an
MSO called myObj , and the following expression attempts to insert 10 into the sec-
ond element of the inst  object.

inst = myObj(a);
inst(2) = 10;

The extraction index operator enables indexing into an object instance on the right
side of the equal sign in an expression. For example, the following expression at-
tempts to extract the value from the fifth element of the inst  object.

ans = inst(5);

The definition of the insertion and extraction index operators would have the follow-
ing structure and would reside in the myobj.mso  file.
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Operator Object(i) = y
... Mathscript code
endOperator
Operator y = Object(i)
... Mathscript code
endOperator

The argument i would contain the element indices 2 and 5 from the above examples
at runtime. The argument y would contain the value to be inserted or the result to
be extracted to or from the object. The MathScript code within the index operator
should check and restrict the input arguments (i and y ) to only object types with
values that the MathScript code can properly handle; an error should be returned if
the conditions are not met.

The word Object in the above declarations is a reserved token which instructs
Xmath that this is a special operator that will execute directly within the scope of
the object instance. In other words, the MathScript code within these operators can
directly access the class variables within the instance. For example, let’s say the
variable x is a class variable of myObj . The MathScript code within a binary plus (+)
operator would have to reference x with the statement left.x or right.x , but the
index operator can reference x directly with the statement x . Take care that the de-
clared arguments of the operator (y and i) do not overwrite the class variables of
the object.

The index operators can accept any number of operands, as long as an operator def-
inition with the appropriate number of arguments resides in the object’s MSO file.
To also handle two-dimensional indexing for the myObj example object, the follow-
ing two operators, each with two index arguments, i  and j , would be required.

Operator Object(i,j) = y
... Mathscript code
endOperator

Operator y = Object(i,j)
... Mathscript code
endOperator

The index operators also support the variable argument construct to handle any
number of operands generically. The following extraction index operator illustrates
the variable argument syntax for the index operator.
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Operator y = Object(:)
n = argn();
for i = 1:n

x = argv(i);
y = ...

end
endOperator

7.4 Member Functions

Your MSO should include any functions or commands that use your object.

■ Member functions and commands behave like MSFs and MSCs with the excep-
tions that they cannot be debugged individually unless they are uniquely
named.

Once your MSO is defined, MSO member entities can be called from the Xmath
command area, or other MathScript files.

■ You can overload existing commands and functions to operate on your object.
For example, the following function overloads the function max to accommodate
the MSO type group .

function [out]=max(<group>a)
   out=max(a.data)
endfunction

When a function or command is overloaded, its behavior is limited to the cases
specified in the function header. For example, the overloaded version of max will
only be enabled if the input is a group object.

■ The file need not contain all the code for each new function or command. Using
LNXs for complex numerical operations will speed up execution considerably.

■ You can identify member functions with the whatis  command. For example:

whatis other

other is a member function (./other.mso)

■ Member function and command definitions do not include Help text; their Help
text should be included with the Help text for the MSO.
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7.4.1 Sample MSO

The MSO shown in Example 7-2 defines an object named group . This MSO will ac-
cept any single row matrix. This MSO overloads the min and max functions to sup-
port this object. It also overloads binary and unary minus (-), *, +, and binary and
unary equality. You can find this example in $XMATH/examples/mso/group.mso .

EXAMPLE 7-2: group.mso

#{--------------------------------------------------------------
The group object is an unordered collection of unique whole numbers
which can be manipulated by operators that adhere to conventional set
theory. We are using the name "group" for this object so it does not
conflict with the "set" command in Xmath.

A new group is defined using the group initializer. For example:

      s1 = group( [1,2,3,4] );
      s2 = group( [3,4,5,6] );

Binary group operators are defined as follows:

      A + B = union of A and B
      A - B = difference, the elements of A
              which are not in B
      A * B = intersection of groups A and B

   Unary group operators are defined as follows:

       - A  = inverse of all the elements of A
--------------------------------------------------------------}#

Object group( data )
   if( !check(data,{rows=1,!report}))
      error("Parameter 'data' must be a single row matrix","F")
      return
   endif

   data = sort(data); // check for duplicate elements
   [,n] = size(data);
   for i = 1:n-1
      if data(i) == data(i+1)
         error("Non-unique element","F",data);
      endif
   endfor
endObject
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#------------------------------------------------
# Overload of max
#------------------------------------------------
function [out]=max(<group> a)
   out=max(a.data)
endfunction

#------------------------------------------------
# Overload of min
#------------------------------------------------
function [out]=min(<group> a)
   out=min(a.data)
endfunction

#------------------------------------------------
# Unary Minus
#------------------------------------------------
Operator y = - (<group> a)
   y = group(-a.data);
endOperator

#------------------------------------------------
# Difference
#------------------------------------------------
operator y = -(<group> a, <group> b)
   [,cols]=size(a.data)
   y = null;
   temp = null;
   for i = 1:cols
     loc = find(a.data(i) == b.data )
     if( loc == null )
       temp = [temp,a.data(i)];
     endif
   endfor
   if (temp <> null)
      y = group(temp);
   endif
endoperator

#------------------------------------------------
# Intersection
#------------------------------------------------
operator y = * (<group> a, <group> b)
   [,cols]=size(a.data)
   y = null;
   temp = null;
   for i = 1:cols
     loc = find(a.data(i) == b.data )
     if( loc <> null )
       temp = [temp,a.data(i)];
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     endif
   endfor
   if (temp <> null)
      y = group(temp);
   endif
endoperator

#------------------------------------------------
# Union
#------------------------------------------------
operator y = + (<group> a, <group> b)
   c = b - a;
   y = group( [a.data,c.data] );
endoperator

#------------------------------------------------
# Equality
#------------------------------------------------
operator y = == (<group> a, <group> b)
   y = 0
   [,acols]=size(a.data)
   [,bcols]=size(b.data)
   if( acols <> bcols )
     return
   endif
   res = a.data==b.data
   if( check(res,{nonzero,!report}) )
     y = 1
   endif
endoperator

#---------------------------------------------------------------
# Index Operators
#---------------------------------------------------------------
Operator Object(i) = y
   [r,c]=size(y);
   if (r <> 1 & c <> 1)
         error("Invalid insertion data","F",y);
   endif
   data(i) = y;
endOperator

Operator [y] = Object(i)
   y = data(i);
endOperator

#---------------------------------------------------------------
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7.4.2 Limitations

■ Member entities and operators cannot have their own online Help.

■ You cannot explicitly define or debug a member function, command, or opera-
tor, only the object initializer. Consequently, if you alter the definition of a mem-
ber entity, you must UNDEFINE it before the new definition can be used.

■ A MathScript object cannot be passed into an LNX, but the class variables from
a given instance can be passed into an LNX as other variables are.

■ You cannot assign or access a variable using an expression that contains more
than one dot. This implies that if an object instance contains another MSO as a
class variable, you cannot directly access the class variables of the nested ob-
ject. For example, the following syntax is not allowed:

x = obj1.obj2.var;

This limitation can be circumvented if you use a temporary variable:

temp = obj1.obj2;
x = temp.var
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8 External Program Interface

This chapter describes the three Xmath interfaces for user programs written in C,
C++, or FORTRAN:

■ The User-Callable Interface (UCI) mechanism allows a user program to call
Xmath as a server.

■ The LNX (LiNked eXecutable) mechanism allows a subroutine in a user program
to be callable by Xmath as if it were a regular MathScript function.

■ Any C or C++ program can call the functions XmathSave and XmathLoad to
save and load Xmath data files.

8.1 Overview

A user program using the LNX or UCI mechanism is termed an LNX or UCI program,
or simply an LNX or UCI. Table 8-1 summarizes the differences between an LNX and
a UCI.

TABLE 8-1 LNX and UCI Comparison

Feature Comparison

Purpose A UCI starts Xmath; an LNX is started by Xmath.

Data Structure Both use the same data structure, the externType .

Functions UCI: Must use XmathStart  and XmathStop ; must not use
XmathMain .

LNX: Must use XmathMain ; must not use XmathStart  or
XmathStop .
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Xmath also provides two functions, XmathSave and XmathLoad , which allow an ex-
ternal program to save and load Xmath data.

The Xmath directory $XMATH/src contains code examples for the LNX and UCI util-
ities, as well as a sample makefile . $XMATH/include has include files for LNX
and UCI scripts.

8.1.1 LNX

The LNX utility allows you to invoke C, C++, or FORTRAN subroutines from within
Xmath. Once an LNX is built, it can be used in the same manner as any MathScript
function. Furthermore, an LNX can be invoked in background mode so that it can
run in parallel with Xmath.

Sample LNX Program

An LNX written in C program has the layout shown in Figure 8-1. Each LNX pro-
gram contains one LNX function. The LNX function performs a specified calculation
and has the following format:

void LNXfunc(nlhs, lhs, nrhs, rhs)
int nlhs, nrhs;
externType **lhs, **rhs;
{
  ...
}

The input arguments reside in an array of externType pointers to which the vari-
able rhs (right-hand side) points. The integer nrhs (number of right-hand side ar-
guments) defines how many externType  pointers are in the array.

An LNX function writes its outputs to lhs , which is an array of nlhs pointers allo-
cated by Xmath. For example, if nlhs=3 (indicating that your LNX was called with

Build Both must include a C header file called xmathlib.h and link
with a library called libXmath.a  (for UNIX) and xmath.lib
(for Windows).

Running UCI: Start Xmath with -call (a switch that triggers the UCI),
the program that is calling Xmath, and any other desired star-
tup options..

LNX: An LNX can be called just like any other MathScript
function.

TABLE 8-1 LNX and UCI Comparison (Continued)
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#include "xmathlib.h"

void LNXfunc(nlhs,lhs,nrhs,rhs)
int nlhs, nrhs;
externType **lhs, **rhs;

{
/* test for errors in input data */

if (condition){ /*input data errors*/
XmathError(ERROR_FATAL, "error msg",1);
return;
}

/* code */
}

static functionData fdata[]={

{"myLNX",LNXfunc,

1,3,1,3,

"myLNX takes the first input ..."},

{0}

};

main(argc,argv)
int argc;
char** argv;
{
   ...

XmathMain(argc,argv,fdata,0);
  ...

return 0;
}

externType is a data structure defined in
xmathlib.h. The variables nlhs and nrhs
specify the number of left-hand side and
right-hand side arguments (inputs and
outputs). Each element in the lhs array holds
an output variable pointer; each element in
the rhs array holds an input variable pointer.

Required header file

Main program must call XmathMain

Table of function data

Main program

FIGURE 8-1 Typical C Language LNX Program Format

Argument number in error

Residency flag (0 or 1)

Minimum # of inputs,

minimum # of outputs,

Severity is defined in xmathlib.h

Help text

Return 0 is mandatory

maximum # of inputs,

maximum # of outputs

Error message

LNX function pointer
the name of the LNX
(currently unused)

xb.book  Page 3  Wednesday, October 6, 1999  11:28 AM



External Program Interface Xmath Basics

8-4

three outputs), you might allocate a matrix for the first input, a PDM for the second,
and a string for the third:

8.1.2 UCI Programs

The User Callable Interface (UCI) lets an external C program invoke Xmath as a
child process, send and receive data to and from Xmath as shown in Figure 8-2,
and execute MathScript statements. A UCI has the layout shown in Figure 8-3.

matrix PDM string

lhs[0] lhs[1] lhs[2]lhs

FIGURE 8-2 Calling Xmath from an External Program (UCI)

MathScript Value externType

Xmath Process LNX Process

Inputs

Outputs

#include "xmathlib.h"

main(argc,argv)
int argc;
char** argv;
{
   ...

XmathStart(""); /* Starts Xmath */
  /* Calls to XmathGet, XmathPut,

XmathExecute, etc....*/
XmathStop("");  /* Stops Xmath */
return 0;

Required header file

Main program

FIGURE 8-3 Typical C Language UCI Program Format
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8.1.3 Compatibility

If an existing LNX or UCI compiled for an older version of MATRIXX is intended to be
run in a new version of MATRIXX, we recommend that you rebuild the LNX or UCI
using the new version of MATRIXX to maintain currency with the new compiler,
DLLs, and OS supported by the new version of MATRIXX.

Sometimes the IPC protocol in the Xmath LNX or UCI library changes due to bug
fixes and enhancements. An existing LNX or UCI must be rebuilt using the new ver-
sion of the MATRIXX LNX or UCI library (libXmath.a/xmath.lib ). If you attempt
to run a previous version of an LNX or UCI, Xmath displays the following message:

Process failed to load (incompatible ipc version).

8.2 externType Data Types

The file $XMATH/include/xmathlib.h contains the data structures for extern-
Type data types and related function declarations. This file must be included in all
LNX and UCI programs and programs that call XmathSave (see page 8-19) and
XmathLoad (see page 8-20).

An externType is an external version of an Xmath data value such as matrix,
string, and PDM. These are detailed in the following subsections.

If you allocate memory for the externType data type with an Allocate* function,
you need to remember to deallocate the memory with the corresponding Delete*
function, especially before re-using the variable. The function tables in this section
provide the names of these functions for each data type.

8.2.1 Matrix Data Type

The externType et_matrix  corresponds to a MathScript scalar matrix value.

typedef struct {
   externType et;
   int rows, columns, isReal;
   double *real, *imag;
} et_matrix;

The Boolean member isReal  indicates whether the matrix is complex
(isReal = 0 ) or real (isReal = 1 ).

Table 8-2 lists the functions provided in the LNX functions used to allocate a new
matrix, convert arrays to the matrix structure, and delete existing matrices.

xb.book  Page 5  Wednesday, October 6, 1999  11:28 AM



External Program Interface Xmath Basics

8-6

8.2.2 String Data Type

The externType et_string  corresponds to the MathScript string value.

typedef struct {
   externType et;
   int len, rows, columns;
   char *buf;
   char **array;
} et_string;

■ array  is an array of char*  with dimensions defined by rows  and columns .

■ buf points to the string in the first row, first column of array . The integer len
defines the length of this string. len does not have any significance for any of
the other strings in array .

For a summary of the et_string  type functions, see Table 8-3.

TABLE 8-2 et_matrix  Functions

Function Description and Prototype

AllocateMatrix Allocates a matrix:

et_matrix* AllocateMatrix(int rows,int columns,int
isReal);

WrapMatrix Converts single or double arrays into a real or complex matrix.

et_matrix* WrapMatrix(int rows,int columns double*
real,double* imag);

Both input arrays must be previously allocated and of type dou-
ble . If the matrix is real, use the NULL pointer 0 as the imag argu-
ment.

This function does not copy the input data; therefore, do not delete
the original arrays after calling WrapMatrix .

DeleteMatrix Deallocates storage associated with the et_matrix  input argu-
ment.

void DeleteMatrix, (et_matrix* the_matrix)
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8.2.3 PDM Data Type

The PDM data structure et_pdm  is defined as shown below:

typedef struct {
externType  et;
et_matrix   *iv;
et_string   *name;
et_string   *columnNames;
et_string   *rowNames;
et_matrix   *theData;
int rows, columns;

} et_pdm;

The meaning of each member is described in the following PDM:

testpdm=pdm([1:3; 4:6; 7:9; 10:12],101:1:104,{rowNames = "leaves",
columnNames =["birch", "elm", "oak"], domainName = "time"}):

TABLE 8-3 et_string  Type Functions

Function Description and Prototype

AllocateStringMatrix Creates an et_string  structure that can hold strings up to
length len .

et_string* AllocateStringMatrix(int rows,int columns,int
len))

The length of the string does not include the termination
character.

WrapString Converts a previously defined string to the et_string  data
type:

et_string* WrapString(char *buffer);

WrapStringMatrix Converts a previously allocated array of strings to a string
matrix object (LNX string data type).

et_string* WrapStringMatrix(int rows,int columns,char**
buffer))

Wrapping functions WrapStringMatrix  and WrapString
do not perform any copying of strings; therefore, do not delete
the original input strings after calling a wrap function.

DeleteString Deallocates storage associated with the structure
et_string .

void DeleteString, (et_string* the_string)
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Figure 8-4 shows the PDM testpdm  and the et_pdm  struct mapped to its parts.

typedef struct {
externType  et;
et_matrix   *iv;
et_string   *name;
et_string   *columnNames;
et_string   *rowNames;
et_matrix   *theData;
int rows, columns;

} et_pdm;

testpdm (a pdm) =

time |         birch  elm  oak
-----+------------------------
 101 | leaves   1      2    3
-----+------------------------
 102 | leaves   4      5    6
-----+------------------------
 103 | leaves   7      8    9
-----+------------------------
 104 | leaves  10     11   12
-----+------------------------

FIGURE 8-4 Mapping the et_pdm Structure to a PDM
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Figure 8-5 shows how the information from testpd mis assigned to the fields of the
et_pdm structure. Use AllocateMatrix and AllocateStringMatrix to build
the PDM components, and WrapPDMto form the PDM. For a summary of these func-
tions, see Table 8-4.

et_pdm →et= etpdm

et_pdm →rows= 1

et_pdm →columnNames rows= 1
columns= 3
len= 5 (length of birch)

array= ["birch","elm","oak"]

(et_string struct)

et_pdm →iv
real= 101,102,103,104
rows= 1
columns= 4

et_pdm →theData
(et_matrix struct)

rows= 4
columns= 3
isReal= 1
real= 1:12
imag= NULL

(et_matrix struct)

et_pdm →rowNames
(et_string struct)

array= leaves
rows= 1
columns= 3
len= 5

et_pdm →columns= 3

et_pdm →name
(et_string struct) len= 4

array= time

FIGURE 8-5 et_pdm  Data Structure
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8.2.4 List Data Type

The externType et_list  corresponds to a MathScript list object.

typedef struct {
externType et;
int nElem;         /* The number of elements in the list */
externType** item; /* an array of pointers to the list elements */

} et_list;

For a summary of et_list  functions, see Table 8-5.

TABLE 8-4 et_pdm  Functions

Function Description and Prototype

WrapPDM et_pdm* WrapPDM(et_matrix *iv,
et_matrix *theData,
int rows,
int columns,
et_string *name,
et_string* columnNames,
et_string* rowNames)

Inputs must be previously defined using AllocateMatrix  and
AllocateStringMatrix . Like the other wrapping functions, no
copying is done, so don’t delete the input after the call.

DeletePDM Deallocates storage associated with the et_pdm  input argument.

void DeletePDM(et_pdm* the_pdm)

TABLE 8-5 et_list  Functions

Function Description and Prototype

AllocateList Allocates a list:

et_list* AllocateList(int N)

DeleteList Deallocates storage.

void DeleteList(et_list* N)

xb.book  Page 10  Wednesday, October 6, 1999  11:28 AM



Xmath Basics External Program Interface

8-11

8

8.2.5 Null Data Type

The Null data type corresponds to the Xmath Null value ([] ).

8.3 LNX and UCI Functions

The functions available for use in LNX and UCI programs (described in Section 8.4
on page 8-24) are described in the following sections. A summary of these functions
appears in Table 8-7.

TABLE 8-6 et_null  Functions

Function Description and Prototype

AllocateNull Allocates a null:

et_null* AllocateNull()

DeleteNull Deallocates storage.

void DeleteNull(et_null* N)

DeleteAny (Generic deallocation) Deallocates any externType  you allocate.

void DeleteAny(externType*)

TABLE 8-7 LNX Functions

Function Description
See

Page

XmathMain
(for LNX only)

Sets up the communication facility and transmits infor-
mation about the LNX back to Xmath; it then transfers
control to your LNX function. Upon completion, the re-
sults are transmitted back to Xmath.

8-12

XmathCommand Executes Xmath commands and provides access to com-
mand and error output.

8-14

XmathDisplay Displays a message to the Xmath log window. 8-15

XmathError Allows you to report errors and make log entries. Sever-
ity levels are described in the file $XMATH/include/
xmathlib.h . The argument in error will be highlighted
in the Command Window command area.

8-15
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8.3.1 XmathMain (for LNX only)

XmathMain sets up the communication facility and transmits information about the
LNX back to Xmath; it then transfers control to your LNX function. Upon completion
of the LNX function, the results are transmitted back to Xmath. For an example, see
Figure 8-1 on page 8-3.

int XmathMain(int argc, char **argv, functionData* fData, int flag);

The flag argument to XmathMain specifies whether the process remains resident.
If this argument has the value LNX_RESIDENT, the process is resident. It remains in
memory across invocation until Xmath is exited or the LNX is undefined by issuing
the UNDEFINEcommand in Xmath. If the flag argument to XmathMain is 0, the
process is nonresident. It is terminated after each invocation and a new process
started.

XmathExecute Executes Xmath commands. Xmath windows (except for
the commands window and the debugger) are created as
needed. XmathExecute  returns 0 if successful and an
error string otherwise.

8-16

XmathGet Retrieves the value of a variable from Xmath. XmathGet
returns 0 if successful and an error string otherwise.

8-16

XmathLoad
(for any C or C++
program)

Creates externType  values from an Xmath data file. 8-19

XmathPut Copies the contents of a data structure to the Xmath en-
vironment.

8-16

XmathSave
(for any C or C++
program)

Saves externType  values to an Xmath data file. 8-19

XmathStart
(for UCI only)

Starts Xmath. option  is a char * that is reserved for fu-
ture Xmath invocation options. The option must be an
empty string  ("" ) for this version.

8-22

XmathStop
(for UCI only)

Terminates the Xmath process immediately. Modified
variables will not be saved.

8-22

TABLE 8-7 LNX Functions

Function Description
See

Page
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If an LNX function is called often, then it is advisable to make the process resident.
If the user function allocates a large amount of memory and is called infrequently,
then it is more memory efficient to make the LNX nonresident.

The functionData  data structure is typically used as follows:

static functionData fdata[] ={
   {"userFun",userFun,minIn, maxIn,minOut,maxOut,help},

{0}
}

Figure 8-1 on page 8-3 shows functionData  in relation to the rest of an LNX.

■ fdata is the name of an array that holds the function data. Although it is an ar-
ray, Xmath currently uses only the first element.

■ "userFun" is the name of this LNX; the lowercase version of this name must
match the filename of the executable LNX program.

■ userFun  is the pointer to the function itself.

■ minIn , maxIn are the minimum and maximum number of input arguments, re-
spectively. For example, if userFun must be called with no less than two, and
no more than four inputs, minIn  is 2, and maxIn  is 4.

■ minOut , maxOut are the minimum and maximum number of output argu-
ments, respectively.

Every time userFun is called, Xmath automatically verifies that the number of
input and output arguments is in the valid range.

■ The optional Help text entry is a char* pointer; 0 can be used if there is no Help.
The Help text can span multiple lines (as shown in Example 8-1). For an addi-
tional example on formatting Help, see $XMATH/src/fasthilb.c .

NOTE: You can provide a Help file for your LNX just as you can for MSFs,
MSCs, and MSOs in the same directory as your LNX. If Xmath finds
no Help file, it uses the optional Help text within the LNX itself. See
Section 6.1.6 on page 6-8 for details.

■ The mandatory array terminator {0}  comes last.
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EXAMPLE 8-1: Sample Help Text

/* Define the online Help */

#define Help "\
Description: Produces an n x n matrix\n\
with each element multiplied by -1.\n\
\n\
Syntax:      C = negate(A)\n\
\n\
Inputs:      A is a matrix or PDM.\n\
\n\
Outputs:     C is a matrix or PDM.\n\
\n\
Examples: a = 1:10; negate(a)?\n\
\n\"

8.3.2 XmathCommand

XmathCommandis an enhanced version of XmathExecute providing access to com-
mand and error output. The syntax is as follows:

char **XmathCommand(char *command,int options);

The return value of XmathCommandis a static array of two pointers of type char* .
The first pointer points to command output, or 0 if none or not requested. The sec-
ond pointer points to an error message caused by the command, or 0 if none or not
requested. This can be illustrated as follows:

The options  parameter is a bit mask defined with the following macros:

XMCMD_OUT Returns command output.

XMCMD_ERR Returns command errors.

command error

out[0] out[1]char**out

output message
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Both of these macros are used in the following example:

char *xmcmd = "foo(bar)?";
char **out = XmathCommand(xmcmd,XMCMD_OUT|XMCMD_ERR);
if (out[0]) {

printf("The output of \"%s\" is %s\n",xmcmd,out[0]);
free(out[0]);

}

else
printf("\"%s\" has no output\n",xmcmd);

if (out[1]) {
printf("\"%s\" resulted in the error: %s\n",xmcmd,out[1]);
free(out[1]);

}
else

printf("\"%s\" has no errors\n",xmcmd);

NOTE: The error message string returned by XmathCommandis memory allocated
with the C library function malloc. To free this string, use the C library
function free.

8.3.3 XmathDisplay

XmathDisplay displays a message to the Xmath log window. The syntax is as fol-
lows:

void XmathDisplay(char *message);

An example of using this function follows:

XmathDisplay("Have a nice day.");

This output appears in the Xmath log window.

8.3.4 XmathError

XmathError allows you to report fatal and warning errors as well as log entries. The
syntax is as follows:

void XmathError(errorType error, char* message, int argNum)

Severity levels are described in the file $XMATH/include/xmathlib.h . You can
specify ERROR_FATAL, ERROR_WARNINGor ERROR_LOG. You must also specify the
input argument number that is in error (a scalar between 1 and the number of
right-hand side arguments), or specify 0 to indicate the function itself. The argu-
ment in error will be highlighted in the Command Window command area.
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The following code fragment uses XmathError to check whether the first input is a
matrix.

if (*rhs[0]!= ETMATRIX) {
XmathError(ERROR_FATAL, " Input must be a matrix! " , 1);
return;
}

This code fragment checks if the matrix is real:

x=(et_matrix*)rhs[0]
if (!x->isReal) {
XmathError(ERROR_WARNING, " Matrix is not real! " , 1);
}

In the above example, we cast the first input into x , an et_matrix pointer, then
check to see if it is real.

8.3.5 XmathExecute

XmathExecute executes Xmath commands. Xmath windows (except for the com-
mands window and the debugger) will be opened as needed. XmathExecute returns
0 if successful and an error string otherwise.

char *XmathExecute(char *cmd)

For example, this call opens the Graphics window:

XmathExecute("plot(random(2,3))?");

This call opens the Help window:

XmathExecute("help bode;");

NOTE: The command string must end with a question mark (?) or semicolon (;).

For an example of how to use XmathExecute , see Example 8-2.

NOTE: The error message string returned by XmathExecute is memory allocated
with the C library function malloc. To free this string, use the C library
function free.

8.3.6 XmathGet and XmathPut

XmathGet  and XmathPut  retrieve and modify Xmath variable values.
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XmathGet

XmathGet retrieves the value of an Xmath variable. It sets the second argument to
externType* . XmathGet returns 0 if successful and an error string otherwise. The
syntax is as follows:

char *XmathGet(char* name, externType** data)

For example:

er_string = XmathGet("data", (externType**)&data);
if (er_string != NULL)
   printf("ERROR: %s", er_string);
switch(*data) {
case ETMATRIX:
   M = (et_matrix*)data;
   break;

case ETSTRING:
   S=(et_string*)data;
   break;

case ETPDM:
   P=(et_pdm*)data;
   break;
}

Notice how the externType pointer is dereferenced to determine the actual data
type.

XmathGet allocates storage for Xmath variables. If you re-use the variable, be sure
to deallocate the storage prior to an XmathGet call. For an example of how to use
XmathGet , see Example 8-2.

NOTE: The error message string (er_string ) returned by XmathGet is memory
allocated with the C library function malloc. To free this string, use the
C library function free.

XmathPut

XmathPut creates or modifies an Xmath variable with a given data value. The first
argument (name) must be a valid Xmath variable name. The second argument
(data ) is a pointer to one of the external types described in the externType Data
Types section on page 8-5. XmathPut returns 0 if successful and an error string
otherwise. The syntax is as follows:

char *XmathPut(char *name, externType* data)
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 For example:

/* allocate a real-valued Matrix struct */
x = AllocateMatrix(n, 1, 1);

/* fill up some local data */
ptx = x->real;
pty = y->real;

for (i = 0; i < n; i++) {
   *ptx = (double)i;
   *pty++ = sin(*ptx);
   *pty++ = cos(*ptx++);
}

/* send local x over to Xmath as variable x */
er_string = XmathPut("x", x);

if (er_string != NULL) {
   printf("ERROR: %s", er_string);
   free(er_string);
   }

For an example of how to use XmathPut , see Example 8-2.

NOTE: The error message string (er_string ) returned by XmathPut is memory
allocated with the C library function malloc. To free this string, use the
C library function free.

8.3.7 Example Using XmathGet, XmathPut, and XmathExecute

Example 8-2 combines the use of the last three functions discussed.

EXAMPLE 8-2: Using XmathGet , XmathPut , and XmathExecute

n = 10;
y = AllocateMatrix(n, 2, 1);
/* fill up some local data */
pty = y->real;
for (i = 0; i < n; i++)
   *pty = (double)i;

/* copy data over to Xmath*/
er_string = XmathPut("y", y);
if (er_string != NULL) {
   printf("ERROR: %s", er_string);
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   free(er_string);
   }

/* execute the function */
er_string = XmathExecute("y = log(abs(y));");
if (er_string != NULL) {
   printf("ERROR: %s", er_string);
   free(er_string);
   }

/* Free up existing memory associated with y
   before executing XmathGet() */
DeleteMatrix(y);
er_string = XmathGet("y", (externType**)&y);
if (er_string != NULL) {
   printf("ERROR: %s", er_string);
   free(er_string);
   }

8.3.8 XmathSave and XmathLoad

XmathSave and XmathLoad make it possible for a C or C++ program to save and
load files in Xmath format without starting Xmath. Both functions make use of the
externVar  data structure:

typedef struct {
   char *name;
   externType *value;
} externVar;

The variable name points to the full name of the Xmath variable, which consists of
the partition name and the variable name (for example, main.var) . value is the
standard LNX data structure pointer.

XmathSave and XmathLoad both work with an array of pointers to externVars ,
one for each Xmath variable. The name field of the last element of such an array
must be a NULL pointer.

XmathSave

XmathSave  has the following prototype:

char *XmathSave (char *filename, externVar *data, int type)

where
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filename  is the name of the file to be saved

data  is an array of externVar defined above

type parameter is an integer that lets you select ASCII (value 0) or binary for-
mat (value 1)

XmathSave returns a NULL pointer for success. If this function fails, it returns a
string that describes the error.

XmathLoad

XmathLoad  has the following prototype:

char *XmathLoad (char *filename, externVar **data)

where

filename  is the name of the file to load

data  is an array of externVar  defined above

XmathLoad loads the specified file and constructs an array of externVars , one for
each variable loaded, and stores the address of the array into data .

XmathLoad returns the NULL pointer for success. If this function fails, it returns a
string that describes the error.

Standard Library Linkage

XmathSave and XmathLoad are declared in the LNX header file and defined in the
LNX library. Therefore, a C or C++ program that calls XmathSave and XmathLoad
should be built and invoked as an LNX or UCI.

For an alternative method of library linkage on UNIX only, see Section 8.6.2 on
page 8-44.

Example of XmathSave and XmathLoad

The following example illustrates how to use XmathSave  and XmathLoad.

EXAMPLE 8-3: XmathSave and XmathLoad

#include <stdio.h>
#include <stdlib.h>
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#include <string.h>
#include "xmathlib.h"

#define N          10
#define NAME      "main.m1"
#define FILE_NAME "call5.xmd"

int main(void)
{
 int k;
 char   name[] = NAME;
 char * status;
 et_matrix * matrix1;
 externVar * my_data, * my_data_1;

 /*== Allocate mem. for 2 data struct. type "externVar" ==*/
 my_data = (externVar *)malloc (sizeof(externVar)*2);
 /*== Backup the pointer ==*/
 my_data_1 = my_data;

 /*====================================================
   MUST set field "name" of LAST (#2) structure to NULL
   ====================================================*/
  (my_data + 1)->name = NULL;

  /*== Allocate mem. for field "name" of struct. "my_data" ==*/
  my_data->name = (char *)malloc (sizeof(char) * (strlen(name)+1));

  /*== Copy str. NAME to field "name" of struct. "my_data" ==*/
  strcpy (my_data->name, name);

  /*== Allocate mem. for "et_matrix" data struct. ==*/
  matrix1 = AllocateMatrix(N, 1, 0);

  /*== Fill in some data ==*/
  for (k = 0; k < N; k++) {
      (matrix1->real)[k] = k;
       (matrix1->imag)[k] = k+1;
  }

  /*== Fill in field "value" after cast to "externType" ==*/
  my_data->value = (externType *)matrix1;

 /*== Save matrix1 (Xmath format) in file = FILE_NAME ==*/
 if (status = XmathSave(FILE_NAME, my_data)) {
      printf ("status = %s\n", status);
      return 1;
 }
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 /*== Free each field of every struct. type "externVar"
      Do it in for loop until field "name" = NULL      ==*/

 for (my_data = my_data_1; my_data->name; my_data++) {
      free (my_data->name);
      /*== Free mem. from AllocateMatrix() above ==*/
       DeleteAny(my_data->value);
 }

  /*== Free array of "externVar" ==*/
  free (my_data_1);

   return 0;
  }

8.3.9 XmathStart and XmathStop

The file $XMATH/include/xmathlib.h defines the XmathStart and XmathStop ,
which allow your program to communicate with Xmath. Each routine description
below is followed by a prototype.

XmathStart

XmathStart starts Xmath. option is a char * that is reserved for future use. Cur-
rently, the option must be an empty string ("" ). This function returns the Xmath
process ID (pid)  if successful and 0 if unsuccessful.

int XmathStart(char *option)

XmathStop

XmathStop terminates the Xmath process immediately. Modified variables will not
be saved. This function returns 0 if successful and 1 if unsuccessful.

int XmathStop()

8.3.10 Sample LNX Demonstrating Most Functions (myfun)

myfun has one input and one output. The syntax to invoke myfun is the same as for
any other MathScript function:

y = myfun(x)

Example 8-4 provides sample code for most of the external program interface func-
tions.
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NOTE: On UNIX systems, the filename for an LNX must be in lowercase letters.

EXAMPLE 8-4:  myfun.c

#include "xmathlib.h"
void myfun(int nlhs, externType **lhs, int nrhs,externType **rhs)
{
et_matrix *x,*y;

/* This function is written to indicate how you would use your   */
/* own C code to perform operations on Xmath data objects, and is*/
/* thus quite general. In this example, we manipulate the real   */
/* and imaginary components of the data separately. Note that    */
/* these elements are DOUBLES. The next line defines storage     */
/* variables for the real and imaginary components of the        */
/* output data matrix.                                           */

double *val, *ival;
int i; /* a counter variable                                     */

/* Do some error checking.                                       */

if (*rhs[0] != ETMATRIX) {
   XmathError(ERROR_FATAL,"Input must be a matrix!",1);
   return;
   }
x=(et_matrix*)rhs[0];
if (x->columns !=1) {
   XmathError(ERROR_FATAL,"Can only work on column vectors!",1);
   return;
   }
if (x->isReal) {
   XmathError(ERROR_WARNING,"Need complex input!",1);
   x->imag=(double*)calloc(x->rows,sizeof(double));
   x->isReal =0;
   }

/* Pre-allocate the output y as a matrix having the same size    */
/* as input x. */

y=AllocateMatrix(x->rows, 1, x->isReal);

/* The following five lines assign the real and imaginary data   */
/* to the variables val and ival respectively. Then 2 is added   */
/* to each of the real components and 3 to each of the imaginary */
/* components. Instead of using the dummy example here, you      */
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/* replace these lines with a call to a more sophisticated       */
/* function of your own.                                         */

val = y->real; ival = y->imag;
for (i = 0; i < x->rows; i++) {
   val[i] = 2.0+x->real[i];
   ival[i] = 3.0+x->imag[i];
   }

/* Return y as the first--and in this case, only--output of      */
/* the left side of the function call.                           */

lhs[0]=(externType*)y;
}
static char help[]={"This is the Help text.\n No Help yet."};
static functionData fdata[]={
   {"myfun",myfun,1,1,1,1,help},
   {0,0,0,0,0,0}
   };

main(argc,argv)
int argc;
char** argv;
{
   XmathMain(argc,argv,fdata,0);
   /* This must always return 0.                                 */
   return 0;
}

8.4 Building and Calling LNX and UCI

In this section, we use the sample LNX file myfun.c (Example 8-4) to illustrate how
to build an LNX. A UCI is built exactly the same as an LNX.

8.4.1 Building on a UNIX System

To build a makefile and call an LNX on a UNIX system:

1. Copy the sample program myfun.c from $XMATH/src to your working directory
as follows:

copyfile "$XMATH/src/myfun.c"

xb.book  Page 24  Wednesday, October 6, 1999  11:28 AM



Xmath Basics External Program Interface

8-25

8

2. $XMATH/src/Makefile is the makefile used to build an LNX or UCI. Copy the
makefile template to your working directory:

copyfile "$XMATH/src/Makefile"

3. Edit the template to put myfun.c on the NAME line and myfun.o on the
USEROBJECTSline. In addition, specify the appropriate compiler command (for
example, acc ) on the LINK line and appropriate compiler libraries (for example,
$(CLIBS) ) on the LIBS  line.

NOTE: You can skip this step and use the expanded form of the make
command below.

4. Enter the make command from the Xmath command area:

oscmd("make")

or

oscmd("make NAME=myfun USEROBJECTS=myfun.o
LIBS='-L$(XMATH)/lib -lXmath' LINK=acc")

NOTE: Use the simple form only if you edited the makefile.

5. Once the make has run successfully, you can call myfun as a regular Xmath
function:

myfun(1 + jay)

8.4.2 Sample makefile (UNIX)

Example 8-5 provides a sample makefile for an LNX or UCI. This example includes
several lines that are user-editable, such as the NAME and DEFS lines. Comments
in the example explain the required user inputs. In this sample, myfun.c is the
name of the sample LNX. The required user-input fields appear in bold type, but
these are normally blank and require your modification.

EXAMPLE 8-5: Sample makefile  for Solaris Platform

# Basic MAKEFILE for creating callable interface/lnx executable

# Following fields must be set (Makefile or command line)

# NAME Prefix name of program that uses the callable
# interface or of the lnx file you wish to create
# USEROBJECTS List of .o files you wish to link with
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# LIBS Name of compiler-specific libraries (suggested
# Solaris SC4.0 libraries pre-defined in CLIBS, CCLIBS,
# and FLIBS
# LINK Name of compiler or link editor

# Following fields are user-settable

# USERLIBS List of library search paths and/or libraries
# (e.g. library, -Lpath, and/or -llibname)
# DEFS C or C++ pre-processor define directive
# (e.g. -DXTFUNCPROTO)
# UCFLAG User CFLAGS, i.e. options the user wants sent to
# C compiler (e.g. -g)
# UCCFLAG User CCFLAGS, i.e. options the user wants sent to
# C++ compiler (e.g. -g)
# UFFLAG User FFLAGS, i.e. options the user wants sent to
# FORTRAN 77 compiler (e.g. -g)
# ULDFLAG User LDFLAGS, i.e. options the user wants sent to
# linker (e.g. -v)
# INCLUDE List of directories that are searched for
# #include files
# CC Name of C compiler
# CCC Name of C++ compiler
# FC Name of FORTRAN compiler

        NAME = myfun
 USEROBJECTS = myfun.o
    USERLIBS =
        DEFS = -DSOLARIS
      UCFLAG =
     UCCFLAG =
      UFFLAG =
     ULDFLAG =

     INCLUDE = -I. -I$(XMATH)/include

       CLIBS = -L$(XMATH)/lib -lXmath
      CCLIBS = -L$(XMATH)/lib -lXmath_cxx
# F77 and M77 are Solaris Fortran SC2.0 runtime libraries
#      FLIBS = -L$(XMATH)/lib -lXmath_cxx -lF77 -lM77
# F77, M77, and sunmath are Solaris Fortran SC3.0 and SC4.0 runtime
# libraries
       FLIBS = -L$(XMATH)/lib -lXmath_cxx -lF77 -lM77 -lsunmath
        LIBS = $(CLIBS)

          CC = acc
         CCC = CC
          FC = f77 -temp=$(HOME)
        LINK = $(CC)
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      CFLAGS = $(DEFS) $(UCFLAG) $(INCLUDE)
     CCFLAGS = $(DEFS) $(UCCFLAG) $(INCLUDE)
      FFLAGS = $(UFFLAG) $(INCLUDE)
     LDFLAGS = $(ULDFLAG)

.SUFFIXES : .o .c .cxx .C .f .F

.c.o:
     $(CC) $(CFLAGS) -c $< -o $@
.cxx.o:
     $(CCC) $(CCFLAGS) -c $< -o $@
.C.o:
     $(CCC) $(CCFLAGS) -c $< -o $@
.f.o:
     $(FC) $(FFLAGS) -c $< -o $@
.F.o:
     $(FC) $(FFLAGS) -c $< -o $@

$(NAME): $(USEROBJECTS)
     $(LINK) $(LDFLAGS) -o $@.lnx $(USEROBJECTS) $(USERLIBS) $(LIBS)
$@echo " Done."

8.4.3 Building on a Windows System

To build a makefile and call an LNX on a Windows system in Xmath:

1. Copy the sample program myfun.c from %XMATH%\srcto your working direc-
tory as follows:

copyfile "%XMATH%\src\myfun.c"

2. Enter the following command from the Xmath command area:

oscmd("makelnx myfun.c")

In general, to build LNXs and UCIs for Xmath use on a Windows system, enter the
makelnx  command with the following syntax:

> makelnx - debug  "file1 file2 ..."

For the above command, the default is to build “nodebug” objects unless you specify
the -debug  option.

The above command is a batch file that calls the makefile. Here is the path to the
batch file and makefile:

%XMATH%\bin\makelnx.bat
%XMATH%\bin\makelnx.mk
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Typically, you will not need to edit or change these files to perform routine build
tasks. If you do need to customize your build procedures, you can copy these files to
your local project directory and edit them as required.

If you do not specify a source module filename or list of filenames in the command
area, the script by default will look in your local directory for a specific argument file
containing the list of filenames. These default argument files require a filename ex-
tension of .arg and must have a name that matches the name of the corresponding
build command. For example, makelnx.arg is used by makelnx.bat . In these ar-
gument files you include a list of your files to compile and link.

The filenames can be separated by spaces or placed on separate lines and any text
on a line following ‘\ ’ (backslash space) will be treated as comment text.

NOTE: Filenames can be separated by spaces or placed on separate lines with a
continuation character ‘\’ appended at the end of the previous one.

All target filenames specified with the above “make” commands must have a suit-
able file extension because this determines the choice of compiler for each file. The
default file extensions currently supported include:

Like most standard make facilities, the above “make” commands support condi-
tional compilation and linking of files depending on file creation time and whether
the necessary dependent files currently exist. This means that recompiles will only
be done for files where source is newer than the corresponding object file. If you
need to force recompilation of a source module, delete the corresponding object file.

The make commands automatically create a log in your current working directory.
The log filename has an extension of .log (for example, makexxx.log) . Upon com-
pletion of the make, a copy of this file remains in your local directory in case you
need to review the contents of the make.

If you need to customize your builds, each of the make script source files described
above contains a commented section highlighting several predefined macro strings
that you can modify as needed to customize the build process. Follow the instruc-
tions provided in the files.

C .c

C++ .cxx or .cpp or .cc

FORTRAN .for or .f
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8.4.4 Undefining an LNX

If an existing resident LNX file is relinked while Xmath is running, use the unde-
fine command to terminate the current LNX process so that the new LNX is used
upon the next invocation.

8.4.5 Using the User-Callable Interface

The User Callable Interface (UCI) program uses the function XmathStart to invoke
Xmath. Any inputs that will be used in Xmath are copied from the user program to
Xmath objects using XmathPut . Once all inputs are copied over to the Xmath pro-
cess, any Xmath statement can be executed using XmathExecute or XmathCom-
mand. Any data transferred to Xmath and altered can be retrieved using XmathGet
or saved to a file using XmathSave . The Xmath process is terminated using Xmath-
Stop .

8.4.6 Building and Calling a UCI

A UCI is created in the same way as an LNX. A UCI is invoked by specifying the
-call   option to the command  to start Xmath:

xmath -call myuci.ext

xmath -tty -call myuci.ext

where ext  = lnx  on UNIX machines and exe on PCs.

Any required arguments to myuci  can be supplied at the end of the command line.

8.4.7 LNX Example

Example 8-6 provides an example of the LNX function negate . The negate func-
tion works exactly like the minus (-) operator on matrix and PDM inputs. The func-
tion returns an error if the input is a string.
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EXAMPLE 8-6: negate

#include "xmathlib.h"
void negate(nlhs, lhs, nrhs, rhs)
int nlhs, nrhs;
/* lhs is a pointer to the return arguments */
/* rhs is a pointer to the input arguments */
externType **lhs, **rhs;
{
   int number_elem, i;
   et_matrix *input;
   et_pdm  *in_pdm;
   double *in_data;
   switch(*rhs[0]) {
      case ETMATRIX: {
        input = (et_matrix *)rhs[0];
        in_data = input->real;
        number_elem = input->rows * input->columns;
        for(i=0; i < number_elem;i++, in_data++)
           *in_data = -(*in_data);
        lhs[0] = (externType*)input;
        break;
      }
      case ETPDM:{
        in_pdm = (et_pdm *)rhs[0];
        in_data = in_pdm->theData->real;
        number_ele =in_pdm->theData->rows*in_pdm->theData->columns;
         for(i=0; i < number_elem; i++, in_data++)
             *in_data = -(*in_data);
         lhs[0] = (externType*)in_pdm;
        break;
      }
      default:
         XmathError(ERROR_FATAL,
               "Data Type not supported in this function", 1);
   }
}

/* Define the online Help */

#define Help "No Help yet"

/* Holds the function information: */

static functionData fdata[] = {
   {"negate", negate, 1, 1, 1, 1, help},
   {0}
};
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main(argc, argv)
int argc;
char **argv;
{
   int resident = 0;
   XmathMain(argc, argv, fdata, resident);

return 0;
}

8.4.8 UCI Examples

Example 8-7 is a UCI program that uses the Xmath lo g function to calculate the
logarithm of an input. This file is found in $XMATH/src/call.c . Example 8-8 is a
UCI example that uses Xmath graphics in an external C program.

EXAMPLE 8-7: Xmath as a Computational Engine

#include <math.h>
#include <stdio.h>
#include "xmathlib.h"
int doMyProgram()
{
et_matrix *x, *y;
double *ptx, *pty;
int n, i;
n = 10;

/* allocate two matrix structs */

x = AllocateMatrix(n, 1, 1);
y = AllocateMatrix(n, 2, 1);

/* fill up some local data */

ptx = x->real;
pty = y->real;
for (i = 0; i < n; i++) {
*ptx = (double)i;
*pty++ = sin(*ptx);
*pty++ = cos(*ptx++);
}
/* send local x and y over to Xmath as variable y.
   Check for errors*/

er_string = XmathPut("y", y);
if (er_string != NULL)
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   printf("ERROR: %s", er_string);

/* execute an Xmath function */

er_string = XmathExecute("y = log(abs(y));");
if (er_string != NULL)
printf("ERROR: %s", er_string);

/* Get y back. have to delete the current y since we
* get a new one from XmathGet.*/

DeleteMatrix(y);
er_string = XmathGet("y", (externType**)&y);
if (er_string != NULL)
  printf("ERROR: %s", er_string);

/* Output the new y */

pty = y->real;
for (i = 0; i < n; i++)
fprintf(stdout, "%g %g\n", *pty++, *pty++);
}
int main(argc, argv)
unsigned argc;
char** argv;
{
XmathStart("");
doMyProgram();
XmathStop();
return 0;
}

EXAMPLE 8-8: Xmath as a Graphics Engine

#include "xmathlib.h"
#include <stdio.h>

/* Generate some test data */
double data[8] = {0.0, 1.0, 2.0, 3.0, 4.0, 3.0, 2.0, 1.0};
int number_points = 8;

int DisplayVector(vector, columns)
double *vector;
int columns;
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{
   et_matrix *thedata;
   int real = 1;
   char *er_string;

/* Convert the data array to the data type et_matrix, so
   Xmath will recognize it*/

   thedata = WrapMatrix(1, columns, vector, 0);

/* Copy the data over to the Xmath child process */

er_string = XmathPut("thedata", (externType*)thedata);
if (er_string != NULL)

printf("ERROR: %s", er_string);

er_string = XmathExecute("plot(thedata)?");
if (er_string != NULL)

printf("ERROR: %s", er_string);

/* The plot is now drawn, and the user can interact with
   the window, adding text, changing colors, etc*/

XmathExecute("pause");
}
int main(argc, argv)
   unsigned argc;
   char**   argv;
{
/* Start the Xmath process */

XmathStart("");

/* Send data to be plotted */
DisplayVector(data, number_points);5

/* Stop the Xmath child process */
XmathStop();
return 0;

}

Any plot can be saved to a PostScript or HPGL file using the hardcopy  command:

XmathExecute("hardcopy file=\"mygraph\", {ps}");

The C escape character \ (backslash) is necessary for the embedded Xmath string.
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8.4.9 Calling an LNX in Background Mode

If an LNX performs a long calculation, you can invoke the LNX in background mode
so that you can continue to use Xmath for other tasks while the LNX runs.

Another scenario where a background LNX is useful is where the LNX is a GUI ap-
plication (see Advanced Background LNX Function (IPCWC) on page 8-45) for infor-
mation on how to communicate with a background LNX).

Example

To invoke the LNX myfun  in background mode, issue the following command:

[output] = (define myfun, {background})(1000);

The return value, output , will be “busy” during the background LNX’s execution. In
this example, 1000  is the input argument to myfun .

Given the above example, typing the command WHO(which lists variables) in the
Xmath window shows that output  is busy:

who

output -- busy (job #13103)

After the background define command for the LNX process has been entered, the
process will be spawned to run in background mode and the user will have immedi-
ate control of the Xmath command area.

Upon completion of the background LNX process, notification of the process termi-
nation status appears in the Xmath log area, after you press Return .

[out]=(define myfun, {background}) (1000);
(job 13103) has terminated normally.

Example 8-9 is an example of an LNX program that can run in either foreground or
background mode.

Compile this sample LNX program using the steps described in Section 8.4.1 on
page 8-24. To see how to run the sample program in background mode, refer to Ad-
vanced Background LNX Function (IPCWC) on page 8-45.

EXAMPLE 8-9: getpi  (Runs in Foreground or Background)

#include <stdio.h>
#include <stdlib.h>
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#include <math.h>
#include "xmathlib.h"

/* This sample lnx program calculates the value of pi based on the */
/* number of randomly-generated (x,y) points that fall within the */
/* upper right quarter of the unit circle. */
/* */
/* Test using an input value between 500000 and MAXRANDOM. */

#define REAL1
#define MAXRANDOM((double) (exp(31 * log(2.0))-1)) /* (2**31) - 1 */

void getpi(nlhs, lhs, nrhs, rhs)
int nlhs, nrhs;
externType **lhs, **rhs;
{
   externType *data;
   et_matrix  *arg;
   et_matrix  *out;
   long        steps;
   double      x, y, r;
   double      p_i;
   char        buffer[255], *errstr;

int count; /* Number of random points inside unit circle */

   if (nrhs != 1) {
      /* User did not provide an integer argument. Go to Xmath's */
      /* main partition and get the variable `step_number'.      */
      errstr = XmathGet("main.step_number", &data);
      if (errstr != NULL) {
         sprintf(buffer, "Error getting main.step_number : %s",
            errstr);
      XmathError(ERROR_FATAL, buffer, 1);
      free(errstr);
      return;
      }

   if (*data != ETMATRIX) {
      XmathError(ERROR_FATAL, "Usage: getpi number", 1);
         return;
      }
      arg = (et_matrix*) data;
      XmathExecute("main.pi = 0;"); /*create the result variable*/
   }  else {
      /* User provided an integer argument to the lnx */
   if (*rhs[0] != ETMATRIX) {
      XmathError(ERROR_FATAL, "This LNX requires a number!", 1);
      return;
      }
   arg = (et_matrix*) rhs[0];
}
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   srandom((int) time(0));/* Start random number generator */

   count = 0;
   for (steps = 0; steps < (int) arg->real[0]; steps++) {
      /* Get x and y coordinate values between 0 and 1 */
      x = random() / MAXRANDOM;
      y = random() / MAXRANDOM;
      r = sqrt( (x * x) + (y * y) );
      if (r <= 1.0)
         count++;
      }
   p_i = 4.0 * count / steps;
   fprintf(stderr, "%ld steps: p_i = %f\n", steps, p_i);

   out = AllocateMatrix(1, 1, REAL);
   nlhs = 1;
   out->real[0] = p_i;
   lhs[0] = (externType*) out;

   if (nrhs != 1) {
      XmathPut("main.pi", (externType*) out);
      DeleteAny(data);
   }
}

functionData fdata[] =
{{"getpi", getpi, 0, 1, 0, 1, "Help text for getpi" }, {0} };

main(argc, argv)
int argc;
char **argv;
{
   fprintf(stderr, "Starting ...\n");
   XmathMain(argc, argv, fdata, 0);
   fprintf(stderr, "Stopping ...\n");
   return 0;
}

8.4.10 Removing an LNX Job

When an LNX is invoked in background mode, Xmath echoes a job number (which
is really its process ID) to the log area. This job number can be used as input to the
REMOVE JOB command.

REMOVE JOBjob_number

The REMOVE JOB command uses the specified job number to terminate the LNX.
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8.4.11 Building an LNX to Link a FORTRAN Routine

Xmath provides two ways to create an LNX function based on FORTRAN code. The
preferred approach is to use C as described in the previous sections and then trans-
fer control to your FORTRAN subroutine from within C. The second method is to
use the special FORTRAN interface to LNX described in this section. This approach
is less complete due to limitations in FORTRAN, and it is recommended only for us-
ers who don’t know C.

Calling FORTRAN from C LNX Files

There are three important points to remember when calling a FORTRAN routine
from C: name linkage, argument linkage, and array ordering.

1. (UNIX Only) In C, append an underscore (_ ) to the end of the name of the FOR-
TRAN routine you need to call. You will need to define the FORTRAN function as
a void external function within your C routine. (Some architectures do not sup-
port underscores.)

2. FORTRAN expects subroutine arguments to be passed by reference (address).
Here is a sample FORTRAN subroutine:

subroutine fort(n, a)
double precision a(n)
integer n

To call the above subroutine from C, you need:

double *a;
int n;
fort_(&n, a)

Here you pass the address of n. Note that the variable a is already an address.

3. FORTRAN stores two-dimensional arrays in column-major, as opposed to row-
major, mode. This means that sequential elements of a FORTRAN array that
comprise the columns and sequential elements of a C array run along the rows
of the array.

Creating FORTRAN LNX Files

The C interface to LNX described above is the preferred method of presenting exter-
nal FORTRAN code as an Xmath function. However, for users who may not be famil-
iar with the C language, a FORTRAN interface that does not require any C
programming is also provided.
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To get started using FORTRAN LNX you may want to study the file template.f in
$XMATH/src . This file is an example of how to link a FORTRAN matrix-vector multi-
ply routine into Xmath. You must supply an initialized common block named fdata
declared as:

character *10 name
integer minIn, maxIn, minOut, maxOut
common /fdata/ minIn, maxIn, minOut, maxOut, name

The template does this by using a block data section where it initializes the common
block with data statements. These parameters have the same meaning as the fields
of the functionData structure in Section 8.3.1 on page 8-12. Currently the name
is ignored, and the name of the LNX function will be the name of the generated LNX
executable file.

You must also supply a subroutine named ftnlnx with the calling sequence. The
template ($XMATH/src/template.f ) gives an example of a ftnlnx  subroutine.

subroutine ftnlnx(thefun,
! nin, stkin, locin, cmxin, rowin, colin,
! nout, stkout, locout, cmxout, rowout, colout,
! howmuch, error)

integer thefun
integer nin,locin(nin),cmxin(nin),rowin(nin),colin(nin)
integer nout,locout(nout),cmxout(nout),rowout(nout),colout(nout)

 integer howmuch, error
 double precision stkin(*), stkout(howmuch)

The meanings of the parameters are described in Table 8-8.

TABLE 8-8 ftnlnx Parameters

Parameter Function

thefun: For future expansion. Set to 1 in this version.

nin The number of input arguments.

stkin A “stack” of the input matrices.

locin An array indicating the index in stkin  of each input matrix.

For example, input argument 2 starts at position locin(2) , so the
(1,1)  element of input argument 2 is stkin(locin(2)) , and the
(2,1)  element is stkin(locin(2)+1) .

cmxin cmxin(i)  is 1 if input argument i  is complex. Zero otherwise.
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The typical sequence in ftnlnx  will be to:

1. Unpack the input stack (stkin ).

2. Pass control to your desired FORTRAN subroutine.

3. Pack the output arguments in stkout (and set locout , cmxout , rowout , and
colout ).

The routines discussed in previous sections (XmathError , AllocateMatrix , etc.)
are not available in FORTRAN LNX.

8.5 Debugging

Debugging procedures for LNXs and UCIs involve setting breakpoints and then ana-
lyzing errant behavior versus expected behavior as described in the following sec-
tions.

rowin rowin(i)  gives the number of rows of input argument i.

colin colin(i)  gives the number of columns of input argument i .

nout The number of output arguments requested by the Xmath user.

stkout , locout , cmxout , rowout , and colout  are analogous to stkin, lo-
cin, cmxin, rowin , and colin, except that they pertain to the output argu-
ments. You are responsible for setting these values completely and correctly.

howmuch Indicates how much space is reserved in stkout . That is, you should
regard stkout  as an array declared as double precision stk-
out(howmuch) .

error a user-settable error flag.

if error >  0 - fatal error
if error <  0 - warning
if error == 0 - no error

TABLE 8-8 ftnlnx Parameters (Continued)

Parameter Function
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8.5.1 Debugging an LNX with dbx (on UNIX Systems)

1. Create an LNX called myfun.lnx  with debug information.

You can modify the make command itself (see step 4 on page 8-25) by adding
the debug option (for example, UCFLAG = -g) or by changing the appropriate
user-defined flag within the makefile itself (for example, UCFLAG = -g or
UCCFLAG = -g ) (see Sample makefile  for Solaris Platform on page 8-25).

2. You must indicate that you want the debugger to ignore the USR1 interprocess
signal handler.

● For dbx under SunOS, create a file called .dbxinit  with this line:

ignore USR1

● On HP-UX, create a file called .xdbrc  with this line:

z 16sr

3. Issue the Xmath DEBUG command:

debug myfun

4. Now call the function:

myfun(1+jay)

Xmath displays the debug LNX dialog window and then pauses. The debug mes-
sage dialog will have a message similar to,

dbx ./myfun.lnx 8134

where dbx is followed by the LNX function and the process ID.

5. To start the dbx process with the LNX process attached, type or copy the above
command into a UNIX shell.

6. In dbx, set a breakpoint in myfun  with the command:

stop in myfun

7. Issue the dbx continue command by typing cont  in the debugger.

8. Return to Xmath and dismiss the debug LNX dialog.

Immediately, dbx breaks at the breakpoint previously set. You can start debug-
ging the function.
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9. When you finish debugging the function, issue the dbx CONT command.

Xmath returns with the output of the LNX function.

10. When the debug session is complete, use the dbx DETACHcommand to detach
the LNX process from dbx.

For resident functions, Xmath automatically turns off debug mode for LNXnameaf-
ter it returns. If you want to debug the LNX function with another set of inputs, call
LNXnameagain. This time, however, Xmath will not display the debug dialog. On the
other hand, if you haven’t removed the breakpoint in dbx, the LNX process will
break at the same breakpoint. The function can then be debugged with the new in-
puts.

Specifying an LNX to be nonresident means that the LNX is automatically undefined
after it finishes. Therefore, the debugging mode is forgotten. This makes MSF and
LNX debug mode behavior consistent, because undefining an MSF also makes
Xmath forget everything about the MSF, including the debug mode.

8.5.2 Debugging LNXs (on Windows systems)

To debug an LNX, use the following procedure:

1. Create an LNX called myfun.exe with debug information as described in Build-
ing on a Windows System on page 8-27:

makelnx (-debug) myfun.c

This creates an LNX called myfun.exe.

2. Go to Xmath commands window and call the LNX:

debug myfun

myfun(1+jay)

3. A dialog box (myfun.exe -Application Error) appears with the message:

A breakpoint has been reached. Click Cancel to go into the de-
bugger.

Then another dialog appears with the message:

Break caused by hard coded breakpoint instruction.

Click OK in this dialog.
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4. Now, select Debug→Breakpoints.

A Breakpoints dialog appears.

5. In the Location area, enter myfun . Click Add to add the name to the breakpoints
column. Click OK to dismiss the dialog.

6. Select Debug→Go from the Debug pull-down menu.

The debugger will now stop at the breakpoints you have specified.

7. When you are finished debugging, select Debug→Breakpoints. When the Break-
points dialog appears, click Clear All to clear the breakpoints. Click OK to dismiss
the dialog box. Select Debug→Go.

The LNX will run to completion.

NOTE: Do not exit the debugger until the LNX runs to a completion.

8. To exit the debugger window, select File→Exit.

8.5.3 Debugging UCIs (on UNIX systems)

To debug a UCI on a UNIX system, perform the following procedure:

1. Create a UCI with debug information as described in Building on a UNIX System
on page 8-24.

2. Debug the UCI using dbx :

xmath -call dbx uci.lnx

3. Now, set a breakpoint in myfun.c  with the command:

stop in myfun

For each function you want to debug.

4. Enter run .

The debugger will now stop at the breakpoints you have specified.

5. When you are finished debugging, clear the breakpoints and type cont to let
the UCI run to completion.

NOTE: Do not exit the debugger until the UCI runs to a completion.

6. To exit the debugger, type quit .
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8.5.4 Debugging UCIs (on Windows systems)

To debug a UCI on a Windows system, perform the following procedure:

1. Create a UCI with debug information as described in Building on a Windows
System on page 8-27.

2. Debug the UCI using MSVC:

xmath -call msdev uci.exe

3. Now, select Debug→Breakpoints.

A Breakpoints dialog appears.

4. In the Location area, enter the name of the function you want to debug. Click
Add to add the name to the breakpoints column. Keep doing this for all of the de-
sired breakpoints. Click OK when you have finished.

5. Select Debug→Go.

The debugger will now stop at the breakpoints you have specified.

6. When you are finished debugging, select Debug→Breakpoints. When the Break-
points dialog appears, click on Clear All to clear the breakpoints. Click OK to dis-
miss the dialog. Select Debug→Go from the Debug pull-down menu to let the
UCI run to completion.

NOTE: Do not exit the debugger until the UCI runs to a completion.

7. To exit the debugger, select File→Exit.

8.6 Advanced Topics

8.6.1 Handling an Aborted LNX

The following MathScript command

set debugonerror off

allows a script to resume execution after an LNX that it calls terminates abnormally.
Without using this command, a script will be aborted if the LNX that it calls termi-
nates abnormally.
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For example:

command callsegv
   set debugonerr off# allow this script to resume if segv() aborted
   out = []          # assuming segv() never returns a []
   out = segv()      # an LNX that terminates abnormally
   if out == []      # if segv() aborted,
      display " segv() failed. "
   else
      display " segv() returned successfully. "
   endif
endcommand

If an LNX process terminates abnormally, Xmath prints out a message similar to the
following:

Process name  has terminated abnormally (Signal #)

The signal number is the UNIX error code. These codes are standard on UNIX sys-
tems and are described in the file /usr/include/sys/signal.h .

NOTE: XmathPanic should be in your LNX or UCI program’s Ctrl-C signal handler
to clean up after an abnormal stop. The syntax is as follows:

void XmathPanic()

8.6.2 Advanced Features and Notes

On UNIX systems only:

■ When an XmathSave or XmathLoad link is called, an Xmath process called
xmathsl is invoked. To avoid this overhead, you can link with the libxmsl.a
library in addition to libXmath.a (libXmath.a must follow libxmsl.a in
the link command). You will need the standard C++ library supported for your
platform for the link, typically by including -lC  in the link command line.

That is, the standalone saveload document references the last line of this file:

$(CC) -o $@.lnx $(USEROBJECTS) -L$(LIBS) $(USERLIBS) -lXmath

which must be changed to the following:

$(CC) -o $@.lnx $(USEROBJECTS) -L$(LIBS) $(USERLIBS) -lxmsl
-lXmath -lC

■ LNX and UCI use the signal USR1 as part of communications processes; do not
modify this signal’s handler.
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8.6.3 Advanced Background LNX Function (IPCWC)

IPCWCallows you to communicate with a background LNX process that is also a
windows client. First, a message is sent to the LNX with the specified window ID
(wid) and the process ID (pid). Additional data (the arguments listed) is then sent to
the LNX (formatted according to the specifiers in the format string, as applicable).
The calling syntax is:

IPCWC wid, pid, format_string, arg_list ...

■ The format specifiers are codes consisting of the percent sign (%) and a charac-
ter. They are:

■ All non-format specifiers are sent as individual characters.

■ The LNX process receives data with the calls shown in Table 8-9. XmathIPCgets

returns a malloc'ed string. Remember to free it when done.

wid Window ID (a number).

pid Process ID (a number).

format_string A string with format specifiers (as described below).

arg_list The values to be sent. You can have as many values as you like,
as long as they are separated by commas and each one maps to
a format specifier in format_string .

%c A single character.

%d A decimal number.

%s A string.

TABLE 8-9 Background LNX Functions

Function Description and Prototype

XmathIPCgetc XmathIPCgetc  returns a character from the IPC stream to
the LNX process.

char XmathIPCgetc()
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■ $XMATH/include/xmathlib.h contains the definition for optional flags, such
as LNX_USE_IPC. In a background call, XmathReleaseIPC detaches an LNX.
The last argument in the XmathMain call sets the LNX_USE_IPC flag. The call-
back LNX function, defined in the functionData structure, is responsible for
calling XmathReleaseIPC .

Sample IPCWC Calling Sequence

The following sample IPCWC calling sequence sends the character H followed by the
number 104 to an LNX that has window ID 9999 and process ID 99:

ipcwc 9999, 99, "H%d", 104

The next step is to send the character B followed by character A, the string "Test1",
and then the ID number 5 to an LNX that has window ID 9999 and process ID 99.

ipcwc 9999, 99, "B%c%s%d", "A", "Test1", 5

NOTE: To ensure proper handshaking between the client and server in
sophisticated LNXs, the client program should wait for a status from the
client; when the client has finished reading it should return the status via
XmathIPCputs . For example:

ipcwc 9999, 99, "B%c%s%d&s", "A", "Test1", 5, status

Example 8-10 shows a pseudocode LNX example that uses some of the
XmathIPCget call. Example 8-11 is pseudo-code for a sample LNX program using
IPCWC.

XmathIPCgeti XmathIPCgeti  returns an integer from the IPC stream to
the LNX process.

int XmathIPCgeti()

XmathIPCgets XmathIPCgets returns a malloc string from the IPC stream
to the LNX process. Remember to free the string when you
are done.

char *XmathIPCgets()

TABLE 8-9 Background LNX Functions (Continued)

Function Description and Prototype
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EXAMPLE 8-10: Sample Usage of ipcwc  to Communicate with a Background LNX

#
#  action = SaveFile or LoadFile
#
Command SendAction action, file_name

wid = 9999;
pid = 99;

if (!is(action, {string}))
   error("Argument 'action' must be a string", "F")
endif

if (!is(file_name, {string}))
   error("Argument 'file_name' must be a string", "F")
endif

ipcwc wid, pid, "%c %s", stringex(action, 1, 1), file_name

endCommand

EXAMPLE 8-11: Pseudo-Code for an LNX that Responds to ipcwc

#ifdef UNIX

#include <X11/Xlib.h>

/* This is how the ipcwc command actually sends to the client window
*/
void Send_ipcwc_window_message(Window wid)
{
   XEvent xclient;
   extern Display *dpy;
   xclient.xclient.message_type = 0;
   xclient.xclient.type = ClientMessage;
   strcpy(xclient.xclient.data.b, " XMATH" );
   xclient.xclient.format = 8;
   XSendEvent(dpy, wid, 0, NoEventMask, &xclient);
   XFlush(dpy);
}

/* This is how to detect a window message sent by the ipcwc command */
/* The following is a typical X event loop                        */
...
XEvent event;
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switch (event.type) {
case ClientMessage:
if (Is_ipcwc_window_message(&event)) {
   action = XmathIPCgetc()
   switch (action) {
      case 'S':
      savefile = XmathIPCgets()
...
      case 'L':
      loadfile = XmathIPCgets()
      ...
      default:
   ...
   }
}
else {

/* other ClientMessage messages */
}

int Is_ipcwc_window_message(XEvent *event)
{
extern Display *dpy;
XClientMessageEvent *xclient;
Atom wmpAtom, wmdAtom;
xclient = (XClientMessageEvent *) event;
wmpAtom = XInternAtom( dpy, " WM_PROTOCOLS" ,     True );
wmdAtom = XInternAtom( dpy, " WM_DELETE_WINDOW" , True );
return ((wmpAtom == None || wmdAtom == None ||
xclient->message_type != wmpAtom ||
xclient->data.l[0] != wmdAtom)
&& !strcmp( " XMATH" , xclient->data.b ));
}

#else

#include <windows.h>

/* This is how the ipcwc command actually sends to the client window
*/
void Send_ipcwc_window_message(HWND hwnd)
{
   PostMessage(hwnd, WM_USER, 0, 0);
}
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/* This is how to detect a window message sent by the ipcwc command
*/
/* The following is a typical Windows event loop */
   ...
   switch (message) {

case WM_USER:
/* ipcwc Window message detected */

   }
#endif
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9 Graphical User Interface

This chapter introduces Xmath’s fully programmable graphical user interface (PGUI
or GUI).

The GUI is available on all MATRIXX platforms. The GUI allows arbitrary windows to
be created and manipulated using only Xmath source code (MathScript). GUI win-
dows might contain, for example, sliders, pushbuttons, menus, and plot areas, all of
which can accept user input from the mouse. Xmath simultaneously supports user
interaction in any number of newly created GUI windows, as well as through each of
its standard windows.

The GUI provides a number of predefined dialogs that can be used to interact with
the user. These dialogs are a collection of modal dialogs that are used by most appli-
cations. When called they suspend command execution until the user responds to
the dialog. Once the user responds, the response is returned and command execu-
tion resumes.

9.1 Finding Out About the GUI

Whether you are a GUI tool user or a developer, you will want to learn about the
GUI, although the ultimate learning will be at different levels.

9.1.1 GUI Tool Users

GUI tools are simple and intuitive to use, but there are a few basic things you
should know. You should run guidemo and look at some of the examples, especially
leadlag , to get a feel for the features and capabilities of GUI tools. Each GUI tool
has extensive Help menus describing its use. Browsing through Help messages is a
good way to learn what a tool does.
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9.1.2 GUI Developers

You might also want to develop your own GUI tools. For example, you might add a
graphical user interface to an existing Xmath command script. Programming with
the GUI is more difficult than writing your own Xmath commands and functions, so
delay trying this until you are quite comfortable programming in Xmath and using
GUI tools.

To develop your own simple tools using the GUI, we recommend that you run the
GUI demos while looking at the corresponding source code, which is in $XMATH/
demos/gui . The next step is to read the Help entries for the GUI functions in the
Xmath online Help. Start with uiToolCreate . Each function has an example. To
see them work, paste the examples into the Xmath command window.

9.1.3 Running the GUI Examples

To see a menu of Programmable GUI examples, type guidemo in the Xmath com-
mand area. This displays the menu shown in Figure 9-1.

Figure 9-1 lists a number of GUI demos. You can run several demos at once.

FIGURE 9-1 Programmable GUI Examples
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To run a demo:

1. Select a demo (for example, Variable Binding).

2. Click OK.

In a few seconds the demo appears. (Your window manager may require you to
position the window(s) generated by the demo.)

Each demo has a Help menu in its menu bar (near the upper right side of the
window). The Help messages explain how to interact with the demo and what it
does. It may be helpful to read the rest of this chapter before (or while) you try
the demos.

3. To exit a demo, select Special→Exit or File→Exit from the individual demo win-
dow.

To see another example of a GUI implementation, type ifilter in the commands
window command area.

9.2 Interacting with a GUI Application

This section describes the mechanics of interacting with GUI windows. First, we cre-
ate an example dialog and then we discuss the various kinds of GUI objects that you
can place in a dialog or window and how to use them.

9.2.1 Creating an Example Dialog

Tools that use the GUI create windows that contain control elements such as push-
buttons, sliders, pulldown menus, plots, and lists. Some of these elements are
shown in Figure 9-2, the PGUI Example dialog.

FIGURE 9-2 PGUI Example Dialog
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If you are a user only, you might want to just create the dialog without paying much
attention to the individual commands that follow. If you are a developer, this is
another example from which you can learn.

To create the dialog in Figure 9-2, type the following in the Xmath command area:

tl = uiToolCreate("guiexhelp");
mw = uiWindow(tl,{title="PGUI Example"});
tb = uiTable(mw,{height = 200, columns = 2});
void = uiButton(tb,{ text = "Do It"});
void = uiButton(tb,{ type = "toggle", text = "Toggle Button"});
void = uiLabel(tb,{ text = "v value"});
void = uiSlider(tb, {varname = "main.v", min = 0, max = 10});
void = uiVarEdit(tb, {varname = "main.w", text = "w value" });
void = uiShow(mw);
main.v = 5;
main.w = 12;

To kill the dialog in Figure 9-2 type:

uiDestroy("guiexhelp")

9.2.2 Controlling GUI Objects

You can control most functions with the left mouse button. For example, you can
activate a button by placing the mouse pointer anywhere on the button and clicking
the left mouse button. The PGUI Example dialog has two buttons: Do It and 12.

Other objects behave as follows:

■ A toggle button (square shaped) is either on or off. Its indicator is filled in when
it is on. It can be toggled by pointing and clicking the left mouse button. The
toggle button shown in Figure 9-2 is off. Activating a toggle button causes some
action to be performed.

■ Radio buttons (diamond shaped) are a group of buttons with “radio” behavior.
Like the station selection buttons on a radio, selecting one button automatically
turns off any other button that is on.

■ A pulldown menu is displayed by depressing and holding the left mouse button.
As the mouse is dragged, the various menu selections (usually pushbuttons) are
highlighted. Releasing the mouse activates the selected button.

A cascade menu is indicated by a small arrow to the right of the text in the but-
ton. The cascade menu is displayed by moving the mouse to the right.
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■ A text entry area behaves like the command input area in Xmath. Input is termi-
nated by a newline character. Before you can type into a text entry area, you
must focus on the area by placing the mouse pointer in the area and clicking
the left mouse button. Focus is indicated by a border highlight.

■ A list is a vertical list of items (strings) that can be selected (highlighted). De-
pending on the application, a list can be configured to allow various types of se-
lection:

● A single-selection list allows only a single line to be selected. Clicking the
left mouse button selects a line.

● A multiple-selection list allows multiple lines to be selected. The selection of
a single line is toggled by clicking with the left mouse button.

● An extended-selection list also allows multiple lines to be selected. A contig-
uous range of items can be selected by pressing the left mouse button,
dragging the mouse, and releasing. Depressing Shift and the left mouse but-
ton selects all the items from the current item to the previous item that was
selected with the left mouse button. Depressing Control and the left mouse
button augments (rather than replaces) the existing selections. This allows
discontiguous ranges of items to be selected. This type of list is used in the
history sorting and history column dialogs in the leadlag  demo.

Once you select one or more items from a list, you then choose some action
such as Delete or Display .

■ A dialog is a small window that can contain a message and one or more buttons.
For example, a dialog might have a single button and a message giving a warn-
ing or indicating an error.

Usually a dialog is modal—that is, you cannot interact with any other GUI or
Xmath window until the dialog has been closed. If you find you can’t interact
with Xmath or other GUI windows, then look for a modal dialog that might have
been accidently covered by another window.

■ Help messages are often listed under a Help pulldown menu at the top-right of
the GUI window. The Help message appears in a new window that provides
scroll bars as needed. The scroll bars are operated with the left and middle
mouse buttons. The window is dismissed by selecting the Close  button.

■ A variable edit box appears in a GUI window as a button that displays some
value. The value can be changed by selecting the button, whereupon a text en-
try area appears in place of the button. You can type a new value followed by Re-
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turn . If the GUI tool doesn’t like your new value, it reserves the right to change it
to an acceptable value that is displayed again on the button.

The pushbutton labeled 12 shown in Figure 9-2 is a variable edit box (displaying
the value of the variable w). If you press this button, it is replaced by the “w
value” text entry area as shown in Figure 9-3. After entering a value from the
keyboard, the text entry area is replaced by a button that contains the new
value.

■ A slider resembles a linear potentiometer and its value is changed by a linear
motion of the handle. The position of the slider’s handle represents its value.
Usually the limits of the slider are shown at its ends. Figure 9-3 shows a slider
with minimum value 0 and maximum value 10. Its current value is about 6. You
can change the value of a slider in several ways:

● Place the mouse pointer on the handle, depress the left mouse button, and
drag the handle to the desired location. Some GUI tools might do something
(for example, change a plot) as you drag the handle. In other cases, nothing
happens until you release the handle at the new value.

● Click the middle button at the new value.

● Click the left button away from the handle to increase or decrease the value
a small amount. Holding the button down makes the handle steadily move
towards the cursor.

Often a value is displayed with a slider and a variable edit box (for example, the
leadlag demo). This allows the value to be changed either by dragging the
slider or entering a new value via the keyboard.

FIGURE 9-3 PGUI Example Dialog after
Pressing the 12 Button
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■ Plots, which can accept graphical input from the user, can also appear in GUI
windows. You can use the left mouse button for graphical input, the middle for
plot zooming, and the right for plot data value viewing:

● The function of the left mouse button depends upon the particular tool and
plot. Often a tool allows a curve to be grabbed and dragged by depressing
the left mouse button with the cursor near the curve, dragging the mouse
with the button down, and then releasing at a new position.

● Pressing the middle mouse button anywhere in the plot creates a box con-
taining a magnification of a small area of the plot centered at the cursor.
The middle mouse button can be held down and dragged, which creates an
effect similar to dragging a magnifying glass across the plot. The center of
the zoomed window corresponds to the tip of the cursor.

Pressing Control with the middle mouse button increases the size of the mag-
nified box. Pressing Shift with the middle mouse button increases the zoom
factor. Pressing Shift and Control with middle mouse button yields a large
zoom box with a large magnification factor.

● By pointing at or near a curve or object in a plot and pressing the right
mouse button, a small window appears; it identifies the curve or object and
gives the coordinates and index of the nearest data value.

If you press and drag the right mouse button, the selected curve is tracked,
even if another curve comes close.

Pressing Shift along with the right mouse button allows the user to get val-
ues on the piecewise line curve that interpolates the data values. In this
case “index 45.7” means that the selected plot point is between the 45th
and 46th curve index entries.

9.3 GUI Programming Overview

The Programmable GUI allows you to perform the following tasks:

■ Design the layout and appearance of windows.

■ Create, destroy, and manipulate these windows.

■ Bind Xmath variables to various objects in the windows.

■ Arrange for Xmath code to be executed when the user interacts with the win-
dows.
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These tasks are accomplished as follows:

■ Windows are created, destroyed, and manipulated using a number of Xmath
functions.

■ Bindings between Xmath variables and sliders, pushbuttons, plotted curves,
and other objects in the GUI windows are specified by setting the appropriate
widget attribute.

■ The execution of particular pieces of Xmath code when the user interacts with a
GUI window is also specified by setting the appropriate widget attribute.

These tasks are described in more detail later in this chapter and in the Xmath on-
line Help.

9.4 Concepts and Terminology

A single GUI application is called a tool. The components that make up a complete
tool are described in the following section. Usually a user explicitly starts a tool by
sending a command (MSC) to Xmath. The MSC calls some Xmath functions that tell
the GUI to create a new tool, one or more windows, and their children widgets. This
is what happens when you type guidemo . After the MSC creates one or more initial
windows, the MSC returns and Xmath is again idle. Tools can be launched in other
ways. For example, an MSF, script file, or another tool can launch new tools.

Once a tool is created, it is then used as the parent of all subsequent windows cre-
ated. Each window is then in turn used as the parent of each widget in that window.
In this way a hierarchy of the tool is defined. As it is created, each object is given
various attributes that define different aspects of appearance and behavior, includ-
ing the binding hooks back to Xmath. The binding of variables to various objects on
a window is a key feature of the GUI. For example, a variable can be bound to a
slider in a window. Whenever the user moves the slider, the Xmath variable is up-
dated. Similarly, whenever the Xmath variable is updated, the slider moves. Vari-
ables can also be bound to plotted curves: whenever the variable is changed, the
plotted curve changes accordingly. With variable binding, you don’t have to explic-
itly update a display; merely changing the value of the variable (reassigning it)
causes all displays bound to the variable to update automatically.

A second key feature of the GUI is the Xmath callback. In itself, updating a variable
when the user moves a slider isn’t useful. Every time the user interacts with a win-
dow (that is, moves a slider or selects a pushbutton), you can specify certain Xmath
code to be executed through an Xmath callback. An Xmath callback simply means
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that the tool’s MSC is called with arguments that describe what the user just did.
Based on these arguments, the MSC can take whatever action is required.

The GUI is event driven. Normally, Xmath is idle. When the user does something to
a GUI window, variables, if any, are updated, and Xmath callback(s), if any, are exe-
cuted. Once the Xmath callbacks finish (that is, the MSC returns), Xmath is again
idle, waiting for a new event.

9.4.1 Conceptual Example

A conceptual example can show how these features work together to form a simple
tool. Suppose we have some Xmath code computey.msc that computes some value
y given some parameter value x . Our tool arranges for the variable y to be bound to
a read-only slider and the variable x to be bound to an interactive slider. The tool ar-
ranges for the Xmath code computey.msc to be executed when the interactive
slider is released.

When our tool is invoked, a window containing the sliders appears. When the user
moves and releases the interactive slider, the variable x is first updated (assigned its
new value) and then the Xmath code is executed (using the new value of x ). The
Xmath code assigns a new value to the variable y . Since y is bound to the read-only
slider, the read-only slider changes to reflect the new value of y .

It is interesting to compare the original Xmath code with the tool described above
from the user’s point of view. The user interacts with the original code by repeatedly
typing commands into the Xmath command window such as x=3.2 followed by
computey followed by y , which prints the new value of y to the Xmath log area.
Thus, user input and output are via the Xmath command and log areas, respec-
tively, and both are alphanumeric in form.

In contrast, the user interacts with the tool described above by simply grabbing and
moving the interactive slider. After it is released, the new value of y is displayed on
the read-only slider. Thus, user input and output are via the sliders in the tool’s
window and graphical in form. In effect, we have implemented a completely graphi-
cal interface for our original Xmath code computey.msc . In fact, once the graphical
tool is running, we can iconify all of the standard Xmath windows, and someone
completely unfamiliar with Xmath can use the code computey through the slider
and bargraph.
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9.4.2 Anatomy of a GUI Tool

It is possible to type commands directly in the Xmath command window that in-
struct the GUI to create a tool and windows. Usually, however, a GUI tool consists of
MathScript Command files (MSCs), MathScript Function files (MSFs), and a Help file
(.hlp ):

■ An MSC contains the code for starting the GUI tool and all the code for the
Xmath callbacks. An Xmath callback simply calls the MSC with particular argu-
ments, and the MSC takes the corresponding action based on these arguments.
If the tool is smaller, the MSC may also contain all the widget creation code as
well. A large tool can consist of multiple MSCs. Usually though all the tool call-
backs are in one MSC. The tool’s MSC filename is the tool name followed by the
extension, .msc.

■ MSFs are often used if the tool is quite large. An MSF can help organize and
group widget creation code to a particular window or functionality. The MSC
can call an MSF at the appropriate time to create portions of the tools GUI as
needed.

■ A Help file contains one or more Help messages or strings. The tool’s Help file is
the tool name followed by the extension, .hlp .

These files are described in more detail in the following sections. See the GUI demos
in $XMATH/demos/gui for examples of each of these files. Each of the demos is im-
plemented as an MSC script, possibly an MSF script, and an ASCII file that contains
the Help message text and global plot options. You can develop and debug GUI ap-
plications rapidly with Xmath’s interactive environment and debugger.

9.4.3 MSC File

The tool’s MSC is declared with three arguments:

command MSC_name {fragname, widgetname, instance}

When an Xmath callback occurs, the MSC is called with two strings (fragname and
widgetname ), and an integer (instance ). The string fragname is the name of the
Xmath code fragment to execute. The string widgetname is the name of the widget
that caused the callback (usually this will be ignored, unless a single Xmath code
fragment needs to handle user input into different widgets). Finally, the instance
number uniquely identifies multiple instances of the same window. For example, if
two identical windows are instantiated (see “uiWindow” in the online Help) and the
user selects a pushbutton on each window, one Xmath callback will have instance
= 1 , and the other will have instance = 2 .
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Usually each Xmath code fragment is executed using goto , so each Xmath code
fragment name is written as a goto label. Also, when the MSC is invoked with no
arguments, it is often convenient (but not necessary) to arrange that the tool itself
be launched. Therefore, a template MSC appears as follows:

Command MSC_name {fragName, widgetName, instance}

if (exist(fragName))
goto *fragName;
else# start tool
[CODE LAUNCH TOOL GOES HERE]
return;
endif

<ButtonPressed> #executed when fragname == "ButtonPressed"
[CODE TO EXECUTE WHEN BUTTON IS PRESSED]
return;

<SliderMoved> #executed when fragname == "SliderMoved"
[CODE TO EXECUTE WHEN SLIDER IS MOVED]
return;

<DoQuit> # executed when fragname == "DoQuit"
[CODE TO QUIT TOOL]
return;

endCommand

9.4.4 Help File

The tool’s Help file is where the tool’s Help messages are stored. Each Help message
(or Help fragment) is preceded by a name or label. The name is used to refer to the
particular Help fragment. The order of the Help fragments in the Help file is not im-
portant. The Help file can be quite large if necessary; fragments are read only when
needed.

Each Help fragment has the form:

<helpFragName>
This is the Help text that will be displayed.
The Help text can contain many lines. The indent of
the initial line is stripped from all lines.
# comment lines (lines starting with '#') are ignored,
# although an embedded '#' will not be treated
# specially. Use '\#' at the start of a line if
# you need a '#' at the start of a non-comment line.

The Help fragment name helpFragName is any string of your choice. The indent of
the initial line of the Help fragment will be stripped off all the lines in the Help
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fragment when the Help fragment is displayed. This assists in the legibility of the
Help file.

One Help fragment can be included inside another with an include  directive:

<helpFrag1>
Note that:
!#include <helpFrag1>

That's all folks!

<helpFrag2>
This Help text contains two
lines.

The extra indent of the include line is applied to the entire included fragment, so the
above is equivalent to:

<helpFrag1>
Note that:

This Help text contains two
lines.

That's all folks.

The include facility is useful for grouping Help messages on specific topics into a
single large overview message. For an example, see the Help file for the leadlag demo
($XMATH/demos/gui/leadlag.hlp ).

The Help fragment name can be followed by an optional title:

<helpFragName> Help Dialog title
This is the Help text that will be displayed.

The Help text can contain many lines.

Depending on the windowing system you use, the title should be displayed in the
top border of the Help window.

The Help file is really a database of strings accessed by name. The Help file can be
used to store strings or string arrays that a tool needs. Long options to the uiPlot
function, for example, can be placed in the Help file. This feature is shown in the
binding1 demo ($XMATH/demos/gui/binding1.hlp ).
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9.5 Xmath GUI Functions

The Xmath GUI functions are categorized as follows:

■ uiToolCreate— creates a function for a tool.

■ uiWindow—creates a function for a top-level window of a tool.

■ uiPanel , uiTab , and uiTable— create container regions in a window or other
container.

■ uiMenu and uiMenuItem— create menu bars, pulldown menus, popup menus,
and menu items.

■ uiButton , uiComboBox , uiList , uiSeparator , uiSlider , uiText , uiVar-
Choice , uiVarEdit , uiVarView , and uiLabel— are controls for windows and
containers for user interaction and displaying data.

■ uiPlotArea— creates a special control for displaying two-dimensional graphical
plots.

■ uiDestroy , uiExist , and uiHandle— are PGUI object operations for checking
existence, handle/name conversions and generic destruction.

■ uiHide  and uiShow—display and hide a PGUI object.

■ uiGetValue  and uiSetValue— get or set a PGUI object’s resources.

■ uiFlush— forces the update of the objects displayed.

■ uiTimer— invokes an Xmath callback after a given amount of time has elapsed.

■ uiPlot and uiPlotGet— are commands for generating two-dimensional plots
in a uiPlotArea  and getting user’s input to the plot.

■ uiFileSelection , uiMessage , and uiPrompt— are predefined dialogs for se-
lecting files, displaying messages, and prompting the user for input.

■ uiWindowDeiconify  and uiWindowIconify— deiconify and iconify a window.

■ uiWindowLower  and uiWindowRaise— lower and raise a window.

For more information on PGUI functions, see the “Programmable GUI” topic in the
online Help, which is under “MathScript Programming” in the left frame.
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9.6 Tutorial

In this section we discuss two tools: the pushbutton and the calculator examples.
These tools perform trivial functions; the point is not their purpose but their opera-
tion.

9.6.1 Pushbutton

Example 9-1 shows the ex1.msc  file, located in the $XMATH/demos/gui  directory.

EXAMPLE 9-1: Pushbutton Creation

command ex1 {fragname, widgetname, instance}

alias T "ex1"

if( exist(fragname) )
goto *fragname;

else
tl = uiToolCreate("ex1");
wn = uiWindow(tl,{name = "win", title = "Tutorial"});
void = uiButton(wn,{

text = "Press This Button",
xmath = "ButtonPress"});

main.count = 1;
void = uiShow(wn);

return;
 endif

<ButtonPress>
main.count = main.count + 1;
display sprintf("Button Press count: %d", main.count);
if(main.count >= 5)

void=uiDestroy("ex1");
 endif;
 return;

endcommand

When the user types

ex1

The ex1 tool window appears.
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Let’s investigate the steps that produced this window. When the user types ex1 , the
MSC ex1.msc  is invoked with no arguments. Therefore, the if conditional

if( exist(fragname) )

fails, and the else clause is executed. The statement

tl = uiToolCreate("ex1");

creates the new tool ex1 . (If the tool already existed, this step would first destroy the
tool and all its windows before creating a new tool.) The value returned and stored
in tl is the tool’s handle. All GUI creation routines return an object handle that is
used when creating the tool’s windows; the object handle can also be used to refer-
ence the tool for other GUI functions, such as uiExist and uiDestroy . In addition
to the handle, some operations on a tool can also be invoked with the tool’s name.

The next statement:

wn = uiWindow(tl,{name = "win", title = "Tutorial"});

actually creates a new window. The keyword arguments provide attribute informa-
tion about a widget, the window in this case. You can provide a widget name—win
in this case—so that you can reference the widget by its name instead of its handle.

void = uiButton(wn,{text = "Press This Button",
xmath = "ButtonPress"});

creates a single button as a child of the window. Since no type keyword is specified,
the default type “button” is created. The text keyword specifies the text to appear
on the button face and the xmath keyword designates the callback fragment to exe-
cute when the button is pressed.

At this point, the window is still not visible. The call to uiShow makes the window
appear when desired. In this case, note that the call to uiShow takes the handle re-
turned from the uiWindow call. The call to uiShow could just as well appear as fol-
lows, which uses the name passed into the uiWindow  function.:

uiShow("ex1","PushBWin")

While handles are slightly more efficient at times, they are less convenient. There-
fore, both methods are provided.
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Finally, the MSC initializes a global variable that is used to count button presses
and then returns:

main.count = 1;
return;

When the user clicks the button, the button checks to see if it has a value for its
xmath attribute. In this case it is set to “ButtonPress” so the button will invoke
the tool’s MSC as:

ex1 "ButtonPress", "Push"

We use the term Xmath callback to describe the calling of the tool’s MSC in this way.
The first argument is the argument value set as the xmath attribute, the second ar-
gument is the pushbutton’s name, and the third argument is the instance number
of the window, which will always be 1 (unless we create multiple instances of the
same window). Therefore, when the user activates the button, it is equivalent to typ-
ing:

ex1 "ButtonPress", "Push"

When called with these arguments, the MSC executes the code

main.count = main.count + 1;
display sprintf("Button press count: %d", main.count);
if(main.count >= 5)

void = uiDestroy("ex1");
endif;
return;

This increments the count variable and displays a message in Xmath’s log area. If
the button has been pressed five times, you can see the following messages in the
log area:

Button press count: 2
Button press count: 3
Button press count: 4
Button press count: 5

Then the tool is destroyed, which causes the window to disappear.

We use a global variable (main.count ) so that its value is maintained between calls
to the tool’s MSC. Local variables in an MSC disappear when the MSC returns. You
might notice that most GUI tools create their own partitions for storing all their glo-
bal variables.

xb.book  Page 16  Wednesday, October 6, 1999  11:28 AM



Xmath Basics Graphical User Interface

9-17

9

9.6.2 Calculator

Example 9-2 shows the ex2.msc  file, located in the $XMATH/demos/gui  directory.

EXAMPLE 9-2: Calculator

command ex2 {fragname, widgetname, instance}

alias T "ex2"

if( exist(fragname) )
goto *fragname;

else
tl=uiToolCreate("ex2")
wn=uiWindow(tl,{name = "win", title="Tutorial"});
tb=uiTable(wn,{columns = 2});
void = uiLabel(tb,{text = "Operand 1"});
void = uiSlider(tb,{varname = "op1",

xmath="NewOperand",
xmathdrag="NewOperand", flags = "hdm",
min = -1, max = 1})

void =uiVarChoice(tb,{text="Operation",
xmath="NewOperation",
varname= "operation", flags = "H",
items=["plus", "minus", "times"],
values=[1,2,3]});

void = uiLabel(tb,{text="Operand 2"})
void = uiSlider(tb,{varname = "op2",

xmath="NewOperand",
xmathdrag="NewOperand", flags = "hdm",
min = -1, max = 1})

void = uiSeparator(tb,{colspan = 2});
void = uiLabel(tb,{text="Result"})
void = uiSlider(tb,{varname = "result",

xmath="NewOperand",
xmathdrag="NewOperand", flags = "bhdms",
readonly, min = -2, max = 2})

void = uiSeparator(tb,{colspan = 2});
void = uiButton(tb,{text = "Quit",

col = 1, xmath = "DoQuit"});
main.op1=0;
main.op2=0;
main.operation=1;
ex2 "NewOperation";
void = uiShow(wn);
return;

endif

<NewOperation>
<NewOperand>

if( main.operation == 1 )
main.result = main.op1 + main.op2;
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elseif ( main.operation == 2 )
main.result = main.op1 - main.op2;

elseif ( main.operation == 3 )
main.result = main.op1 * main.op2;

endif
return;

<DoQuit>
uiDestroy("ex2");
return;

endcommand

When the user types

ex2

a window showing a selectable operation between two operands appears. This win-
dow is created using the same steps as the previous tutorial. However, it uses a few
more widgets, the first of which is the uiTable . A table is used for laying out a
number of other objects in regular rows and columns.

tb = uiTable(wn,{columns=2});

The keyword columns  does two things:

■ It sets the number of columns the table will have

■ It specifies that the table will fill rows first

Widgets will be added across the table, one per column.

void = uiLabel(tb,{text = "Operand 1"});

creates a label containing text string, “Operand 1.”

void = uiSlider(tb,{varname = "op1", xmath="NewOperand",
       xmathdrag="NewOperand", flags = "hdm", min = -1, max = 1})

creates a slider bound to the Xmath variable op1 . Each time the user sets the slider
to a new value, and each time the slider is dragged, the variable op1 is updated and
the Xmath callback NewOperand is called. (Similarly, if the variable op1 is set to a
new value, the slider moves to the corresponding position.) The flag hdm specifies
that the slider is horizontal. The Xmath variable is updated as the user drags the
slider, and the minimum and maximum of -1 and 1 are enforced (even if the Xmath
variable is set by the programmer to a value outside this interval).
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void    = uiVarChoice(tb,{text="Operation",xmath="NewOperation",
varname = "operation", flags="H", items=["plus", "minus",
         "times"], values=[1,2,3]});

creates two entries in the table:

■ A label containing the text “Operation”

■ A box containing three radio buttons with the choices "plus" , "minus" , and
"times"  bound to the Xmath variable operation .

When the user selects one of these choices, the values 1, 2, and 3, respectively,
are assigned to the variable operation . (Similarly, if the variable is set to one
of these values, the corresponding radio button is set.)

Whenever the user selects a new toggle button, the Xmath callback NewOperation
is called.

void = uiLabel(tb,{text="Operand 2"})

creates a label containing the text string,  “Operand 2.”

void      = uiSlider(tb,{varname = "op2", xmath="NewOperand",
xmathdrag = "NewOperand", flags = "hdm",
            min = -1, max = 1})

creates a slider bound to the Xmath variable op2 . This slider is otherwise the same
as the first.

void = uiSeparator(tb,{colspan = 2});

draws a horizontal line in the row. The colspan = 2 keyword expression causes it
to occupy both columns in the table.

void = uiLabel(tb,{text="Result"})

creates a label containing the text “Result.”

void      = uiSlider(tb,{varname = "result", xmath="NewOperand",
xmathdrag = "NewOperand", flags = "bhdms",
            readonly, min = -2, max = 2})

creates a read-only slider bound to the Xmath variable result . The user cannot
drag this slider because of the readonly keyword, but, whenever the Xmath vari-
able result is set to a new value, the slider changes accordingly. The limits of this
slider are -2 and 2.
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When the user sets the Operand 1 slider to a new value, the variable op1 is set to
the new value, and the Xmath callback NewOperand is called. If the new value is,
for example, 0.75, these operations are identical to the user typing the statements:

main.op1 = 0.75;
ex2 "NewOperand", "dontcare",1;

(The actual widgetname argument will be different, but this isn’t relevant to the dis-
cussion.)

This callback causes the following Xmath code to be executed:

<NewOperation>
<NewOperand>

if( main.operation == 1 )
main.result = main.op1 + main.op2;

elseif ( main.operation == 2 )
main.result = main.op1 - main.op2;

elseif ( main.operation == 3 )
main.result = main.op1 * main.op2;

endif
return;

Based on the operation, the new result is computed. Since the variable main.re-
sul t is bound to the bottom slider, the new value is automatically displayed when
the variable is assigned. Similarly, when the user changes the operation, the same
Xmath code is called to compute the new result.

For additional examples and descriptions, see the Xmath online Help.

9.7 Translating Version 5.X GUI Files to Version 6.X PGUI Files

This section describes the two utilities for translating Version 5.X GUI files to Ver-
sion 6.X PGUI files, instructions on executing these scripts, details on using the
translator, and some minor limitations.

9.7.1 Overview

Due to the significant changes in the Xmath Programmable GUI (PGUI) syntax in
MATRIXX Version 6.X, the to60pgui utility has been created to facilitate the transi-
tion of old graphical tools to the new syntax (see Section 9.4.2 on page 9-10). This
utility consists of a pair of Perl scripts that convert the resource and MSC or MSF
files from Version 5.X syntax to the Version 6.X syntax.

NOTE: MSC and MSF files are translated in place. Make sure you have a backup.
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9.7.2 Execution

The easiest way to execute these Perl scripts is to copy them to a working directory.
Ensure that Perl is in your path and copy the tool to be translated to that working
directory. Then execute the main script with the following command:

perl to60pgui.pl Mytool mytool .msc

where Mytool is the X resource file used by mytool .msc . A resource file is a collec-
tion of resource settings that describe the appearance of the windows,

NOTE: The tool could also be an MSF in which case you provide the appropriate
name and extension.

This script modifies the original mytool .msc file (make sure you have a backup)
and creates a new file named mytool _build.msf from the resource file. You can
then compare the files and make any needed modifications. After that you should be
able to run the MSC as before.

The Perl script restopgui.pl converts the X resource file, Mytool , to an MSF file
in the new format. To run the resource translator restopgui.pl independently,
use the following syntax:

perl restopgui.pl Mytool

where Mytool  is the X resource file.

This script creates a new MSF file with the name mytool _build.msf .

9.7.3 Details

The MSC translator scans through an MSC file and changes any Version 5.X
Gui Function to a Version 6.X ui Function with the exception of
GuiShellCreate and GuiDialogCreate . These functions have no counterpart in
the Version 6.X PGUI because there is no need to create a shell separately from cre-
ating a window. However, in the old GUI these calls caused the window and its chil-
dren to be created, so they are not just omitted from the new file. Instead they are
changed to a call to an MSF file that is generated from the tool’s X resource file. This
call to the new MSF file has the same result as calling GuiShellCreate or
GuiDialogCreate  in that the window specified and its children are created.

For example, in our Fourier  tool a GuiShellCreate  call such as:

GuiShellCreate("fourier", "MainWin", "Fourier Tool", "fourier
tool");
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becomes

Fourier_build("fourier", "MAINWIN", "Fourier Tool", "fourier tool");

Notice that the second argument is converted to uppercase because the second ar-
gument in the fourier_build.msf file is used as the fragment label. The third
and fourth arguments are optional as they are in GuiShellCreate . See Limita-
tions.

The resource file conversion results in a new MSF file named
resourcefile _build.msf . For example, Fourier becomes
fourier_build.msf . The resource file conversion is the biggest task of the trans-
lator. It takes all of the X resource specifications and creates a hierarchy of Xmath
calls to build the desired user interface. The commands in the resulting MSFfile are
grouped by window and indented to show the hierarchy. Fragment labels separate
the code associated with each window so each window can be created as needed.

9.7.4 Limitations

The PGUI translators have some minor limitations because some features are not
supported by PGUI or X resource settings need human intervention to be properly
assigned. More specifically, X resources set in a global sense, such as a Motif class
of widget, are not handled. Also, X resources set to affect all children of a certain
widget are not handled. Examples of these are:

*MyTool*background: red

and

*MyTool*MainWin*background: redvisible

Specific X resources, such as the following, are not supported:

*MyTool*MyText.marginwidth: 4

In general, anything that can’t automatically be translated is set as a comment us-
ing uiSetValue . The generic comments appear in the beginning of the MSFfile and
the more specific ones appear after the creation of the widget in question.

Within an MSC, calls to GuiSetValue  are not translated if they are of the form

GuiSetValue(T, "resource block");

where resource block is one or more X resource settings to be applied to the re-
source database. For both GuiSetValue and GuiGetValue , if the resource
block is not known, then the command is not translated.
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For additional help with any PGUI translation, contact Support as described on
page xxvi.
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A X Windows and Motif

This appendix introduces X Windows and the Motif window manager. If you are not
using Motif, much of the Motif material will still be useful to you, as Xmath uses
Motif to create dialogs and other elements (regardless of your window manager).

The material in this appendix gives general information that allows an
inexperienced X Windows or Motif user to use Xmath and X at a novice level.
However, it is not a replacement for X Windows documentation or documentation
appropriate to your window manager.

A.1 X Window System

What is X Windows? “The X Window System, commonly referred to as X, is a net-
work-based graphics window system that was developed at MIT in 1984.”†

Xmath can be used with any window manager that runs as a layer over X Windows.
X is largely transparent from Xmath; usually you only notice it while logging in or
out.

Your X installation can be very complicated. If you are unfamiliar with X, you
should consult the documentation or ask your system manager about your installa-
tion.

† Quercia, Valerie & O’Reilly, Tim, The Definitive Guides to the X Window
System, Volume 3: X Window System User’s Guide (O’Reilly & Associates,
Inc., 1988, 1989), p 5.
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You should know the answers to the following questions:

■ Does your installation have an autostart procedure for X Windows, or must you
start X Windows manually?

■ If you start manually, what is the command to initialize X Windows at your site?
(Usually it is xinit .)

■ Are X Windows, window manager, and Xmath available locally, or must you ac-
cess them across a network? If you are getting these applications from a remote
source, what special instructions apply?

A.1.1 Starting X

You should see your system manager to verify the correct way to start X at your in-
stallation. The normal procedure for starting X is as follows:

1. Log in at the system prompt.

2. Type xinit .

A.1.2 X Terminology

This section defines some general terms this manual uses to direct your interaction
with Xmath windows and menus. For comprehensive information, consult X Win-
dows documentation or man pages.

Software Terms

Creating an environment for Xmath requires several types of software that are usu-
ally transparent to you. They are mentioned briefly here so that you have a point of
reference if you see these terms in error messages, default files, etc.

The lowest-level software is the operating system—currently we assume UNIX. On
top of that you must have X Windows and a window manager (such as Motif).

X Windows is a windowing system. A windowing system allows many processes to
exist simultaneously, each running in a different window. X keeps track of input
and output data for all windows.

A window manager is a client (an application) that describes how a window looks
and allows you to manipulate windows (move, resize, stack, etc.). Xmath could be
run without a window manager, but there would be no borders, the windows
couldn’t be moved or resized, and so on.
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The final element is the server. In this context, the server communicates X graphics
instructions to the screen.

In general, X tells how a window is drawn, a window manager defines its appearance
and activity, and the server implements these instructions on your graphics display.

Mouse Terms

A list of the mouse conventions is on page 1-9. Some common mouse instructions
are:

click — Press and quickly release a mouse button. If click is used without a button
designation, MB1 is assumed. For example, “click the root window.”

double–click — Two clicks in quick succession. Double-click without a button
designation assumes MB1.

drag — Hold down a mouse button while moving the mouse. This action is used for
movement and resizing. Release the button when the desired result is obtained.
Drag assumes MB1.

press, push — ““Press” or “push” can be used interchangeably with “click MB1.” These
terms are often used for buttons. For example, “press the Lock  button.”

A.2 Motif Window Manager

As discussed earlier, a window manager allows you to manipulate windows. In the-
ory, you should be able to use any window manager that is compatible with X11 (see
the System Administrator’s Guide for your operating system; this documents UNIX
window managers under which Xmath has been tested). The window manager cre-
ates frames and is also responsible for any window functions in X Windows and
Xmath. The graphics in this manual use standard Motif frames.

A.2.1 Motif Frame Components

The frame is basic to all windows. Figure A-1 shows an xterm and labels each fea-
ture in the frame.

■ The rectangular button shown in Figure A-1 activates the Default Window
Menu. This button has seven selections to change the window’s appearance or
position. These are discussed in Default Window Menu.

■ The title area displays the name of the window. Click on this area (not including
the buttons), then drag to move the window.
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■ The title bar is the title area and the buttons.

■ The Minimize button turns the window into an icon (a small manageable graphic).
To minimize (or iconify) a window, click MB1 on the Minimize button. The result-
ing icon has the same name as the window. To bring the window back, click
MB1 on the icon.

■ The Maximize button enlarges a window to fill the screen (it is not the opposite of
Minimize ). To maximize a window, click MB1 on the Maximize button. To return the
window to its former size, click the Maximize  button again.

Default Window Menu

To view this menu, click MB1 over the rectangle. You can see the selection box move
as you run the mouse up and down the menu. Click MB1 to select. If an item is not
available, it will be grayed out. If you don’t want to make a selection, move the
mouse off the menu and release the mouse click in a neutral area (the root window,
for example).

■ Restore returns a minimized or maximized window to its original state.

■ Move enables you to position a window anywhere you wish. The cursor will at-
tach to the center of the window.

■ Size resizes the window.

■ Minimize reduces a window to an icon.

■ Maximize enlarges a window so that it fills the entire screen.

Minimize MaximizeDefault Window Menu Title Area

Title

FIGURE A-1 Window Frame

Bar
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■ Lower puts the current window in back of any window(s) sharing the same
space.

■ Close terminates the client. In Xmath it is preferable to use File→Quit for the
Xmath Commands window or File→Close Window from other Xmath windows,
rather than closing from the Default Window Menu.

For instructions on making menu selections using keystrokes, see Section A.2.4.

Frame Buttons

Minimize

Reduces the window to an icon; double-click or select Restore from the Default Win-
dow Menu to return it to original size. Has the same effect as Minimize on the De-
fault Window Menu.

Maximize

Enlarges the window to fill the entire screen; click the Maximize button again, or se-
lect Restore from the Default Window Menu to restore it to original size. Has the
same effect as Maximize on the Default Window Menu.

Window Operations

These operations can be accomplished without using the Default Window Menu.
Move the pointer over a window’s frame. Notice the changes in the pointer. The
pointer symbols are shown in Figure A-2.

Resize and move require you to drag:

resize — To change the size in one direction, place the cursor over an edge, then drag
to the desired dimension. To simultaneously change two dimensions, place the
cursor over a corner, then drag to new size.

move — To move a window, place the cursor in the title area, then drag to the desired
location.

A window is raised (brought to the front) whenever you click on its Title Area. The
only way to lower a window (send it to the back) is from the Default Window Menu.

A.2.2 Mouse Focus and the Pointer

When you move the mouse, the pointer moves on the display. Pointer position gov-
erns input focus (that is, where keyboard input appears). That is, the pointer deter-
mines the active window.
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In Motif (and most other window managers) there are two ways to give input focus.
For simplicity, let’s describe them as point and point-and-click. The point method
means that input is directed to the window under the pointer. For point-and-click,
you must position the cursor over the target window, and then click before you have
focus.

There are several pointer symbols to become familiar with. The pointer symbol
changes according to the context, as described in Figure A-2.

Consult your window manager documentation or see your system manager for more
information.

A.2.3 Copying and Pasting with Motif

You may find it easier to cut and paste available text (such as pathnames, etc.) in-
stead of retyping. Your machine’s selecting, copying, and pasting methods are valid
for both X Windows and Xmath.

The standard Motif method is:

1. Point to the desired text and drag until everything you want appears in reverse
video (is highlighted). Avoid highlighting extra characters.

2. Point to the destination and click MB2.

For movement, changes to a fleur.

For menus, points opposite direction from selection arrow.

If a corner is selected, the chosen corner is displayed.

If an edge is selected, the chosen edge is displayed.

FIGURE A-2 Pointer Symbols

A large X is visible when the pointer is over the root window.

The "I-beam" appears when the pointer is over an area that accepts text.

For resize, the pointer changes to a symbol appropriate to the selection:
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As an alternative to dragging, use one of the following three mouse-click selection
sequences. To select a word, point anywhere within the desired word and double-
click. To select a line, point anywhere on the line and click three times. To select all
text in an Xmath window, point and click four times.

These click sequences are often used in the Xmath Commands window to copy text
from the log area and paste it into the command area.

A.2.4 Using Menus Without the Mouse

The Motif window manager makes it possible to use Xmath menus via the keyboard.
To make a menu selection you normally place the pointer over the menu, drag down
MB1, and release when the desired selection is highlighted. If you look at the Com-
mands window menu bar, you will see that the first character of each pull-down is
underlined.

1. To invoke a menu, make sure the proper window has focus.

Press the Meta key (see Table 1-5 on page 1-11 for equivalents across platforms),
followed by the character underlined in the menu bar. For example, press Meta-e to
invoke the Edit menu. Note that although the underlined letter is capitalized,
only lowercase letters will work (this is a Motif limitation). Use the up and down
arrow keys to travel up and down the available options. Hit Return to invoke an
option.

2. Once you are in the menu bar, use the left and right arrow keys to move along
the menu bar.

3. If a submenu is available, an arrow points to the right at the end of the entry.
Cursor up or down to the submenu and press the right arrow key to pop up the
submenu. To go to a top-level menu, keep pressing the left or right arrow  keys.

4. Press Esc or F10 to dismiss the latest menu.

The above option works with any Xmath window.

A.2.5 Using a Motif File Selection Dialog

Figure A-3 shows a typical dialog that uses the Motif file selection dialog. Most dia-
logs have the same fields, but some actions may not require all fields. The instruc-
tions below show UNIX file paths.
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1. The first step is usually to make a selection from the Directories (the column on
the left): either click on a selection and press Filter , or double-click on the selec-
tion. You may need to use the scroll bars to bring the name in view.

Alternatively, type in the Filter field to alter the search parameters. However, you
must have a file specification, even if it is only the wildcard * . To start the
search, either press Return  or push the Filter button at the bottom of the dialog.

Files meeting the filter criteria are displayed in the Files field. To search for the
same parameters in another place, double-click on a new entry in the Directories
field. Note that both columns can be scrolled to view long names.

2. To make a selection from the Files field, either click on an entry and press Return ,
or click on an entry and push OK, or double-click on the file. Note that the se-
lected file will be displayed in the Selection  field.

FIGURE A-3 Exec File Selection Dialog
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A.3 Changing Resource Parameters

If you want to change Xmath’s appearance (color, etc.), you must be familiar with
how X Windows works. The way Xmath looks is defined in a resource file, which
contains hundreds of settings. Xmath looks for a resource file that isolates re-
sources that directly affect Xmath (see Table A-1); this file often resides in your
home directory and is read when X windows is started. (If you are on a network, you
may not have a copy in your home directory.)

The $XMATH/etc/Xmath file contains default settings for Xmath that you may want
to change or override. Do not modify the $XMATH/etc/Xmath file. Instead, use a lo-
cal version in your home directory to specify any changes. Your version only needs
to contain settings that differ from the defaults. Example A-1 shows a sample Xmath
file.

EXAMPLE A-1: Sample Xmath File

!A local Xmath file must reside in your home directory. This file
!changes window sizes and has them appear staggered on the right side
!of the screen:
!----------------------------------------------
! COMMAND WINDOW
*main.geometry:       535x695-5+85
*main*log.rows:            32
*main*command.rows:        7

! GRAPHICS WINDOW
*graphicsW.geometry:  545x450-13+93

! HELP WINDOW
*helpW.geometry:     -21+101
*helpW*text.rows:          40

! DEBUGGER WINDOW
*debuggerW.geometry:  -29+109
*debuggerW*text.rows:      30

TABLE A-1 Resource File Default Location

ISI Top Level Resource File

UNIX $ISIHOME $XMATH/etc/Xmath
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Example A-1 deals with window dimension and placement only, but other common
changes might be changes to the keybindings or window colors. To make your own
Xmath  file, follow this procedure:

1. Copy Xmath  from its default location (see Table A-1) to your home directory.

2. Use a text editor to alter the local Xmath  file.

If you are changing the key bindings to a style other than emacs, the settings
will be commented out with exclamation marks (!); make sure these are removed
in your personal file.

3. After making changes, delete all unchanged portions.

Your changes will be implemented the next time you invoke Xmath. When you
start Xmath, the Xmath file in the default installation location is read first, fol-
lowed by the Xmath file in your home directory. (This is why duplications should
be deleted; startup will be slower if they exist.)

A.3.1 Remapping Your Keyboard

Because the keyboards in use with X workstations vary so much between platforms,
vendors, and countries, you may at some point wish to change the key bindings
Xmath uses.

Changing Key Bindings in X

A machine-specific key code is associated with each key on your keyboard. Within
the X Window system, you can use keysyms (key symbols) to make this machine-
specific code produce whatever key-binding code you need. To get the complete list
of key codes for all the keys on your keyboard, type:

xmodmap -pk

xmodmap gives output similar to that shown in Example A-2.

UNIX: If xmodmap is not in your path, see your system administrator.
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EXAMPLE A-2: Sample KeySym Output

There are 2 KeySyms per KeyCode; KeyCodes range from 8 to 132.

KeyCode KeySym (Keysym) ...
Value Value (Name) ...

: : :
61 0x0051 (Q)
62 0x0057 (W)
63 0x0045 (E)
64 0x0052 (R)
65 0x0054 (T)
66 0x0059 (Y)
67 0x0055 (U)
68 0x0049 (I)
69 0x004f (O)
70 0x0050 (P)
71 0x005b (bracketleft) 0x007b (braceleft)
72 0x005d (bracketright) 0x007d (braceright)
: : :

The KeyCode value in the first column is machine-specific and cannot be changed.
However, you can change the Keysym value globally (so that the key’s function is
changed in all applications) or locally.

For example, some keyboards do not include the []{} characters, which are used
widely within Xmath. On the SunOS and Solaris platforms, if you want to bind the [{
characters to the F1 key and the ]} characters to the F2 key, go to the command line
and type:

xmodmap -e "keycode 12 = bracketleft braceleft"
xmodmap -e "keycode 13 = bracketright braceright"

This means F1 will type “[” and Shift-F1 will type “{”, etc. Note that you should
modmap to keys you do not use, rather than to alphanumeric or punctuation keys.
Also, the key code values may be different on different platforms. For example, on
the HP platform, F1 is key code 16 and F2 is key code 24.

These xmodmap settings will be lost when you log out, so if you want them to be a
standard part of your environment, save the settings to a file and call this file up as
part of your .login  file.
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Changing an Xmath Key Binding

To get the list of all key bindings local to Xmath, look at the default Xmath file.
There you can see that the emacs style keyboard translation settings are the de-
fault.

Note that there are two translations: XmTextField.translations and
*XmText.translations . Text field translations are active in dialog boxes (where all
input is appended on a single line) such as the Load dialog. Text translations, (the
longer list) are active in multiline environments such as the commands window
command area and the debugger edit area. For this reason a key may have different
assignments. For example, look at the assignments for Key<Home>. In the Text field
translation it is set to beginning-of-line . In the text translation it is set to
beginning-of-file .

1. Create a file called Xmath in your home directory (this can be the same file dis-
cussed in Table A-1 on page A-9).

2. Go to the operating system and use xmodmap (page A-10) to identify the KeySym
name for the key you are rebinding.

3. Locate the key binding to assign to the chosen keycode.

4. To change a binding, put a line of the following form in your personal Xmath
file:

*defaultBinding:yourKeyBinding:<Key>yourKeySymName

5. Save your Xmath file and restart Xmath to see the change.

A.3.2 Sizing and Placing Windows

X Windows uses a geometry option to size and place windows. The standard geome-
try string is:

 width × height ± xoffset ± yoffset .

As shown in Example A-1, there are full geometry strings for the Commands window
and the Graphics window (dimensions are specified in pixels). You can size and
place the Graphics window in one step, because it is a single window.

It takes two steps, however, to do the same for the Commands window, (which han-
dles text in three areas). For it, you specify the number of character columns (the
default is 80), then specify the number of rows of text you want to see in each area.
Xmath builds a window that reflects your changes. Consequently the width × height
dimensions are unknown. This means the dimensions shown in the example may
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not necessarily work on your machine, because the true dimension of a window is
affected by factors Xmath does not control, such as border width and shadowing
settings specified for your window manager. If the sizes do not agree with what X
Windows knows, it may use the defaults instead; or you may see that the size was
changed as you desired, but the window is not in the place you want it.

To find out the true window size, restart Xmath with the new settings. When the
window appears, go to an xterm and type xwininfo .

When you get a crosshairs cursor, click on the window you need to control, and
make note of the width and height dimensions.

Note that in the sample on page A-9 only the placement dimensions need to be sup-
plied for windows other than the commands window; your window manager, may,
however, require a full geometry. See your X Window documentation for a full de-
scription of this process. Edit your Xmath file so that it contains the correct dimen-
sions for the windows you want to move. Save your file and restart Xmath.
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B Xmath HP-GL Driver

Xmath supports Hewlett-Packard Graphics Language (HP-GL) hardcopy devices. You
can choose to either print to a file (that is, save the output in a file), or print to a
printer. To write an HP-GL file, go to the graphics window and select File→Save (to
print to a file) or File→Print (to print to an output device), or use the hpgl keyword
in the HARDCOPY command.

NOTE: The HPGL driver does not support hidden surfaces. For 3-dimensional
plots, you must remove the surfaces by suppressing the face keyword
(!face  or face=0 ).

B.1 Supported Devices

All devices supporting the HP-GL language (for example, HP plotters models
HP7550A, 7470, 7475, 7580, 7585, and 7586) should be able to plot the .hp file
created by Xmath. The following plotters have been tested: HP7440A, HP7575, and
the ENCAD SP2800 plotter.

B.2 Setting the Aspect Ratio

Xmath assumes a paper size of 8.5 by 11 inches on the HP7440A, corresponding to
a plotting area of 25 by 18.1 cm. The aspect ratio of the hardcopy output might
change if you use a different plotter or paper size. You can use the Print Scale op-
tions in the Print dialog to change the aspect ratio of the plot.
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B.3 Color Pen Specifications

Xmath expects the following color pens to be in the specified stalls in the pen carou-
sel, as indicated in Table B-1.

Xmath attempts to map plot colors to these eight colors.

TABLE B-1 Color Pen Specifications

Pen
Number

Expected Color
Pen

Number
Expected Color

1 black 5 red

2 blue 6 magenta

3 green 7 yellow

4 cyan 8 digitizing sight
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C Xmath for MATLAB Users

Xmath is a numerical problem-solving application similar to MATLAB™ and other
numerical software. While many of the constructs for storing and manipulating data
are similar to MATLAB, you will find that Xmath extends both the amount of infor-
mation stored with a given object and the number of actions a command or function
can take, depending on the type of data passed. The Xmath work environment re-
tains the configurable nature you are accustomed to in MATLAB, but syntax
changes have been made to make Xmath more consistent, intuitive, and flexible.

This appendix describes changed features, explains the motivation for changes, and
in general helps smooth your transition from MATLAB to Xmath. Section C.1 de-
scribes basic changes in the punctuation and syntax used in the software.
Section C.2 describes objects that were represented as vectors or matrices in MAT-
LAB but are represented as full-fledged data types in Xmath. Section C.3 describes
differences that affect environment settings, data representations, and program-
ming issues. Section C.4 provides a comparison between Xmath and MATLAB of fre-
quently used commands. Moreover, tables illustrating equivalent expressions in
MATLAB and Xmath appear throughout this appendix.

C.1 Syntactic Differences

This section details Xmath features that have the same functionality as MATLAB
features, but are invoked in a slightly different way.

C.1.1 Continuation

If a MATLAB function cannot fit onto a single line, it can be split over multiple lines
with two adjacent periods to signal a continuation.
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In Xmath, a continuation is seldom needed; if an unmatched parenthesis or brace
exists, or the line ends in a comma, Xmath assumes that the expression will con-
tinue. Aside from this, the Xmath command area can take a line of nearly infinite
length (2^31-1). Most users break their instructions for readability rather than ne-
cessity. Xmath uses an ellipsis (...) when an explicit continuation is required. Be-
cause strings must be complete on a line, they are the most frequent candidates for
continuation. Table C-1 shows examples of command continuation in MATLAB and
Xmath.

C.1.2 Output Display

In MATLAB, variables are by default displayed to the MATLAB command window as
soon as they are created; output is suppressed if a semicolon is placed at the end of
the expression that generated the variable.

Xmath’s default display mode behaves similarly. This mode can be explicitly set with
the command set display on .

Alternatively, you can specify set display off . In display-off mode, any variable
created with an expression containing an equality sign is not displayed to the
Xmath Commands window log area. For example,

A=sin(pi)

does not generate any output in the commands window log area if the display is Off.
If you want to display a value as soon as it is created, place a question mark (?) at
the end of the expression. If you want to see the value of a previously-created vari-
able, type its name; because the name is not an expression (does not contain an
equality sign), its value is displayed. Table C-2 shows examples of output display in
MATLAB and Xmath.

TABLE C-1 Command Continuation Examples

MATLAB Xmath

plot(1:10,..
'b')
title('An Easy Plot')

plot (1:10, {!grid,
title="An Easy Plot"})

plot(x,
{title="A very"+...
" long string"})
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C.1.3 Matrix Punctuation

Matrices are created and entered in the same basic manner, with one important dif-
ference: all matrix elements in Xmath must be separated by commas, as shown in
Table C-3, whereas commas are optional in MATLAB.

When you specify matrix elements separated only by spaces, it is unclear whether
the element specification [1 -1] represents two separate numbers or the single num-
ber 0 (the result of the arithmetic operation 1 - 1 = 0). Because matrix elements in
Xmath must be explicitly delineated by commas, the value of a given element is al-
ways clear both to you and to the Xmath interpreter. You still use semicolons and
new lines to mark the end of a matrix row.

C.1.4 String Punctuation

To avoid confusion with the transpose operator, Xmath uses double quotation
marks rather than the single quotation marks used in MATLAB. Table C-4 illus-
trates.

The treatment of string variables is discussed in more detail later in this appendix.

TABLE C-2 Output Display Examples

MATLAB
Xmath

(set display on)
Xmath

(set display off)
output?

A = SIN(PI); A = sin(pi); A = sin(pi) No

A = SIN(PI) A = sin(pi) A = sin(pi)? Yes

A A A Yes

TABLE C-3 Matrix Punctuation Examples

MATLAB Xmath

A = [1 -1 2;-4 3 12]
or
A = [1,-1,2;-4,3,12]

A = [1,-1,2;-4,3,12]

TABLE C-4 String Punctuation Examples

MATLAB Xmath

str = 'This is a string' str = "This is a string"
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C.1.5 Logical Not

In MATLAB the operator denoting a logical not is a tilde (~); in Xmath it is an excla-
mation point (! ). To express an inequality relation in Xmath, use <> (the greater-
than and less-than signs); in MATLAB ~= (tilde-equality sign) denotes inequality.
Table C-5 shows the logical not  operators for MATLAB and Xmath.

C.1.6 Comments

The single-line comment symbol has been changed from % in MATLAB to # in
Xmath. Unlike MATLAB, Xmath supports block comments, which are delineated
with #{ at the beginning and }# at the end. Instead of beginning each line of a sec-
tion of comments with #, you can place the #{ marker at the beginning of the first
comment line and the } # marker at the end of the last comment line. Table C-6
shows comment examples for MATLAB and Xmath.

C.1.7 Function Names

Xmath tends to preserve the full names of functions performing a given operation.
Where the Hessenberg-decomposition and random-value generation functions in
MATLAB are HESSand RAND, respectively, the Xmath equivalents are hessenberg
and random . These names are less cryptic and more descriptive to the new user.

TABLE C-5 Logical Not Operators

MATLAB Xmath

if ~(A > 0)
disp('A is negative')

end

if !(A > 0)
display "A is negative"

endif

A ~= B A <> B

TABLE C-6 Comment Examples

MATLAB Xmath

% This is a comment. # This is a comment.

% Should you feel the need
% to describe what you have
% written at greater length
% you have to comment each
% line individually in MATLAB.

#{ This is a block comment.
Anything inside the markers is
interpreted as a comment. Most
programming languages support
this construct.}#
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For your convenience, however, Xmath also recognizes a function called using only
the first four letters of its name, or as many more as needed to specify the function
uniquely. For example, you can call random as rand , but would need to use polyn
to distinguish polynomial  from polyfit .

In addition, you can take advantage of Xmath’s alias command to alias lengthy
function names or command statements to shorter ones of your choosing. For ex-
ample:

alias sdon set display on

(See Section C.3.13 on page C-17 for a listing of aliases that you might want to have
predefined in a startup file.)

C.1.8 RAND, ONES, ZEROS, and EYE

Another syntax change concerns the matrix-building functions RAND, ONES, ZEROS,
and EYE. These functions operate in one of two ways depending on the type of input
provided. They either create a random, ones, or identity matrix of the same size as
the input, or a matrix of the dimensions specified in the input. This causes some
ambiguity when the function argument is a scalar—should the output matrix also
be a scalar, or should it be a square matrix whose dimensions have the same value
as the scalar?

When these functions are used with one argument in Xmath, the output matrix al-
ways has the same dimensions as the input object. Table C-7 illustrates.

C.1.9 IF, FOR, and WHILE

In executable files, MathScript functions, commands, the IF...END, FOR...END, and
WHILE...END loops, and conditional structures have been modified slightly. Condi-
tional statements starting with If in Xmath should be closed with endIf , rather
than END. (Because functions and commands are case-insensitive, any capitaliza-
tion scheme will work with these constructs.) Similarly, Xmath For and While
loops terminate with endFor and endWhile , making it much easier for a user

TABLE C-7 Examples With RAND

MATLAB Xmath

RAND(1) random(4) # (a 1x1 matrix)

RAND(4) random(4,4) # (a 4x4 matrix)

RAND(2,3) random(2,3) # (a 2x3 matrix)
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reading MathScript to decipher which ending statements close which loops.
Table C-8 shows examples of conditional statements in MATLAB and Xmath.

C.1.10 Pure Imaginary Number

The variable representation of the pure imaginary number (the square root of -1) is
jay  in Xmath, following engineering standards, as opposed to i in MATLAB.

C.2 Object Differences

Several objects that were represented as vectors or matrices in MATLAB are repre-
sented as full-fledged data types in Xmath.

C.2.1 Strings

Xmath’s real character strings can be manipulated more easily than strings imple-
mented in MATLAB (which are essentially vectors of ASCII values). For example, in
Xmath you can append one string to another one of any length using the + operator.
You can also create matrices where elements are all strings of differing sizes. (This
is, in fact, a handy way to create a table where text entries are neatly aligned.)

TABLE C-8 Conditional Statement Examples

MATLAB Xmath

FOR variable=vector DO,
commands;

END

For variable=vector
commands

endFor

WHILE expression DO,
commands;

END

While  expression
commands

endWhile

IF  relation1 THEN,
commands;

ELSEIF  relation2 THEN
commands

ELSE,
commands;

END

If  relation1
commands

elseIf  relation2
commands

else
commands

endIf
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C.2.2 Polynomials

In Xmath, polynomial coefficients and roots are stored as one of two types of polyno-
mial objects instead of vectors. When you create a polynomial, both the roots and
the coefficients of that polynomial are stored internally for use in future computa-
tions for greatest efficiency and accuracy. Table C-10 gives examples of polynomial
creation in MATLAB and Xmath.

C.2.3 Dynamic Systems

Xmath stores dynamic systems as single objects containing all state-space or nu-
merator/denominator information, as well as any sampling rate information. In
MATLAB you need to keep track of different commands for building different types
of systems. In Xmath, everything is grouped in the system object. A brief compari-
son of these representations is shown in Table C-11.

TABLE C-9 String Examples

MATLAB Xmath

STR='A string' str = "A string"

TABLE C-10 Polynomial Examples

MATLAB Xmath

% Creating a polynomial by
% listing its coefficients:
CP = [1 4 4]

# Creating a polynomial by
# listing its coefficients:
cp = makepoly([1,4,4])

% Creating a polynomial by
% listing its roots:
RP = POLY([-2 -2])

# Creating a polynomial by
# listing its roots:
rp = polynomial([-2,-2])

TABLE C-11 Dynamic Systems Examples

MATLAB Xmath

% For statespace systems
sys = ss(A, B, C, D);

% For transfer function
sys = tf(num, dem);

# Creating a system from
# matrices A, B, C, and D:
sys = system(A,B,C,D)

# Same command for transfer fn
sys = system(num, dem);
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The system , makepoly , and polynomial functions are far more flexible, and can
encompass more information, than their MATLAB equivalents. See the Xmath on-
line Help for a complete reference on these functions.

C.3 Interpretation Differences

The differences described in this section are by-products of Xmath’s more complete
user environment. In general, these are conceptual changes that involve learning
new terms rather than word-for-word syntax changes.

C.3.1 Environment Commands

Xmath has a highly customizable user environment. Many environment settings in
Xmath replace functionalities that existed as individual commands in MATLAB.
These include creating session and command diaries, changing display format in
the commands window, setting random number distribution and generator seeds
and more. In Xmath, settings are treated as parameters that are changed with the
set command; each parameter is a keyword. Help for the set command describes
many new capabilities not included in MATLAB. It is strongly recommended that
you read the Xmath online Help to get a full picture of the range of settings avail-
able. A setting remains in its current mode until it is explicitly changed. To see the
status of a particular environmental setting, you can use show. For example:

show echo      #(default is off)
set echo on

The settings discussed below map closely to MATLAB capabilities you are probably
familiar with.

Creating Diaries

Once a diary file has been created, it collects input from your Xmath or MATLAB
session until it is closed. The presence or absence of a diary is thus a mode of oper-
ation. The DIARY function used to start a diary session in MATLAB has been re-
placed with the set sessiondiary and set commanddiary syntax shown in
Table C-12.
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Random Seeds and Distribution

The MATLAB RANDfunction is ambiguous because it returns an output like a stan-
dard function when called with purely numeric input, but also takes string input
and uses it to set the distribution mode and initial seed. In these cases there is no
logical function output. Xmath’s handling of these functionalities through the set
command is more consistent, as shown in Table C-13. The Xmath rando mfunction
always returns purely numeric output.

The default seed is 0 and the default distribution is uniform .

Number Formatting

The Xmath equivalent to the MATLAB commands SHORT, SHORT E, LONG, LONG E,
HEX, BANK, COMPACT, LOOSEand RAT is set format formatname . An advantage of
the Xmath syntax is that it allows a wider range of formatting options without the
need to add a new command each time! Table C-14 gives an example.

TABLE C-12 Creating Diaries

MATLAB Xmath

% Creating diaries
DIARY 'stamen'
DIARY off
% MATLAB can't
% keep a
% command diary

# Creating diaries
set sessionDiary="sdname"
remove sessionDiary

set commandDiary = "cdname"
remove commandDiary

TABLE C-13 Random Seeds and Distribution Examples

MATLAB Xmath

% Setting random
% number seed
randn('SEED',100)

# Setting random
# number seed

set seed 100

% Setting distribution
randn('NORMAL')

# Setting distribution
set distribution normal
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The Xmath format names are: compact (the default format), engineering , fixed ,
long , longe , scientific , short , and shorte . Note that the format can also be
set interactively via the Options→Format menu option in the commands window.

Note that fixed is slightly different in that you must set two parameters; you must
specify the format name fixed , and the precision:

set precision 4;set format fixed

The precision is the number of characters allowed. Remember that both settings re-
main the same until you reset them; if you use the above settings and then set
another format, the precision will still be 4 the next time you set format to
fixed .

C.3.2 User-Defined Functions and Commands

While MATLAB allows you to define optional arguments to a user-defined function
or command, delineating them with single quotation marks, Xmath offers related
but much richer ways to extend the user input to a MathScript function or com-
mand.

In Xmath, optional arguments and keywords are specified following the required ar-
gument list when the function is declared.

■ Keywords must be delineated with curly braces {} . They can take any values
and be specified in any order, but the name of the keyword must always be used
so that the Xmath interpreter knows which keyword is being sent. If you are
writing your own function or command using keywords, you should provide de-
fault values for any keywords where values are not user-supplied. (See
Section 3.5.1 starting on page 3-16 for more on function syntax.)

■ Optional arguments can be specified by their value or variable name alone, and
are assigned to the optional variables in the order that they are listed. When a
function is called with optional arguments, they are listed directly after the re-
quired arguments and are not enclosed in curly braces.

TABLE C-14 Number Formatting Examples

MATLAB Xmath

% Set number format
long
% or
format long

# Set number format
set format long
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In both MATLAB and Xmath, you can define functions and commands that override
existing functions and commands, including intrinsic ones. In Xmath, you can place
the function or command in the search path or use the DEFINE command to deter-
mine which one you want to use (see Section 6.1.7 on page 6-9); in MATLAB, a
user-defined function has priority over a function supplied by MATLAB.

C.3.3 Plot

In Xmath, plot is a function that returns an output variable (a graphics object, as
discussed in Section 4.1 on page 4-1). This variable can be subsequently replotted
to regenerate a plot, kept to form a background or template for subsequent plots,
and augmented via interactive changes to the graphics.

MATLAB option strings are replaced in Xmath by plot keywords. Referring to the on-
line Help will give you a good idea of the scope of plot parameters that you can set in
Xmath, but Table C-15 illustrates briefly.

C.3.4 Transpose Operators

The transpose operator is interpreted differently in Xmath. MATLAB offers only one
transpose operator, the apostrophe ('). When used with a complex matrix, the trans-
pose operator performs a Hermitian, or complex-conjugate transpose.

Xmath offers two transpose operators:

■ The Xmath apostrophe operator (') performs a regular transpose, leaving com-
plex values untouched.

■ The Xmath complex-conjugate transpose operator is the asterisk-apostrophe
(*').

For purely real matrices these two transpose operators perform the same function.

TABLE C-15 Plot Examples

MATLAB Xmath

PLOT(1:10, 'b') plot(1:10,{line_color=4}) # or
plot(1:10,{line_color="Blue"})
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Table C-16 illustrates Xmath and MATLAB equivalents.

C.3.5 Convolve

The CONVfunction, which performs polynomial and vector convolution in MATLAB,
has been replaced by the convolve function and the * operator in Xmath.
convolve is equivalent to CONVwhen used on two vectors or two polynomial
objects; however, the * operator performs exactly the same operation on
polynomials as convolve  does and is easier to use.

C.3.6 Series and Parallel

The MATLAB functions SERIES and PARALLEL have been replaced by the Xmath
operators * and + respectively, when these operators are used with dynamic sys-
tems. You will find the online Help and Using Operators with Dynamic Systems on
page 5-46 useful for a quick but thorough overview of the extended role operators
play in Xmath.

C.3.7 Simulation

The MATLAB continuous- and discrete-time simulation primitives LSIM and DLSIM
have been replaced with the system*PDM construct. (The parameter-dependent ma-
trix [PDM] is a highly useful data type unique to Xmath. It allows you to store multi-
ple sets of matrix information (input values) that are dependent on a parameter
[time]. For a complete explanation of PDMs, see Section 5.4 on page 5-21.) This con-
struction finds the system response to the input values contained at each point in
the PDM. The syntax inherits from terminology frequently used in the linear sys-
tems field: Y = H*U, where U represents system input, H represents the mathemati-
cal model of the system’s dynamics, and Y is the output of the system. This is a brief
description; for more information, see Section 5.5.5 on page 5-49.

Note that where MATLAB generally offers two separate functions for discrete- and
continuous-time system representations, Xmath only offers one. This is because
sampling-rate information (which is by default zero, thus describing a continuous

TABLE C-16 Transpose Operator Examples

MATLAB Xmath

A = [1+i 1+2*i;
3-6*i 2+9*i]

A'

A = [1+jay,1+2*jay;
3-6*jay,2+9*jay]

A*'

CONJ(A') A'
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system) is stored with the system object itself. For example, the Xmath function
bode , which encompasses all the functionality of the MATLAB functions BODEand
DBODE, automatically checks whether your system is continuous or discrete and
then performs the appropriate operations in either case. You can write similarly
flexible MathScript functions.

C.3.8 Eval (Executable Strings)

Xmath offers a facility (similar to the MATLAB EVAL function) that allows you to cre-
ate strings containing valid Xmath commands and then execute the contents of the
strings. It can be used for creating macros or customizing functions. You can create
strings directly or append them using the + operator, then use Xmath’s execute
command. The only constraint is that the string must form a complete Xmath state-
ment by itself and be terminated by a semicolon or question mark to indicate its
end. Table C-17 illustrates.

As mentioned in Section C.1.4, MATLAB does not allow string concatenation. In
Xmath, the + operator is overloaded to perform string concatenation. In addition,
numbers can be converted to strings using the string  function.

C.3.9 Executable Files

Executable files (often referred to as script files in Xmath) function similar to
script.m files in MATLAB. A small change is that the names of these files must ter-
minate with the extension .ms in Xmath. The syntax to execute files is slightly dif-
ferent as well, as shown in Table C-18, for an executable file called testexec.m s in
Xmath and testexec.m  in MATLAB.

TABLE C-17 Executable String Examples

MATLAB Xmath

x = pi
s = 'y = sin(x);'
eval(s)

x = pi;
s = "y = sin(x)?"
execute s

TABLE C-18 Executable Filename Examples

MATLAB Xmath

TESTEXEC execute file="testexec"
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C.3.10 Finding Files

Xmath has the ability to use files that are not in the working directory. It does this
in a more flexible manner than that employed in MATLAB. In MATLAB, the
MATLABPATHenvironment symbol defining the accessible directories is generally set
up before you start your MATLAB session. The MATLABPATHcould be changed
during a session using the MATLABPATHcommand, but it had to be completely
changed at once. In Xmath you can alter the directory search path at any time
during your Xmath session, and you can add or remove paths separately, without
having to redefine the entire path each time a modification is desired.

set path is used to specify a list of directories that Xmath will automatically
search to find MathScript functions and commands (MSFs and MSCs). You can use
the corresponding remove path command to remove paths you no longer want or
need.

If you write an MSF in one of the directories in the path, you can call it immediately
from within Xmath. When you call a function you have written, Xmath searches
your current directory and all the directories in your path until it finds a function
file where name matches the function you called. Upon finding the file, Xmath com-
piles it to a low-level operational code and it runs immediately. If a function or com-
mand file is not in a directory listed as one of your path directories, you need to
define it explicitly and specify the directory where it resides.

Table C-19 compares these facilities in Xmath and MATLAB (the operating system
commands shown are for a version of MATLAB running under a UNIX operating sys-
tem).

TABLE C-19 Examples of Finding Files

MATLAB Xmath

!pwd show directory

!cd /home/new set directory = "/home/new"

!echo $MATLABPATH % or
matlabpath

show path

matlabpath("~me/myfuns") set path = "~me/myfuns"

(no analogous feature) remove path 2
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In MATLAB, the exclamation-point notation (! ) can be used to send out an operat-
ing-system command and display its output. Xmath offers an analogous oscmd
function, as shown in Table C-20.

C.3.11 Debugging Files (on UNIX systems)

MATLAB’s debugging facility consists primarily of keyboard commands. Xmath pro-
vides an interactive debugger for MathScript files. It can be used in either of two
modes:

■ The Xmath debugger is automatically invoked when you try to run a function
containing a syntax error. The offending statement is highlighted. You can fix
the mistake, save the file, and rerun the function, all from the debugger
window.

■ The second debugging mode is useful when you have written a function and
want to halt execution at some point to examine variable values. To do this, type
debug functionName in the Xmath commands window. The debugger will
then appear when you call the function, allowing you to step through any por-
tion of the MSF one statement at the time, or to set breakpoints and jump to
them. You can use the commands window to look at local variable values or
evaluate expressions.

For more on the debugger window, see Section 6.4 on page 6-23.

C.3.12 Save and Load

The commands for saving and loading data also differ somewhat. MATLAB offers
flags that enable you to save data in either a MATLAB-written binary format or a
short or long ASCII format. Xmath’s save command has a number of keywords as-
sociated with it to determine what type of format to use to save the data. Xmath’s
load command can be used to load in data saved by Xmath or MATRIXX (FSAVE-
format data). Table C-21 compares the commands.

TABLE C-20 Operating System Command Examples

MATLAB Xmath

!ls -l oscmd("ls -l")
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In Xmath, as in MATLAB, if a list of variables to be saved or loaded is omitted, all
variables are saved or loaded. Xmath data files terminate with the suffix .xmd (MAT-
LAB uses the .mat suffix). MATLAB always loads all the data stored in a .mat file;
Xmath can load either all or part of the data stored in a .xmd  file.

Xmath’s load command cannot directly load MATLAB data; however, as described
in Chapter 8, you can create a linked executable (LNX) that can. $XMATH/src/mat-
load.c is a sample LNX that loads MATRIXX 3.X format (which is similar to older
MATLAB formats) into Xmath data objects. This file is commented to assist you in
making any changes. To make a local copy of matload.c in the Xmath log area and
create a local copy, go to the command area and type:

copyfile "$XMATH/src/matload.c"

Loading In External Data (read)

Loading in data generated by external programs other than Xmath, MATRIXX, and
MATLAB is also possible. If you have data written to a non-Xmath file by another
program and you know the size and type of the data in the file, you can use the
read function to read from the data file into an Xmath matrix variable. The input
arguments you pass to read describe how large the matrix should be, the format of
the data in the external file, and how many bytes of data (if any) you choose to skip
before reading data into the target variable. This allows you to create data files that
are easily readable by a variety of programs, not necessarily just Xmath. This func-
tion is described in more detail in the Xmath online Help, and the $XMATH/demos
directory contains sample files that you can use to test read .

TABLE C-21 Save and Load Examples

MATLAB Xmath

SAVE 'filename' VAR1 VAR2... save var1 var2...
file = "filename" {keyword}
# The keyword is optional and
# may be set for binary, ASCII,
# or MATRIXx formatted saves

LOAD 'filename' load "filename"

No equivalent feature load a b "filename"
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Writing Data to an External File (print, fprintf)

In addition to the Xmath-formatted save command, Xmath provides two other
functions that are useful for writing data to external files: print  and fprintf .

print writes any Xmath data object to an external file you specify. The data is writ-
ten exactly as it appears when displayed in the commands window log area.

fprintf converts scalar numeric values to a string representation, then writes
them to the file you specify. A wide range of format specifiers (identical to the ones
used for the C-language fprintf function) can be used to specify field width, zero-
padding, tabs, and newlines, among other formatting options.

C.3.13 Useful Aliases

You may want to define the following aliases in a startup.ms file so that you can
use familiar names for the following Xmath commands. Some examples follow.

The MATLAB function names lyap and conv invoke their Xmath counterparts
lyapunov and convolve , but the Xmath functions have a different set or order of
inputs. Along these lines, Xmath has both a rootlocus and rlocus function.
rlocus is the one analogous to MATLAB rootlocus . To create an alias enter the
following:

Xmath versions do not necessarily take exactly the same inputs in exactly the same
order as their MATLAB namesakes. When in doubt, refer to the Xmath online Help.

You are, of course, not limited to these aliases. Xmath commands and functions
tend to be as descriptive as possible without being excessively long. As you acquire
expertise with Xmath, you will probably want to alias other frequently used com-
mands as well. To obtain a list of all the aliases currently set up in an Xmath ses-
sion, just type alias  on a line by itself in the command area.

Note that aliases can cause some problems; for example, if you have clear defined
as an alias for delete , you will not be able to use clear as a keyword in a function.

alias clear delete

alias ss2tf numden

alias tf2ss abcd

alias rlocus rootlocus
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We recommend that you use aliases to speed your transition from MATLAB to
Xmath, and then learn the Xmath syntax as you go along.

C.4 Comparison of Frequently Used Commands

Table C-22 summarizes some of the most frequently used Xmath and corresponding
MATLAB commands. Both Xmath and MATLAB commands are case insensitive.

TABLE C-22 Xmath and MATLAB Summary of Frequently Used Commands

Xmath Command or
Operator

MATLAB Command or
Operator

Description

cond(A) cond(A) Finds the condition number.

convolve or * conv Performs polynomial and vector
convolution.

cos(x) cos(x) Calculates the trigonometric cos  function.

bode bode or dbode The Xmath function bode checks whether
your system is continuous or discrete and
then performs the appropriate operation.

det(A) det(A) Finds the determinant.

eig(A) eig(A) Computes eigenvalues and eigenvectors for
real and complex square matrices.

execute eval Xmath and MATLAB versions perform
similar functions (see Section 3.9 on
page 3-27).

execute file file .m Executable files are similar (see Section 3.9).

NOTE: In MATLAB, execution of a script can
be done directly from the script’s
name. In Xmath, execution must be
done with the execute function. (This
prevents ambiguous code or
accidental execution.)

exp(x) exp(x) Computes the exponent of (x).

NOTE: For matrix exponentiation, MATLAB
requires the format expm(A) .

eye(A) eye(A) Generates the identity matrix.
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GuiPlotGet ginput Get the current pointer selection and
coordinates.

hessenberg hess Converts a matrix to Hessenberg form.

hilbert(n) hilb(n) Creates a Hilbert ill-conditioned matrix.

hilberttransform No MATLAB
equivalent

{Apparently this command is available but
not documented.}

inv(A) inv(A) Finds the inverse matrix.

load load Xmath and MATLAB versions perform
similar functions (see Section 3.7 on
page 3-19).

log(x) log(x) Computes natural logarithm.

makepoly No corresponding
command

Create a polynomial from its coefficients.
MATLAB reformats polynomials by using the
corresponding vector with its coefficients.

norm norm Calculates the norm of a vector, matrix, or
PDM (Xmath only).

No corresponding
command?

null The null(A)  command in MATLAB
calculates an orthonormal basis for the null
space of A.

ones ones Xmath and MATLAB have some minor
syntactical differences (see MATRIXX online
Help).

ortho orth Used as ortho(A)  to give the orthonormal
basis for A.

pinv pinv Used as pinv(A)  to give the pseudoinverse
for A.

plot(0:10) plot(0:10) The basic plot command is the same, but
the keyword syntax is different.

TABLE C-22 Xmath and MATLAB Summary of Frequently Used Commands (Continued)

Xmath Command or
Operator

MATLAB Command or
Operator

Description
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polyfit polyfit Both commands fit a polynomial, but the
Xmath command uses a PDM as input.
(PDMs are not supported in MATLAB.)

polynomial poly Create a polynomial from its roots.

polyval polyval Evaluates a polynomial.

No corresponding
command

quad8
quad -dblquad

Estimates an integral numerically.

random rand Generates random numbers or matrices.

residue(sys) residue(b,a) Expands a partial fraction.

roots(p) roots(p) Returns the roots of a polynomial.

round round Round matrix values to the nearest integer.

rref rref Transforms a matrix into reduced echelon
form.

save save Xmath and MATLAB versions perform
similar functions (see Section 3.7 on
page 3-19).

schur schur Calculates the Schur factorization.

set format name format name

short, short e,
long, long e,
hex, bank,
compact, loose,
rat

Xmath format names are compact (the
default), engineering, fixed , long ,
longe , scientific , short , and shorte .

set seed num rand('seed',
num)

Setting the random number seed. For
MATLAB 5, rand('State), j )  gives the
jth state. rand('State', s )  makes the
actual state equal to s (state = s ).

sin(x) sin(x) Calculates the trigonometric sin  function.

sqrt(x) sqrt(x) Calculates the square root of x.

TABLE C-22 Xmath and MATLAB Summary of Frequently Used Commands (Continued)

Xmath Command or
Operator

MATLAB Command or
Operator

Description
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zeros zeros Generates a matrix of zeros.

./,.*, ... ./,.*, ... Point preceding operator means elementwise
operation.

' and *' .' and ' Transpose operators. The operators on the
left (' and .') are for regular transpose and
The operators on the right are for complex-
conjugate transpose.

+ parallel The overloaded Xmath + operator performs
the same function as the MATLAB
parallel  function.

* series The overloaded Xmath * operator performs
the same function as the MATLAB series
function.

# ... #
or
#
#
.
.
.
#

% Indicates a comment. MATRIXX supports
block comments that span multiple lines.
The second # is only needed for a multiple-
line comment.

"string" 'string' MATRIXX uses double quotes to avoid
confusion with the transpose operator.

A <> B A~=B Logical NOT EQUAL operators.

!A ~A Logical NOT operators.

x = A\b x = A\b Computes the least squares approximation
(Ax = b).

TABLE C-22 Xmath and MATLAB Summary of Frequently Used Commands (Continued)

Xmath Command or
Operator

MATLAB Command or
Operator

Description
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D Xmath to Mathematica
Interface

This appendix describes how to set up and use the Xmath to Mathematica Interface.

D.1 Overview

Mathematica is a powerful symbolic manipulation program from Wolfram Research,
Inc. (WRI). It performs operations such as differentiation and integration symboli-
cally, achieving exact general solutions to many problems. This capability can be
coupled with Xmath’s powerful numerical analysis and design capabilities, resulting
in a very strong joint analysis tool.

Xmath was developed with an open architecture, which simplifies communication
with other programs and processes. The interface between Xmath and Mathematica
is based on Xmath’s LNX (link external) capability and Mathematica’s Mathlink fa-
cility. When Mathematica is first invoked from Xmath, Mathematica’s Mathlink fa-
cility establishes a process running Mathematica, and maintains a link to that
process for all subsequent calls from the same Xmath session, allowing Xmath the
use of intermediate variables in Mathematica. Furthermore, the Mathlink facility al-
lows Mathematica to be invoked on a different computer than the Xmath host; this
is completely transparent to the user.

When a valid Mathematica command is entered in the Commands Window com-
mand area, a separate Mathematica process computes the answer (commands that
produce graphics should never be used). The resulting text output that would nor-
mally appear in Mathematica is converted to an Xmath string object that is dis-
played in the Commands Window log area. If the answer is a numeric matrix, it can
be passed directly to Xmath. Matrices can also be passed from Xmath to Mathemat-
ica. All Mathematica warnings and other messages are transmitted to Xmath and
displayed in the Commands Window message area.
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For a more detailed explanation of the LNX process, see Chapter 8. The source for
the Xmath to Mathematica interface can be found in $XMATH/src/mathlink.c .

D.2 Setup

These instructions apply to setting up Xmath, and the Xmath to Mathematica inter-
face on an Xmath host. If you encounter problems related to Mathematica function-
ality, contact Wolfram Research, Inc. Their website is http://www.wri.com , their
e-mail address is support@wolframi.com, and their Technical Support phone num-
ber in the USA is 217-398-6500.

To use the Xmath to Mathematica interface the following conditions must be met.

■ Mathematica must be installed and accessible to you, the Xmath user. The
Mathematica version must be 3.0 or higher.

■ Only UNIX versions of Xmath and Mathematica are supported.

■ Your UNIX execution path must include the path to your Mathematica installa-
tion directory. For example,

set path = ($path /home/Mathematica/Executables/SPARC)

where the above path points to the Mathematica installation at your site.

Because the Mathematica interface LNX must be linked with the local Mathlink li-
braries on your target system, Integrated Systems cannot deliver an executable in-
terface. However, we have provided all of the necessary routines to quickly create an
executable interface LNX.

To allow all users access to the Xmath to Mathematica interface, a system adminis-
trator must perform the steps in Section D.2.1. Users who do not have system priv-
ileges can perform the steps in Creating a Local LNX (Single User) to create a local
LNX.

D.2.1 Setting Up the Xmath to Mathematica Interface for All Users

These instructions assume the $ISIHOME environment variable was properly set at
installation time to the path to the root MATRIXX Product Family installation.

1. Change directory to $ISIHOME/ platform /xmath/src.

2. Edit the mma.mk file as follows:

a. Define the XMATH variable to be $(ISIHOME)/ platform /xmath .
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b. Replace PATH_TO_libML.a with the path to the Mathlink libraries (for ex-
ample:

*/Mathematica/AddOns/MathLink/DevKits/SPARC/CompilerAddOns

3. To create mmalnx.lnx , run the makefile as follows:

make -f mma.mk

4. Copy mmalnx.lnx  to $ISIHOME/ platform /xmath/modules/mathematica .

All Xmath users will now be able to use the Xmath to Mathematica interface.

D.2.2 Creating a Local LNX (Single User)

Although it is preferable to have a system administrator set up the Xmath to Mathe-
matica interface, a user with no root privileges can set up an LNX for his personal
use. To use the Mathematica interface without modifying the Xmath source directo-
ries, the user can copy $ISIHOME/ platform /xmath/src/mma.mk and mathlink.c to a
local directory, and then perform steps 2 and 3 described in Section D.2.1. However,
before using the interface, the user must tell Xmath not to look in the modules di-
rectory for the LNX. To do this type the following Xmath commands in the Xmath
Commands window command area:

undefine mma
define mma {directory=" path_to_lnx "}

For future usability, these lines can be placed in your personal Xmath startup.ms
file, along with a set path command that points to the location of your local
mmalnx.lnx file (so that if you start Xmath from another directory you will still be
able to use the LNX). For example:

set path=" path_to_lnx "

See Section 3.9.3 on page 3-28 for more on startup.ms , and Search Paths on
page 6-9.
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D.3 Syntax

Xmath provides three functions, which perform the following tasks:

1. Send a command to Mathematica (a Mathematica session is started if one does
not exist):

mma("valid_Mathematica_cmd")

mma is actually an accepted abbreviation for mmaexecute .

2. Transfer a matrix from Xmath to Mathematica:

mmaput("mma_matrix_name", xmath_matrix_name)

3. Transfer a matrix from Mathematica to Xmath:

xmath_matrix_name = mmaget("mma_matrix_name")

Note that you can assign the output of a Mathematica command to a Mathemat-
ica variable and an Xmath variable in one step:

xmath_var = mmaget("var=Mathematica_numerics_cmd")

4. Close the Mathematica session:

mma("quit")

The lowercase string "quit" causes the LNX to close the Mathematica process.
However, the LNX stays resident and active. If you issue another Mathematica
command, the existing LNX will restart Mathematica. When you exit Xmath, the
LNX will be killed.

D.3.1 Passing Xmath Data to Mathematica

You can pass scalars, vectors, or matrices from Xmath to Mathematica. These forms
all qualify as matrix objects in Xmath.

Mathematica assumes all incoming values are matrices and places them in nested
Lists. For example, the Xmath matrix [1,2;3,4] is represented as
{{1,2},{3,4}} when passed to Mathematica, and the Xmath scalar 7.2 is repre-
sented as {{7.2}} .

Xmath vectors should always be passed to Mathematica as row vectors. (If a column
vector is passed, the resulting nested list will not be as readily useful.) After a row
vector is passed to Mathematica, it can be extracted from a nested List to a single
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List using x=x[[1]] . Scalars can be extracted from a nested List to a true scalar
using s=s[[1,1]] .

D.3.2 Passing Mathematica Data to Xmath

Lists or nested Lists can be passed to Xmath from Mathematica. The Lists can only
contain numerical data, never symbolic data. In the case of nested Lists, the compo-
nent List lengths must be equal so that Xmath can convert the List to a matrix.

A Mathematica symbolic matrix can be converted to a numerical equivalent using
the command x=N[x] , and the result can then be passed to Xmath. For example,

mma("x = Table[EllipticK[i], {i, 0, 2/3, 1/6}]")
x=mmaget("N[x]")

To pass a scalar to Xmath it must first be placed in a List of length one. This can be
done using the command a={a} .

D.4 Examples

The following Xmath inputs and Mathematica responses demonstrate how data is
passed between the applications.

When we ask for the Mathematica version, Xmath receives a string:

mma("$Version")

ans (a string) = SPARC 3.0 (April 26, 1997)

The following call to Mathematica asks for a numeric result with a precision of 40.

str=mma("N[EulerGamma,40]")

str (a string) = 0.5772156649015328606065120900824024310422

We can convert this simple string to a number in Xmath and compare the displays.
First, we set the format to longe , the longest output Xmath can display. Then we
can convert the string to a scalar with makematrix :

set format longe
s=makem(str)

s (a scalar) = 5.772156649015329e-01
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Symbolic output (strings containing superscripts or a mixture of text and numbers)
can be viewed in the Xmath Commands Window log area, but not used as Xmath in-
puts:

mma("Integrate[x^2 Sin[x]^2,x]")

ans (a string) =
3 2

4 x  - 6 x Cos[2 x] + 3 Sin[2 x] - 6 x  Sin[2 x]
------------------------------------------------
                       24

Create a matrix in Xmath and send it to Mathematica:

set format compact
m=[pi,42,0;7,tiny,6;17,huge,.02]

m (a square matrix) =

3.14159    42               0
7           2.22507e-308    6

17           1.79769e+308    0.02

mmaput("m",m)

You can use Mathematica functions to manipulate the matrix and pass numeric
versions of the matrix manipulations back to Xmath:

mRev=mmaget("mRev=N[Reverse[m],9]");
mRot=mmaget("mRot=N[RotateLeft[m,2],9]");

Display the matrices (in compact form):

mRev?

17          Inf               0.02
 7            2.22507e-308    6
 3.14159     42               0

mRot?

mRot (a square matrix) =

 3.14159     42               0
17          Inf               0.02
 7            2.22507e-308    6

For more examples, execute the files $XMATH/demos/mathematica/mma.ms and
$XMATH/demos/mathematica/elliptic.ms .
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app-defaults A file containing X Windows application defaults. Settings
relevant to Xmath are in a file called Xmath . You can keep an
edited version of this file in your home directory.

assignment A statement of the form: varName = expr or
varName(subscripts...) = expression.

basis vectors A set of n ×1 vectors such that any point in an n dimensional
space can be expressed.

batch file A MathScript file containing valid Xmath instructions. Used
with execute file= "filename" .

binary operator An operator that works over two objects (operands).

BOOLEAN A value that can be either TRUE (nonzero) or FALSE (zero).

canonical form A matrix form representing state–space equations; it simplifies
the algebra need to design controllers for the system.

cascade menu On a menu, an arrow following the text indicates that dragging
the mouse to the right will open a related menu.

channels A vector consisting of all elements in a particular portion of
each matrix in a set of matrices.
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class In Xmath, a set of objects with common organizational
attributes.

class hierarchy An organizational system based on inheritance; child classes
inherit all properties of parent classes.

click Quickly press and release a mouse button; if a button number
(MB1, MB2, MB3) is not stated, MB1 is assumed.

client In X windows, any application.

click to type A focusing method where the user must click in the desired
window to get input focus.

column vector A vector that is oriented vertically; it has m rows and one
column.

comments Text in a MathScript file (or on the command line) that is not
executed by Xmath. A pound sign (#) tells Xmath to disregard
the remainder of a line, while #{  and }#  delimit multiline
comments.

comparison operator An operator used to compare values or sets of values; also
referred to as a comparator.

debugging Using the Xmath debugger to look for errors in an Xmath file.

diagonal matrix A matrix where off–diagonal elements are all 0 (zero).

diary A file containing a record of inputs issued from the command
area, or a record of both inputs and outputs. The first is a
command diary, and the second a session diary.

domain The independent variable in a parameter-dependent matrix.

double-click Click MB1 twice rapidly.

drag Hold down a button while moving the mouse, then release.
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dynamic system A single-input/single-output (SISO) or multiple-input/
multiple-output (MIMO) system where input/output behavior
is described by a set of linear, constant-coefficient differential
equations.

eigenvalue A scalar value λ associated with a matrix A that satisfies
Ax = λx for some nonzero vector x (the eigenvector).

eps A permanent variable representing your machine’s precision.
It is the smallest possible number such that 1+eps>1 .

expression A combination of variable names, function references, and
operators which evaluates to an Xmath object.

focus Use the mouse to position the cursor within a certain window
or window area.

frequency response The complex ratio of the Laplace transforms of the output and
input of a dynamic system at any frequency.

frobenius norm A norm defined as the square root of the sum of the squares of
the singular values of a matrix.

GUI Graphical user interface.

Hermitian matrix A matrix that is equal to its conjugate transpose.

Hessenberg matrix A matrix where elements are all zero below the first
subdiagonal, or above the first superdiagonal.

huge A permanent variable representing the largest finite number
that can be represented on your machine.

iconify Reduce a window by clicking on the Minimize button.

identity matrix A diagonal matrix with ones on the diagonal.

imaginary number The square root of a negative number expressed as some
multiple of jay  where jay=sqrt(-1) .

improper transfer function A transfer function where the order of the numerator is greater
than the order of the denominator.
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independent parameter The domain; commonly part of a PDM.

index list A list of indices or pointers into a vector, matrix of PDM.

indices Names or expressions used to index into matrices.

Inf A permanent variable representing infinity.

infinity norm The largest row-sum of a matrix.

integer A real number that has no fractional part.

intrinsic function A function written at ISI that is built into Xmath.

jay A permanent variable representing sqrt(-1) .

key bindings Sequences or combinations of keystrokes mapped to editing or
UI functions.

keywords Optional inputs that are delimited with curly braces.

label In an MSF or MSC, a name enclosed in angle brackets <>;
goto <label>  redirects the program.

left null space For an n×n matrix A, the set of all n×1 vectors such that vTA=0.

list object A set of other objects.

LNX A file containing information needed to link a user function to
Xmath. Pronounced links .

log-linear interpolation Interpolation where the logarithm of the input vector is
linearly interpolated into the existing function.

logical A Boolean value.

logspaced vector A vector with points evenly spaced on the log scale.

lower triangular matrix A matrix where entries above the diagonal are all 0 (zero).

MathScript The language of Xmath.
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MathScript entity A general term referring to specially formatted MathScript files
that Xmath will recognize and compile to create MathScript
functions, commands, or objects as the file format dictates.

matrix A matrix is a set of rows and columns of real or complex
numbers, or strings.

modal dialog A dialog that halts interaction with GUI and Xmath windows
until it is removed.

Motif widgets Library of user interface building blocks available with
OSF/Motif.

MS MathScript batch file.

MSC A command written in MathScript.

MSF A function written in MathScript.

MSO MathScript object.

name A string of characters representing an Xmath variable.

NaN ‘Not a number’, the IEEE standard for floating-point
arithmetic defines it to be the result of nonsensical operation.

noncausal transfer function A transfer function representing a discrete-time system where
the order of the numerator is greater than the order of the
denominator.

nonsingular An invertible matrix (having a nonzero determinant).

norm One of several numeric indicators based on the values of the
elements in a vector or matrix.

null A permanent variable representing a null variable.

null space The set of all n×1 vectors v such that A*v=0 where A is n×n.

null variable A variable with no data associated; it does not belong to a
class.
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object An object is a member of a class.

operator A nonalphanumeric symbol that operates on its operands.

orthonormal A set of vectors (may be the columns of a matrix) in which all
the vectors have norm 1 and they are all mutually
perpendicular.

overloading Programming a function or an operator to take advantage of
an object’s special properties.

partition Similar to a directory or folder, a partition is a repository for
variables.

PDM A parameter–dependent matrix.

pi A permanent variable representing the perimeter of a circle
divided by its diameter (3.14159265358973 ...).

picture The entire plotting surface of the graphical window; by default,
only its center is visible.

point Move the pointer to a specified area.

pointer focus A focusing method where the placement of the pointer dictates
input focus.

polynomial An expression of the form x^3+9x^2–4x+7.

positive semi–definite An n×n matrix A such that for all n×1 vectors x,
; for symmetric matrices a matrix where eigenvalues

are all greater than or equal to zero.

proper transfer function A transfer function where the order of the numerator is less
than or equal to the order of the denominator.

pushbutton A button that is activated by or selected by pointing the mouse
at it and clicking.

radio button
behavior

A set of toggle buttons designed so that only one can be active
at a given time.

x
T

A x 0≥
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real number A number that has no imaginary component.

reduced–row
echelon form

A matrix form where the first nonzero element of each row is 1
and each column that contains a leading 1 has zeros in the
rest of the column; each leading 1 occurs farther to the right
than the leading 1 in the preceding row.

regular vector An evenly spaced vector (created with the : operator).

resident function A LNX function where the process remains in memory until
the LNX is undefined or the Xmath session is terminated.

row vector A horizontally-oriented vector.

root window The background window that covers the entire screen.

scalar A matrix with a single row and a single column.

script files Files containing MathScript statements (MSFs/MSCs/MSOs;
batch files: .ms , .msf , .msc , .mso ).

slider A slider is a scroll bar with a handle; it has minimum and
maximum values and the position of the handle determines a
value.

square matrix A matrix having an equal number of rows and columns.

startup file An optional MathScript file called startup.ms . If a startup
file exists in your xmath  directory, it will be read every time
Xmath is started. Because Xmath can be started from any
directory, you can keep different startups in different
directories. A local startup supersedes the startup in xmath (if
it exists).

startup.ms A file containing Xmath statements that is executed at
startup.

state-space system A matrix form representation of a dynamic system. The
matrices are obtained from the coefficient of first-order
differential or difference equations describing the behavior of
the system. The variables used in these equations are referred
to as the states of the system.
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statement Any complete command, assignment, or expression.

string Text enclosed in double quotes.

string matrix A matrix object where elements are strings.

symmetric matrix A matrix that is equal to its transpose.

table String matrix.

time response The behavior of a dynamic system as a function of time in
response to external stimuli.

tiny A permanent variable representing the smallest nonzero
number that can be represented on your machine.

toggle button A button that can be either on or off.

transfer function A means of representing a SISO system where current output
is a function of past outputs and past and present inputs.

triangular matrix A matrix with only 0 either above or below the diagonal.

tridiagonal A matrix that is 0 above the first superdiagonal and 0 below
the first subdiagonal.

UCI User-callable interface that allows a program to call Xmath.

unary operator An operator that works on one operand.

unitary matrix A matrix U such that UU*=I.

upper triangular
matrix

A matrix with only zeros below the diagonal.

vector A matrix where a dimension equals one.

wildcard A symbol indicating that any single character (%) or set of
characters (*) is acceptable.

When indexing, a colon (:) is a wildcard for all rows or
columns.
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window manager An application that allows you to manipulate windows (size,
minimize, etc.).

X Windows default menu A root menu of windowing operations defined by your window
manager.

Xmath file The application defaults file containing X11 default settings
for Xmath, including menu information, key actions, font
types, and general information determining Xmath’s
appearance under X.
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A
abcd 5-48

abort Xmath (Ctrl-\, UNIX) 1-7

advanced topics 6-30

alias 3-17, 3-27

AllocateList 8-10

AllocateMatrix 8-6

AllocateNull 8-11

AllocateStringMatrix 8-7

ans 2-4, 3-11

apostrophe operator (”) C-11

app-defaults gloss-1

argn 6-30

argv 6-30

arrays, C vs. FORTRAN 8-37

ascii 5-51

assignment gloss-1

assignment statement 3-1

asterisk-apostrophe (*”) C-11

autocompile 3-23

axes 4-21

B
background LNX 8-2, 8-34

function assignment syntax 6-34

terminating 8-36

basis vectors gloss-1

batch file 3-28

creating 3-31

running 3-31

beep 6-22

behavior

GUI objects 9-4

binary operators 3-4, gloss-1

BOOLEAN data type gloss-1

breakpoint

remove 6-27

set 6-23, 6-26

show 6-27

breakpoints 6-26

button

radio 9-4

toggle 9-4

C
C language

arrays vs. FORTRAN 8-37

LNX function file format 8-3, 8-4

resident functions 8-41

canonical form gloss-1

cascade menu 9-4, gloss-1

channels 5-29, 5-40, 5-41, gloss-1

char 5-51

check 5-49, 6-18

class gloss-2

hierarchy 5-2, gloss-2

variables 7-4

computed 7-4

optional 7-4
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required 7-4

clear

logarea 1-14

click 4-48, A-3, gloss-2

click to type gloss-2

client A-2, gloss-2

colon (:)

in regular vector specifier 2-26

index operator 3-6, 5-8, 5-9, 6-30

color map 4-9

current 4-10

using your own 4-10

column vector 2-26, 5-10, gloss-2

comma (,) 5-5

command

area 1-14, 2-2

editing text 1-17

recall 1-20

declaration 6-3

diary 3-32

intrinsic 2-12, 3-15

syntax rules 3-16, 3-17

using 2-11

Commands window 1-11

comment

add via dialog 3-12

partition 3-9

variable 3-9

comment 2-4, 3-9

commentof 3-9

comments 2-4, gloss-2

multiple lines (#{ }#) 3-15

single lines (#) 3-15

comparator 3-3, gloss-2

complex

conjugate transpose (’*) 3-5

matrix 5-3

number 5-3

concatenate 5-5, 5-50, 5-54

concatenation

lists 5-54

matrix 5-5

PDM 5-36

strings 5-50

connection

parallel 5-46

series 5-46

continuing Xmath command lines 3-14

contour plot 4-43

convert using check 5-49

copy 2-15

copying and pasting text

in Motif A-6

within Xmath A-6

Ctrl-Break 1-6

Ctrl-c 1-6

Ctrl-\ 1-7

cursor A-6

D
data structure

et_list 8-10

et_matrix 8-5

et_null 8-11

et_pdm 8-7, 8-8

et_string 8-6

data type

list 8-10

matrix 8-5

null 8-11

PDM 8-7

string 8-6

dbx 8-40
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index-3

debug

off 6-27, 6-28

set 6-26

debug 6-23

debugger window 2-40, 6-23

debugging mode 6-25

setting breakpoints 6-26

setting watchpoints 6-27

debugging an LNX 8-40

declaration line 6-2, 6-3, 6-6

default values 6-7

DEFINE 6-11

#define 8-14

defTimeRange 5-49

DeleteAny 8-11

DeleteList 8-10

DeleteMatrix 8-6

DeleteNull 8-11

DeletePDM 8-10

DeleteString 8-7

delsubstr 5-53

demo

debugger 2-40

graphics 2-23

guidemo 2-42

leadlag 9-1

diagonal 5-13

diagonal matrix 5-13, gloss-2

dialog 9-5

modal 9-5

diary 3-33, gloss-2

command 3-32

session 3-33

directory

pathnames, specifying in Xmath
Command area 1-14

set 1-5, 3-19

show 3-19

directory 6-34

discretize 5-48

DISPLAY 5-52

display  environment variable 3-24

distribution, random 3-24

domain 2-35, 5-21, 5-22, gloss-2

domain 5-33

double-click A-3

drag 4-48, A-3, gloss-2

dynamic system 5-42, C-7, gloss-3

indexing 5-47

null matrix specifier 5-44

operators 5-46

size 5-44

state-space form 5-42

transfer function form 5-43

E
echo

set 3-32

show 3-28

editing text in Xmath 1-17

eigenvalue gloss-3

ellipsis 3-14, C-1

environment variable

expanding in script files 3-26

set 3-23

XMATH_PRINT 3-28, 3-29

eps 3-10, gloss-3

ERASE 4-45

erase

logarea 1-14

err  (permanent variable) 3-10

error

codes 8-44

handling, LNX 8-11, 8-15
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index-4

error 6-19, 6-21

et_list 8-10

et_matrix 8-5

et_null 8-11

et_pdm 8-7

et_string 8-6

EVAL C-13

executable string 3-28

execute 3-27, 3-28, 3-33

exist 6-17

exponentiation 3-5

expression 3-2, gloss-3

extended-selection list 9-5

eye 5-13, C-5

F
face_color 4-33

face_style 4-33

fg_color 4-33

file selection dialog 1-15, A-7

filenames, specifying in Xmath Command
area 1-14

find 2-28, 6-22

find variable 3-13

focus gloss-3

fonts 4-25

for 3-15, 6-15, C-5

format, numerical display 3-24

FORTRAN 8-38

FORTRAN LNX 8-37

fprintf 3-22

frequency response gloss-3

Frobenius norm gloss-3

ftnlnx 8-38

FTP to ISI Technical Support xxvii

functions

intrinsic 3-15, 3-16

MIMO 3-18

nonresident 8-41

resident 8-41

syntax rules 3-16

using 2-10

void 6-6, 6-7

G
general simulation 2-38

get

path 3-26

get 3-26

getchoice 6-20

getline 6-20

goto 6-17

graph object 4-4

bind to variable 4-4, 4-54

graphical user interface. See GUI

Graphics window 2-13

graphics window 4-1, 4-46

colors 4-11

grids 4-23

grip 1-10

GUI 9-1, gloss-3

Help menus 9-1

objects 9-4

radio button gloss-6

slider gloss-7

tools

developing your own 9-2

using 9-1

guidemo 2-42

H
HARDCOPY command 4-55

hardcopy (graphics) 4-54
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index-5

Help

messages 9-5

window 1-21

Xmath

UNIX 1-5

Windows 1-6

Hermitian matrix gloss-3

hessenberg 5-14

Hessenberg matrix 5-14, gloss-3

history. See recall

huge 3-10, gloss-3

I
icon bar 4-49

iconify A-4, gloss-3

identity matrix 5-13, gloss-3

if 3-15, 6-16, C-5

imaginary number gloss-3

improper transfer function 5-43, gloss-3

impulse 5-49

independent parameter 5-22, gloss-4

index

list 5-8, 5-53, 5-54, 6-22, gloss-4

operator 7-10

index 5-53, 6-22

indexing

dynamic systems 5-47

functions 6-22

matrices 2-27, 5-7

PDMs 2-37

indices gloss-4

Inf 3-10, gloss-4

infinity norm gloss-4

initial 5-49

initializer function 7-2

input names, extracting 5-49

integer gloss-4

interrupt

Ctrl-Break 1-6

Ctrl-c 1-6

intrinsic functions 3-16

ISIHOME 1-2

J
Jay 3-10, C-6, gloss-4

K
keep 2-15

key bindings

changing 1-19

default 1-17

keyboard, remapping A-10

keywords 3-17, 4-5, gloss-4

assigning default values 6-7

Kronecker product 3-5

L
label 6-17

leadlag demo 9-1

left null space gloss-4

length 5-51

licenseinfo 1-8

line

feed 1-16, 2-3, 5-4

styles 4-13

widths 4-13

list 9-5

extended-selection 9-5

multiple-selection 9-5

object 2-38, 5-53, gloss-4

single-selection 9-5

list 5-53

xb.book  Page 5  Wednesday, October 6, 1999  11:28 AM



Index Xmath Basics

index-6

LNX

background

function assignment syntax 6-34

mode 8-2, 8-34

terminating 8-36

windows client, communicating
with 8-45

building and calling 8-24

C function format 8-3, 8-4

data type. See data type

debugging with dbx 8-40, 8-41

definition 8-1

FORTRAN 8-37

function

communicating with Xmath 8-12

sample 8-22, 8-29

functions 8-11

AllocateList 8-10

AllocateMatrix 8-6

AllocateNull 8-11

AllocateStringMatrix 8-7

DeleteAny 8-11

DeleteList 8-10

DeleteMatrix 8-6

DeleteNull 8-11

DeletePDM 8-10

DeleteString 8-7

WrapMatrix 8-6

WrapPDM 8-10

WrapString 8-7

WrapStringMatrix 8-7

XmathIPCgetc 8-45

XmathIPCgeti 8-46

XmathIPCgets 8-46

XmathLoad 8-20

XmathSave 8-19, 8-20

handling aborted 8-43

include file, required 8-5

interfacing Xmath with Mathematica
D-1, D-2–D-3

limitations on passing variables 7-15

loading MATLAB data C-16

makefile 8-25

nonresident functions 8-41

program, sample 8-2, 8-34

prototype 8-3, 8-4

resident functions 8-41

speeding execution for MSOs 7-11

string data type, converting to 8-7

UCI comparison 8-1

undefining 8-29

user function structure 8-2, 8-4

USR1 signal handler 8-40

utility 8-2

version compatibility 8-5

load 1-8, 3-20, C-15

log area 1-13

clear 1-14

logical 3-3, gloss-4

log-linear interpolation gloss-4

logspaced vector 2-26, 5-10, gloss-4

loop 3-15

for 3-15, 6-15

if 3-15

if 6-16

while 3-15, 6-16

lower triangular matrix 5-14, gloss-4

M
makecontinuous 5-48

makefile

for an LNX program 8-24, 8-27

template 8-24, 8-27

makefile 8-24, 8-27
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index-7

makematrix

converts strings to numbers 6-20

makematrix 5-37, 5-51

makepoly 2-29, 5-19

markers 4-14

Mathematica to Xmath Interface D-1

MathScript 2-39, 3-1, gloss-4, gloss-5

files 3-27

batch 3-28

execute 3-28

format 6-4

function. See MSF

object. See MSO

programming 6-6

punctuation 3-13

scoping rules 6-7

search paths 6-9

MATLAB

data

using LNX to load C-16

to Xmath translator

aliases C-17

syntax difference C-1

matload.c C-16

matrix 5-3, gloss-5

building 2-25

brackets 5-4

commas 5-4

line feed 5-4

semicolons 5-4

concatenation 5-5

data type 8-5

diagonal 5-13

Hessenberg 5-14

identity 5-13

indexing 2-27, 5-7

operators 5-5, 5-6

punctuation 5-4

square 5-11

string 2-25

symmetric 5-12

Toeplitz 5-14

triangular 5-14

MATRIXX

block diagram 9-2, 9-3, 9-6

menu

bar 1-10

cascade 9-4

pulldown 9-4

selection from keyboard A-7

message area 1-20

Meta key 1-11

MIMO, definition and representation
2-31

mma D-4

mmaget D-4

mmaput D-4

modal dialog 9-5, gloss-5

Motif widgets gloss-5

mouse

click A-3

double-click A-3

drag A-3

instructions A-3

press, push A-3

selecting text

by clicking 1-17, A-7

by dragging 1-17, A-6

move 4-31

graphic objects 4-48

window A-4, A-5

MSC 6-2, gloss-5

building 6-4

command declaration 6-3
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index-8

example 6-14

file format (figure) 6-5

inputs 6-2

inputs (syntax) 6-3

scoping rules 6-8

user-interface functions 6-19

variable arguments 6-30

MSF 6-1, gloss-5

building 6-4

calling syntax 3-16

file format (figure) 6-5

function declaration 6-2

Help 6-2

inputs 6-2

optional block comment 6-2

scoping rules 6-8

user-interface functions 6-19

variable arguments 6-30

MSO 7-1, gloss-5

defining 7-3

index operators 7-9

initializer function 7-3

member entities 7-15

object instantiation 7-2

operator overloading 7-6

scoping (nested objects) 7-5

speeding execution with LNXs 7-11

type declaration 7-6

multiple-selection list 9-5

N
name gloss-5

names 5-33, 5-49

names, specifying directory pathnames and
filenames 1-14

naming rules 3-2

NaN 3-10, gloss-5

negation operator (!) 3-18

new partition 3-7

non-causal transfer function gloss-5

nonresident 8-12

non-singular gloss-5

norm gloss-5

null

space gloss-5

variable gloss-5

null 3-10, gloss-5

numden 5-48

O
object gloss-6

ones C-5

operators 3-4

and PDMs 5-38

indexing 2-27

matrix 5-6

precedence 3-6

with dynamic systems 5-46

with polynomials 2-30

optional arguments, assigning default
values 6-7

orthonormal gloss-6

oscmd

expanding path names 3-26

oscmd 2-9, 3-19

output

keywords 6-7

names, extracting 5-49

overloading gloss-6

P
PARALLEL C-12

parallel connection 5-46

parameter–dependent matrix. See PDM
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index-9

parentheses 5-8

partition 3-7, 3-9, gloss-6

changing via variables window 3-11

delete 2-7, 3-8

handling 2-5

lock 3-13

name 3-2

new 2-5

set 2-6, 3-25

show 2-6, 3-7

size 3-12

viewing variables 2-7, 3-11

partition, definition 2-5

pasting selected text in Motif A-6

path 6-10

adding (set path ) 6-10

overriding (define ) 6-11

removing (remove path ) 6-10

set 6-10

specifying 1-14

viewing (show path ) 6-10

path name

expanding in script files 3-26

pathnames 3-26

pause 6-20

PDM 5-21, gloss-6

allocate for LNX or UCI 8-9

channel 5-29, 5-40

concatenation 5-36

convert to matrix 5-37

creating 5-23, 5-25

dimensions 5-30

domain 5-22

extracting 5-33

independent parameter 5-22

indexing 5-30, 5-33

substitution 5-35

modifying 5-35

names 5-23, 5-33

extracting 5-33

operators 5-38

using with functions 5-40

pdm 5-24

PDM, definition 2-35

period 5-48

permanent variables 3-10

pi 3-10, gloss-6

picture gloss-6

plot 9-7

and mouse buttons 9-7

complex data 4-1

copy 4-18

datestamp 4-55

drawing tools 4-51

edit graphics window 4-55

font sizes 4-56

icon bar 4-56

interactive tools 4-49

keep 4-18

timestamp 4-55

toolbar 4-49

zoom 4-51

plot 2-12, 4-1, 4-5

plot keywords

animate 4-30

axes 4-21

axisfix 4-21

bg_color 4-33

colors 4-9

contour 4-43

defaults 4-6

edge 4-33

face 4-33

face_color 4-33
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index-10

face_style 4-33

fg_color 4-33

grid 4-23

hold 4-37

increments 4-23

keep 4-19

keepsubplot 4-20

labels 4-8

legend 4-8, 4-56

light 4-35, 4-55

line 4-12

marker 4-14

move 4-31

polar 4-45

position 4-31

projection 4-31, 4-55

reset 4-37, 4-55

rotate 4-30

rows and columns 4-16

scale 4-30

strip 4-40

text 4-25

tic labels 4-23

tics 4-23

titles 4-8

zero lines 4-22

plus (+) operator 5-50, 5-54, 7-10

point (verb) A-6, gloss-6

pointer

focus gloss-6

polar plot 4-45

polynomial 2-29, 5-19, C-7, gloss-6

addition 2-30

default variable 2-29

indexing 2-31

multiplication 2-30

operators 5-20

polynomial 2-29, 5-19

polyval 2-31

position 4-31

positive semi–definite gloss-6

power, raise to 3-5

precision (set format fixed) 3-25

press A-3

print 2-8, 3-21

print a graphics file 4-54

PRINTER 1-3, 4-54

proper transfer function 5-43, gloss-6

pulldown menu 9-4

punctuation, MathScript 3-13

push A-3

pushbutton gloss-6

Q
question mark (?) 3-24

quit

in batch .ms files 3-31

quit 1-7

R
radio button 9-4

raise to a power 3-5

random

distribution (set ) 3-24

seed (set seed ) 3-25

random C-5, C-9

read 3-22

real number gloss-7

recall

ctrl sequences 1-18, 1-19

@ sequences 1-20

reduced–row echelon form gloss-7

regular vector 2-26, 5-10, gloss-7
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index-11

remove

break 6-27

commanddiary 3-32

path 6-10

sessiondiary 3-33

watch 6-28

remove 3-25

resident

function 8-12, 8-41, gloss-7

process 8-12

resize window A-4, A-5

resizing window 1-10

restore A-4

root window gloss-7

roots 2-31

rotate 4-30

row vector gloss-7

S
sample period, extract with period 5-48

save

all 1-13

PDMs as matrices 5-38

simulation data 5-38

save 1-8, 2-8, 3-19, C-15

save.xmd 1-7, 3-19

scalar 5-15, gloss-7

scale 4-30

scoping (in scripts) 6-7

script files gloss-7

scroll bars 1-10

search path 6-9, 6-10

selecting

object

by clicking 2-13

by Shift-clicking 2-14

text

by clicking A-7

by dragging A-6

semicolon (;) 3-14, 3-24, 5-5

SERIES C-12

series connection 5-46

set

autocompile 6-12

break 3-23

buffering 3-24

commanddiary 3-24, 3-32

debugonerror 3-24

directory 1-5, 3-19, 3-24, 3-26

display 3-24

echo 1-14, 3-24, 3-28, 3-32

format 3-24, 3-25

logarea 1-13

partition 2-6, 3-25

path 3-25

path 6-10

pause 3-25, 6-21

seed 3-25

sessiondiary 3-25, 3-33

timestamp 3-25

uiupdate 3-25

watch 3-25

set 3-23

Shift-Enter 2-5

Shift-Return 2-5

show

break 6-27

echo 3-28

logarea 1-14

partition(s) 3-7

path 6-10

path 6-10

seed 3-25

watch 6-28
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index-12

show 3-25

simulation, general 2-38

single-selection list 9-5

SISO, definition and representation 2-31

slider 9-6

square matrix 5-11, gloss-7

start Xmath 1-1, 1-4

startup file gloss-7

startup.ms 3-29, 3-30, gloss-7

state names, extracting 5-49

statement 3-1, gloss-8

state-space system 2-31, 2-33, 5-42,
gloss-7

decompose with abcd 5-48

step 5-49

string 2-24, 5-50, C-6, gloss-8

breaking across lines 2-25

concatenation 5-50

converting numbers 5-51

data type 8-6

executable 3-28

indexing 5-52

matrix 5-50, gloss-8

plus (+) operator 5-50

size of 5-51

special characters 5-52

stringex 5-53

strip plots 4-40

support

contacting by e-mail xxvii

contacting by phone xxvii

file a problem report xxvii

sending files via FTP xxvii

symmetric matrix 5-12, gloss-8

system 2-32, 5-43, 5-45

system . See dynamic system

sys*u  (time domain sim) 5-43

T
table gloss-8

target directory 3-19

Technical Support. See support

template.f 8-38

text 1-17

entry area 9-5

tics 4-23

time response 5-49, gloss-8

timestamp 3-25

tiny 3-10, gloss-8

Toeplitz matrix 5-14

toggle button gloss-8

toolbar 4-49

transfer function 2-31, 5-43, gloss-8

converted to state space before
decomposition 5-48

transpose (’) 2-26, 3-5

transpose, complex conjugate (*’) 3-5

triangular matrix 5-14, gloss-8

tridiagonal gloss-8

tril 5-15

triu 5-15

U
UCI 8-4, 8-29

building and calling 8-24

cleanupafter terminationwith -clean
1-5, 1-6

functions 8-11

include file, required 8-5

LNX comparison 8-1

start with -call 1-5, 1-6, 8-2, 8-29

Xmath

computational engine 8-31

graphics engine 8-31

XmathExecute 8-16
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index-13

XmathGet 8-17

XmathPanic 8-44

XmathPut 8-17

XmathStart 8-22

XmathStop 8-22

unalias 3-27

unary operator 3-4, 3-6, gloss-8

UNDEFINE 6-12, 8-29

unitary matrix gloss-8

upper triangular matrix 5-14, gloss-8

user interface functions 6-19

user-callable interface. See UCI

USR1 signal handler 8-40, 8-44

V
variable 2-2, 2-4

comment 3-9

creating 2-2

edit box 9-5

environment, changing 3-23

find 3-13

load 3-12

lock 3-11, 3-13

name includes partition name 3-7

naming 3-2

permanent 3-10

print to file (print ) 2-8, 3-21

save 3-12

show 2-6

size 3-12

temporary (ans ) 3-11

type 3-11

using wildcards with 3-9

viewing 2-7

Variables window 2-8, 3-11

vector 5-9, gloss-8

creating 2-26

expand with [] 2-26, 3-6

logspaced 2-26, 5-10

regular 2-26, 5-10

reversing 2-27

transpose (’) 2-26, 3-5

void function

calling 6-7

declaration 6-6

W
watchpoint 6-27

whatis 3-15, 6-11

while 3-15, 6-16, C-5

WHO 8-34

who 3-8

wildcard 3-9

asterisk 3-9

colon 5-8

percent 3-9

window A-4

close A-5

default window menu A-4

frame A-3

iconify A-4

lower A-5

manager A-2, A-3, gloss-9

maximize A-4

minimize A-4

move A-4, A-5

raise A-5

resize A-4, A-5

restore A-4

Xmath 1-10

Commands 1-11

debugger 6-23

Graphics 4-1, 4-46

resizing 1-10
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index-14

Variables 3-11

working directory 3-19

WrapMatrix 8-6

WrapPDM 8-10

WrapString 8-7

WrapStringMatrix 8-7

X
X Windows A-2

default menu gloss-9

starting A-2

XMATH 1-2, A-9

Xmath

abort (Ctrl-\, UNIX) 1-7

cut and paste 1-17

debugger, exiting 8-42, 8-43

default key bindings 1-17

editing text 1-17

file A-9, gloss-9

interrupt

Ctrl-Break 1-6

Ctrl-c 1-6

Mathematica interface D-1, D-2

quitting 1-7, 1-8

running across the network 1-5

starting 1-4

displaying to a local host 1-5

from a remote host (-host) 1-4

with UCI 8-2, 8-29

syntax differences from MATLAB C-1

tty version 1-5

Xmath command

Help

UNIX 1-5

Windows 1-6

XmathError 8-11, 8-15

XmathExecute 8-16

XmathGet 8-12, 8-17

xmathlib.h 8-5

XmathLNX.h 8-11, 8-15

XmathLoad 8-20

XmathMain 8-1, 8-11, 8-12

XmathPanic 8-44

XmathPut 8-17

XmathSave 8-19

XmathStart 8-12, 8-22

XmathStop 8-12, 8-22

XMATH_PRINT 1-2, 1-3, 3-28, 3-29, 4-54

XMATH_STARTUP 1-2, 3-29, 3-30

xmodmap A-10

Z
zero lines 4-22

zeros C-5

Symbols
- 3-4

– 3-6

! 3-3, 3-5, 3-6, 3-18

% 3-9

& 3-3, 3-5, 3-6

* 3-5, 3-6, 3-9

** 3-5, 3-6

*’ 3-5, 3-6

+ 3-4, 3-6

+ operator 2-25

, 5-5

.* 3-5, 3-6

.** 3-5, 3-6

.*. 3-5, 3-6

... 3-14

./ 3-5, 3-6

./. 3-5, 3-6

.\ 3-5
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.^ 3-5

.˙ 3-5, 3-6

/ 3-5, 3-6

: in regular vector specifier 2-26

: index operator 3-6

: (variable arguments) 6-30

; 3-14, 3-24

< 3-3, 3-5, 3-6

<= 3-3, 3-5, 3-6

<> 3-3, 3-6, 7-6

= 3-6

== 3-3, 3-5, 3-6

=== 6-36

> 3-3, 3-5, 3-6

>= 3-3, 3-5

? 3-24, 3-28

@, @str, @int, @:l, @str:l, @str:p,@@, @@:p
1-20

[ ] 2-25, 2-26, 3-6

\ 3-5

^ 3-5

# 3-15

#{ }# 3-15

( ) 3-6

{ } 3-6, 3-17

| 3-3, 3-5, 3-6

’ 2-26, 3-5, 3-6
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Technical Support and Professional Services

Visit the following sections of the National Instruments Web site at 
ni.com for technical support and professional services:

• Support—Online technical support resources include the following:

– Self-Help Resources—For immediate answers and solutions, 
visit our extensive library of technical support resources available 
in English, Japanese, and Spanish at ni.com/support. These 
resources are available for most products at no cost to registered 
users and include software drivers and updates, a KnowledgeBase, 
product manuals, step-by-step troubleshooting wizards, 
conformity documentation, example code, tutorials and 
application notes, instrument drivers, discussion forums, 
a measurement glossary, and so on.

– Assisted Support Options—Contact NI engineers and other 
measurement and automation professionals by visiting 
ni.com/support. Our online system helps you define your 
question and connects you to the experts by phone, discussion 
forum, or email.

• Training—Visit ni.com/training for self-paced tutorials, videos, 
and interactive CDs. You also can register for instructor-led, hands-on 
courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 
technical resources, or other project challenges, NI Alliance Program 
members can help. To learn more, call your local NI office or visit 
ni.com/alliance.

If you searched ni.com and could not find the answers you need, contact 
your local office or NI corporate headquarters. Phone numbers for our 
worldwide offices are listed at the front of this manual. You also can visit 
the Worldwide Offices section of ni.com/niglobal to access the branch 
office Web sites, which provide up-to-date contact information, support 
phone numbers, email addresses, and current events.
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